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Preface
Krita is a free, open source digital painting program with industry-leading functionality  
and a creative suite of tools that enables you to bring any visual idea to life. It allows for  
a fast, clean approach to creating digital art, without the hassle of pay-to-play or subscription 
license fees. But just like all other art software, it takes time and effort to learn it.

This book provides a comprehensive look into functional tools, visual problem-solving, and 
leading painting techniques using Krita to unleash your inner artist. You'll learn about 
the functionality and tools of Krita for creating digital and print-quality work, as well as 
exploring manipulation toolsets, custom brush creation, overviews of color spaces, and 
layer management. As you progress, you'll get to grips with the "key styles" needed to make 
professional-grade digital art, through techniques such as photobashing, 3D paint-overs, and 
more traditional painting methods, along with covering how Krita handles these workflows. 
After that, you'll work through a few step-by-step art pieces using the skills and tools learned 
throughout the book.

By the end of this Krita book, you'll have a solid understanding of the Krita work 
environment and be able to bring your artistic visions to life with a myriad of leading 
industry-standard techniques.

Who this book is for
If you're an artist wanting to take your artwork and portfolio to a professional level, then 
this book is for you. You'll need some experience in using art creation software (ideally Krita, 
Photoshop, or Clip Studio Paint) before you jump in, but beginners willing to use external 
sources to keep up will find plenty of useful information. Artists looking to upgrade their 
skills for working in the entertainment industry will benefit the most from this digital  
art book.
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What this book covers
Chapter 1, Getting Started with Krita, covers the installation and general settings of Krita 
to get you off to a strong start!

Chapter 2, Reviewing Canvas Properties and Color, reviews aspects such as color modes, 
resolutions, canvas sizes, and the definition of a color, and we also simplify the  
color wheel.

Chapter 3, Utilizing Layers and Layer Groups, discusses the use of layers in your work  
and setting yourself up for success by grouping layers in a logical way.

Chapter 4, Utilizing Brushes and Tools, breaks down Krita's brush engine, including 
making custom categories, using brush features, and customizing Krita's UI for an 
optimum workflow.

Chapter 5, Implementing Layer Blending Modes, showcases some often-used layer blending 
tricks, bringing new clarity to your work in a non-destructive way.

Chapter 6, Composing Using Krita's Toolbox, goes over topics such as layer masks,  
selection tools, a quick introduction to perspective tools, and refining brushwork in 
interesting ways.

Chapter 7, Changing the Feel with Painting, Values, and Sliders, shows you the power of 
Krita's filter options, allowing you to change things such as the tone, mood, and contrast 
of your work with just a few simple clicks.

Chapter 8, Controlling Chaos – Organizing Your Workflow, walks you through  
industry-standard organizational skills, allowing you to revisit your own personal  
work in the future more clearly, and even work alongside colleagues in a professional art 
studio environment.

Chapter 9, Setting Up a Still-Life Study, covers preparing your work area, finding  
good references for studies, prepping your canvas, and controlling your mindset for  
a time-tested art exercise.

Chapter 10, Enforcing Fundamentals, showcases best practices for doing various types of 
art studies, using repeatable and effective steps that will get you great results no matter 
your artistic goals.

Chapter 11, Working with Concept Art, introduces you to the more "imaginative 
realism" side of painting and illustration with definitions of concept art, learning good 
compositional tricks, the power of keeping your ideas open-ended, and embracing the 
digital tools Krita provides to create thumbnails of those ideas.
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Chapter 12, Refining and Creating Cinematic Concept Art, shows how to take your ideas to 
a final "polish," painting over photographic textures, mixing and matching your best ideas 
between thumbnails to make a stronger piece, the process of rendering, and preparing 
your final piece with various postprocessing effects for maximum visual impact.

Chapter 13, Going beyond These Pages, brings the book to a close, allowing you to reflect 
on the progress you have made throughout the book, view your overall progress, and 
understand where Krita and your imagination can take you. 

To get the most out of this book
This book is a hybrid book, covering both some professional-grade tips for general digital 
illustration and the use of Krita in your artistic journey. Familiarity with art terms (such as 
composition, rendering, and brushwork) will come in handy, as will a basic knowledge  
of using a computer (how to open programs, save files, and so on). We will cover all of this 
(and more) in detail, but it's always great to have a head start!

While not mandatory, I highly recommend the use of a stylus, pen tablet, or touchscreen  
tablet device to mimic a more traditional artistic approach. This book and the steps can 
be followed only using a mouse, but certain tips and tricks you will learn will be aided by 
having a touch-based tablet device.

No matter whether you're a digital painting newcomer or a tenured professional illustrator, 
this book should provide some guidance and food for thought about your working approach, 
methods, and overall artistic goals.

Download the example code files
You can download the example Krita files for this book from https://static.
packt-cdn.com/downloads/Krita_Sample_Files.zip.

https://static.packt-cdn.com/downloads/Krita_Sample_Files.zip
https://static.packt-cdn.com/downloads/Krita_Sample_Files.zip
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Download the color images
We also provide a PDF file that has color images of the screenshots and diagrams  
used in this book. You can download it here: https://static.packt-cdn.com/
downloads/9781801071765_ColorImages.pdf

Conventions used
There are a number of text conventions used throughout this book.

Code in text: Indicates code words in the text, database table names, folder names, 
filenames, file extensions, pathnames, dummy URLs, user input, and Twitter handles. 
Here is an example: "Import a custom image (in .jpg, .png, .gif, .pdf, .tif, and 
dozens of other image types)."

Bold: Indicates a new term, an important word, or words that you see on screen. For 
instance, words in menus or dialog boxes appear in bold. Here is an example: "To see  
the different options available, click on the down arrow next to the current Color Model 
Type graphic."

Tips or Important Notes	
Appear like this.

Get in touch
Feedback from our readers is always welcome.

General feedback: If you have questions about any aspect of this book, email us at 
customercare@packtpub.com and mention the book title in the subject of  
your message.

Errata: Although we have taken every care to ensure the accuracy of our content, mistakes 
do happen. If you have found a mistake in this book, we would be grateful if you would 
report this to us. Please visit www.packtpub.com/support/errata and fill in  
the form.

Piracy: If you come across any illegal copies of our works in any form on the internet, 
we would be grateful if you would provide us with the location address or website name. 
Please contact us at copyright@packt.com with a link to the material.

If you are interested in becoming an author: If there is a topic that you have expertise in 
and you are interested in either writing or contributing to a book, please visit authors.
packtpub.com.

https://static.packt-cdn.com/downloads/9781801071765_ColorImages.pdf
https://static.packt-cdn.com/downloads/9781801071765_ColorImages.pdf
mailto:customercare@packtpub.com
https://www.packtpub.com/support/errata
mailto:copyright@packt.com
https://authors.packtpub.com
https://authors.packtpub.com


Part 1:  
Intro to Krita 

and Digital Art 
Terminology Review

In this part, you will learn (or review) industry-standard digital art terminology 
while learning about the ins and outs of Krita as software. We will discuss digital art 
fundamentals such as canvases, color modes, the Color Wheel, layer management, 
brushes, and Krita's toolset for various working styles.

This book is primarily a digital art book, with Krita acting as the vessel for our artistic 
journey. In order to get the most out of this experience, we will review the fundamentals!

This part comprises the following chapters:

•	 Chapter 1, Getting Started with Krita

•	 Chapter 2, Reviewing Canvas Properties and Color

•	 Chapter 3, Utilizing Layers and Layer Groups

•	 Chapter 4, Utilizing Brushes and Tools





1
Getting Started  

with Krita
As we have established, the goal of this book is not to be a technical manual about Krita 
(as Krita's official documentation is way better at that than I will ever be!). However, there 
are some fundamentals that we are going to cover to make sure we start our Krita journey 
in the best possible way. Whether you're a seasoned professional or someone who is brand 
new to digital art, you're certain to find something interesting here!

This chapter is going to cover some of my basic hardware recommendations so that you 
can get the most out of your Krita painting experience. We will look at a quick overview 
of Krita as a piece of software, learn how to download and install Krita, and go over Krita's 
default user interface (UI) once you have the software installed. 

In this chapter, we will cover the following topics:

•	 Recommending hardware – tablets and upgrades

•	 What is Krita, and what makes it different?

•	 Installing Krita

•	 Breaking down the Krita UI 
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Technical requirements
We will be installing Krita from the official website's Download page at https://
krita.org/en/download/krita-desktop/. 

Recommending hardware – tablets and 
upgrades
Normally, in technical guides (especially in other great books from Packt Publishing), 
there's a Technical requirements section that lists the necessary requirements that you 
might need to participate in the guided practices or workshops within the book. However, 
this book has been set up a little bit differently, as it does not require specific hardware 
(other than a machine that meets Krita's system requirements, which we will cover later). 
There are a few items that I'd like to touch on that will make your digital painting journey 
much easier. They come as my personal recommendations. 

The first thing I'd like to cover is the different types of tablets you could consider. If you 
already have a tablet, feel free to skip ahead; however, if you haven't made the plunge,  
I very much encourage you to take a look. Here are some of my thoughts on what to look 
for. Afterward, we will take a look at some recommended hardware upgrade paths to 
ensure your computer is giving the performance levels that you require.

The graphic drawing tablet
If you want to push your digital painting and illustration skills to the next level and have 
not done so already, I highly recommend investing in a graphic drawing tablet (also 
known as a pen tablet) or a touch monitor tablet (also known as a touchscreen tablet) set 
up for your computer. There is a myriad of choices you have regarding sizes, styles, and 
brands when it comes to your tablet purchase, but you'll notice there's no one-size-fits-all 
solution that will work for everyone. So, find something that fits within your budget (on 
Amazon, some graphic drawing tablets start at $40!), and be sure to do your research!

https://krita.org/en/download/krita-desktop/
https://krita.org/en/download/krita-desktop/
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For instance, I used the Huion H610 Pro V2 graphics tablet (as pictured in Figure 1.1) for 
my first year of professional digital art, and I still have it kicking around: 

Figure 1.1 – The Huion H610 Pro V2 graphic drawing tablet

It was a fantastic starting point for me, as it came in under $80 and had all the cool 
features (such as pen pressure, pen tilt, and programmable buttons on the side) that I saw 
my digital art heroes (such as Craig Mullins, Sparth, and Barontieri) using at the time. 

Graphic drawing tablets are devices that only require a single USB slot, so they can be 
used with a large number of computer setups (and even with some cell phones, depending 
on your phone's capabilities). It is a perfect way to get in the door without breaking the 
bank, and it comes highly recommended not only for the projects within this book but for 
your overall enjoyment of digital art in general.
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The graphic drawing monitor/pen display
If you are looking to "level up" your digital art workspace, a drawing monitor could be the 
next step. Drawing monitors mimic drawing or painting in traditional media in terms of 
how they allow you to use a stylus to draw and paint directly on the screen itself, but they 
need a computer to attach to. They will come with power cables, input cables to attach to 
your computer, and depending on the make or model, charging stations or docks for the 
stylus pen. There are many companies, sizes, and styles to choose from, so shop around 
and find something that fits within your budget! While the higher-end Wacom drawing 
monitors can be a few thousand dollars a pop, entry companies such as Huion or XP-Pen 
start around the $300 range, maybe even cheaper during a holiday sale or a special event, 
so keep a lookout!

As I write this, my Huion Kamvas 20 (as pictured in Figure 1.2) is sitting right next to me, 
acting as my third monitor. I have had fantastic luck with driver support and features such 
as pen tilt and pen sensitivity within Krita:

Figure 1.2 – The Huion Kamvas 20

If you want to go beyond the pure hobbyist level, I do think the touch tablet might be 
worth the additional cost investment for the cohesive nature of mimicking drawing  
or painting on a traditional sketchbook or canvas. However, both tablet options are great 
for hobbyists and professionals alike! Remember, impactful art is up to the artist creating 
it; the tools just make communicating the ideas easier!
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Speaking of tools to help your craft, you might have your computer at the ready but be 
interested in upgrading some of the internal hardware to really get the best out of your 
new tablet device. Let's talk about general computer upgrades!

Upgrading your computer
If you want a quick cheat sheet on things to look for regarding upgrading your computer 
to get the most out of Krita, your best bet will be to look at the following items:

•	 Central Processing Unit (CPU): Since Krita has so many moving parts and 
different systems that talk to one other (regarding file management, import/export 
capabilities, and layer calculations), you will want to make sure your computer's 
processor is up to the challenge of handling multiple tasks at once. Newer Intel and 
AMD processors should be up to the task, but if you are noticing your machine is 
lagging while you paint and it is a bit older (for example, 2016 or earlier), it might 
benefit you to look at upgrading the CPU. The CPU is the "brain" of the computer, 
and as we all know, it's always good to have a sharp mind!

•	 Random Access Memory (RAM): Since digital art deals with displaying images on 
the screen, and more advanced techniques such as photobashing and matte painting 
will use multiple images combined to make a cohesive piece, you will want as much 
memory as you can afford. Krita's official documentation lists 8 GB of RAM as  
a system requirement, and I would say that is a fair assessment. You can get by with 
less; however, you might notice a slowdown in performance when making complex 
or larger documents. Upgrading the amount of RAM your system has will improve 
load times, ensure certain tools (such as transforms, warps, and blending modes) 
respond quicker, and display results more instantly on the screen. Think of RAM 
as your computer's "immediate memory," for example, having papers on your desk. 
They're right there at your fingertips, so they provide information quickly without 
having to search (as opposed to a hard drive's memory, which we will cover later). 
In this case, having more RAM would be the same as having a bigger desk to hold 
more immediately accessible items. Krita also uses a great swap feature, allowing 
you to allocate your RAM more heavily to specific tasks and items of your choosing, 
such as the canvas size, the brush engine, and the editing tools while offloading 
(or, in this case, "swapping") things such as extended undo history or recent file 
directories to a hard drive's memory. Essentially, this will free up more RAM for  
you to use in the moment while you create! Pretty slick stuff.
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•	 Graphics Processing Unit (GPU) or graphics card: Many artists and tech people 
might tell you that a graphics card should be the first component of this list, but  
I disagree. Because of their limited availability and moderate-to-high asking price 
compared to both CPU and RAM upgrades, I put a graphics card behind those  
two on the list. Yes, having a graphics card will give you additional processing power 
and memory (as Krita can utilize the additional boost of power that a graphics  
card grants you). However, I would argue that you could comfortably get solid  
CPU and RAM upgrades for less than the price of a single graphics card in the 
current market. If you can get a graphics card for a fair asking price, or do not  
mind spending on some outright ridiculous markup, a graphics card is a good  
choice for getting that boost of performance you might be looking for with your 
Krita workflow. 

•	 Solid-State Drive (SSD) or Hard Drive (HDD): In many ways, your computer's 
hard drive is its filing cabinet. The faster you're able to access information within 
it, the more productive you can be. In practice, getting a solid-state (meaning no 
moving parts) hard drive will allow files to be retrieved, loaded, and brought into 
RAM faster. Think of an SSD upgrade as adding a brand new six-lane highway 
to your computer, making sure there are no pesky traffic jams (such as program 
loading times, data crashes, or slow boot-ups) between when you click on a button 
to do a task and the conversation between your operating system, CPU, RAM, GPU, 
and data, to make that request a reality. Additionally, solid-state drives have the 
benefit of having lower power consumption and higher reliability than a standard 
hard-disk drive due to the lack of clunky internal moving parts. The likelihood 
that you will have the ill-fated "hard drive crash" and lose all your data goes down 
exponentially with a good SSD.

Now that we have some of the basic recommendations for technology and hardware 
upgrades out of the way, let's get into the main reason you're probably reading these  
pages: Krita!

What is Krita, and what makes it different?
Krita is an open source digital art software that is available free of charge for Windows, 
macOS, and Linux. It utilizes many key features that hobby-grade and professional-grade 
digital artists, illustrators, and animators might want or need in their workflow and is 
updated on a very consistent basis. We will cover the installation of the Windows version, 
along with notes about installing the Linux and macOS versions, later in this chapter.
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Krita on Mobile?
While there is currently an Android mobile version of Krita in beta, I am not 
listing "mobile" as a platform, as it is not officially released. However, feel free to 
download the mobile beta and poke around if you have a device that is capable! 
You can find up-to-date information about the status of any and all mobile 
versions of Krita from the official Krita website (Krita.org).

Krita, as we know it, came to be in 2002. However, some interesting history traces the 
beginnings of the Krita project all the way back to 1998! Krita has been going strong ever 
since, and in 2012, the Krita Foundation was formed by the collective Krita community 
to ensure the longevity and success of Krita going into the future. The goal of Krita is to 
be the go-to software for digital artists from all walks of life, and regular donations and 
fundraisers aided by the Krita Foundation ensure that can be the case.

Whether you are just starting your digital art journey or are a tenured veteran in your 
respective art industry, you understand there is a ton of digital art software to choose from 
when it comes to digital painting and illustration. Krita is different in quite a few ways, but 
I would put one feature above all the others: it has been created by creators, for creators.

The Krita Artist Community
Krita has another fantastic feature, and that's the overall art community it has 
nurtured over the years. Various artists, at all levels (from absolute beginners 
to decades-long seasoned art professionals), are available for guidance, advice, 
and sharing creations! You can check out the Krita Artist community by 
navigating to https://krita-artists.org. See you there!

While Photoshop will always be considered an "industry standard" in the digital art 
realm, first and foremost, it started off as strictly a way to edit photographs. Creating 
digital art in Photoshop was almost a "happy accident" that resulted from features being 
added to Photoshop over the years, as opposed to being built from the ground up for 
digital painting and art. On the other hand, Krita has stayed true to its initial goal of 
being a heavy-hitting digital artist suite, by bringing in tools heavily used in Photoshop 
and adapting them to a more matter-of-fact way for visual painters and illustrators to 
use. These subtle changes range from filters, to the way perspective rulers work, to slight 
tweaks of the color wheel and natural brush engines to mimic the feel of traditional 
painting on a canvas. We will be covering all of these features (and many more!) 
throughout this book to create our projects. So, you will see the depth and breadth of 
possibilities that Krita can provide for yourself.

https://Krita.org
https://krita-artists.org


10     Getting Started with Krita

The biggest "difference" Krita provides upfront is the low barrier of entry: it is free! The 
only real thing Krita requires is the time to download and install it, and you are using 
the same software as some of your favorite professional artists at no charge. While I love 
the fact that Krita does not cost anything to download and use, I highly recommend 
donating to the Krita Foundation if and when you can, as our ongoing support as the 
Krita community can ensure the software stays as fresh as possible, for as many people as 
possible. Digital creativity should be available for everybody, and I believe we can act as 
ambassadors to make that a reality!

Another fantastic feature that we will cover, which makes Krita different, is its nature as 
an open source piece of software. So, what does open source mean in this case? Well, the 
full code base (programmed in Python) is available to look at, modify, create extensions 
for, and customize to your liking. The full-time Krita development team is less than ten 
people, with multiple volunteers committing changes, edits, and updates regularly, and 
each new release brings about fantastic changes because of this hybrid team's hard work. 
The UI is fully drag and drop, allowing you to set up your workflow in any way that feels 
comfortable for your creativity. I am friends with quite a few other Krita artists, and  
let me just tell you: not one of our UIs looks the same! That sort of flexibility is very hard 
to come by in the digital art and software industry. However, Krita's open source nature 
makes it one of the most inviting, customizable tools that you can use in your digital 
artistic journey.

Custom interfaces, life-like brushes, awesome tools, and regular updates, all for free?  
You bet! Let's finally get to the installation of Krita. Then, we will discuss some basic 
things that you will see the first time you load the program.

Installing Krita
Krita is free and available for Windows, Mac, and Linux. Because there is a myriad of 
different ways to install Krita on different operating systems, here, I will just cover the 
Windows version step by step.

Installing Krita is easy, as the official website has everything you need to get started! If 
you are downloading the macOS version, please bear in mind that you will need macOS 
10.12.0, or later, for the most current versions of Krita.
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As your first step for downloading and installing Krita onto your Windows device,  
you should ensure that your system meets the minimum system requirements. While  
you could download and use Krita with a slightly older setup than is recommended,  
I do believe the boost of performance you will have when using the minimum system 
requirements, or greater, is well worth the investment.

System requirements
As of writing, Krita's system requirements for Windows PCs use Windows 8.1, or higher, 
as your operating system, 4 GB of RAM, and OpenGL 3.0 (which should be standard, 
even on the vast majority of built-in integrated graphics cards – no standalone graphics 
card is required!) 

Krita's .appimage file for the Linux 64-bit version is readily available from Krita's main 
download page. It is also included in many Linux distribution packages, but you might 
have to enable extra repositories. Krita's official website (Krita.org) has detailed tips 
and commands for more specific Linux setups, including Fedora, OpenSUSE, Debian, 
Arch, Flatpak, Snaps, and more.

Additionally, Krita's website recommends a graphics tablet, which we covered in-depth 
earlier. You can use a mouse, but trust me, painting with a graphics tablet or touch device 
is a game-changer!

A step-by-step example (for Windows)
Now we will begin our step-by-step installation guide for the Windows 64-bit version  
of Krita. 

Note
As of writing, I've installed both Krita 4.4.5 (which was current at the time) and 
the beta version of Krita 5.0. So, some of the images you see here may differ 
slightly from what you see during your first installation.

http://Krita.org


12     Getting Started with Krita

Now, let's begin with the installation process:

1.	 Navigate to Krita's official website (http://www.krita.org), and click on the 
Download option in the main navigation bar.

2.	 You will see a Download Krita graphic, which defaults to Windows Installer 
64-bit, as shown in Figure 1.3:

Figure 1.3 – The Download Krita page as of Krita 5.0
While this is the Windows installation tutorial, note that you can click on All 
Download Versions to bring up the macOS installer and Linux .appimage files  
if needed.

http://www.krita.org
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3.	 Choose your version of Krita (for us, this will be the Windows Installer 64-bit 
version). You will see a prompt asking you to save the file, as shown in Figure 1.4. 
Click on Save File when prompted:

Figure 1.4 – The Save File prompt for the Krita installer version 4.4.5

4.	 Once downloaded, locate your downloaded setup file from your download location 
(many browsers now default to their Download folder in the upper-right corner of 
your browser window). Double-click on your setup file. 

5.	 In Windows 8.1 or greater, you might see the User Account Control window pop 
up, which asks Do you want to allow this app to make changes to your device?. 
This looks very similar to Figure 1.5. Click on Yes when prompted:

Figure 1.5 – The Windows User Account Control permission prompt for Krita 5.0 (beta)
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6.	 For the next step, you will be prompted to choose a language to use during the setup 
process, as shown in Figure 1.6:

Figure 1.6 – The language selection setup prompt
Please note that you can select from over 60 languages inside Krita once it is 
installed, as we will cover later in the Breaking down the Krita UI section of the 
chapter. Krita (and this setup process) should automatically default to your system 
language setting within Windows.

7.	 The next portion of the setup will be the End User License Agreement (EULA).  
I know these can be a bit mundane, but if you are interested in the open source 
nature of the Krita project and the development libraries used in development,  
I suggest giving it a quick read! Click on Next until the installation process starts,  
as shown in Figure 1.7:

Figure 1.7 – Krita's EULA prompt
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8.	 Once you have completed these steps, you should see a screen showing a full 
installation log. It will give you a confirmation message of Completed, as shown  
in Figure 1.8:

Figure 1.8 – A successful installation prompt
Click on Next, and that's a wrap!

9.	 Once installed, you should have a prompt to either Launch Krita or exit the 
installer to return to the desktop. You are ready to start mastering Krita!

Now, let's take a bit of time to look at the default layout of Krita once it has been  
installed and start introducing customizations that you can use to make it feel a little  
more like home!
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Breaking down the Krita UI
Now that your Krita installation is complete, it is time to open the program for the  
first time! 

Once the installation is complete, find the Krita shortcut icon on your desktop, or locate 
Krita in the file location you chose during installation. Double-click on the shortcut and 
Krita should greet you with a loading/splash page to let you know the assets are loading 
(as shown in Figure 1.9):

Figure 1.9 – The Krita loading or splash screen for Krita 5.0 (beta)

Your "New" Install
One thing to bear in mind is that your "splash screen" might look different 
from mine, and that is okay! One of the benefits of Krita being open source is 
that once you customize the software to your liking, a large amount of those 
UI changes will carry over to newer installations of the program on the same 
device (the tools and dockers might change slightly based upon updated 
features). Since I have used Krita for many years, each new version still has 
"my" layout, with my brushes and tools on the left-hand side, while the color 
wheel, sliders, and layer controls are on the right-hand side. Even if it has 
been years since your previous installation of Krita, you might be surprised to 
discover that certain tools are exactly where you left them when you load in 
from a fresh installation!
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You will notice a fairly standard startup screen, and if you are familiar with digital art 
software, the layout might have some familiar features (as shown in Figure 1.10):

Figure 1.10 – My default Krita startup screen from a fresh installation (Krita 5.0 beta)

For the rest of the chapter, we will do a quick overview of the main components that make 
up Krita's basic layout and build up our comfort in terms of navigating the program.  
I know this part might appear basic, but as any good artist knows, the fundamentals are 
key to success!

While the initial startup screen might appear somewhat daunting when you first open the 
program, remember that everything you might need to get started on your masterpiece is 
at your fingertips. We are going to go line by line, in almost a "glossary" style of tour, and 
discuss what we are looking at. 

Dockers and Tool Visibility
If something from these images is not automatically showing for you, a quick 
way to check the visibility of a given tool within Krita is under the Settings > 
Dockers menu command.
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The file menu and toolbar
Starting from the upper-left corner of your screen, we will look at the traditional File 
menu (as shown in Figure 1.11):

Figure 1.11 – Krita's traditional File program menu

The File menu is your core functionality menu within Krita. Features such as creating 
new documents, loading, saving, program settings, and more can be accessed through this 
menu. Bear in mind that the File menu stays static (that is, it does not change) depending 
on the current tool you have selected or the project you have loaded into your workspace, 
so be sure to familiarize yourself with the functionality of each option, as they will always 
be available to you! We will be covering a large portion of what this entire menu has to 
offer throughout this book.

Next, directly under the File menu, we have the contextual Toolbar menu (as shown in 
Figure 1.12):

Figure 1.12 – The contextual Toolbar menu

I want to note that this Toolbar menu is contextual, as the options provided to you on this 
menu will change depending on the tool you have currently selected. For instance, the 
Toolbar menu will give different options if you have the brush tool selected, as opposed to 
the options it will provide when having the text tool selected. Each tool provides a myriad 
of options; later in the book, we will discuss how to customize your toolbar with options 
and sliders of your choosing!
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The workspace
If we continue to use the layout, as shown in Figure 1.10, the next items we will look at will 
be my standard workspace (as shown in Figure 1.13):

Figure 1.13 – A guided look at the main work area of Krita

Here is a quick breakdown of my standard setup within Krita, along with some notation 
regarding what each tool is. Remember, you can mimic this layout if you like or customize 
the sizes and locations of these (and other) tools based on your preferences:

•	 Brush Preset docker (A): This allows you to have your favorite brushes, erasers, and 
illustration tools quickly accessible at any time.

•	 Toolbox docker (B): Similar to the Brush Preset docker, the Toolbox docker allows 
you to quickly access a lot of important formatting, editing, selection, and warping 
tools so that you can manipulate your image in a variety of ways.

•	 Work area (C): The work area is the general area on which your canvas will be 
located. Within this area, you can zoom, rotate, scale, and flip your canvas with  
a variety of tools and keyboard shortcuts that we will review throughout the book.



20     Getting Started with Krita

•	 Overview (D): This is the area in which you'll see a "zoomed-out" version of your 
current project. This is a must-have for me, as I love to see the "readability" of my art 
as I work, even if I'm zoomed in and working on specific details!

•	 Advanced Color Selector (E): This is a tool that we will become much more 
familiar with in upcoming chapters. Some features of this tool include custom  
color wheels and various sliders for the hue, saturation, and brightness of your 
selected color.

•	 Specific Color Selector (F): This is slightly more specific than the Advanced Color 
Selector tool (hence its name!). It gives you more subtle customization of the tones, 
temperatures, and overall "mood" of your selected color. Once again, we'll do a deep 
dive into what this truly means throughout the rest of the book.

•	 Layers panel (G): Your Layers panel will definitely be a staple of your workflow. 
Controlling your layer organization is a very important skillset and one that  
we will review in great depth throughout the book. This area allows for adding 
layers, deleting layers, changing blending modes, grouping content, masking 
content, and more.

Additionally, we will be looking at a large number of these features and settings 
throughout this book. So, while I did a quick overview of each tool I use on a regular 
basis, note that we will be taking a far more comprehensive look at these tools throughout 
the remainder of this book. I am very much a person who likes to learn by doing, and  
I believe the best way to really get comfortable with using the tools of Krita is to use 
them in the context of creating artwork. Seeing another artist's Krita UI setup is always 
interesting, and I hope this quick rundown will help you to decide which dockers and 
settings you would like at your fingertips.

The pop-up palette
Speaking of having features at your fingertips, one very cool feature that Krita offers, 
which will be helpful during your art journey, is the Pop-Up Palette (as shown  
in Figure 1.14): 
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Figure 1.14 – The pop-up palette

This is a shortcut system within Krita that allows you to bring up your most used  
or favorite brushes within your workspace, without needing to fuss around with clicking 
on bulky menus or constantly changing your docker settings. 

To bring up the Pop-Up Palette feature, you simply need to right-click when you are in 
your workspace area. The small tag in the lower-right corner of the pop-up palette will 
allow you to change your brush preset categories, which are displayed in the pop-up 
palette radial menu.

Additionally, note that there is a miniature color wheel in the middle of the radial menu, 
foreground and background color swatches in the upper-left corner of the radial menu, 
and various display options for tool customization and canvas visibility.
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Customizing your workspace
Now that you are familiar with some basic terminology within Krita, the first order of 
business is to set up the program in a way that makes the most sense for you!

Every digital artist is going to have slightly different needs or have their own "go-to" 
features that they consider to be essential when creating the artwork they love. Krita uses 
a powerful system of Dockers (that is, windowed tools that can be locked or "docked" 
to each other and/or anchor points of the program itself). The full list of dockers is 
substantial (as shown in Figure 1.15) and allows for several options and workflows  
within Krita:

Figure 1.15 – The location of various docker options

As you can see from my setup, I only keep a small number of dockers activated at one 
time, as I enjoy keeping my work area free from clutter. Feel free to activate any docker 
that you think sounds interesting and give it a spin! 
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Experimenting and editing your docker locations and settings in your workspace is cool, 
but what if you want to have separate workspace setups depending on what type of project 
you are working on? Working with digital painting will require different "must-have" 
features as opposed to say photography, animation, or graphic design. 

Krita makes having "custom loadouts" very easy, and the program already comes 
preloaded with some standard workspace loadouts that you can try for yourself:

1.	 You can get to this menu by navigating to the Window > Workspace option in your 
File menu (as shown in Figure 1.16):

Figure 1.16 – Krita's workspace selection menu, showcasing various workspace layout options

2.	 Once you have explored your docker windows and would like to save what  
you currently have, you can click on the Window > Workspace > New  
Workspace option. 

3.	 You will be prompted to enter a custom name for this Workspace (as shown  
in Figure 1.17). 
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4.	 Once saved, your custom workspace will be added to the list of options found under 
the Window > Workspace menu in the File menu bar:

Figure 1.17 – The New Workspace prompt

Sharing Your Workspace
Krita has the ability to actually import the workspaces of other artists! Under 
the Window > Workspace window, you will see an option entitled Import 
Workspace. These are stored as Krita workspace files (.kws), and they will 
be located in the Krita > Share > Krita > Workspaces folder of your Krita 
installation directory. This is great for newer artists who are receiving training 
or even sharing workspaces in a studio environment to ensure everyone  
is using the same tools, leading to more consistent results!

Congratulations! You have now created your own custom workspace! This functionality 
might not seem like much at first, but it is a crucial asset that will serve you well. No 
matter the task at hand, you will be prepared with all of your favorite tools for the job,  
all at the click of a button due to your understanding of workspaces.

Configuring the toolbars
While we've touched on how to customize our workspace, note that Krita also allows 
you to make your own customized toolbar. The number of options available for toolbar 
customization is staggering, literally allowing you to browse through every single action 
that Krita can take and then add shortcuts to those actions. The number of options is 
easily in the thousands, ranging from text augmentation and canvas options to importing 
Python plugins and showing system information for bug reports. 
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However, for our needs, I will be adding the Reference Images Tool feature (as we will be 
using this feature in a later project!). Let's add that option to our custom toolbar next:

1.	 Similar to getting the full list of dockers available in Figure 1.15, you will receive the 
Configuring Toolbars prompt by clicking on Settings > Configure Toolbars in the 
File menu at the top of Krita. 

2.	 Once you click on this option, the Configure Toolbars menu will be displayed  
(as shown in Figure 1.18):

Figure 1.18 – The Configure Toolbars prompt

3.	 Once the Configure Toolbars prompt has appeared on the screen, under  
the Available Actions filter, type in Reference. You will notice a few options  
pop up, including one option entitled Reference Images Tool with a push-pin icon 
in the list. 



26     Getting Started with Krita

4.	 Select the Reference Images Tool option (with the push-pin icon) and drag it to the 
right-hand side of the menu (as shown in Figure 1.19):

Figure 1.19 – Getting our Reference Images Tool shortcut configured in our custom toolbar

5.	 Go ahead and select Apply once the shortcut appears in the list at the location  
you would like. 

6.	 Note that the change takes place immediately on your Toolbar section after 
selecting Apply. 

7.	 Continue adding any other shortcuts that you might find useful and apply  
the changes. 

8.	 Once you are done, click on OK.

There we have it! Your change has taken a global effect on Krita. That means every time 
you load the program, your customized toolbar should be available! Regarding your 
custom workspaces, Krita will usually default to the most recently used workspace. Saving 
your custom workspaces is highly recommended as swapping back and forth between 
them will be as easy as clicking on a button instead of having to memorize layouts that  
you liked in the past!
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Returning to True Defaults
At any point, if you would like to return to either of the default toolbars  
or workspaces, you can use the Reset Krita Configurations option in the 
Settings menu.

Now that we have glanced at some docker and toolbar customizations, we can briefly 
discuss some interesting, advanced options in the overall configuration of Krita.

Configuring Krita (advanced)
To get to the more advanced software setup area of Krita, click on Settings > Configure 
Krita. You will see several options (such as Display, Canvas Inputs, Keyboard shortcuts, 
Tablet settings, and more). All of these can enhance your workflow within Krita 
tremendously. If you have specific shortcut keys that you like, custom Python scripts that 
you would like to run, want to set file handling options, or even change the way multiple 
projects being open will appear on screen, this is the area where you can tinker to your 
heart's content. 

For this book, we will look at two main configuration areas: Author profiles and Color 
Selector Settings.

Setting your author information
Author information within Krita is a cool feature that allows every image you create in 
Krita to have metadata embedded into it! When an image you create in Krita is exported 
with the author information embedded, if a viewer right-clicks on your image, your 
information will appear in the image's description. The information allowed in the author 
information embed is varied and can include your name, website, email address, physical 
address, phone number, or fax number.
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To set a customized Author Information feature within the Configure Krita prompt, 
perform the following steps:

1.	 Click on the Author icon on the left-hand side of the Configure Krita prompt. 
2.	 To create a new author persona, click on the + button in the upper-right corner  

of the Author prompt. 
3.	 Create a new name for this author persona and begin filling out the information 

that you would like embedded in your Krita-exported images (an example is shown 
in Figure 1.20):

Figure 1.20 – The Author information panel
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4.	 After filling out the information that you would like to provide in your image's 
metadata, click on the OK button to save your changes. 

Now, let's make sure that your new author profile has been enabled so that you can receive 
that sweet credit for your artwork online! To enable your newly created author profile, 
perform the following steps:

1.	 Click on the Settings menu. Then, scroll to Active Author Profile near the bottom 
of the list. 

2.	 From here, you will see all of the author personas you have created (as shown  
in Figure 1.21):

Figure 1.21 – Activating your custom author profile

Now you can make as many author personas as you wish!

Exporting Images with Author Information
To successfully export your images with your author metadata, make sure that 
the Sign with Author Data option is checked while exporting your image. 
Please note that only JPG and PNG exports allow the metadata to carry over 
and, initially, the export's metadata fields will only provide what you have 
listed as the Nickname value and the first entry of Contact information. In 
the example shown in Figure 1.20, my file would export with Wes-Default 
(http://www.wesleygardner.com) as my metadata.

http://www.wesleygardner.com
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Color selector settings
In the next chapter, we will be looking at a comprehensive guide on how to color in Krita 
(and, in general, digital art). To get us up to speed and set up for the upcoming chapter, 
let's look at a few of the Color Selector Settings options that Krita provides in the 
Configure Krita prompt (as shown in Figure 1.22):

Figure 1.22 – The Color Selector Settings panel
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As you can see, there are a variety of options available for color within this screen.  
For our setup, we will look at the Color Selector panel, customizing the look of  
our selector itself and the mode in which it displays information.

You have a variety of options for choosing your "color wheel" within Krita. To see the 
different options available, click on the down arrow next to the current Color Model  
Type graphic. A list of different graphics should be displayed (as shown in Figure 1.23):

Figure 1.23 – The full range of color wheels available in Krita
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Wow, there are so many options! Which one should you choose? My recommendation 
is to select the color wheel that makes the most sense to you. My usual color wheel is the 
rightmost option on the top row in Figure 1.23, and will be the one I recommend using 
if you want to follow directly along with the examples in this book. After selecting your 
preferred color selector, go ahead and change the mode in the drop-down menu to HSL 
(as shown in Figure 1.24):

Figure 1.24 – The color mode hue/saturation format selector

Do not worry if you are not sure what the hue and saturation modes mean. We will cover 
that (and much more!) in the next chapter when we discuss color.

While we are moving forward through the book, we will keep discussing UI 
customizations and how slight tweaks could help your workflow become more refined, 
structured, and easier to handle.

The beauty of Krita's UI is in its flexibility, and the more you experiment with different 
setups and settings, the greater and more enriched your digital art experience will become. 
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Summary
In this chapter, we looked at the basics of Krita, hardware recommendations, and a few 
customization options for Krita's interface and tools. We learned about dockers, toolbars, 
workspaces, the pop-up palette, and more advanced options to make Krita feel like our 
own personal art studio. Getting comfortable with Krita is a foundational component 
of being an effective digital artist, as the more comfortable you feel when using the tools 
provided in Krita, the more you can focus on the fun part of creating art!

In Chapter 2, Reviewing Canvas Properties and Color, we will do an extensive deep-dive 
into what makes up color. We will not only look at how Krita displays and uses it but 
in general, how to best utilize color theory in the creation of art. We will discuss the 
differences (and similarities) in how the human eye perceives color in traditional art 
versus digital art, what the differences are between RGB color and CMYK color, how  
to build any color from memory, highly effective ways to read the color wheel, and even 
dissect the components that make a color what it is.

Join me in the next chapter, where we will cover topics such as resolution and color theory. 
These topics may seem intimidating and dense at first, but hopefully we will break them 
down into something much more approachable and easy to understand!
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Properties and Color
Welcome to the second chapter! In the previous chapter, we discussed what makes Krita 
unique, installed the software, and discovered some fun ways to customize your user 
interface (UI) to make sure you have everything you need to get creating.

This chapter will be discussing a few things that seem to be "gotcha" topics for a sizeable 
portion of digital artists, even at intermediate and advanced levels. My goal for this book 
is to be a reference that acts as your "art buddy"—something you can take off the shelf year 
after year and find something new to chew on. No chapter will encapsulate this more so 
than this one. 

In this chapter, we will discuss the following topics:

•	 Breaking down resolution, aspect ratios, canvases, and dots per inch (DPI)/pixels 
per inch (PPI)

•	 Evaluating color modes—red, green, blue (RGB), cyan, magenta, yellow, and 
blacK (CMYK), and the RGB/RYB difference (additive versus subtractive color)

•	 Understanding basic color theory

•	 Clarifying the color wheel
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First, we are going to cover some key terms and definitions regarding digital screens and 
your options regarding the creation of digital art. This quick review will help us refresh 
our knowledge of a few of the fundamental terms regarding our craft. We will then look at 
how digital color works in relation to "traditional" color theory, and some effective ways to 
use the color wheel that may make your life easier going forward!

While this book is focused on using Krita to create your digital art, this chapter is more 
all-encompassing on digital art in its totality. Think of this chapter as a "crash course" for 
the topics discussed, taking advanced topics and breaking them down into repeatable, 
impactful steps to help you produce your visions the way they were meant to be seen!

Technical requirements
To follow along with this chapter, you will need the following:

•	 Krita (version 5.0 +)

•	 A way to interact with Krita, such as a keyboard and either a mouse, tablet, or touch 
device with a stylus

There Are No Rules! Well…Sort of.
In this chapter, I will be giving very general recommendations when it comes 
to formatting your artwork in Krita. In no way, shape, or form are these 
"requirements" for your art. These come from my experience working with a 
variety of professional clients, and as many times as I've followed these general 
guidelines, I've broken them as well. When in doubt, your client is always right, 
and their request for a certain aspect ratio or resolution takes paramount! Art 
directors often give "template files" or "art bibles" that list ratios, resolutions, 
and dimensions that you are required to use. If it's for personal work, these 
choices are up to you and you alone!

Breaking down resolution, aspect ratios, 
canvases, and DPI/PPI
Let's go ahead and break down some terms in a "definition" style list first, and then we will 
talk about the functional, everyday impact these topics will have on your workflow when 
it comes to working with clients or personal work. Here we go:

•	 Resolution—The number of pixels, usually listed in a "width by height" format, that 
a given digital device can display. Popular resolution terms you may have seen are 
1080p (1920 pixels wide x 1080 pixels tall) or 4k (3840 pixels wide x 2160 pixels tall).
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•	 Aspect ratio—The ratio of the width and height of a given display or canvas, usually 
given in a width:height format, using the lowest common denominator of each. For 
instance, both 1080p and 4K resolution examples would be 16:9 aspect ratios, while 
older non-widescreen televisions (such as cathode-ray tubes, or CRTs) would have 
display aspect ratios of 4:3, being more box-like in appearance. More on this in a bit.

•	 Canvas—The canvas is your functional working space for a project in Krita. This 
is a document (consisting of layers) that you create that has the capability to be 
edited and manipulated in various ways, including painting. Canvases can be 
created in any aspect ratio, with any resolution settings (within the confines of your 
computer's hardware capabilities, of course, but more on that in a minute). Basically, 
this is your painting area! If you think of canvases you can purchase at a store, or the 
various sizes of papers available for traditional art, you can start getting an idea of 
the possibilities you have when creating a digital canvas.

•	 DPI and PPI—DPI and PPI are both terms used in relation to the amount of visual 
information provided within a 1-inch area of an image. DPI is a term used for 
physical printing, such as newspapers, magazines, and other physical deliverables. 
PPI is used for images displayed on digital devices such as computer screens, cell 
phones, and tablets. The higher the number of pixels or dots within a 1-inch space, 
the more clarity, detail, or "sharpness" an image will have. For this book, we will 
exclusively be working with "PPI" when we make our images, as we are creating our 
artwork on a digital canvas, for presentation online. Just know that for our purposes 
as digital artists, DPI and PPI are interchangeable. The functional difference 
between PPI and DPI comes more into play when you're browsing around for 
a professional printing service, as DPI can change depending on the printer 
manufacturer. One company's 300-DPI printer may have the same clarity and print 
quality as another company's 700-DPI printer: there's no "industry standard" dot 
size or shape when it comes to physically printing something, so it's worth shopping 
around your local printers to find the perfect fit for you if you're interested in 
creating prints of your work.

There are a ton of combinations when it comes to mixing resolution, canvas sizes, and 
aspect ratios. For your personal art, having so many options may seem overwhelming. 
Where do you start?

Next is a "quick guide" list of sorts, and some notes discussing the decisions for these 
combinations in creating your artwork.
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Print versus digital resolution (PPI) settings
Setting up a canvas is all about context and intent. There's a lot of problem solving that 
you can do before you even put a brush to canvas, and that begins with setting up your 
document in a way that best matches what your final output's use case will be. Here,  
we will discuss some differences and important distinctions between working with 
projects that would be mainly viewed digitally and work that would be used for  
creating prints.

Digital-only 
If you are creating work with the intent of it to only be seen on a digital screen, I would 
recommend sticking to 72 PPI for your image (unless required to go larger by your client, of 
course!). Your height and width dimensions can be variable depending on your project 
(such as posting to a web portfolio versus posting on social media), but staying at 72 PPI 
will ensure Krita will have enough headroom to use any and all types of tools you throw 
at it. Your brushes will respond faster, resizing and cropping items on your canvas will 
be smoother, and you'll overall improve the real-time speed at which you'll create, as you 
won't be waiting around for parsing and loading of tools or effects. Digital screens, even 
with high resolutions such as 4K and 8K, are great at calculating and presenting 72-PPI 
images with stunning clarity.

Print 
If you are working with the intent of printing (whether as a gift, selling prints as  
a business, or pursuing mixed media), I recommend sticking to 300 PPI or above for  
your images. While these files will require more system resources and may cause a slight 
slowdown depending on your system's capabilities (such as random-access memory 
(RAM) and central processing unit (CPU) performance), the clarity of your art is 
paramount when translating it from a digital screen to a physical printer. 

There's no specific "mathematical ratio" of translating the PPI setting of your art to  
a printer's DPI setting (unless one is provided by your printing service provider (SP)), 
so you want to work with a canvas that allows for the highest density of information 
possible as a "better safe than sorry" approach. Going over 300 PPI is possible, but in my 
experience, there are diminishing returns that don't make it worthwhile. Going to 1200 
PPI when creating your image will not necessarily be "four times clearer" than 300 DPI. 
The cost of printing would go up (specialized printers would be needed), and the amount 
of slowdown on your computer would be exponential (as you are literally growing the 
amount of information per inch of canvas space to be functional). It's just not worth  
the hassle. 
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Out of dozens of professional clients I have worked for, exactly one (!) required a piece 
larger than 300 DPI/PPI in resolution. Consumer-grade printers can go upward of 4800 
DPI, but I would argue that past a certain point, a higher DPI is just wasted ink. 1200 DPI 
is usually the upper limit I've found in professional conversations with printmakers and 
photographers, but I would definitely not recommend working with a canvas at 1200 DPI 
for digital painting. The amount of memory needed to work in real time showing each 
brush stroke effectively manipulating the canvas would be too much for the vast majority 
of machines.

Landscape versus portrait versus freeform
While knowing our finalized intent of print versus digital is critical, so are the main 
resolution and dimensions we want to use when creating our piece. Setting up your 
canvas's size to better align with the goal you want in your work will solve some 
compositional problems, even before they might arise! Let's look at three of the most 
popular and often-used image dimension ratios for professional and personal work alike: 
landscape, portrait, and what I like to call "freeform".

Landscape 
Landscape images often follow a general rule of "fat rectangles", so having an aspect ratio 
of 16:9 (widescreen panoramic) is a safe bet, as are ratios such as 2:1, 3:1 (both considered 
panoramic), and 6:4 (standard 35-millimeter (mm) format).

Functionally, let's say we're making a wallpaper landscape for a client, and they want you 
to paint a piece that fills their new 4K display for their office building to greet customers 
as they approach an information desk. For thumbnailing and first-draft passes, I would 
create a new document and set the canvas size at 3840 x 2160 at 72 PPI, as shown in the 
following screenshot. This would fit the exact specifications of what they're asking for  
(a 16:9, 4K-resolution digital-only presentation), and you could display these thumbnails 
on the actual screen for the client to see and approve:

Figure 2.1 – A 4K-resolution (3840 x 2160) canvas example



40     Reviewing Canvas Properties and Color

However, once I got the go-ahead from the client to finalize my art, I may transfer what  
I have into a canvas that doubles in width and height but stays at 72 PPI. This would allow 
me to work on a 7680 x 4320 canvas and be able to have enough space to really nail down 
some fine details and would scale perfectly down to half-size for their 4K display for an 
extra pop of clarity. 

Staying at 72 PPI for this piece will allow Krita some more breathing room to process your 
work, as when you start making your width and height dimensions larger, the number of 
system resources (the amount of RAM, most commonly) required for a smooth workflow 
for brushes and tools grows as well. There'd be no need to go to 300 DPI, as they wouldn't 
be printing this piece. Job well done!

Portrait  
On the flip side (literally!), think of portraits as "tall rectangles." These will usually be 
taller than they are wide, so you can safely take the ratios of landscape images and invert 
the numbers. Ratios such as 9:16, 1:2, 2:3, and the like should serve you well. Once again, 
if you're creating these for digital displays only (such as social media posts or online 
portfolios), 72 PPI is a perfect resolution for personal work. If you're printing, go for  
300 PPI. 

Let's say you want to break in your new inkjet printer by completely filling up a piece of 
computer paper with a portrait. For this task, I'd mimic the size dimensions of a generic 
piece of printer paper (8.5 inches wide by 11 inches tall) and work in 300 PPI in Krita,  
as shown in the following screenshot: 

Figure 2.2 – A portrait canvas example, mimicking the dimensions of computer paper for printing

This will allow my inkjet printer to use all the visual density of a 300-PPI piece, as it would 
convert 1-to-1 for my 300-DPI printer. Just know, the higher your printer's DPI setting, 
the more ink it's going to use! 
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Freeform 
As we discussed earlier, there are no "rules" in art. There ARE, however, these pesky 
things called "requirements", and each website seems to have different ones! Creating an 
art post for Instagram will have different requirements than a post for Twitter, Facebook, 
or an online portfolio, as each website has its own visual identity, branding, and aspect 
ratios that display best on its platform. When in doubt, always check the documentation 
of the platform you are wanting to post art on, as many social media sites have frequently 
asked questions (FAQs) discussing image formatting for optimal presentations. I consider 
these "freeform", as the needs of each site can change, meaning your presentation style 
should remain free enough to form to each site's specifications. Remember: social media 
is digital, so 72 PPI is the sweet spot in relation to resolution. You arguably won't get much 
return on investment (ROI) if you go too much higher than that.

Make a lot of projects, in many aspect ratios, using a variety of DPI/PPI settings. What 
difference does bumping your resolution from 72 PPI to 150 PPI make in regard to 
the clarity of your digital art? Is it worthwhile converting a 72-PPI image to 300 PPI 
by copying and pasting, and resizing to fit the new canvas? A huge benefit of working 
as a digital artist is having the ability to experiment. Experimentation is key for truly 
understanding the impact these settings can have on your work, so I'd recommend 
playing! Prepping your canvases for art projects is a topic that could have an entire book 
dedicated to it, so my biggest piece of advice is to practice!

That was our quick look at canvas settings! Hopefully, this takes some of the fear you may 
have of "making the right decisions" when setting up your document. The more digital 
art you make, the more these decisions will come as second nature to you as you'll have 
experience in knowing what works best for your workflow. 

Now, let's get into the nitty-gritty of digital color theory (be sure to grab a snack—it's  
a whopper of a topic!).

Evaluating color modes
Now, let's start our coverage of color modes! We are going to cover quite a bit in this 
section, including the following: 

•	 Fundamentals of digital color space (RGB versus CMYK)

•	 Krita's terminology and settings for color

•	 Some differences between digital and print as it pertains to color
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Out of the many sections in this book, I believe that the color portion may be the one that 
will be most beneficial to return back to from time to time as a reference. The more years 
I spend creating art, the more subtlety and range I learn about using color to share my 
artistic voice more effectively. 

Color Experts?
This may seem weird to say, but I'm a firm believer there's no such thing as an 
"expert" when it comes to using color in relation to "choosing the right color 
while painting on a canvas." While some artists are extremely gifted in their 
color understanding, thinking of an "expert" means there's a tangible finish 
line where you stop learning, which is not true! The following information 
will discuss the mathematical differences between color modes in regard to bit 
depth and light versus pigment, but the act of using color artistically is very 
subjective and up to the individual. In the color wheel portion, we will talk 
more artistically about making strong choices when it comes to using color.

Before we dig too far into the nitty-gritty of color, we should define the "technology" 
aspect of how we will interact with it within Krita. Enter color depth, bit depth, color 
modes, and setting up your canvas.

RGB, RYB, CMYK, and bit depth
Something to keep in mind before we get into discussing using these acronyms is making 
sense of them in the context of one another. Please keep in mind that these are extremely 
general breakdowns of each topic, and each one could easily fill an entire 400+-page book 
on its own. For the purposes of this book, we want to keep these complicated topics easy 
to digest (as our emphasis will be on digital painting, and painting techniques). I highly 
recommend doing a deeper study through these topics if you're interested in the more 
specific details.

RGB 
The RGB color model is a way of using colors in regard to light. As you add more pigment 
(or light) to the three primary colors (red, green, and blue), you will be adding brightness, 
which will then push the colors closer to pure white, hence the term additive color 
model. Full amounts of red light, green light, and blue light overlayed and stacked  
on top of one another will make pure white.
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In digital art, we work primarily in an RGB color model. Each of these colors (red, green, 
and blue) is broken down into separate channels—basically, grayscale-mapped lightness 
and darkness maps that tie brightness values with each color hue independently. You 
can manipulate each channel separately, making for some interesting effects and editing 
opportunities. We will cover just a few of these throughout this book.

Sometimes, you may also see the term RBG/A, which is our RGB color channels with an 
added equation for an alpha channel. 

Alpha Channels
An alpha channel is the property name given to the opacity (or viewability) 
of the contents on a layer, with an alpha set to 0 (or 0%) as invisible, while an 
alpha setting of 1 (or 100%) is fully visible. This comes in handy when working 
in certain file types (such as .PNG, .GIF, .TIFF, .TGA, and JPEG-0000) 
with the ability to hide various amounts of information in an image. Think of 
when you create a logo: you'll want the logo by itself, with no white or black 
background integrated into the image (this is where alpha channels come  
into play).

The main takeaway with RGB (or RGB/A) is to remember the following: this color model 
deals with the use and properties of light instead of physical pigments. 

RYB 
Considered the "traditional painting" primary colors, red, yellow, and blue (RYB) is often 
mentioned along with the likes of pigment stacking or a subtractive color model. As the 
opposite of additive color (where the more pigment or color you add, the brightness  
or light value increases), with subtractive color, the more pigment you mix together, light 
is subtracted from the mix (as the light can't penetrate the multiple layers of physical 
pigment molecules as easily), causing the colors to darken. 

You will often hear about traditional painters getting "muddy colors" due to mixing too 
many colors together, which forms a darkish-brown neutral color. This is due to the colors 
themselves canceling each other out (which we'll talk about in the color wheel portion in  
a bit). When you're adding more pigment information (in this case, colors of paint on 
your palette) on top of each other with layers, the thick stacks of paint on top of one 
another start to block the light from traveling through the mixture on your canvas. This 
leads to a "mud" comparison, as it becomes difficult to discern specific hues or values with  
your paint.

In essence, "additive" and "subtractive" are terms in relation to light, and how the eye 
perceives light passing through colors.
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CMYK 
CMYK is a term used for pigments as it pertains to printing. Since printing transfers 
information into a physical space, it follows the rules of a subtractive color model (the 
more pigments you overlay, the darker the result). CMYK uses four ink plates and 
halftones (opacity percentages) to give a seemingly limitless amount of color and works by 
masking colors onto a light background. 

To get the colors for the CMYK process, you would remove the primary colors (in this 
case, red, green, and blue) from white light, in essence removing them and only leaving 
the two remaining primary colors, combined together to make a new hue. 

For instance, if you mix pure white light and remove the red wavelength, you will get  
a cyan hue (an even mixture of the two remaining primary colors, green and blue). White 
light and removing the blue wavelength would leave yellow (a mix of red and green), and 
white light with removed green would leave magenta (a mix of red and blue). 

Black is used to "pick up the slack" for darker darks, as it's easier for printers to mix subtle 
amounts of black with different hues to make greater color and value ranges instead of 
using exponentially larger amounts of cyan, magenta, or yellow halftones. You can get very 
dark darks without black ink, but the fiscal cost of printing goes up considerably as more 
ink would be needed to stack in order to block light.

Bit depth 
Think of bit depth as the "size" of value information a color channel can allow in  
a digital space. Krita uses four main bit-depth options, and this refers to the amount of 
information on a given channel (the independent values for red, green, and blue). The 
higher the bit-depth count, the more information or data per color channel. Here's a quick 
breakdown of Krita's four options as it pertains to bit depth for your images:

•	 8-bit (true color)—With this bit depth, each channel will use values up to 256 
(ranging from 0, which represents none, to 255, which represents maximum) to 
represent the amount of the given channel's hue present in the color. This can allow 
for the creation of over 16 million colors!

Reading RBG and RGBA
If we're using an RGB(A) method, the numbers would be presented in the 
format "x,x,x,x", each part corresponding to the hue acronym in R, G, B, A. Full 
red would be 255, 0, 0, 1, for instance, showing maximum (255) red, no green 
(0), no blue (0), and 100% opacity (1). Full blue, but at 50% visibility, would 
then be notated as 0, 0, 255, .5, meaning no red (0), no green (0), maximum 
blue (255), and 50% visibility (.5, as alpha works on a 0-1 scale).
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•	 16-bit (integer)—This is sometimes known as deep color, and essentially doubles 
the amount of color information per channel. Some screens can't even tell the 
difference between some of the more subtle shifts of color present in 16-bit depth, 
but the file's data information can allow for smoother transfers between hues and 
values, as more data is present in the file.

•	 16-bit (float)—Very similar to 16-bit-integer depth, but allows for decimal-point 
coordinates for even more refinement. For instance, while a 16-bit-integer depth 
scale may look at coordinates such as 2, 5, and 12, a 16-bit float has the capability  
to look at ranges such as .7 or .921 when mapping color.

•	 32-bit—This is even higher precision and is the standard for Image Maximum 
(IMAX) and high-dynamic-range (HDR)-capable films, using color management 
solutions such as the popular OpenColorIO system. Krita natively works with 
OpenColorIO, meaning it can be used for video-production pipeline work for 
Hollywood films. Awesome stuff!

As you can see, there are a lot of equations and mathematics going on behind the 
scenes in order to bring your colors to life within Krita. While this information can be 
overwhelming, throughout the book, I will be giving notes about decisions we'll make in 
regard to creating specific bit-depth pieces. 

Primarily, I work in an 8-bit integer/channel mode on a vast majority of my personal 
pieces; however, if I'm working with a client that provides 16- or 32-bit images (such as  
a movie studio), I'm glad Krita has the capability to open and work with them. Just as with 
resolution, the higher your bit depth, the more resources your computer should have to 
interact with it at an effective rate. 

I work primarily in an 8-bit mode because the response time for brush strokes, warping 
layers, using blending modes, and save/load times is much faster than for 32-bit. 16-bit 
is a great "middle ground," allowing for smoother gradients (as there's more color 
information per channel, giving a more exact representation of hue shifts) and higher 
value ranges. The performance hit is less drastic than going from 8-bit to 32-bit, but the 
feel of certain brushes and features will feel slower and less responsive depending on their 
complexity, even on the jump from 8-bit to 16-bit.

Digital screens are very good at showing 8-bit depth and haven't steered me wrong in 
creating my art. You still get a luscious, beautiful color that showcases the way you want, 
with a more responsive painting experience—what's not to love? If you prefer working in 
16-bit or 32-bit modes and you don't feel any slowdown with your workstation, go for it!



46     Reviewing Canvas Properties and Color

Going from RGBA to CMYK – digital to print
We have discussed the difference between additive (RGBA) and subtractive (print) color 
models from a technical standpoint, but what does all of that mean in relation to creating 
digital art and printing it? At any point, you can change your color mode between RGB 
and CMYK within Krita!

To change between these two color modes while you work, proceed as follows:

1.	 Browse to your File menu and click the Image option.
2.	 On the drop-down menu, select Convert Image Color Space. You will be greeted 

by the Convert Image Color Space Option window, as illustrated in the  
following screenshot:

Figure 2.3 – Convert Image Color Space Option window

3.	 To change between CMYK and RGB (or from one color model to another available 
color model), click the Model drop-down menu.

4.	 You can also convert your bit depth by clicking the Depth drop-down menu and 
selecting between 8-bit, 16-bit, and 32-bit.
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Going Back and Forth between Color Models and Bit Depths
If you have the ability to go back and forth between bit depths and color 
models, why would it matter which settings you used when you initially made 
your canvas? As we discussed earlier in the book, intent is everything. The 
more you mess with depths and color models after creating your initial canvas, 
the more awkward and unnatural your work will appear. Each time you make 
a "behind the scenes" adjustment such as this, you're fundamentally changing 
the foundation of your image. Going from CMYK to RGB, back to CMYK? 
Generally, your colors will appear more muted, less vibrant, and less cohesive 
as the conversion algorithm is making your decisions for you. Changing bit 
depths will alter the amount of information and data on the canvas, impacting 
the blends and gradients you are able to achieve. I highly advise making  
your color model and bit-depth decisions before you begin and sticking with 
your choice.

You will also notice a setting on this window called Rendering Intent, which gives four 
options: Perceptual, Relative colorimetric, Saturation, and Absolute Colorimetric. 
Each one of these gives differing results in relation to transferring your current colors 
into another "map" when the image conversion takes place. Reds and blues may be altered 
more heavily than greens or purples, for instance, so it is worth playing around with 
settings to match the color-impact effect you are looking for. We will take a look at this 
later in the book when we start doing some advanced techniques such as photobashing 
and creating work for prints, as these properties deal with transferring color ranges for 
printing. While they may seem super-advanced based on their fancy names, the changes 
between each are subtle and are usually handled by a printing team.

Recommending canvas sizes and settings
There is a heavy amount of information in the preceding portions of the chapter, and I can 
tell you that once you find a workflow that works for you, feel free to stick with it. Going 
from digital to print is something you will have to experiment with, as settings such as 
bit depth and color models have learning curves. The best way to find out the difference 
between RGB and CMYK for printing is to print! Look at the colors, look at the clarity, 
and make a choice that feels the most natural for you.

To wrap up this portion, before we move on to breaking down colors and reading the 
color wheel, here are my go-to settings when creating pieces:

•	 Digital—If I'm working on a piece purely for digital reproduction (whether on an 
online portfolio, social media, or something for a client with digital intent), I'll work 
in either 8-bit or 16-bit integer bit depth at 72 PPI, in an RGB color space model.
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•	 Print—If it's in print, I will usually work in 16-bit integer or float bit depth, at 300 
PPI/DPI, in the CMYK color space. This is the most natural fit, as most printing 
companies I've worked with require 300 DPI and have top-of-the-line CMYK  
color-space replication processes. If the printing option you use requires RGB  
color mode, making the switch using the Convert Image Color Space process  
we previously looked at will give stable color reproduction and shouldn't darken  
or lighten your hues or values too much. However, going from RGB to CMYK  
has a more drastic impact (as you're essentially removing light from your hues  
and values).

I very rarely use 32-bit bit depth when creating personal images, as I feel any 
"improvement" I see in my work is not worth the hit on performance. However, if a client 
provides (or requires) content that needs to be in 32-bit, I will gladly oblige. Different 
creative industries work with different professional pipelines and have very specific 
requirements, so it is important to become familiar with the ways individual settings (such 
as differences in bit depth) can impact your work. Remember, your client's needs come 
above your own when it comes to industry-standard and shippable, deliverable items. 

We have looked at some Krita options for setting up canvases for your digital work and 
setting yourself up for success with your initial setup in regard to how color will display. 
Now, we are going to look at color as a feature in and of itself, dissecting a key prospect of 
art that has been studied for centuries.

Understanding basic color theory
Coming into this section, we are going to enter more of the "general artistry" part of the 
chapter. That means that while we may see a few Krita options and screens, the overall 
tone of the remainder of this chapter can be used in any form of visual communication, 
not just Krita (or digital painting). 

I was trained as an observational artist in an atelier setting, meaning I've done enough 
still-life paintings and figure drawings to last 20 lifetimes! What it also means, though, is 
that my understanding of color and its different aspects is heavily influenced by in-person, 
professional classroom training under a mentor. Much of it comes from painting from life, 
and the overall idea of color for me is very contextual.

Breaking down a color
Before we get too deep into the theory behind color and the observational approach, 
however, we will define each of the three aspects of color. We will be going into a deep 
discussion about these three properties in the Clarifying the color wheel section of this 
chapter in a bit, but let's just refresh our understanding of the terms themselves.
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Hue 
This is the most misused and misunderstood aspect of color, as hue is the perception of the 
color we see in its unaltered, original context. Normally, people will interchange the words 
color and hue, and while that can technically be correct, hue is only one-third of the story 
of defining a color. 

If you say, "yellow school bus" or "red apple," you would be naming the hue as a basic 
descriptor. Orange basketball. Green frog. This discusses the color at face value, not adding 
any sort of tint, tone, shade, or editing to the pure origin of the color, meaning you are 
naming the color's hue. Hue can also be referred to as an object's or subject's local color.

However, simply naming a hue by itself is limiting as it may not give enough information. 
While you could call "powder blue" and "ocean blue" both just "blue," that wouldn't quite 
be descriptive enough, would it? That is where the other two qualifiers come into play.

Saturation 
Saturation is the amount of "intensity" or "vibrancy" of the hue. What we think of as 
a rich "candy-apple red" will have a higher amount or saturation of red (or be more 
red-saturated) than the amount of red found in pink, for instance. An orange peel would 
have a higher saturation of orange hue than sand, which only has trace amounts of orange 
hue within it depending on the time of day. 

As our previous blue example would show, "ocean blue" would have a higher saturation of 
blue hue than "powder blue," which would have the amount of blue softened down with 
varying degrees of grays and whites.

Value
This is the lightness or darkness of hue and/or saturation, usually mappable in a grayscale 
capacity from pure black to pure white. While value may be the most basic to understand 
of these three descriptors, I am of the belief that value does the absolute most of the three 
aspects when it comes to making appealing, compelling paintings. In fact, you can make 
spellbinding pieces of art without even using hue or saturation at all.

There is an old art-school saying that I completely agree with, and something that we will 
be proving throughout the projects in this book: Value does the work, color gets the credit.
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When people make comments on art, most of the time they will be describing the 
interplay of values (lights versus darks) more so than any specific color saturation or hue. 
You'll often hear feedback or critiques of art, like so:

"Wow, that landscape looks so inviting because of the light coming through the trees!"

"I love the mood of this, it's so cinematic!"

"The highlights really pop!"

"Those colors are so bright/dark/deep—it really adds to the atmosphere!"

"Those crisp edges interplay with those softer, more careful edges in a great way!"

Every single one of these comments notices value first and foremost, even though 
the viewer may not realize it. The differences between light and dark are more readily 
apparent and noticeable both up close and at a distance than hue shifts or saturation 
changes (unless they are extreme, which we'll talk about in the color wheel portion of  
this chapter). 

Edges are just the intensity in which values change (sharp edges are a forceful, immediate 
change in value, while soft edges have a gradient between light and dark). The deepness of 
a color discusses the light or dark value just as much as the color's saturation. Readability 
of a piece (being able to tell what is going on in your painting) is directly correlated with 
value, while saturation and hue don't make nearly as much impact. I may seem like I'm 
really trying to push this, and you're right—I am!

Value does the work, color gets the credit. Repeat it to yourself, pin it to your desk, and do 
whatever you have to do to focus on your lights and darks (grayscale) above all else.  
I've heard this said to me before, and I will echo this sentiment: If your values are correct,  
you can use whatever color you want and the piece should still work.

Now that we have defined the aspects of what makes up a color, let's talk about the "three 
questions" you can ask to correlate these options to decision making when trying to find  
a color for your art.
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The three questions 
As we will discuss in the color wheel portion of the chapter, a color can only work in 
relation to the other colors surrounding it. This may seem a bit tricky, but with the 
following three questions, we will be on the right track to simplifying our decision  
making when using and choosing colors using either the hue/saturation/value sliders  
or the color wheel:

•	 "Is the color I need warmer or cooler than the color next to it?"

This question will lead us to choose our hue. If we need a warmer color, we can go 
toward the reds, oranges, and yellows, while if we need a cooler color, we can head 
toward the greens, blues, and purples. Remember—for maximum control, you can 
go through the color wheel to get to your destination, traveling through and playing 
with those beautiful grays!

•	 "Is the color I need more or less vibrant than the color next to it?" 

This question will lead us to choose our saturation. If the color needs some more 
"pop" or vibrancy, we'll up the saturation level, but if we need to lower the intensity 
of the color (very useful for putting things "in the distance" or "background" of your 
piece), we would lessen the amount of saturation present.

•	 "Is the color I need lighter or darker than the color next to it?" 

This question will lead us to choose our value. If we need to lighten our color,  
we can add white, while on darkening it we would subtract white (which pushes 
us closer to black). Keep in mind that this doesn't mean your lightest lights will be 
pure white or your darkest darks will be pure black, as this will destroy all the hard 
work you've done with balancing your colors. Think of pure black and pure white 
as "never use these while painting" colors, as even in the darkest night scene or the 
brightest day scene, pure black and pure white simply don't exist. There's color and 
light everywhere—it's all about context!

We will dig into each one of these in detail during the color wheel portion, but since 
they directly correlate to our current topic, I felt it necessary to get you introduced to 
the concept here. You will notice throughout the book that I'll constantly be asking these 
questions before I make choices regarding our projects. It's a great roadmap to follow to 
ensure that you're always making progress with your piece.

With that being said, let's finally dig into the real meat of this chapter—a single item that 
you can spend decades studying and finding new ways to read and that never runs out of 
surprises: the color wheel.
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Clarifying the color wheel
Before we get too far into the depths of this topic, I want to make it very clear that we will 
be using the "RGB" color wheel (the default of Krita and most digital art software) instead 
of the more traditional "RYB" color wheel that you would use in traditional oil, acrylic, 
watercolor, or gouache painting. As we reviewed at the end of Chapter 1, Getting Started 
with Krita, we will be using the HSV color model type in the Color Selector Settings 
section of Krita, as seen in the following screenshot: 

Figure 2.4 – The HSV color wheel selection in the Color Selector Settings section of Krita

What is the color wheel? In the most basic of terms, the color wheel is a method of 
mapping colors in relation to one another. There are a variety of color wheels you can use in 
visual arts, but since we are working with the additive color theory that digital art provides 
through using light, we will use the RGB color wheel. 

We will be breaking this color wheel down into a lot of subsections and discussion points, 
so get ready to dig in!
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Changing the Pace
You may have noticed that this chapter hasn't had a lot of images up to this 
point. I'm happy to say, that is about to change! While aspects such as bit depth, 
canvas sizes, hue, saturation, and value can be defined in a very direct way, 
comparing colors directly creates a need for more visual aids to lead to those 
lovely "a-ha!" moments of understanding.

Dissecting a color
Since we have recently reviewed the terms of HSV, let's discuss how to read the increase  
or decrease of these aspects in relation to the color wheel we have chosen.

Hue 
You will go between different hues by going around the color wheel, as illustrated in the 
following screenshot: 

Figure 2.5 – Going around the color wheel for adjusting hue

This is most likely the way most people (especially non-artists or younger/newer artists) 
see the color wheel when first looking at it. You may see the wheel and think "I'm currently 
on orange, and I need something more green, so I'll use my mouse and move to the green 
side of the color wheel". While this isn't necessarily wrong, this is missing the nuance of 
balancing proper saturation and value when making your color decision. If you approach 
the color wheel in this way, you may run into "loud" colors clashing for attention, or colors 
that don't seem to work together.
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Saturation 
In order to change the saturation of a hue, you will move through the color wheel,  
as illustrated in the following screenshot: 

Figure 2.6 – Moving through the color wheel for adjusting saturation

The key idea to remember here is this: The closer you are to the edge of the wheel, the more 
saturated your color will be. The more you move to the middle of the wheel, the less saturated 
your color will become.

We chose the HSV color wheel in Krita for a reason: the middle of the wheel is true 
neutral (or gray, with varying values depending on the brightness selected). Remember 
when we said that color is only relative to the other colors surrounding it? Gray is the 
perfect way to compare colors with one another. In fact, I personally think gray is the most 
useful color for an artist.

Gray is my Favorite Color for Painting
"Wait, what? Gray, the absence of color, is your favorite color?" It's true! While 
many people may think that gray limits your options regarding color, I feel 
that it gives more impact to every single color decision you make. 50% gray is 
the perfect equalizer— it's always warmer than your colds, colder than your 
warms, lighter than your darks, and darker than your lights. Instead of jumping 
from orange to green, jump from orange to gray. You'll notice that the gray….
appears green!? We will discuss why that happens when we discuss warms 
versus cools in a bit.

Now, let's discuss value in the context of the color wheel.



Clarifying the color wheel     55

Value 
This one is a little bit more involved than the other two, as you can discuss value in 
multiple ways on the color wheel.

Of course, if you adjust the lightness or darkness slider above the HSV color wheel, as 
illustrated in the following screenshot, it's going to have a direct impact on your value: 

Figure 2.7 – Arrows pointing to the value slider above the HSV color wheel

The lighter the slider, the lighter the value, while the darker the slider, the darker the value. 
Pretty obvious stuff, right?

But what if I told you that specific hues and saturations have their own intrinsic lightness 
value? That on any color wheel, at any time, without touching the value slider to make the 
wheel lighter or darker, certain colors are lighter or darker than others?

There is a perception in society that artists and painters, by our very nature, see more of 
the world than other people, meaning that we notice things that the layperson may never 
notice and catalog that information to bring up at random in our art, like a magician. 
However, I'd counter that point by saying that as artists and painters, it's our job to 
actually see less. An example of this? Learn to see the world in grayscale.
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Learning how to see the world in grayscale is actually a very valuable skill to learn, as it 
will help you break down what you are observing in a more simple, concrete way.

Color Blindness
There is a misguided opinion that if you have limited or full-color blindness, 
you cannot be an effective, emotive, or professional artist. This is demonstrably 
false. Claude Monet, Ilya Repin, Edgar Degas, and William Blake were all 
color blind, just to name a few. Remember, artists don't train themselves to see 
more than the rest of society—they train hard to see less, as reality is easier to 
replicate on the canvas if it is simplified and stylized. Remember: value does the 
work, and color gets the credit.

The best way to see this theory in action is to look at our HSV color wheel in grayscale,  
as follows: 

Figure 2.8 – The HSV color wheel in grayscale for natural value comparison

If we look closely at our grayscale version of the color wheel, you'll notice some interesting 
things. If you look just at "light versus dark", it appears that our greens and yellows (the 
upper left of the wheel) seem to be lighter (with yellow being the lightest), while our blues 
(lower right) seem to be the darkest darks near the edge of the wheel. This goes back to 
our point that individual hues, by their very nature, have differences in value ranges.
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Another interesting thing—do you notice the three "lines" of lighter value going through 
the wheel like a spoke, connecting in the middle gray area (at roughly the 3 o'clock, 7 
o'clock, and 11 o'clock positions)? Those colors would be cyan, yellow, and magenta 
(CMYK, what are you doing here?!). We are about to discuss color relationships, and 
if you make a habit out of dissecting the color wheel in this way, it will help you build 
confidence in your decision making.

Also, the blues are the darkest-valued hues at full saturation, while yellows are the lightest-
valued hues at full saturation….Wait a minute, aren't yellow and blue complementary 
colors on the color wheel? Once again, the revelation of color relationships, and how the 
"rules" of the color wheel apply to decision making, can be a powerful motivator for you 
once it starts making sense.

As you start dissecting the color wheel in this way, you will start noticing "happy 
coincidences" all over the place. Do they mean anything? Is there some insane logic to 
it all? That's what artists have been studying for centuries, and I believe the answer is 
different for each individual artist.

Color relationships
I would argue that the very idea of utilizing color to its maximum efficiency and impact  
is the relationships of hues, saturations, and values, but there are some tried-and-true 
color-relationship definitions (also known as "color recipes") that we should cover to 
freshen up our fundamentals.

Remember—these color relationship examples are based on the RGB (additive) color wheel, 
and not the traditional RYB (subtractive) color wheel you may have learned about in school 
for traditional art. The names of the terms are the same, but the hue relationships they 
represent are slightly tweaked, as outlined here:

•	 Complementary colors—Complementary colors are hues directly opposite of one 
another on the color wheel (red and cyan; yellow and blue; green and purple).

•	 Analogous colors—Hues located directly next to each other on the color wheel 
(orange and red; cyan and green; purple and blue; and so on).

•	 Triadic colors—Hues located in three equally distanced positions away from one 
another on the color wheel (such as the cyan, yellow, and magenta example  
we discussed earlier).

•	 Monochromatic colors—Colors that are of the same hue, but differ in saturation  
or value.
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With the textbook color relationships we all know and love out in the open, let's discuss  
a key concept that truly changed my perception of the color wheel, and simplified it to 
such a degree that I went from having zero confidence in choosing colors to….well,  
a bit more confidence!

Warm versus cool colors
Having a digital art space and color wheel can seem mundane if we've been around it for 
a bit, but here's a terrifying thought: with digital art and Krita, you have access to every 
single color ever made, in every hue and alteration, all at once, immediately, every second 
that you work on your artwork. Eep—the pressure to make the right choice can be too 
much to handle!

There are so many options on a color wheel that it can be hard to nail down the mood  
we may want to capture in each piece, especially if we want to work from imagination. 
Having a way to simplify the wheel will do us a world of favors in our art career, and  
the most interesting and dynamic way I've found is to discuss colors in a warm versus  
cool capacity. 

In the most basic terms, warm colors are your reds, yellows, and oranges, while your cools 
are your blues, purples, and greens. Warm colors tend to remind us of warmth, fire,  
the sun, and comfort. Cool colors may remind us of water, ice, clouds, and the breeze  
of nature. 

While the RGB (additive) color model and RYB (subtractive) color model are slightly 
different in the location of the hues, just know that the aspect of warm and cool colors 
never changes, meaning it is a great theory to learn to transfer from creating digital art 
to traditional art, and vice versa. The same "tricks" you learn regarding color temperature 
will work across both traditional and digital art and will allow you the flexibility to create 
what's in your mind, no matter which style of painting you enjoy most. 

In the following screenshot, we dissect our HSV color wheel into warms and cools:
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Figure 2.9 – The HSV color wheel split between warms and cools

The temperatures of warm and cool may seem fairly straightforward at first glance, but 
it is wise to keep in mind that color temperature is relative, instead of absolute. It is very 
possible to have "cool warms" and "warm cools" by moving your color selector closer to 
the temperature change you would like. 

Remember how we discussed saturation earlier in the chapter, and said that by moving 
through the color wheel, you are lowering and increasing the amount of saturation for 
a given color? The same applies to temperature—as you move through the middle of 
the color wheel, your colors are making temperature changes. The closer you are to the 
outskirts of the color wheel (high saturation), the more absolute the "cool" or "warm" 
feeling, while inching closer to the middle (the grays) allows for the nuance of adding 
temperature changes at a delicate rate.
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For instance, let's take a look at the following screenshot, and answer this question: out of 
these three examples, which example takes the red color provided (the top portion of each 
example) and juxtaposes it against a "cooler" color as it relates to color temperature on the 
color wheel?

Figure 2.10 – Warm and cool color-comparison exercise

The correct answer, of course, is all of them! Let's look at this in more detail:

•	 A.—This one is pretty self-explanatory, as clearly, the bottom half of the example is 
more "blue" in nature, making us think of warm versus cool in a very literal sense.

•	 B.—This one's slightly trickier, as we've introduced a touch of gray and lowered the 
saturation, meaning that in the color wheel, the bottom color would be closer to the 
center of the wheel, meaning it is making the journey over to the cooler side of  
our colors.

•	 C.—The most extreme example of the main idea represented in B.. Even though the 
"saturation" is the same (very high), gray is a neutralizer and is removing the red 
"hue", therefore giving us the optical appearance of being the "opposite" of red  
(or, in this instance, warm). 

The most effective way I've found of discussing temperature and hue in relation to one 
another is to add "more" or "less" qualifiers before your hue of choice. If you need to cool 
down your reds, for instance, you can "add more blue", or if you want more total control 
over the shift to cool, you can "add more gray", which will remove some of the warmth but 
at a lesser rate than going straight to the blue portion of the color wheel with your color 
selector. This is shown in the gradient example provided in the following screenshot: 
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Figure 2.11 – Two gradients going from "warm" to "cool"

I fully stand by my opinion that grays are powerful in the right hands, and will allow 
you to get some absolutely stunning results. Subtlety goes a long way when it comes to 
impactful color usage in art, and your control of grays will showcase your understanding 
of those subtleties. 

In our gradient example in Figure 2.11, you have to remember that warm and cool are 
terms relative to one another. While example A. may have a wider gamut (the amount of 
distance between hues on the color wheel), example B. also shows a change from warmer 
to cooler, albeit at a more delicate rate. In fact, for example B., I didn't even move to the 
"blue" part of the color wheel—it's all grays by simply lowering the saturation amount!

Limited palettes
Now, I know what you're probably thinking: 

"I think I know what Wes is going on about, but it's really hard to translate this from reading 
it in a book to actually applying it to real painting!"

This is absolutely true! My advice—if you want to have a "crash course" on understanding 
color harmonies and how the relative nature of color temperatures can be a lot stronger 
than we give it credit for, I urge you to try your hand at using a limited color palette  
or setting rules on how many colors you are allowed to use on a piece.
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My favorite limited palette of all time would have to be the Zorn palette, named after the 
Swedish painter Anders Zorn (1860-1920). He was famous for primarily using a small 
set of oil paint colors for a vast majority of his works and had a true mastery of not only 
controlling color but controlling the contrasts of color temperature as well. The Zorn 
palette usually consisted of only four colors (as seen in the following screenshot), those 
being Ivory Black, Titanium White, Cadmium Red, and Yellow Ochre:

Figure 2.12 – The traditional Zorn palette (Ivory Black, Titanium White, Cadmium Red, and Yellow Ochre)

This palette may seem too limited if you're not familiar with using it, but has a surprising 
amount of versatility. You have your warms (Cadmium Red and Yellow Ochre), your 
cools (Ivory Black and Titanium White, as black and white are both created with high 
amounts of blue wavelength), your lights (Titanium White), darks (Ivory Black), and your 
saturations (Cadmium Red and Yellow Ochre).

Need a green? Mix Yellow Ochre with slight amounts of Ivory Black and a nice helping 
of Titanium White (as they both include blue) to make a nice, deep olive green. Need 
orange? Equal parts Cadmium Red and Yellow Ochre. Blue? Mix equal parts Titanium 
White and Ivory Black, and you'll have a nice, rich gray that, in context, will appear blue. 
If you need pure pops of highly saturated color, you can use any of the four colors straight 
"from the tube" (or, essentially, without mixing with anything else). Yes—it's true that  
you won't get super-bright cyans, magentas, or neon colors of any hue, but that's why  
it's a limited palette. It limits your options and really has you rack your brain in regard  
to finding the color, shade, tint, or tone you may need only using what is given to you.

Remember our three main questions from earlier? Here they are again:

•	 Is the color I need warmer or cooler than what I have currently?

•	 Is the color I need more or less vibrant than the color I have currently?

•	 Is the color lighter or darker than the color I have currently?



Clarifying the color wheel     63

The Zorn palette (and many other limited palettes) can answer these questions just as 
easily as using the entire HSV color wheel provided to you by Krita. For the warmer and 
cooler question, just add either your red or yellow to warm, or white or black to cool. For 
the vibrancy question, although it can be a little trickier, using a more direct "from the 
tube" color may actually increase your vibrancy without adjusting the value too much. 
For lighter or darker colors, add your whites/blacks for those, and use red/yellow for your 
"neutrals" to give your piece a little more personality.

Have a look at this personal landscape piece I made using the Zorn palette: 

Figure 2.13 – A landscape using the Zorn palette

It was an absolute joy to work on this landscape, as, since my palette was limited to only 
four colors and the saturation/values within those colors, I was able to focus on things 
such as brushwork, lighting, and edge control. Limiting your options like this may seem as 
though it limits your creativity, but I would argue that you are actually more able to focus 
on your creativity, knowing that any decision you make in regard to color and temperature 
should "work" within the confines of your goals. 

Learning color fast
There is a lot of information to unpack in this chapter, and the information is better 
understood by doing rather than reading. If you have the budget, I recommend going to 
your local store and buying a cheap pack of acrylic paints and some brushes. Try your 
hand at some paintings, or even create your own limited palette color wheels! 
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You will get more comfortable with color more quickly, and start noticing the nuances of 
some of the topics we've covered in this chapter. Since digital art can be trickier to nail 
down in regard to a workflow of "mixing" colors in real time, mixing real paint pigment 
will allow you to see immediate results. Then, you can transfer this knowledge over to 
Krita for when we start on our projects.

When we begin our projects, we will be discussing every step of the process and the 
decisions we make regarding value and color. Having a solid grasp on color and value will 
help immensely and start to inform your own personal painting style. Every person on the 
planet perceives color slightly differently, so instead of thinking of finding the "correct" 
colors for your painting in a "right or wrong" way, find the combinations that speak to  
you and your eye the most.

Color is, to put it mildly, pretty complex stuff. However, it doesn't have to be scary!  
I hope some of these topics were covered in a way that was either a nice refresher  
or even a brand-new revelation for you regarding color and the way we can utilize it.  
Remember—practice makes perfect!

Summary
During this chapter, we looked at basic terminology for setting up our digital canvases 
and covered such items as resolution, bit depth, and color space. Then, we did a full 
overview of digital color in relation to traditional color and how our eyes interpret 
information through the presence or lack of light. We continued that idea by comparing 
the preparation of our colors for digital or print when creating our art, and the differences 
that DPI or PPI play in displaying our art. We discussed the three aspects of what creates  
a color (hue, saturation, and value), the color wheel, color palettes, color relationships,  
and color temperatures. 

Phew—that's a lot of color!

In the next chapter, Chapter 3, Utilizing Layers and Layer Groups, we will introduce the 
idea of file management when working in Krita. Layers are one of the huge benefits of 
working in the realm of digital art, and we will discuss some great ways to utilize them to 
help speed up your workflow. We will also cover the importance of a solid layer naming 
structure, grouping layers together and using layer collections to help inform decisions 
throughout our artwork. 

Let's now hop on over to the next chapter and get started preparing our canvases for  
our step-by-step projects for our portfolios!
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Utilizing Layers and 

Layer Groups
Coming into this chapter, I bet you are ready to put your new knowledge and refreshed 
theory into action! That's great news, as in this chapter (and all chapters going forward), 
we will be doing some hands-on exercises to better understand the functionality of Krita 
as a program.

In this chapter, we will be dissecting one of Krita's foundational tools and some of the 
biggest boons that digital art provides you as a creator: layers, blending modes, and layer 
groups. In this chapter, we will be covering the following:

•	 Defining layers, layer blending modes, and layer groups

•	 Controlling a landscape painting composition using layers

•	 Starting our landscape painting using our layer structure and Krita's  
built-in brushes

•	 Grouping our landscape into layer groups for maximum efficiency

•	 Refining our painting by utilizing some basic layer management skills to help us 
prepare for bringing this painting to a polished state later in the book

We have our hands full for this chapter, so let's get started by breaking down what a layer 
is, how it works, and why using layers has such a huge impact on your artistic quality of 
life in Krita.
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Technical requirements
To follow along with this chapter, you will need the following:

•	 Krita (version 5.0 +)

•	 A way to interact with Krita, such as a keyboard and either a mouse, a tablet,  
or a touch device with a stylus

Understanding layers – the secret weapon of 
digital art
Like we've done previously, let's start this chapter by defining some of the key concepts 
we're going to be diving into. 

Layers 
Layers are transparent by default, and act as a "stack" of canvas information, presented 
and visible in order from the top to the bottom of the stack. Think of stacking transparent 
sheets of paper, sized to the dimensions of your working canvas, on top of one another 
that can take information you put onto them, including paint, text, or effects. The Layers 
panel (Figure 3.1) is your quick-glance guide for layer management:

Figure 3.1 – The Layers panel
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The Layers panel has quick-access tools at the bottom of the panel to speed up your 
process, including (from left to right) the following:

•	 The Add button – Add new layers, new groups, specialty layer types, masks,  
and more.

•	 Duplicate Layer – Duplicate the selected layer, layers, or group.

•	 Move Layer Down in the stack (can also be done by dragging and dropping the 
highlighted layer or layers in the list).

•	 Move Layer Up in the stack (once again, can also be done by dragging and dropping).

•	 Layer Properties – Where you can change the name of your layer, color coding, 
color modes, and more.

•	 Delete Layer – Delete the layer, layers, or group that is selected in the Layers panel.

These features can also be accessed with hotkeys, so it's up to you what you use!

Blending modes 
Since layers can stack on top of one another, and in digital art we are dealing with aspects 
of light, blending modes allow the changing of the interaction and communication of 
information from one layer to another. The Blending Mode selector is part of the Layers 
panel docker, located above the Opacity slider (as shown in Figure 3.2):

Figure 3.2 – Blending Mode (currently on the Normal option, which is the Krita default blending mode)

Think of this as "mathematical rules" that you're telling a layer to use within a Krita 
document, such as "display only values lighter than what is in the layers below it," or "use 
a formula to multiply the base layer and blended layer, darkening the color and value." We 
will be using these a lot in later chapters for different effects and will go over some of the 
most frequently used layer blending modes at that point.
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Layer groups 
A layer group is a collection of layers, combined into a folder (or group). While a layer 
group in and of itself may not seem fancy, it is an absolute game-changer once you realize 
its potential. Layer groups display in the Layers listing, as shown in Figure 3.3:

Figure 3.3 – A layer group named Group 1, which has Paint Layer 1 as its only included layer

You can tell which layers are in a group by the anchored L shape on the left-hand side of 
the layer (circled in red in Figure 3.3), representing the anchor and inclusion within the 
group above it. Each layer within a group may stay separate from other layers in the group 
and utilize separate blending modes within the group. In fact, layer groups (the entire 
folder) can use blending modes! 

Layer groups are pivotal for the organization of your image's contents and can be used in  
a variety of ways to make drastic moves and tweaks to your compositions. We will be 
using a basic landscape setup to showcase this later in this chapter.

There's only so much we can do by discussing layers, blending modes, and layer groups…
so let's get started by structuring our layers.
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Controlling your landscape composition with 
layers
For the remainder of this chapter, we will be using a lot of things we have discussed in 
previous chapters and combining them with the knowledge we're developing about layers 
and groups. Please keep in mind that this is primarily the setup step for a final project  
we will be completing near the end of the book. Once done, you can then add the project 
to your portfolio!

My Krita Docker Setup
We are about to paint, and I want to make sure that you know exactly what 
dockers and windows I have open, as some of the screenshots going forward 
may be zoomed to a level where you can't see my entire window. For a quick 
look at my fullscreen setup, please review the first chapter's screenshots about 
setting up Krita!

My open dockers are (in order) Advanced Color Selector, Brush Presets, 
Layers, Overview, Palette, Tool Options, and Toolbox.

Setting up our file correctly is paramount to improving our workflow and speed of 
creation and revision, so let's get started with painting our landscape:

1.	 Make sure Krita is open (a pretty important step!).
2.	 Click File | New on your main menu (or you can use the Ctrl + N hotkey, as shown 

in Figure 3.4):

Figure 3.4 – Default Start window in Krita 5 showing the New File icon and hotkey combination
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3.	 On the Create new document window, insert 1920 for your image width, 1080 for 
your image height, and 72 for your resolution (in pixels/inch). Set the color model 
to RGB/Alpha and 8-bit integer/channel for the color depth, and keep the default 
Color Profile setting (in Krita 5's beta version, the default should be sRGB-elle-V2-
srgbtrc.icc (Default)). These settings are shown in Figure 3.5:

Figure 3.5 – The settings for the Create new document window for this project

4.	 Click Create. Your new work canvas should load into your canvas area, and your 
Layers panel should display two layers, one called Background and one on top of 
that called Paint Layer 1 (as shown in Figure 3.6):
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Figure 3.6 – Your "starting" Layers panel, with Background and Paint Layer 1

5.	 Double-click on the words Paint Layer 1 in the Layers panel. This will allow you to 
edit the name of the layer. 

6.	 Change the name of Paint Layer 1 to Background Plane (as shown in Figure 3.7):

Figure 3.7 – The Paint Layer 1 layer renamed to Background Plane

7.	 As it may be a bit confusing to have a Background layer right next to  
a Background Plane layer, let's change the name of the bottom Background layer 
to Starting Layer.
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8.	 You will now have two layers, Starting Layer (the bottom-most layer) and 
Background Plane (the layer above Starting Layer), as shown in Figure 3.8:

Figure 3.8 – Your two layers so far: Starting Layer and Background Plane

9.	 Click the Background Plane layer to select it.
10.	 Once the Background Plane layer is selected, click the bottom-left plus sign (+). 

This will create a new paint layer, defaulting to the name Paint Layer 1. 

Notice that when you hit the plus sign (and not the drop-down arrow next to it), 
it automatically creates a paint layer above your selected layer. If you had Starting 
Layer highlighted, your new paint layer would be sandwiched between your 
Starting Layer and Background Plane layers.

11.	 If Paint Layer 1 is between your Starting Layer and Background Plane layers, click 
the up arrow (^) on the bottom bar (the fourth option from the left) while the Paint 
Layer 1 layer is selected.
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12.	 Double-click on your new Paint Layer 1 layer and rename this layer to  
Midground Plane.

13.	 You should now have three layers, in this order: Starting Layer as the  
bottom-most layer, Background Plane as the middle layer, and Midground Plane 
as the top-most layer (as shown in Figure 3.9):

Figure 3.9 – Your three layers – Starting Layer, Background Plane, and Midground Plane

14.	 With Midground Plane selected, click on the plus icon on the bottom-left toolbar 
(+) to create a new Paint Layer 1.
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15.	 Change the name of Paint Layer 1 to Foreground Plane.

You should now have four total layers. In order (from bottom to top), they should 
be Starting Layer, Background Plane, Midground Plane, and Foreground Plane 
(as shown in Figure 3.10):

Figure 3.10 – Your four main layers – Starting Layer, Background Plane,  
Midground Plane, and Foreground Plane

16.	 Be sure to save your file (use the Ctrl + S keyboard shortcut)!

Setting up our layers in this way before we get started can help us stay organized during 
our painting process. Some artists enjoy creating layers "as needed," meaning they'll start 
with a single layer and work until they feel they need a new layer. Other artists like to 
preplan their pieces much like a traditional watercolor or oil artist, separating their layers 
the same way they'd think about separating their process to adhere to drying paint layers 
on a canvas. There's no right or wrong way to work; just think of layers as a tool that fits 
within your workflow and do what makes sense for you!

Now that we have our layer structure set up, let's go ahead and begin our actual painting!
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Starting our painting
We are all set to get started, so let's start painting! Keep in mind that this will be a very fast 
"blocking-in" phase where we experiment with shapes for our landscape composition. Feel 
free to get as detailed or basic as you would like in this portion, as we will be adding a lot 
of detail to this piece later in the book.

Let's have our layers do some heavy lifting for us! We are going to begin our painting, 
keeping our layers and layer management at the forefront while we work:

1.	 Select your Background Plane layer.
2.	 With this layer selected, choose your brush tool (default hotkey B on the keyboard).
3.	 Select a brush that you like the look of, as we will be blocking in a basic background. 

I have chosen the b) Basic-2 Opacity brush from the Digital section of the Brush 
Presets window (as shown in Figure 3.11):

Figure 3.11 – Our Basic-2 Opacity brush from the Digital section of Brush Presets
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4.	 With your brush selected, go ahead and select a very light, nearly white, neutral 
color from the value slider above the HSV color wheel. Think of this selection as 
80% or 90% on the scale (with 100% being all the way to the right, or pure white).

Figure 3.12 – Choosing a neutral light value on the HSV color wheel

5.	 Paint! This is going to act as our "bright sky and clouds," so feel free to create some 
shapes while slightly tweaking the value slider (the slider above the HSV color 
wheel) to bring about some variety and forms for our clouds. 

Feel Free to Make It Your Own!
Since we're now starting the full tutorial portions of the book, just know that 
you are the artist here! Feel free to use my painting as a guide and follow along 
exactly with the images and steps I provide if you feel more comfortable doing 
that, but never feel like it is the "correct" way to paint! Experimentation is one 
of the most enjoyable parts of digital art, so go wild!
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I've made my basic background and feel like there's enough here to guide the next 
parts of the piece (shown in Figure 3.13):

Figure 3.13 – Our basic Background Plane layer, utilizing the Basic-2 Opacity brush and lighter values

6.	 Once you feel satisfied with what you have, select your Midground Plane layer.
7.	 On the HSV color wheel, move the value slider closer to the midpoint of the slider 

(our goal is to be at 50% gray, or true midtone), as shown in Figure 3.14:

Figure 3.14 – Our value slider (above the HSV color wheel) in the midtone value area
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Now we're going to place some basic "jagged" shapes to mimic mountains. 
8.	 Select a brush (I will be staying with my trusty b) Basic-2 Opacity brush) and start 

placing a set of triangles, varying the height, width, and intensity of your strokes. 
This will act as your midground mountain range.

Once I've spent a bit of time refining the shapes to make an appealing flat look 
(Figure 3.15), I think I'm ready to move on to the next block-in step:

Figure 3.15 – My "mountain range," painted with 50% gray on my Midground Plane layer

9.	 When you've approached a point where you feel happy with the variety, sizes, and 
angles of your midground mountain shapes, go ahead and click on the Foreground 
Plane layer.

10.	 On the HSV color wheel, move the value slider more to the left to darken the 
values once again. Don't go all the way to full black though, as that would limit your 
options considerably when we start rendering! Right around the 25-to-30% spot on 
the value slider should do the trick (Figure 3.16):
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Figure 3.16 – Our darker value selected for our Foreground Plane layer

11.	 Select a brush (once again, I'm sticking with my b) Basic-2 Opacity brush), and 
make some more refined, larger, darker triangle shapes. These will act as your 
foreground mountains.
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12.	 I refined a few of my darker shapes and decided that I'd like this mountain range on 
a body of water. I used my Foreground Plane layer and my current darker values to 
roughly sketch in a lake, using soft vertical brush strokes instead of horizontal brush 
strokes to simply show a variance in subject type that is easy for the eye to read 
(Figure 3.17):

 

Figure 3.17 – Darker values added to Foreground Plane, as well as a basic "lake"
This will help us refine where the horizon line is located and give us some more 
information to work with when we want to add some features of visual interest later.

13.	 Be sure to save your file! (You can use the Ctrl + S hotkey to do this quickly!)

For the next steps, it's a good idea to start organizing your layers to make it easier for you 
to find exactly what you want to work on, and comfortably make edits without destroying 
the hard work you've done and the design you've made so far.

Grouping our layers
What we have so far may not feel like a masterpiece, and that's okay! This is a very early 
stage (one of many "ugly stages" of a painting), mainly used to throw down some ideas 
and see whether they read well to the eye. For client work, you can expect to do a lot of 
thumbnailing like this, so it's pretty good practice to work quickly and be organized. 

We're going to start grouping our layers, bringing in some more rendering, and 
performing some deliberate brushwork. Once we get going on this portion, I hope you see 
the importance of the early steps, as they act as the foundation for the rest of our piece!
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Let's set up some layer groups so we can work freely on our background, midground, and 
foreground, while giving us some flexibility in the type and number of layers we can create 
for each plane of our landscape:

1.	 In the Layers panel, make sure the Background Plane layer is selected.
2.	 With the Background Plane layer selected, click on the drop-down arrow to the 

right of the plus sign (+) on the lower left of the Layers panel. This will bring up the 
full list of options for your layers, masks, and selections (as shown in Figure 3.18).

3.	 Select Group Layer (the second option in the list).

Figure 3.18 – The full list of layer, mask, and selection options in the Layers panel
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This will create a new entry above our Background Plane layer, called Group 1 by 
default. Notice that instead of a small paper-and-pen icon to the left of the words, 
there is a small folder icon (as shown in Figure 3.19):

Figure 3.19 – Our Layers panel, now with our new Group 1 group above our Background Plane layer

4.	 Select the Background Plane layer.
5.	 Click and drag the Background Plane layer on top of the Group 1 folder.

If you were successful, you should see that the Background Plane layer has now 
moved over slightly, as well as having an additional anchor icon on the left-hand 
side. You will also notice that the Group 1 folder icon now has a small down arrow, 
symbolizing that Group 1 now has layers within the group, as shown in Figure 3.20:

Figure 3.20 – Our Group 1, now with an inherited Background Plane layer
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6.	 Let's go ahead and repeat this group creation process to create groups for our 
Midground Plane layer (creating Group 2 above it) and Foreground Layer 
(creating Group 3 above that).

7.	 Be sure to drag and drop each respective layer to its respective group, with 
Midground Plane inside Group 2 and Foreground Plane inside Group 3. After 
you are done, you should have a Layers panel that looks as in Figure 3.21:

Figure 3.21 – Your current Layers panel with your landscape plane layers within three separate layer groups
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Now, to polish this step off, let's go ahead and rename our groups to make things 
easier to make sense of, before we fully dig into our painting!

8.	 Select the Group 1 layer and change its name to Background.
9.	 Select the Group 2 layer and change its name to Midground.
10.	 Select the Group 3 layer and change its name to Foreground.

You should have a Layers panel that looks as in Figure 3.22:

Figure 3.22 – Your fully named groups, consisting of each respective plane layer

11.	 Now, for maximum cleanliness, go ahead and click on each group individually, 
clicking its respective down arrow (the down arrow that is below the tiny folder icon 
to the left of the group's name), as shown in Figure 3.23:

Figure 3.23 – The down arrow and small folder icon for our Foreground group
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This "minimizes" the contents of each group, and is a very good way to keep track of 
where you are at in regard to painting! Figure 3.24 shows you just how clean this will 
make your Layers panel look:

Figure 3.24 – The cleaner, "minimized" group listings on our Layers panel

Now that we have created our groups for our separate landscape planes, we are ready to 
start diving into the details of our painting!

Refining our painting
Since we now have our planes in their own groups, our painting session will speed up 
considerably and allow for some great editing and tweaking while retaining our specific 
image planes. Let's refine our image's background:

1.	 On the Layers panel, click the left-most eyeball icon (the visibility icon) next to the 
Foreground and Midground groups. This will hide these groups in their entirety,  
so anything within the folders of the group will be hidden as well. 
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2.	 Click on the Background group and click the arrow underneath the tiny folder icon 
to "maximize" the group, showing us our Background Plane layer. Your Layers 
panel should look as in Figure 3.25 at this point:

Figure 3.25 – The Background group is active, while Midground and Foreground are hidden

3.	 Make sure the Background Plane layer is selected.
4.	 Click the plus icon (+) on the bottom left of the toolbar to create a new Paint Layer 

1 above the Background Plane layer.

You will notice that the new Paint Layer 1 is already inside of the Background 
group, and it happened automatically! The power of working in this "group method" 
is the speed with which you can locate specific areas of your image that you would 
like to edit, without being disruptive to the rest of your composition. Everything 
you create within the Background group will always be under Midground and 
Foreground in your composition, and once we add some details to those groups, 
you'll see your landscape start taking shape.

5.	 On your new Paint Layer 1, start refining some shapes for your clouds and adding 
subtle value shifts by sliding the value slider (the one above the HSV color wheel) 
left or right. 
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Quick Landscape Tip
With landscapes, you can utilize a great trick known as atmospheric 
perspective. Essentially, atmospheric perspective dictates that the further 
something is away from the viewer, the less saturated and less refined 
something might be. With our landscape being created with a more traditional 
"foreground, midground, background" painting approach, think of it like this: 
if you want something to "come closer" to the viewer, have it get darker and 
more refined, but if you want to "push something back," be sure to lighten the 
value and make your brush strokes less refined.

At any point, if you want to see how your refinements are integrating with the rest 
of your piece, feel free to "unhide" your Midground and Foreground groups to see 
your changes in real time as they relate to your entire composition! 

Once you feel that you like the look of your clouds and sky in your Background 
group (Figure 3.26), feel free to move on to the Midground group for  
further refinement:

Figure 3.26 – Our refined Background group, with our Midground and Foreground groups hidden

6.	 Select your Midground group folder and "maximize" the group by clicking the 
arrow icon to the left of Midground, under the tiny folder icon.

7.	 "Unhide" your Midground group by clicking the eyeball icon to the left of the 
Midground group entry.

8.	 With your Midground Plane layer selected inside of your Midground group, 
click the plus sign (+) to create a new layer entitled Paint Layer 2 inside of your 
Midground group.
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Your Layers panel should look as in Figure 3.27 at this stage:

Figure 3.27 – Your Layers panel while working inside of your Midground group
Since we are keeping our Background layer group visible for the duration of this 
piece, we can successfully start modifying and editing our Midground group to take 
advantage of our more refined background. 

9.	 Paint any composition adjustments you would like to make by working within your 
Midground group and rendering out some more specific shapes, while playing with 
the value slider above the HSV color wheel to get some nice variations within the 
middle of the slider. Remember to stay within the midtones, as we don't want to 
mess with our illusion of depth!

Color Picking
We're primarily working in black-and-white values right now, but it's helpful 
to know the hotkey for Krita's color picker (also known as the eyedropper) 
tool. The default hotkey for this is Ctrl for Windows and Cmd for Mac, but 
you can easily change this setting in Krita's settings. To do this, click Settings | 
Configure Krita | Canvas Input Settings | Alternate Invocation to modify the 
color picker/eyedropper to the shortcut you are most comfortable with.
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A helpful trick to stay within your current value range is by color-selecting 
values that are already on your canvas. This will allow you to utilize your already-
established values without introducing new values that may "break" the illusion of 
depth you are creating.

10.	 At this stage, I recommend that you introduce a few more value shifts within your 
midground Paint Layer 2 (making sure that the midground's "lightest values" are 
not as light or bright as the "darkest" background values), and use a larger version 
of your brush to "blot in" some messy circles with a light touch to add some visual 
variety. You can also make some sharper silhouettes for your "darker" midground 
shapes and overall, you'll hopefully start feeling happy with where you're at so far 
(Figure 3.28):

Figure 3.28 – The more refined Midground group on top of the more refined Background group
Now that we feel comfortable with the direction the midground and background are 
headed in, we can start working on the Foreground layer group.

11.	 First, make sure your Foreground group is visible by clicking the eyeball icon to the 
left of the group.

12.	 Make sure you "maximize" the Foreground group by clicking the arrow underneath 
the Foreground group's tiny folder icon.

13.	 Make sure your Foreground Plane layer is selected from within the group and click 
the plus sign (+) on the bottom left of the Layers panel to add a new layer called 
Paint Layer 3.
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Your Layers panel should look as in Figure 3.29 at this stage:

Figure 3.29 – Your full Layers panel with grouped Foreground, Midground,  
and Background groups visible

14.	 Now that you're on Paint Layer 3, start painting in some details for your darkest 
planes. You can also add a variety of brushstroke sizes and shapes to drive home the 
variety of the rocks here.

15.	 A neat trick you can do is use your darkest value (remember, not pure black!) to 
draw your horizon line and blend that line into the rocks themselves. This gives 
the viewer's eye a place to "rest" and form the foundation of your mountain's scale. 
For more massive mountains, create the horizon line lower on your canvas to allow 
room for your mountains to have a larger spectrum of variety in relation to width, 
height, and real estate on your canvas.
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16.	 Once you feel comfortable with where you're at, I think our block-in phase is 
complete (see Figure 3.30). Take your time and make something that gets you 
excited to continue. Don't worry, we'll revisit our landscape and bring it to a 
portfolio-ready finish before you know it!

Figure 3.30 – Our completed block-in phase with all layers and groups visible

Phew, there we have it! Like I've said previously, this phase is very much a "foundational" 
phase of our painting, and you'll notice there's quite a bit of stuff missing. Where's the 
color? Where's the texture? Trust me, there's a method to this madness, and your hard 
work here is going to pay off in a huge way later. The amount of time you spent preparing 
your image's layers and groups is going to speed up the texture work, color passes, and 
finishing touches that we'll be showcasing later in the book. 

Summary
In this chapter, we actually started a painting! Technically, we also learned about the 
importance of layers, layer modes, and grouping layers. While we primarily only worked 
within the Normal blending mode during this chapter, it's still an important feature to 
point out as we will be deep-diving into more blending modes later in the book.
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We also discussed some basics regarding landscape painting, including integrating  
our values and brushwork in an organized, structured way. Hopefully, you are already  
able to see the "illusion" of a landscape, even though we're only using three primary 
groups of content within our painting (those being our foreground, midground, and 
background groups). As artists, it is our job to mimic the sense of three dimensions on  
a two-dimensional plane, and keeping our values organized and structured aids in that 
goal tremendously.

In Chapter 4, Utilizing Brushes and Tools, we will be continuing our refinement of this 
landscape and utilizing custom brushes and tools to really get the most out of our 
composition. We will also be setting up the UI to ensure that we have everything we need 
at our fingertips.

For good measure, we'll also be discussing some more professional secrets on getting  
a huge amount of impact by using some of Krita's incredibly realistic built-in brushes…in 
fact, they're some of the best digital painting brushes I've ever used!

Fantastic work in this chapter! Let's keep it up and go ahead with creating our  
perfect brushes!



4
Utilizing Brushes 

and Tools
Welcome to Chapter 4, Utilizing Brushes and Tools! In the last chapter, we finally got  
our hands dirty by starting our landscape piece by creating specified layers, grouping 
those layers, and formatting our layers in a way that makes logical sense for our project 
(namely breaking down items into foreground, midground, and background working 
areas). While we mentioned what brushes we used to create the first steps of our 
masterpiece, we didn't discuss why we chose our specific brushes, or talk about how  
we can go about making edits or changes to our brushes. That's what this chapter is for!

In this chapter, we will be looking at the power of Krita's brush engine and the way in 
which its functionality can aid us as we move forward with our landscape painting during 
Chapter 5, Implementing Layer Blending Modes. 

So, in this chapter, we will cover the following topics:

•	 Exploring brushes

•	 Customizing your brushes

•	 Exporting our resources

•	 Importing a resource bundle

With our chapter's goals laid out in front of us, there's nothing left to do but to get started!



94     Utilizing Brushes and Tools

Technical requirements
To follow along with this chapter, you will need the following:

•	 Krita (version 5.0 +)

•	 A way to interact with Krita, such as a keyboard, and either a mouse, tablet,  
or touch device with a stylus

Exploring brushes
Before we get too far down this rabbit hole (and trust me, it's a biiiggg rabbit hole!), 
let's define what a brush is in context to Krita. Essentially a brush is a collection of 
customizable settings, mapped to an image (or brush tip), used to lay down visual 
information onto your canvas via your input device (such as a mouse or tablet). Many 
brushes exist natively when you first download Krita, and you can also download 
customized brush packs from various artists who have exported their Krita brush presets 
(which we will get to in the Exporting our resources section of this chapter). 

Brushes have hundreds of settings at their disposal, and mixing and matching these 
settings can offer up thousands of different brushes with various feels that can mimic 
traditional pencils, paintbrushes, digital spray paint, and more. Couple these settings  
with the fact that you can create your own brush tips from scratch, and that number 
grows to a near-infinite number of choices. While we could write an entire 300+ page 
book just about brushes, I want to give you the "greatest hits" as it were, some key settings 
and features to keep in mind to give you the biggest impact for the least amount of stress. 
Don't worry, from here on out throughout the rest of the book, we will be discussing 
various tweaks and changes to brushes as we work on our projects. For a full rundown  
of every setting for your brushes in full detail, I highly recommend the official  
Krita documentation.
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Krita's Official Documentation
Krita, as we're learning, is a fantastic piece of art software that can work 
at the highest levels of production. Along that same line, Krita's official 
documentation (also called the User Manual) is fantastic, and I cannot stress 
enough how well-organized and helpful it can be in learning the technical ins 
and outs of the program. If you ever want to dig deeper on a technical aspect 
we discuss in the book, I can say with a good amount of confidence that the 
official Krita documentation will cover what you're looking for.

At the time of this book being written, the official Krita documentation can be 
found online here: https://docs.krita.org/en/user_manual.
html. Also, Krita has a fantastic YouTube channel (if you prefer a more  
audio-video presentation style) which can be found at https://www.
youtube.com/channel/UCkIccKaHDGA8lYVmUerLhag.

As we have established previously in the book, my main goal for us throughout this 
journey is to think like a painter first and foremost, channeling your inner artistic 
know-how to solve problems you may encounter during your digital art career (whether 
professional or hobbyist). This way of thinking helps when discussing the brushes, 
customization options, and the brush engines in Krita, as it will better guide you to make 
stronger design decisions. What would you look for when buying traditional art supplies? 
What would you look for in an ink pen, or mechanical drafting pencil, perhaps?

With that way of thinking being at the forefront of your mind, let's discover Krita's brush 
presets to get a solid understanding of how the program showcases and categorizes its 
menu of brushes for you, then we can explore how to work with tags to save your favorite 
brushes for later use.

https://docs.krita.org/en/user_manual.html
https://docs.krita.org/en/user_manual.html
https://www.youtube.com/channel/UCkIccKaHDGA8lYVmUerLhag
https://www.youtube.com/channel/UCkIccKaHDGA8lYVmUerLhag
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Discovering brush presets
Krita comes installed with a large amount of brush presets (a pre-saved assortment of 
brush tip and option combinations), separated into a list of categories (done with Tags). 
Knowing what type of brush you need for a specific portion of your piece is half the battle, 
and tagging your favorite brushes into custom categories makes it a breeze to find exactly 
what you're looking for. We can see an example of a full Brush Presets selector window  
in Figure 4.1:

Figure 4.1 – The Brush Presets menu, displaying every one  
of my brush presets available (the All category tag)
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Figure 4.1 is an expanded look at all my brush presets (notated by the All drop-down 
selector at the top of the window), ranging from erasers, sketching pencils, airbrushes, 
watercolors, charcoal brushes, mixers, stamps, and blenders. To make sure this window  
is active for you to be able to browse, follow these steps:

1.	 Select Settings on your main menu.
2.	 Make sure Show Dockers is active (as seen in Figure 4.2):

Figure 4.2 – The active Show Dockers option from the Settings menu

3.	 Under the Show Dockers option, hover over Dockers so the submenu expands.
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4.	 Make sure Brush Presets is selected (as shown in Figure 4.3):

Figure 4.3 – The selected Brush Presets option under the Dockers submenu

By default, your Brush Presets window should appear docked to either side of your work 
area. To do a full "disconnect" from the side docking bays and allow you to drag and move 
your window around, you can click on the Float Docker button (which looks like two 
stacked windows on top of each other – shown in Figure 4.4):

Figure 4.4 – The Float Docker button on the Brush Presets docker window
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Keep in mind that every one of your dockers behaves in this way, making Krita an 
extremely customizable solution for painting. Feel free to experiment with dragging, 
dropping, floating, and re-docking your dock windows to become familiar with how  
Krita handles the sizing and structure of your docks as they relate to one another.

Modifying Brush Presets display options
While having all our presets for brushes displayed in an icon format is sleek, unless you 
have had a ton of experience with each brush and memorized their features and correlated 
them with their icons, you may want a little bit more information about which brush 
preset you're selecting. 

Krita gives you a few quick options for both resizing your Brush Presets icons, as well as 
allowing you to see the name of each individual preset next to the icon.

To get to these options, follow these steps:

1.	 On your Brush Presets docker, click on the three stacked lines to the right of the 
Tag icon (also known as a "hamburger menu").

2.	 You will see an option to choose between displaying Thumbnails (which is just 
the icon by itself with no text) or Details (which has a smaller version of the icon, 
alongside the name of the brush in text). You will also see a slider to adjust the size 
of the icons themselves. 

A full look at these options (and the menu's location) can be seen in Figure 4.5:

Figure 4.5 – The Brush Presets display options menu
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My personal recommendation is to go for the Details display type with a moderately large 
(higher than mid-point) Icon Size. Of course, your personal preference takes priority 
here, but I enjoy having the quick visibility of the brush's thumbnail icon, alongside the 
brush's detailed name as well (as seen in Figure 4.6):

Figure 4.6 – Active Details display option for the Brush Presets docker

I have had great luck in keeping my Brush Presets docker in the docked position on the 
upper-left corner of the screen, as that location closely mimics the brush tool placements 
for other digital art software, such as Photoshop. It makes the "learning curve" of going 
from one program to another much less daunting, and anything to save yourself  
a headache is always a good thing!

Another great way you can make your life easier in relation to navigating brushes is the 
Tag ability.

Categorizing with tags
Tags within Krita work as a personalized category system for sorting your resources. Not 
only can you tag brushes (both default preset brushes and custom brushes you create), but 
you can also tag things such as specific brush tips, patterns, and gradients. 
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A great way to use this feature is to add brushes to the My Favorites list (a tag category 
that is already made in Krita by default). Let's find our brush from Chapter 3, Utilizing 
Layers and Layer Groups (from within the Digital category, titled b) Basic-2 Opacity)  
and add it as one of our favorites:

1.	 Hover your mouse over the drop-down menu within your Brush Presets docker, 
immediately to the left of your Tag icon (Figure 4.7):

Figure 4.7 – The drop-down menu to select your Tag category

2.	 Click on the drop-down arrow and select the Digital category.
3.	 Once Digital is selected, scroll until you see the brush titled b) Basic-2 Opacity 

(Figure 4.8):

Figure 4.8 – Selecting the Basic-2 Opacity brush in the Digital category

4.	 Right-click on the brush in your Brush Presets list.
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5.	 A submenu will pop up with options. Hover over the Assign to tag option  
(Figure 4.9):

Figure 4.9 – The expanded Assign to tag menu

6.	 Click on the My Favorites option (the entry with the star beside it).
7.	 Now, go ahead and click on the Digital tag category drop-down menu, and change 

it to My Favorites.

You should see your newly-favorited b) Basic-2 Opacity brush in your My Favorites 
category tag (Figure 4.10):

Figure 4.10 – The My Favorites category with our newly favorited brush
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While this is a great way to start sorting through your most-used brushes and resources, 
I think that you can take this idea a step further and start making your own custom tags, 
which in turn create your own custom categories on the Brush Presets drop-down list. 
This is also a wise move, as saving all of your favorite brushes under the My Favorites tag 
will make the list very long to sort through, which sort of defeats the purpose of properly 
organizing your brushes!

Remember how earlier in the chapter we discussed "thinking like an artist" when it comes 
to your brushes? For instance, with my traditional art tools, I keep my palette knives 
separate from my synthetic bristle brushes, and my natural hair brushes have their own 
separate container as well (as cleaning synthetic brushes requires different methods than 
cleaning natural hair brushes). I methodically place each of these brush types by physical 
use case and application, making it easier for me to find what I need exactly when I need it.

In Krita, a great way to do this is by making a custom category to store your brushes in. 
You can do this by creating a custom Tag category. Let's do that now.

Creating a custom tag
The plan here is for us to categorize a nice set of brushes to choose from as we start 
developing and rendering the landscape painting that we started in Chapter 3, Utilizing 
Layers and Layer Groups. To do this, we are going to create a custom tag called Krita 
for Packt, and place some of our favorite landscape-style brushes into the category:

1.	 On your Brush Presets window, click on the Tag tab (the one with the ribbon  
icon visible).

2.	 Click on the text area for the New tag portion of the dropdown (Figure 4.11):

Figure 4.11 – The New tag dropdown from the Brush Presets window



104     Utilizing Brushes and Tools

3.	 Name your new tag something memorable! I'll be naming mine Krita for 
Packt, as mentioned earlier.

4.	 Hit the Enter key to finalize your new tag name.
5.	 Your new tag will show up in your Tag category dropdown in alphabetical order 

(Figure 4.12):

Figure 4.12 – Our new Krita for Packt custom tag category

Now that we have our custom tag created, it's time to fill in the category with some great 
brushes and tools that will help us with our landscape!

Filling our custom tag
As we are working with a landscape painting, there are a few types of brushes that 
immediately come to mind that I'll want to utilize, as follows:

•	 A hard round brush (a general work-horse brush, great for a variety of uses)

•	 A traditional feeling pencil (for sketching in finer details and adjusting  
edges quickly)

•	 A "wet" round brush (a version of a round brush that smudges edges based  
upon pen pressure)

•	 A "dry" texture brush (which will be great for impressionist rocks and  
random details)

•	 A "thick paint" brush (to allow for some nice impasto and painterly edges)
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•	 A blender (something that mimics a Q-tip to smooth out items such as sky, clouds, 
and water)

•	 A palette knife (great for sharp edges and those great Bob Ross-inspired  
"happy accidents")

This mimics the type of brushes and techniques I would use for a landscape painting 
created on canvas with traditional oils or acrylics, and I highly recommend using 
workflows that you feel comfortable with. Remember, at the end of the day, digital 
painting is painting; a lot of the same rules and methods apply across the board between 
traditional and digital! 

Let's get started on filling out our new custom tag:

1.	 For a hard round brush and a "wet" round brush, go to the Digital tag in your 
Brush Presets list.

2.	 A great hard round brush is the one named b) Basic-1, so right-click on the icon for 
the brush.

3.	 On the pop-up menu, hover over Assign to tag and find your new custom tag  
(in my case, Krita for Packt), as shown in Figure 4.13:

Figure 4.13 – Assigning our b) Basic-1 brush to our Krita for Packt custom tag
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4.	 Click your custom tag in the list to categorize the b) Basic-1 brush.
5.	 For the "wet" round brush, we will use our tried-and-true b) Basic-2 Opacity brush 

from Chapter 3, Utilizing Layers and Layer Groups.
6.	 Select b) Basic-2 Opacity and right-click to bring up the pop-up menu.
7.	 Hover over Assign to tag, and assign b) Basic-2 Opacity to our custom tag (once 

again, Krita for Packt in my case).
8.	 To check and make sure that your categorizing is working correctly, go ahead and 

click on the category header dropdown and select your custom category.

As we can see, both b) Basic-1 and b) Basic-2 Opacity are currently in the Krita for 
Packt category, and things are going well (Figure 4.14):

Figure 4.14 – Our two hard round brushes in our custom category, Krita for Packt

You probably noticed the asterisk (*) symbol next to our b) Basic-2 Opacity brush in 
Figure 4.14. This essentially means I have altered some settings and/or properties of this 
brush to make it different than Krita's default version of the brush; this is a topic we will 
cover in the Customizing your brushes section of this chapter when we will customize our 
brushes in this custom category.

We have our hard round brushes sorted, so now let's find a good-quality pencil brush to 
add to our custom category:

1.	 On the Brush Presets window, select the Sketch tag category on the  
drop-down selector.

2.	 Scroll until you see the c) Pencil-2 brush.
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3.	 Right-click on c) Pencil-2 and assign it to your custom tag (Figure 4.15):

Figure 4.15 – Assigning our pencil brush to our custom tag category

Now, let's add two brushes for the "thick paint" motif, both of which will come from one 
of my personal favorite brush categories in all of Krita:

1.	 On your Brush Presets window, select the RGBA tag category.
2.	 We will select both m) RGBA 01 Thick-dry and m) RGBA 02 Thickpaint, and 

assign them to our custom tag category using the same steps as we've been doing 
(the right-click > Assign to tag method).

RGBA Brushes Side Note
A quick note about the RGBA brushes while we're on the topic. While I 
absolutely adore the way they mimic real brushes, they can cause considerable 
slowdown on certain computer setups. If you find that your machine isn't 
giving you an enjoyable experience using the RGBA brushes, feel free to use 
any "wet" brush from the Paint tag instead.
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Now, let's do a quick review of our custom category and make sure our brushes have been 
added successfully (Figure 4.16). Now, we only have a few more tools left to add:

Figure 4.16 – Our Krita for Packt custom tag category

We still need a nice "dry texture" brush to add in some impressionistic rock details,  
so let's add that now:

1.	 In your Brush Presets window, navigate to the Paint tag category.
2.	 Scroll until you see the brush named g) Dry Bristles.
3.	 Assign your brush to your custom tag category using the right-click method.

Finally, let's add our palette knife and blender brushes to our custom category:

1.	 In the Brush Presets window, make sure you are still in the Paint tag category.
2.	 Scroll down until you see two tools – one named i) Wet Knife and the second 

named k) Blender Blur.
3.	 Right-click on each brush, and assign them to your custom category.
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Phew, now your custom tag category should be fully ready with some versatile brushes, 
sketching tools, blenders, and thick impasto paints (Figure 4.17):

Figure 4.17 – My Krita for Packt custom tag category, displaying brushes in alphabetical order

Before we start painting with our new brushes, there's still a major strength of Krita  
we've yet to use, and it's where we really get to dig in and make each of these brushes  
our own: brush customization.
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Customizing your brushes
In my opinion, Krita has some of the most comprehensive brush customization options 
I've ever seen in a digital art suite. This is really where Krita opens into something truly 
magical for digital artists – if there's a brush that you can imagine creating, odds are very 
high that Krita can make it happen. 

In this portion of the chapter, we're going to take a look at the many ways by which  
we can customize our brushes, save the edits we make, and even create our own brush 
from scratch!

Your Preferences Matter
In this portion of the chapter, I'll be discussing my personal favorite options for 
customizing brushes within Krita. There are hundreds of different sliders and 
knobs worth looking at; however, I'll try keeping my brush changes (and why 
I made them) concise, as well as easy to understand and follow. Please tinker 
with every setting you find; you will be blown away with the possibilities,  
I promise!

Let's get started on our brush customization by opening the Edit Brush Settings panel.

The easiest way to bring up your Edit Brush Settings panel is by pressing F5 on your 
keyboard with a brush selected in your Brush Presets window. However, it's also nice 
to know which icon represents this tool, so let's look at the Brushes and Stuff toolbar in 
greater detail.

As you can recall from Chapter 1, Getting Started with Krita, the Brushes and Stuff 
toolbar is where our New Document, Open, Save File, Undo, Redo, and brush 
properties are found. It's also the menu where we added our Reference Images tool while 
customizing our basic menu interface (Figure 4.18):

Figure 4.18 – The location of the Brushes and Stuff toolbar
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While Figure 4.18 shows the overall location and portion of the toolbar you're already 
familiar with from Chapter 1, Getting Started with Krita, let's shift our view of this toolbar 
over to the right a little bit:

Figure 4.19 – An extended view of the Brushes and Stuff toolbar

In Figure 4.19, we can see a variety of options and icons. From left to right, these include 
the following: 

•	 Gradient selector for Fill gradients

•	 Pattern/texture selector

•	 Foreground and background color selector

•	 Brush preset editor

•	 Brush preset selector

•	 Brush blending mode menu

•	 Eraser toggle

•	 Preserve Alpha toggle

•	 Reload brush preset button (sets your brush preset back to Krita's default for  
the brush)

•	 Brush opacity

•	 Brush size

Having these options at the top of all of your projects is extremely handy! You'll be 
spending a lot of time tweaking options to get exactly the right tool for what you need.  
For what we're focusing on, let's talk about the brush preset editor. This area of Krita is 
key for customizing your brushes, so the more familiar we get with it, the more productive 
we will be in reaching our goals of making an ultimate brush set! Let's get started by 
looking at the Brush Editor and its options.
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Brush Editor
You can quickly bring up your Brush Editor by either clicking the icon on your  
Brushes and Stuff toolbar, or by hitting the default Krita hotkey of F5 while you have  
a brush selected.

This is a hefty menu that you can spend hours tinkering around with, so while we're going 
to do a brief overview of everything in the menu in Figure 4.20, my primary focus will be 
on altering the "feel" of a few brushes to aid us in our landscape painting:

Figure 4.20 – The Brush Editor screen (extended with Scratchpad visible)

Let's do a quick breakdown of this menu. From left to right, we have the following:

•	 Brush selector

•	 Brush properties

•	 Brush tip editor

•	 Scratchpad

While these can be self-explanatory based on their name, let's have a hands-on look at 
what these options are by editing a few brushes from our custom category to really make 
them our own.
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At any point, if you would like to remove your changes and refer back to the default 
version of a brush you're working on, you can click the Reload the brush preset button 
near the top-middle of the window (Figure 4.21):

Figure 4.21 – The Reload the brush preset button in the Brush Preset Editor menu

You may also notice the small exclamation point inside of the triangle immediately to  
the right of the Reload the brush preset button. This symbol notates that the brush you 
have selected has been altered from the default (which also places an asterisk next to the 
name of the brush in the Brush Selection tab). This is just some handy information  
to have before we get too far into editing our brush, as it's nice to know there's always  
a "reset" button!

Let's get started by altering the feel of our c) Pencil-2 brush (or whichever "sketching" 
style brush you've selected for your custom tag category):

1.	 In the Brush Editor window, make sure your custom tag category is selected in the 
brush selector (left) portion of the window (Figure 4.22):

Figure 4.22 – Our custom category as selected in the Brush Editor window



114     Utilizing Brushes and Tools

I like the way the c) Pencil-2 brush looks when the mark is placed on the canvas, 
however, I wish it had a bit more control over the amount of pigment/lead that was 
placed when I make a mark. I'd like this to feel as "natural" as possible, just like 
sketching in a sketchbook with a #2 pencil. To make this happen, I need to ensure 
there's a nice feeling of "build-up" and "drop-off " to my line density as, right now, 
the moment I put my pen stylus on my tablet, the brush is laying down lines at 
100% width and 100% opacity.

2.	 With our c) Pencil-2 brush selected, let's look at the Brush Properties area.
3.	 Click on the Flow property.
4.	 In the Flow property settings, you will notice options such as Strength, as well as 

some checkboxes such as Enable Pen Settings, and various graphs (Figure 4.23):

Figure 4.23 – Our c) Pencil-2 Flow properties customization area

5.	 To get the feel I'm looking for, I'm going to adjust the Pressure curve to mimic the 
"lazy S curve" (the third setting from left, above our pressure sensitivity graph in 
Figure 4.24). This will allow the pencil to "build up" into a smooth line based on how 
hard I press on my tablet. 
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6.	 I have also adjusted the Strength option under Flow to be 76% as it more 
comfortably captures the grittier and more inconsistent flow of a pencil, instead of 
the smooth flow of something like an ink pen (Figure 4.24):

Figure 4.24 – Adjusted Flow pressure curve, and Strength settings
Let's also add a slight fade to the brush, just to see what impact it has.

7.	 While still within the Flow settings, click the Fade checkbox.
8.	 Since we have the Share curve across all settings option checked for the Flow 

category, our Fade setting has inherited the lazy S curve from our Pressure  
curve setting.

9.	 Uncheck the Share curve across all settings box in the Fade settings.
10.	 Click on the first option (the 45-degree incline in Figure 4.25) to change the Fade 

setting to a linear growth rate.
11.	 Adjust the Fade Length property as you see fit, testing the changes on your 

Scratchpad. I've chosen 22 pixels for my fade length.
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Your fade curve should resemble what we have in Figure 4.25:

Figure 4.25 – Our Fade properties with corrected non-shared curve and custom fade length

Now that we've gone ahead and made our adjustments to the c) Pencil-2 Brush, let's save 
it as its own standalone Brush Preset.

Saving your custom brush preset
You have your brush that you've altered and would prefer that the custom brush be saved 
as its own default preset. Krita makes this extremely easy! 



Customizing your brushes     117

Finding Your Default Save Location
Depending on your operating system, your resources will be saved to  
a different directory on your hard drive. To know where your resources, 
presets, and other customizations are saved, you can open your resources folder 
at any time. To do this, on your Manage Resources page (Settings > Manage 
Resources), click on the Open Resource Folder option. This will load up your 
default resource directory save location. For instance, my default save location 
for my Krita resources on my Windows 10 machine is User > AppData > 
Roaming > Krita.

Let's go ahead and save our custom brush preset so we can return to this exact brush every 
time we need it:

1.	 Make sure the brush you have customized is the active brush.
2.	 In the Brush Editor window, hover over the Save New Brush Preset option in the 

upper right (Figure 4.26):

Figure 4.26 – The Save New Brush Preset button within the Brush Editor window
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3.	 The Save New Brush Preset window will now display, giving you a variety of 
options to edit (Figure 4.27):

Figure 4.27 – The Save New Brush Preset window

4.	 Enter a name that will be easy to remember. I'm going to name my brush  
Wes Pencil.

Now, there are a variety of options for the thumbnail. Let's review these quickly:

a. Load Existing Thumbnail – Use the thumbnail that Krita already has displayed.

b. �Load Scratchpad Thumbnail – Load a snapshot of your current  
scratchpad information.

c. �Load image – Import a custom image (in .jpg, .png, .gif, .pdf, .tif, and 
dozens of other image types).

d. �Load from Icon Library – Use Krita's library of iconography to customize  
a new thumbnail.

e. Clear Thumbnail – Delete what you currently have.

For our thumbnail, let's select Load from Icon Library. This will make sure our 
brush's thumbnail stays visually consistent with our other (Krita default) brushes.
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5.	 Click Load from Icon Library.

The Preset Icon Library window will display.
6.	 Scroll through your Tool image options, adjust your hues/saturations, and add any 

custom emblems you would like.

I have created a custom icon for my new Wes Pencil brush, the settings of which are 
shown in Figure 4.28:

Figure 4.28 – My custom Icon settings for "Wes Pencil"
Know that you can really customize your icon with tons of icons, colors, and even 
custom emblems! Feel free to experiment!
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7.	 Once you're done with your settings, click OK.

Your thumbnail should have been updated accordingly inside of the Save New 
Brush Preset window.

8.	 Once you are happy with your changes, click Save.

While your new custom brush preset will be saved, it will not automatically be 
added to your custom category tag. Let's do that now.

9.	 Within the Brush Editor window, change the category from your custom category 
(in my case, Krita for Packt) to All Untagged (Figure 4.29):

Figure 4.29 – The All Untagged category within the Brush Editor window
Your new custom brush should be in this listing (as it has no tags at the moment), 
at the bottom of the list by default (as it was the most recently added brush to Krita).

10.	 I am going to scroll down and add Wes Pencil to my Krita for Packt custom 
category by using the right-click > Assign to tag method (Figure 4.30):

Figure 4.30 – Adding Wes Pencil to the Krita for Packt tag category
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11.	 The custom brush should now show in your custom tag category (in alphabetical 
order by default)! You're all done!

This is a handy way to make slight tweaks to a brush within Krita and make something 
new out of it. But, what if you want to make a brush purely from scratch? That's where 
brush creation comes into play.

Creating your own brush
While I love using Krita's pre-made default brushes as a template to modify and create 
my own presets, sometimes it's fun to really dig in deep and create your own brush from 
scratch. Let's quickly do that now by creating a fun, all-purpose texture brush that has 
some color smudging and blending built in. I'm thinking I want the consistency of this 
new Krita brush to act like one of my traditional oil brushes as if it was dipped in an 
extender medium such as Liquin. Smooth, thick, and buttery is the goal!

Krita's Extensive Brush Engines
Krita has a variety of brush engines for various brush effects (basically 
mathematical calculations), each having different functionality. While there are 
16 engines at the time of Krita 5.0 beta, I am going to focus on only one here 
for our new brush, the Color Smudge engine. Other engines that are most 
often used within Krita defaults and your everyday brush creation are Pixel, 
Quick Brush, Sketch, Bristle, and, as of Krita 5.0, compatibility with the open 
source MyPaint brush engine.

While we could spend entire chapters focused on the small intricacies between 
these brush engines, just know that all an engine refers to is the mathematical 
calculations used to put data (whether raster or vector) onto a canvas. Krita's 
official documentation not only offers full overviews of the feature-sets of 
these engines, but also breaks down the math in a clear, concise way if you're 
interested in the finer details of brush programming.
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Let's create our new thick brush for our custom tag category:

1.	 With the Brush Editor window open, click the plus (+) sign at the bottom-left of 
the window.

A full listing of available brush engines will display (Figure 4.31):

Figure 4.31 – Full listing of available brush engines for brush creation in Krita 5.0 beta

2.	 Click on Color Smudge near the top of the list.
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A new brush named defaultSmudge should appear, defaulting to Pattern in the 
Texture selection menu (Figure 4.32):

Figure 4.32 – The default settings for our new custom Color Smudge brush defaultSmudge

3.	 At the top of the Brush Editor window, click the pencil icon next to defaultSmudge 
to rename it (Figure 4.33):

Figure 4.33 – The Rename Brush tool inside of the Brush Editor window
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Let's rename our brush. I'm going to name this brush Thick Oil with Medium.
4.	 In the brush properties area (the spot with all the checkboxes), click on the very top 

option called Brush Tip.
5.	 In the Brush Tip editor area, click on the Predefined tab (Figure 4.34):

Figure 4.34 – The Brush Tip options with Predefined selected
This lets us choose from all the brush tips currently inside of Krita. If you don't see 
a brush tip you like the look of, feel free to import your own image by using the 
Import button at the bottom of the Predefined catalog of options! This will let your 
imported brush tip be used across Krita!

Quality Brush Tips
Keep in mind that brushes are "masks", meaning that they should be in pure 
black and white, with white being invisible, and black being opaque. Slight 
amounts of gray are fine, but just know that gray works as an "alpha channel," 
meaning the closer to white, the more transparent the information, while the 
closer to black, the more it will show up during your brush strokes. We will be 
discussing masks in Chapter 5, Implementing Layer Blending Modes, where  
we talk about layers, blending modes, and layer interactions.
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Since I want to mimic an oil brush, I'm going to find a nice, square, slightly chalky 
brush tip (as it can mimic the variance of a real bristle brush with a medium on it).

6.	 I'm going to select the brush tip on the third row (named Chalk), third from the 
left, on the Predefined tab (Figure 4.35):

Figure 4.35 – The chalk option in the Predefined brush tip catalog listing
The great thing about using the Color Smudge brush engine is that most of the hard 
work (getting that nice, painterly feel) is pretty much done as it's a feature of the 
engine itself! I just want to add a bit of texture to the brush to really drive home that 
traditional feel, and I think we'll be good!

7.	 Click on the Pattern checkbox under the General category in the Brush Editor 
properties menu.

8.	 Select a nice canvas texture. I've selected the 26_brush-marks.png (512x512) 
texture (the sixth row, third option from the left in Figure 4.36).
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9.	 I'll play on the Scratchpad panel to make sure this is the texture that I'd like  
(Figure 4.36):

Figure 4.36 – The Pattern settings under the Texture category, with Scratchpad example

I think that's a winner! This should work great in giving us a painterly feel when  
we continue our landscape in Chapter 5, Implementing Layer Blending Modes.

Be sure you save your brush! Instead of the Save New Brush Preset button, you can click 
Overwrite Brush Preset, as this is your own custom brush from scratch!



Exporting our resources     127

Make your changes to your icon and click Save when you are done (Figure 4.37):

Figure 4.37 – Finalizing our new Thick Oil with Medium brush

Don't forget to add this brush to your custom category by going to the All Untagged 
category, finding your new brush, and using the right-click > Assign to tag method!

Now that we have a solid understanding of modifying and creating brushes, we're going to 
learn how to share our tools with other Krita users by exporting our resources!

Exporting our resources
In Krita, a collection of various elements (such as brush tips, brush presets, patterns, 
gradients, and tool customizations) is referred to as a resource.
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Resources can be imported and exported within Krita, and it is yet another way that 
Krita's flexibility makes it a top-tier choice for digital creators. Let's create our Krita 
for Packt resource; that way, I can share all my brushes with you, completely free:

1.	 On your Krita File menu, click the Settings tab.
2.	 Under Settings, click Manage Resources… (Figure 4.38):

Figure 4.38 – The Manage Resources option under the Settings tab

3.	 This will bring up your Manage Resources window.

The Manage Resources window is a great tool for filtering and sorting through 
items and options that Krita uses as its backbone. Items we are familiar with, such 
as Brush Presets, Brush Tips, Workspaces, and Patterns are here, alongside some 
more advanced options, such as Scripts and Symbol Libraries. For our purposes, 
we just need to look at two of the options at the bottom-right of this window – 
Import Resources and Create a Bundle, as shown in Figure 4.39:
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Figure 4.39 – The Manage Resources window, with Import Resources and Create a Bundle highlighted

4.	 Go ahead and click on the Create a Bundle button.
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5.	 The Create Resource Bundle window will display (Figure 4.40):

Figure 4.40 – The Create Resource Bundle window
As you can see, there's a lot to unpack here! 

6.	 First, go ahead and fill out the information on the left-hand side with what 
information you would like in your Resource Bundle. Notice that the author 
metadata we created in Chapter 1, Getting Started with Krita, has auto-filled in  
their respective spots!

7.	 Once that's complete, you can start adding in the resources you would like in your 
bundle using the Type filter and the left/right arrows between the Available and 
Selected areas of the window (Figure 4.41):
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Figure 4.41 – The resource selection process within the Create Resource Bundle window
Everything must be included for your bundle to work correctly! This includes things 
such as Brush Tips (like our chalk brush tip for our Thick Oil with Medium brush 
preset) and our Texture pattern (also for our Thick Oil with Medium brush preset). 
If there is a missing component, while the resource bundle itself will still import 
correctly, some settings, brushes, presets, or more may be grayed out or might not 
work at all.
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Types, and…Wait, Where'd My Stuff Go?!
As you go through each category under the Type drop-down menu, please 
know that only tools from that Type category will show up in the Selected list, so 
don't be alarmed if you move from a type such as Brush Tips to the Patterns 
type and notice that Brush Tips "disappears." They're still selected and part 
of your resource bundle, but the way Krita organizes its information on this 
screen, you will only see Available and Selected tools under the specified Type 
you have selected.

8.	 To clarify what I am including in my bundle, here is a handy list of included items 
according to their Type category:

a. Brush Tips: chalk

b. �Brush Presets: Basic-1, Basic-2 Opacity, Pencil-2, Wet Knife, Blender Blur, 
RGBA-01 Thick-dry, RGBA-02-Thickpaint, Wes Pencil, and Thick Oil  
with Medium

c. Patterns: 26-brush-marks.png
9.	 Have a look at the completed bundle in Figure 4.42, including a custom icon, 

specified metadata, and a custom Save location on my hard drive. I also included  
a snapshot of part of the Brush Presets type category to showcase how your 
Selected items will look per type:

Figure 4.42 – The completed Resource Bundle creation with metadata,  
icon, and viewing Brush Presets included
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10.	 When you are finished with compiling everything for your bundle, go ahead and 
click Save.

Bundle Naming Conventions
At the time of saving a custom bundle, you may see an error that deals with 
repeat names of a brush, brush tip, or another file name. For any edits you 
make, or repeat textures/brush tips you may use, be sure to edit the name 
to something new, such as adding a number or word to your file name. For 
instance, if you have a repeat of chalk.png, you can edit the name of the 
tip, and save it as chalk-1.png or chalk-custom.png. This should 
resolve those bundling issues!

That's it! You've created a full Krita resource that you can share with friends, loved ones, 
and colleagues!

Now that we know how to create a bundle, let's go ahead and import one!

Importing a resource bundle
Before importing a resource bundle, make sure you have a Krita Bundle Resource 
file downloaded (the .bundle filetype), but just know you can import all kinds of 
resources here, including (but not limited to) color palettes, gamuts, SVG (scalable vector 
graphics) files, even Photoshop brushes (the .abr format)! For our example, though,  
let's focus on a full Krita bundle resource:

1.	 In the File menu, click on Settings.
2.	 Under Settings, click on Manage Resources.
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3.	 On the Manage Resources window, click on Import Resources in the lower-right 
corner (Figure 4.43):

Figure 4.43 – The Import Resources button in the Manage Resources window

4.	 Go to the location where you have saved your Krita resource bundle  
(the .bundle file).

5.	 Select the file from the saved location, and click Open.

Krita will load your bundle!
6.	 To verify that your Krita resource bundle has loaded successfully, click the  

drop-down menu titled Local Resources. This will bring up a list of all compiled 
resources loaded into your Krita instance.
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7.	 Your new Krita resource bundle should show up at the bottom of the list as  
in Figure 4.44:

Figure 4.44 – Our Krita for Packt resource bundle is successfully loaded within Krita

That's a wrap! Not only are you able to create your own brushes, brush presets, and 
resource bundles, you now know how to trade them with others and import them into 
your installation of Krita! Great work!

Summary
Take a deep breath; you've made it through the brushes chapter! Brushes in Krita are  
a huge (huge) topic, and they are something that gets more and more fascinating as you 
play around with them. As I mentioned in this chapter, the official Krita documentation is 
a fantastic resource if you want to nail down the nitty-gritty of technicalities, mathematics, 
and programming styles of the brushes and engines. 
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In this chapter, we reviewed the idea of brushes with more of an artistic eye, focusing 
primarily on creating a custom set of brushes that fit our needs, and that we can refer to 
for the remainder of the book. We modified existing Krita brushes, created a brush from 
scratch using one of Krita's powerful brush engines, and even created a full bundle  
of resources to share with our fellow Krita artists!

I hope you found this chapter valuable, and I'm excited about seeing the great types  
of resources you're going to create and share with the world!

In Chapter 5, Implementing Layer Blending Modes, we're going to return to painting  
our landscape using the custom brush bundle we created in this chapter, and dig into 
utilizing various blending modes and layering techniques to bring our piece to a new  
level of polish!

Outstanding job so far! You should be very proud of how far you've come! We're firing  
on all cylinders now, so let's hop back into our landscape painting and get to it!



Part 2:  
Methods of Visual 

Communication 
within Krita

In Part 2, you will get hands-on with an extensive, multi-chapter project to enhance  
your comfort levels with some advanced features and techniques of Krita. You will take  
your landscape project through various phases of the illustration process, learning 
industry-standard organizational and working techniques using Krita's extensive library 
of digital art tools.

This part comprises the following chapters:

•	 Chapter 5, Implementing Layer Blending Modes

•	 Chapter 6, Composing Using Krita's Toolbox

•	 Chapter 7, Changing the Feel with Painting, Values, and Sliders

•	 Chapter 8, Controlling Chaos – Organizing Your Workflow





5
Implementing Layer 

Blending Modes
In Chapter 3, Utilizing Layers and Layer Groups, we started a landscape painting, grouping 
our composition into foreground, midground, and background layer groups. We then 
discussed the naming conventions and management of our layer group structure to set 
ourselves up for success "later in the book." Congratulations! We've made it to this fabled 
"later in the book" portion for our landscape painting!

In this chapter, we will be covering layer blending modes, their uses, popular techniques, 
and getting our hands dirty with a little more hands-on painting. We will be bringing in  
a rough photographic reference for our painting and adding some color tones. The 
structure of this chapter will be as follows:

•	 Understanding layer modes

•	 Evaluating reference material

•	 Bashing our reference

•	 Splashing in color

This chapter is going to give us a ton of progress on our landscape, and, hopefully, simplify 
a topic that can be a bit overwhelming if you're either unfamiliar with the workflow  
or making the jump from traditional art to the digital realm. 
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Technical requirements
To follow along with this chapter, you will need the following:

•	 Krita (version 5.0+).

•	 A way to interact with Krita, such as a keyboard, and either a mouse, tablet,  
or touch device with a stylus.

•	 Your landscape painting from the end of Chapter 3, Utilizing Layers and  
Layer Groups.

•	 If you did not follow along in Chapter 3, Utilizing Layers and Layer Groups,  
a full version of my Krita file (.kra), as of the end of the chapter, is available here:  
https://static.packt-cdn.com/downloads/Krita_Sample_Files.
zip.

With our technical requirements set up and our expectations for the chapter set, let's get 
started by defining and understanding layer modes!

Understanding layer modes
At their most basic level, layer modes (also known as blending modes or layer blending 
modes) are just rules in which two layers (or more, if dealing with layer groups) interact 
with one another using algorithms and computer logic within Krita. For instance, the  
default blending mode within Krita (known as the Normal mode) has the basic logic of  
"If a layer is above another layer on the Layers panel, display the contents of the top layer 
on top of the contents of the layer below it, with relation to the transparency of the top 
layer's contents." 

https://static.packt-cdn.com/downloads/Krita_Sample_Files.zip
https://static.packt-cdn.com/downloads/Krita_Sample_Files.zip
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This may not seem like something useful just from the definition, however, this is  
a powerful benefit of working digitally. Layer blending modes are extremely valuable to 
learn, as the flexibility they provide can take your art to the next level by adding realistic 
texturing, controlling more subtle light and shadow usage, and integrating photographs 
into your compositions, for example.

Over 100 Options, Which to Choose?!
Something to note: Krita 5 has over 100 layer blending modes to choose from, 
sorted between 13 different categories. To go over every single blending mode 
in great detail wouldn't be a great use of our time in this book, but we will 
be covering how to favorite our most-used blending modes and discussing 
some "heavy-hitters" that are industry-standard in the key art, illustration, and 
concept art industries.

For a full list of every blending mode, including a logical explanation of the 
math involved, please refer to the official Krita User Manual's overview of 
blending modes at https://docs.krita.org/en/reference_
manual/blending_modes.html. 

Out of the 100+ blending modes available in Krita, I've only ever used about a dozen, but 
that's not to say that your workflow won't use more (or less!). Remember, having "too 
many" options may actually be a benefit, as I feel it's best to "have something and not need 
it" than to really need a functionality and not have access to it. Let's have a quick look 
at the location of our layer blending modes in Krita, and set up some favorites for easy 
access. Once we have our favorites set up, we'll make a great way to check our values at 
any time, at the click of a button!

https://docs.krita.org/en/reference_manual/blending_modes.html
https://docs.krita.org/en/reference_manual/blending_modes.html
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Browsing our layer blending mode choices
Before we get too far into the chapter, make sure you have an image open and active in 
Krita, as this will ensure that your Layers panel is active and able to be interacted with. 
Since we will be using the work-in-progress landscape we created in Chapter 3, Utilizing 
Layers and Layer Groups, I currently have my copy of it open. If you need a copy of this 
file, check out the link in the Technical requirements section of this chapter; otherwise, get 
your landscape open, and let's explore some blending modes:

1.	 Be sure to save your file before we start making changes! I've changed the name of 
my file to Chapter5-Landscape and saved it in Krita's native filetype (.kra).

2.	 Check your Layers panel on the lower-right of your screen, and notice the  
drop-down option under the word Layers with the name Normal. This is your layer 
blending mode selection menu (Figure 5.1). For the sake of brevity (and clarity),  
I will refer to this as simply blending mode moving forward:

Figure 5.1 – The layer blending mode selection menu (with Normal mode selected)



Understanding layer modes     143

3.	 Click on the down arrow to the right of Normal to bring up the full blending mode 
menu of options (Figure 5.2):

Figure 5.2 – The full list of blending mode categories, with the Favorites category expanded
You'll notice in Figure 5.2 that I have the Favorites panel expanded, while the other 
categories are collapsed. I enjoy keeping my blending mode menu clean in this way, 
as it allows me to focus on accessing my favorite blending modes quickly, without 
having to memorize which category or location they may be in the massive list of 
100+ options. 

Before we start integrating our stock photos in the Bashing our reference section of 
the chapter a bit later, I want to add a few more blending modes to my Favorites 
category. Let's do that now!

4.	 On the Layers panel, click on the blending mode menu to bring up the list of 
categories and modes.
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5.	 Scroll to the Lighten category, and click on it to expand the category to see all of the 
options available to you (Figure 5.3):

Figure 5.3 – The full list of blending mode options under the Lighten category
You will notice in Figure 5.3 that I have my mouse hovered over the Soft Light 
(Photoshop) option near the bottom of the list. 

6.	 To add this to your Favorites list, click on the Soft Light (Photoshop) checkbox as 
seen in Figure 5.4:

Figure 5.4 – The Soft Light (Photoshop) blending mode checked, adding it to the Favorites category
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There's one more option I'd like to add to my Favorites category, one that will make 
it easier to retain some darker, sharp details from some high-resolution stock photos 
to use in our landscape painting. 

7.	 Navigate to the Darken category on the Blending Mode menu.
8.	 Click the checkbox next to Darker Color to add it to Favorites (Figure 5.5):

Figure 5.5 – Selecting the Darker Color blending mode and adding it to the Favorites category

9.	 Now that I've selected all of the blending modes I'd like in my Favorites menu, I can 
go ahead and collapse the other categories by clicking on the drop-down arrow for 
each category I'd like to minimize. 

This leaves me with a nice, clean list of options, only showcasing my Favorites 
category (Figure 5.6):

Figure 5.6 – My updated Favorites category on my layer blending mode menu
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Now that the Favorites list has been updated, we are ready to start playing around with 
some of these modes!

Setting up a value checker
What I'm about to show you is actually one of the first "blending mode tricks" I ever 
learned, and it is one that I literally use on every single digital painting I have ever made, 
to this day. Every single one. In Chapter 2, Reviewing Canvas Properties and Color,  
we covered a saying that I heavily support: Value does the work, color gets the credit. What 
if there was a way to always be able to check your values and evaluate the readability of 
your image, at a single click of a button?

The great news is, there is! Let's set that up now:

1.	 On your Layers panel, create a new layer above your Foreground layer group.
2.	 Name this layer Value Checker. It should live outside of any specific layer group, 

as this should always remain our top-most layer. Your layer stack should look like 
Figure 5.7 at this point:

Figure 5.7 – Our Layers panel with our newly added Value Checker layer above our layer groups

3.	 With the Value Checker layer active, select your Fill tool from your toolbox docker. 
A quick default hotkey for this is F on your keyboard.
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4.	 On Advanced Color Selector, choose black by either selecting it from the HSV color 
wheel directly or bringing the slider all the way to the left of the value slider.

5.	 Fill in your Value Checker layer with black by clicking on the canvas, with the Fill 
tool selected and black set as your active foreground color.

Your composition should now appear 100% black (as shown in Figure 5.8):

Figure 5.8 – The Value Checker (top) layer, filled with pure black, in Normal blending mode

6.	 On your blending mode drop-down selection menu, choose the Color blending 
mode while your Value Checker layer is still active.

7.	 You will notice that your landscape is visible once again, almost as if the Value 
Checker layer disappeared entirely! What's going on?

When you have a layer filled with complete black (or complete white) set up with a 
Color blending mode on top of your composition, you are essentially telling Krita 
to remove all color saturation for every layer underneath your black or white color 
blended layer (in this case, our Value Checker layer). Pure black and pure white 
don't have any native hue information when it comes to additive color theory, 
meaning there's an "absence" of hue information. This Value Checker layer is going 
to allow us to check our relationship of lights and darks (in grayscale), essentially 
removing hue and saturation from the equation, by enabling and disabling it in our 
Layers panel.
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8.	 Go ahead and lock your Value Checker layer by clicking the lock icon to the right of 
the layer name in your Layers panel (as shown in Figure 5.9):

Figure 5.9 – The Value Checker layer, with Color blending mode active, and locked
Locking your Value Checker layer will ensure that you don't accidentally paint  
or make any changes to the layer. Think of this as your "black and white filter" for 
your painting!

Why Wouldn't I Use a Built-In Krita Filter for This?
You may see this method and wonder why I don't simply use a built-in filter 
from the Filter tab inside of Krita, such as Color Balance, Desaturate, HSV 
Adjustment, Gradient Map, or something similar. Often, built-in filters for 
digital art software may enact additional math or algorithmic calculations 
that may impact the actual value of the color you're looking at on the canvas. 
Most commonly from my experiences, I've noticed yellows may become 
more midtone in nature (rather than keeping their inherent brightness by 
being the lightest slice on the color wheel), while reds may appear darker as 
well (unnaturally close to matching the values of blues, for instance). Greens 
can actually become lighter, while darker saturated colors (such as blues and 
purples) can show a false positive as being black after being "crunched" by 
algorithmic filter passes. 

This can muddy up your values in ways that may not be immediately apparent 
and impact your decision-making regarding color choices and value balancing. 
By using the Fill a new layer with black then activate the Color blending mode 
way of doing things, you are getting a very close approximation to the value 
of the colors you have selected for your painting, as you're not changing the 
inherent brightness or darkness of the content within your canvas. There is also 
another great perk when using this method: It can be used in the vast majority 
of digital painting software, not just Krita! This allows workflow continuity, no 
matter what program you're creating art in!
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Now that we've created our layer to view our values at any time, we can start the process 
of bringing in some stock photo assets to integrate into our painting using our blending 
modes and value checks. In order to do that, we have to find some good stock assets to 
work with first!

Evaluating reference material
Please allow me a small aside while we start this portion of the chapter, as I want to "shake 
the cobwebs out" of some pre-conceived notions of reference and its relationship to art.  
I feel this is important to preface, as this will hopefully clarify the "why" of using reference 
before we get into the "how."

Destigmatizing reference in art
Reference in art can sometimes be stigmatized. Some artists feel that using reference is 
"cheating," that if we want to consider ourselves as artists, we should naturally know the 
visual and molecular properties of every item on Earth (and beyond), at every angle, 
under every lighting condition ever made, all the time, forever, purely from our mind's 
eye. That, if it isn't "from imagination," it's not worthwhile art, or the artist who created 
something based upon information from a reference (whether in person or a photograph) 
is "a hack." Using reference is cheating, and, therefore. a reference user is a dirty art cheater 
who cheats.

Tell that to the likes of Johannes Vermeer, Norman Rockwell, and Leonardo Da Vinci. Not 
only did they famously use references in their work but, for the likes of Vermeer and Da 
Vinci, using the camera obscura technique also makes it very likely that these artists may 
have even outright traced their subjects onto the canvas! Clutch the pearls, the horror!

As you can tell, I'm being facetious, and I have a bone to pick with people (whether they 
are artists or not) who may think that using references makes an artist "less than," or not a 
"real artist." I only have one real question to those who knock the use of a reference for art:

How do you know what something looks like if you don't look at it to know what it looks like? 

Artists enjoy interpreting their reality and showcasing it to the world, no matter the art 
form. Music, dance, poetry, writing, and painting are all based on lived experiences in the 
artist's life. Some could even say that the entire premise of an artist sharing their vision is 
based upon referencing their lived experiences. A reference doesn't just mean a visual aid; 
it can be a smell, a memory, or even a feeling you want to invoke in your work. 
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Referencing Yourself
I will always consider the best reference material to be that in which you have  
a lived experience, memory, or knowledge. Your life story is different than 
every other human being that has ever lived, and that is your truth. Nobody 
can take that away, and nobody can invalidate it as not being important or not 
worth influencing your art as a reference. 

In fact, since you are one-of-a-kind, your interpretation of the world around 
you is a true original as well, and you should fully embrace it. This may seem 
like a heart-warming aside from your uplifting Art Coach Guardian Angel, but 
there is business practicality here as well. Your vision cannot be duplicated as 
the art you create can only be made by you, making the value of your artistic 
voice to clients or art buyers significant. It's your selling point. Don't ever sell  
it short.

You can't paint what you don't know to some extent, and experiencing something helps 
you get closer to knowing it. Life drawing, en plein air painting, and using photographic 
reference are all ways that you can bring your vision to life more clearly, noticing details 
that your brain would have no way to remember otherwise. 

To wrap up this aside, just know that using references (whether in person or through 
photographs) is completely valid, and if you are not breaking any intellectual property  
or copyright laws, you can feel comfortable using as many as you would like throughout 
your artistic journey!

This brings up the topic of legality, and it is something very important to consider when 
finding reference images.

Using stock assets and references – legality
Before we start looking up reference images to use as a backbone for our landscape 
painting, it is important to discuss the legality of copyright law and intellectual property. 
Here is a quick disclaimer:

I am not an attorney, and I am not an expert in law. If you are unsure about the legality 
of using a reference for your work, contact the original artist or creator of the item you 
would like to reference to discuss use case scenarios. Many stock photo and reference 
photography packs you can purchase online have disclaimers and license agreements, 
making it very clear what you can or cannot do with their assets. This kind of goes without 
saying, but let's say it anyway: Do not break the law. Do not steal other creators' things. 
Do not steal others' work and claim it as your own. Do not infringe on another creator's 
intellectual property or copyright by using their work without crediting, obtaining 
permission, or breaking any other agreement handled within their specified license 
agreement contract.
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If you are unsure about whether you can use an asset as a reference, or the legality thereof, 
do not use the reference asset in question. 

When in doubt, create your own reference! If you took a photo of a landscape or family 
pet and would like to use that to create a direct one-to-one painting study, go for it! Is the 
picture something that was taken by another person? Ask permission or purchase  
a license to use the item in a new capacity from the original creator. 

The only reference photographs I feel comfortable using for my work (both personal and 
professional) are photographs that meet the following criteria:

•	 Come bundled in a freelance-licensed reference asset pack that allows recreation  
or adaption clauses.

•	 Use true royalty-free, attribution-free, or truly open-license platforms.

•	 I have paid for and received from the photographer themselves, alongside  
a signed clause allowing a use case to reference that piece for a personal  
or commercial painting.

This covers essentially every base and ensures that I am working within the law and 
not committing any form of theft. Let's use this knowledge to find some safe, impactful 
resources that you can use for studies and photobashing, for example.

Discovering resources online
For this book, I will be using three primary websites to find my reference images and stock 
image assets. These three websites are Unsplash.com, Pexels.com, and Pixabay.
com.

While there is some overlap in the material between these three websites, the breadth of 
genres and topics the photographs cover is seemingly limitless. Anything and everything 
from cityscapes to travel photography, landscapes, portraits, and slice-of-life are present 
and accounted for.

While there are other websites that host great reference material as well, these three  
seem to be the ones I always come back to, and their license agreements are fantastic for 
artists. Here are a few key license features that all three of the websites mentioned have  
in common:

•	 You can freely download an unlimited amount of images.

•	 You can use images for both commercial and non-commercial use.

•	 No permission is needed (although they always appreciate attribution for the photo 
when possible!).

https://Unsplash.com
https://Pexels.com
https://Pixabay.com
https://Pixabay.com
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Keep in mind though, that you can't legally sell the photographs as they are without 
significant modification, or use the resources to make a competing service. Other than 
that, it seems to be free rein! For instance, here's the full claim via Unsplash.com's License 
page (https://unsplash.com/license):

Figure 5.10 – Full Longform license agreement via Unsplash.com (circa 2021)

Now that we have established that using reference is always worthwhile, and a few great 
places to start our search for the good stuff, let's find a few mountain photographs that  
we can use for bashing some texture into our landscape painting!

Bashing – What Is It?
The term bashing (or "photobashing") comes from the idea of taking multiple 
assets (originally starting with photographs, but now can include things such as 
3D assets), combining them together as a singular composite piece, and tying 
them together by painting. This "bashes" our sources together to make  
a central, cohesive work of art. You may also hear of "kitbashing," which is 
taking a collection of standalone 3D assets (a toolkit, or "kit") and combining 
them to make one cohesive, original piece.

Finding the right reference
With hundreds of thousands of solid resource images available to you, what should you be 
looking for when finding a reference for your work? As a quick cheat sheet, I always look 
for the following:

•	 A reference that matches, or is similar to the perspective of your work thus far

•	 Clean lighting (good contrast between lights and darks)

https://unsplash.com/license
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•	 Limited use of post-processing (such as heavy filters and color adjustments,  
for example)

Before we integrate a few photographs into our piece, we must keep in mind that the 
photograph's fidelity (the clarity of edges and visual information) will be far greater than 
the loose brush strokes we currently have. The goal is to find a reference that will "fit in" as 
best as possible, and give you the most visual information possible, while not overtaking 
your piece (making it look too photographic). 

Let's finally start integrating some photographs into our current landscape painting!

Choosing our reference
I'll be heading to Unsplash.com to look for some mountain stock assets:

1.	 Go to www.unsplash.com in your favorite internet browser.
2.	 In the Search field, search for Mountain.

Scroll until you find a few mountains that appeal to you. I'm looking for something 
with sharp edges, high contrast (a large difference between the lights and darks), 
and something that reads very quickly as what your mind's eye would consider  
a mountain.

I really like the look of "mountain ranges covered in snow" by Jerry Zhang 
(Unsplash listing shown in Figure 5.11 and you can also see the original listing at 
https://unsplash.com/photos/ePpaQC2c1xA):

Figure 5.11 – Mountain ranges covered in snow by Jerry Zhang, courtesy of Unsplash.com

http://Unsplash.com
http://www.unsplash.com
https://unsplash.com/photos/ePpaQC2c1xA
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3.	 Go ahead and click Free Download (you may have to make a free Unsplash account 
if you don't automatically see the Free Download button).

4.	 I continue to scroll the results on Unsplash, and like the look of "grey rocky 
mountain under blue sky" by Andrea Ledda (listing shown in Figure 5.12 
and you can also see the original listing at https://unsplash.com/
photos/4EwI7yI5Q_8):

Figure 5.12 – Gray rocky mountain under blue sky by Andrea Ledda, courtesy of Unsplash.com
It has a distinct mountain that will be great for texture, but also some fantastic 
planes of rocky nature underneath that we can maybe use to frame our mountain 
range more effectively.

5.	 Make sure you've downloaded your images to a place that is easy to find on your 
hard drive.

https://unsplash.com/photos/4EwI7yI5Q_8
https://unsplash.com/photos/4EwI7yI5Q_8
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6.	 Inside of Krita, make sure your landscape painting is still open and active. 
7.	 Within Krita, click on your File menu and select the Open… option (Ctrl + O 

shortcut), as shown in Figure 5.13:

Figure 5.13 – The Open… option in Krita's File menu

8.	 Within the Open Images prompt, browse to the folder where your references are 
saved. Either drag a box around both images or open them one at a time (Figure 
5.14) to bring them into Krita:

Figure 5.14 – Selecting our reference images to open in Krita

Our reference images are now loaded within Krita, and we're prepared to start the process 
of implementing them into our painting!
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Bashing our reference
Now that our landscape painting and our reference images are all open within Krita, it's 
finally time to start the bashing process! To make our life easier (and also easier for any 
other artists we might collaborate with), let's go ahead and keep our bashed images within 
their own layer group:

1.	 Make sure your Foreground layer group is active.
2.	 Click on the arrow icon on the lower left of the Layers panel and select the 

Group Layer.
3.	 This should create a layer group named Group 4 in between our Value Checker 

layer and our Foreground layer group (Figure 5.15):

Figure 5.15 – Group 4 created between our Value Checker layer and Foreground layer group

4.	 Go ahead and double-click the Group 4 layer group and rename it Photo 
References.

5.	 I want to first put in the photograph we found by Jerry Zhang, so I'll click on the 
file's tab to make sure that the file is active in my workspace. 

6.	 With our Photo References tab active, I will click Select from the File menu, and 
Select All to select the entire canvas of the image.
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7.	 With the full photo selected, go to Edit on your File menu, then Copy Merged (the 
shortcut is Ctrl + Shift + C). This makes a copy of all layers (even though, in this 
case, our reference only has one layer).

8.	 Now that the reference image is copied to your computer's memory, make your 
landscape painting the active tab in your Workspace, and click Edit > Paste.  
This will paste a full-resolution copy of the mountain photograph into a new layer 
above your active layer (in my case, my active layer was my new Photo References 
layer group).

9.	 Drag your new layer (the one with the mountain image pasted into it) into your 
Photo References layer group. 

10.	 Your Layers panel should now look like Figure 5.16:

Figure 5.16 – Our first reference photo pasted into our landscape, in the Photo References group
You'll notice two things at this point: first, your pasted photo needs to be resized! 
Second, you're seeing everything in black and white! 

In regard to the second point, this is because our Value Checker layer is active, 
causing everything underneath it to only appear in grayscale. At any point, you can 
hide the Value Checker layer to see the colors of your piece.

Let's go ahead and fix the sizing issue, however.
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11.	 With your photo layer active (in the case of Figure 5.16, mine is named Paint 
Layer 4 (pasted)), click on your toolbox and choose the Transform a Layer 
or Selection tool (default shortcut Ctrl + T). This will give you anchors to manually 
resize and fit your image inside of your canvas for your selected layer. The tool's icon 
is notated in Figure 5.17:

Figure 5.17 – The Transform a layer or a selection tool via the Toolbox docker window
Resize this layer until the mountain from the image is roughly the same size as the 
mountain in our landscape painting (Figure 5.18):

Figure 5.18 – Our first reference image, resized with the Transform  
a layer or a selection tool to fit our composition
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You'll now notice that, while the image itself is looking okay, our mountain is 
"backward," or facing the wrong direction! Let's correct that now.

12.	 With your reference image still selected, on your File menu, go to Layer > 
Transform > Mirror Layer Horizontally. This will flip our mountain to face the 
correct way, although the mountain may not be lined up correctly any longer.

If your mountain needs to be moved, you can select the Move tool (default hotkey is 
T) in your toolbox and drag the mountain into place (Figure 5.19):

Figure 5.19 – Our mountain reference, mirrored horizontally and moved into place with the Move tool 
This is all well and good, but now the photo reference has taken over our 
composition! How can we successfully "bash" this image into our current 
composition while maintaining the shapes and values we worked so hard to create? 
Layer blending modes, of course!

13.	 With your Photo References layer selected, change the blending mode drop-down 
option to Screen. 

A quick note
Please note, as of the Krita 5.0 beta, I actually have to do this blending mode 
change to the entire Photo References layer group, not just the photo reference 
layer itself to get the intended results.
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This will give a nice blend of lights and darks, allowing us to still retain our 
mountain painting's overall basic shape but providing us with nice, sharp details 
from the photo reference itself (Figure 5.20):

Figure 5.20 – Our reference photo with the Screen blending mode active
Now that we have our first reference image in place, it's time to bring in our second 
reference image!

14.	 In your Workspace area, select the tab for your second photo reference image (in 
my case, the photo by Andrea Ledda we downloaded earlier).

15.	 Select and copy the image by using Select > Select All followed by the Edit > Copy 
Merged method discussed earlier in Steps 5 and 6.
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Go back to our landscape painting, and with our first photo reference layer active, 
paste our newly copied photo reference. This should create a new layer on top 
of our first photo reference layer, set within our Photo References layer group 
automatically (Figure 5.21):

Figure 5.21 – Both of our photo reference layers (renamed), within our Photo References group

16.	 As you can see from Figure 5.21, since we have two photograph layers now, I've 
renamed them First Photograph and Second Photograph, respectively. 
Feel free to name these whatever works best for you!

17.	 With the Second Photograph layer active, go ahead and resize the image as  
you would like it on your canvas (using the Transform tool method talked about in 
Step 11).

You should now have a solid composite (or "bash") that you're happy with! Don't 
worry if things appear really messy right now; we will be modifying and fine-tuning 
features of this messy photo bash in Chapter 6, Composing Using Krita's Toolbox. 

In Chapter 7, Changing the Feel with Painting, Values, and Sliders, we will be applying  
a lot of hands-on painting using our new composite! Before we move on to the end of this 
chapter, though, let's add a nice splash of color to our bash.
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Splashing in color
Earlier in this chapter, we created our Value Checker layer. While this is extremely helpful 
when creating our painting to ensure that our lights and darks read well, there's also 
another hidden benefit to this method: color splashing.

With this technique, you can create a myriad of different color passes for your art, 
extremely quickly. This is by using a new layer on top of our Value Checker layer, using 
the Color blending mode. Let's set that up now, and add some nice blues to our painting 
to set us up for upcoming chapters:

1.	 Create a new layer on top of your Value Checker layer, and name this layer Color 
Splash #1.

2.	 Change the blending mode option for the Color Splash #1 layer to Color.

Your Layers panel should look similar to Figure 5.22:

Figure 5.22 – The Color Splash #1 layer, in Color blending mode, on top of the Layer panel stack

3.	 With the Color Splash #1 layer active, pick a brush and choose a blue color from 
the color wheel.
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4.	 Paint the sky and underneath the mountains blue. The contrast between the blue of 
your Color Splash #1 layer and the greyscale of your Value Checker layer should 
give an appealing start to your colors (Figure 5.23):

Figure 5.23 – Our bashed, color-splashed landscape painting thus far
Feel free to add additional colors to your Color Splash #1 layer, such as some 
subtle browns for the rocks, and maybe even some cyans to the base of where 
the mountains meet the ground. We will be doing extensive color tweaking and 
refinement in Chapter 7, Changing the Feel with Painting, Values, and Sliders, so 
don't get too caught up in making things perfect right now.

5.	 Finally, save your work!

The power of this color splashing method should be readily apparent. You can create 
vivid, strong color decisions in a way that is non-destructive to the work you've done 
underneath it. This is one of the key benefits of digital art, and the Krita workflow makes 
things like this a breeze!
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Summary
That brings us to the end of this chapter, and while we covered a lot of ground, I'm hoping 
that some of these techniques started getting your creativity flowing! 

In this chapter, we successfully learned about blending modes and showcased the 
flexibility they can allow in merging different assets together in a cohesive way. We also 
discussed references, from the stigma they sometimes carry and the legalities of using 
them, to learning some valuable tips on implementing the stock resources you find within 
your work. We covered creating a foolproof value checker, as well as implementing colors 
without destroying our value work!

All of this was in service of updating our ongoing landscape painting project with some 
nice texture work and a very quick color pass. In Chapter 6, Composing Using Krita's 
Toolbox, we're going to be learning about some fantastic composition techniques and 
utilizing Krita's toolbox and masking tools, which will allow our photo references, colors, 
and brush strokes to start singing in harmony. 

This will definitely be pushing our painting to the next level, and will set us up for our goal 
of having a final, portfolio-ready landscape painting we can be proud of!

Fantastic job so far! Let's hop into the next chapter!



6
Composing Using 

Krita's Toolbox
In Chapter 5, Implementing Layer Blending Modes, we took our ongoing landscape 
painting and integrated some photography and color splashes to further our concept  
and start the process of refining our piece. In this chapter, we will be using some of  
Krita's awesome built-in tools to refine our shapes with masks and selections, start 
finalizing our perspective, and add some impactful brushwork before moving on to the 
push for final rendering!

The full structure of this chapter will look like this:

•	 Masking our layers

•	 Adding edges with selection tools

•	 Navigating perspective

•	 Refining our brushwork

Taking each of these topics one step at a time will allow us to dig into Krita's extensive 
toolsets, while also working together to refine our piece, preparing it for our final 
"postprocessing" passes in the next chapter!
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Technical requirements
To follow along with this chapter, you will need the following:

•	 Krita (version 5.0+)

•	 A way to interact with Krita, such as a keyboard and either a mouse, tablet,  
or touch device with a stylus

•	 Your landscape file (carried over from Chapter 5, Implementing Layer  
Blending Modes)

If you did not follow along in Chapter 5, Implementing Layer Blending Modes, a full 
version of my Krita file (.kra) as of the end of the chapter is available for you here: 
https://static.packt-cdn.com/downloads/Krita_Sample_Files.zip.

This chapter's going to be a fun one, covering a lot of ground in a pretty tidy page count! 
Let's get started with looking at a true power-player of Krita: masks!

Masking our layers
A favorite aspect of working in digital art software such as Krita is the ability to work  
in a non-destructive environment, meaning that you can manipulate visual data on  
a layer without removing or destroying the actual layer data in the process. A perfect 
representation of this environment is the use of Masks—a linked add-on connected to  
a layer that gives the layer information on how it should be presented. There are four main 
mask types in Krita 5.0, as shown in the following screenshot: 

Figure 6.1 – The four main mask-type options (box highlighted) from the Add Layer menu

https://static.packt-cdn.com/downloads/Krita_Sample_Files.zip
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Masks are powerful features that have a lot of dynamic power and can be somewhat 
complex. We will now discuss a quick breakdown of each one of these.

Transparency Mask
Transparency Mask is a way for you to control which portion of a layer is visible, or not 
visible, to the viewer. This mask uses a "visible" and "non-visible" black-and-white color 
technique, using pure black to "hide" an area of your connected layer, and pure white to 
"show" an area of your connected layer. You apply the black or white with the paintbrush 
tool on the Transparency Mask itself, which is locked to be grayscale. Essentially, on this 
mask, you paint with your brush in grayscale and, depending on the value and location, 
you can hide or show information on the connected layer. We will be using this mask 
to "hide," "show," and "blend" parts of our mountain texture directly into our painting 
momentarily.

Filter Mask
Filter Mask works similarly to Transparency Mask but shows an area of the connected 
layer using a Krita filter you choose (such as Color Correction, Level Adjustments, Blur, 
and more). This also works with the black-to-white grayscale method, where any portion 
of the mask that is black will be "hidden" while any white area will  
be "visible" as the selected filter on your connected layer. A good example of this mask 
would be to add grainy noise, blurs, or light bloom filters to a specific area of your 
connected layer.

Colorize Mask
Colorize Mask was made for the primary purpose of coloring line art quickly and 
effectively by filling in portions of the connected layer with a specified color that 
you choose. This mask works a bit differently than the others, as it has its own set of 
sub-settings used for things such as closing gaps of line art, detecting edges of your lines, 
and more. For example, if you have an image of a person, you can put small Colorize 
Mask strokes of a skin tone on the face and arms area, a different color swatch on the 
hair, a third color on their clothes, and the algorithm (if Detect Edges and Gap Close are 
enabled) will automatically color in the area using your selected color. Think of this mask 
as a "fill bucket" of sorts, but one that provides you with more control over the rules it uses 
to colorize the layer it is connected to. 
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Transform Mask
Transform Mask allows you to make transform edits (such as rotating, scaling, and 
moving) to your layer without applying the transformation directly to the layer the 
mask is connected to. This is a great "non-destructive" way to make any scale or rotation 
changes to your layer quickly. A great example of this would be if you are working with  
a client or art director and, if they ask for items to be moved or resized, applying this 
layer and making the edit they request. That way, if the client/director enjoys the changes, 
you can retain them via keeping Transform Mask, but if they prefer the original, you 
can delete Transform Mask and keep the original material intact, as the changes only 
impacted the mask itself, not the original material.

Experimenting with Masks
Masks are very powerful tools, but to be completely honest, reading about them 
isn't the best way to learn about them. I highly recommend playing with these 
masks often, as they can really open creative possibilities that are otherwise not 
easily replicable with traditional art. We are working as digital artists, after all, 
so let's embrace the things that make our lives easier!

The best way to get a great understanding of masks is to implement them into our current 
piece, so let's go ahead and start using Transparency Mask right now!

Blending our photo information
As you can see in the following screenshot, we currently have our landscape with  
our newly added photographs with a bit of color overlaid on top:

Figure 6.2 – Our landscape as of the end of Chapter 5, Implementing Layer Blending Modes
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While the textures themselves seem okay, there are a lot of weird issues we need to work 
on and refine. Mainly, there's a straight vertical line near the middle of the composition 
where the two photos are overlapping, as well as some portions of the mountains that 
don't quite fit the shape we had painted before.

Our goal for this step of the process is to "smooth out" these transitions, allowing us to 
control the balance of higher-fidelity information and texture (the photograph) within the 
more artistic, representative shapes (our paint strokes).

Let's add some transparency masks to our photography layers, making this task a breeze. 
Proceed as follows:

1.	 Make sure your landscape image is active within Krita (either from your personal 
file or the file attached in the Technical requirements section at the beginning of  
this chapter).

2.	 With your Second Photograph layer selected (from within your Photo References 
layer group), click the plus (+) button on the lower left of the Layers panel and 
select Transparency Mask, as illustrated in the following screenshot:

Figure 6.3 – Adding a Transparency Mask to our Second Photograph layer
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On your Layers panel, you will now see a Transparency Mask layer attached to the 
Second Photograph layer, nested underneath it. The following screenshot provides 
an illustration of this: 

Figure 6.4 – The new Transparency Mask layer, nested underneath the Second Photograph layer
You will also notice that with the addition of this new Transparency Mask layer, 
while the mask layer is active, your color wheel will turn to grayscale. This ensures 
that you only work within the confines of black and white, allowing total control 
over the visibility of the contents being masked.

3.	 With Transparency Mask active, select a brush. I will be using my b) Basic-2 
Opacity brush.

4.	 Choose pure (100%) black from your color wheel or value slider.
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5.	 With pure black as your active color, begin painting portions of your composition 
you would like to "hide." I will be painting out the vertical line that is causing the 
weird visuals, as well as the mountain peaks behind the horizon on the right-hand 
side of the piece, as illustrated in the following screenshot: 

Figure 6.5 – The masked Second Photograph layer, using the Transparency Mask with black
So, on this one, I've gone a little overboard, and I want to bring some of the 
foreground "plane" back into the piece as it can be an asset in showing depth once 
we start painting on top of it.

6.	 To bring back a portion of the mask, change the color on your brush to pure (100%) 
white (or a lighter gray). 

7.	 Paint over the portions you would like to add back in with a lighter color.
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I've chosen to bring in the foreground plane on the right side, as well as to bring 
back a bit of the background mountain detail with a gray brush to control the 
opacity. You can see the result in the following screenshot: 

Figure 6.6 – The adjusted mask with details added back in, using  
a brush with white on the Transparency Mask

This should showcase the power of Transparency Mask well! You have your 
original photography data always available and can use your painting skills to "hide" 
and "reveal" as little or as much as you would like! Let's take a pass at the First 
Photograph layer using Transparency Mask as well.

8.	 Select the First Photograph layer in your Layers panel.
9.	 With the First Photograph layer active, click the plus (+) button on the lower left of 

your Layers panel window and select Transparency Mask.
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Your Layers panel should resemble the one shown here: 

Figure 6.7 – The newly added Transparency Mask, connected to the First Photograph layer

10.	 On this Transparency Mask layer, go ahead and paint black what you would like 
to hide, keep white what you would like to show, and adjust the opacity of other 
portions using various shades of gray. 

This should not only get you more comfortable with the usage of the mask layer  
in general but also enable you to see exactly how masking portions of a layer, 
coupled with the masked portions of another layer, can lead to some really 
interesting dynamics.
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11.	 On the Transparency Mask attached to the First Photograph layer, I've decided 
to use a black brush and "vignette" the textures inside of the main mountain shape 
on the left-hand side of the piece. This means I start with the most outskirt textures 
(closest to the edges of the mountain) as hidden, and slowly "reveal" them as we get 
closer to the middle of the form. Here's the result: 

Figure 6.8 – Masking the First Photograph layer, vignetting the details near  
the middle of our composition

Doing this is a great setup for doing a paint-over, as it allows us a nice mix of sharp, 
photographic textures at our focal point and fewer crisp edges and details (due to our 
brushwork) near the edges of our shapes.

At this point, I think we have what we need from our photographs, and we can start 
incorporating some more shape language and more defined edges with some selection 
tools work!

Adding edges with selection tools
Usually, when someone makes a comment about a digital image looking "painterly," 
what they're referring to is the control of edges. Any dynamic painting is going to have 
a nice mix of edges, and when we do our still-life study later, in Chapter 10, Enforcing 
Fundamentals, we will do a breakdown of when and where to use which types of edges for 
maximum impact for your viewer.
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In this section of the current chapter, we're going to discuss and use some selection tools 
to create more solidified shapes and give us the ability to work within the confines  
we create in order to make dynamic, interesting mountains. 

Defining the tools
Let's do a quick breakdown of our selection tools to get a good grasp on which types of 
problems we can solve.

Have a look at the following screenshot: 

Figure 6.9 – Our selection tools via the Toolbox

From left to right in Figure 6.9, we have the following tools:

•	 Rectangular selection tool—Allows you to drag a box of varying heights and 
widths around an area of a layer, selecting what is within the box's confines.

•	 Elliptical selection tool—The same functionality as the rectangular selection tool; 
however, with no hard 90-degree edges. It can expand and contract, making for  
a variety of circular shapes for your selection.

•	 Polygonal selection tool—The polygonal selection tool allows you to click "points" 
around your layer. When the selection becomes active once, either the original 
point is re-selected or the artist double-clicks, causing the final point to immediately 
connect to the original point and create a selection. This is a fantastic tool for very 
precise outlines, or creating sharp, angled shapes.

•	 Freehand selection tool—A free-form selection tool is sometimes referred to as  
a lasso tool. The freehand selection tool lets you control the "tip" of the selection, 
drawing freely while your input device has contact within the layer. As you lift off 
of the layer, the selection will "lasso" around to the origin point, allowing for a huge 
variety of shapes you can create.

•	 Contiguous selection tool—The contiguous selection tool (also known as the 
magic wand tool, for its likeness to a magician's wand) selects a point of color and 
all areas of similar color that are directly connected to that point. You can adjust the 
range that the tool will consider "contiguous" with the selection you choose, giving 
you a flexible way of selecting spots of matching hues or values quickly on a layer.
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•	 Similar color selection tool—The similar color selection tool works much like the 
contiguous selection tool in regard to it choosing a color. However, this tool will 
choose a similar color across the entire piece, even if the color isn't connected  
or contiguous to the original point selected.

•	 Bezier curve selection tool—This is also known as the path selection tool, and 
allows you to draw a path around an area, with the ability to either have sharp 
transitions between points or click and drag when creating a point to curve the 
path from your previous point to the new point. Once you are finished, click on the 
original point to close the path and create your selection.

•	 Magnetic selection tool—With the magnetic selection tool, you can either place 
points or draw a continuous outline of an area, and the tool will "snap" to any areas 
of sharp contrast (such as outlines). This may sound cumbersome, but in practice, 
the algorithm for this tool is very intelligent in finding edges. This is a fantastic tool 
for selecting specific areas of a piece, such as flower petals, clothing on a character, 
or other standalone details that you would like to refine.

Now that we have a basic rundown of the selection tools that are available to us, let's go 
ahead and use this knowledge to create some edges for our landscape's mountain range!

Creating edges
For our piece, I'll want to retain some sharp edges at the top of our main focal point 
mountain, and maybe introduce some nice frozen "ice" on top of our lake. Let's get 
started, as follows:

1.	 Firstly, I would like to disable my Color Splash layer by hiding it (clicking on the eye 
icon to the left of the layer's name on your Layers panel), as working in grayscale 
(from our Value Checker layer) will be a more coherent way to make these 
adjustments. We'll add color back in later.

2.	 With our Color Splash layer hidden, go ahead and create a new layer below  
your Value Checker layer named Selection Shapes, as illustrated in the  
following screenshot:
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Figure 6.10 – The new Selection Shapes layer, between our  
Value Checker layer and Photo References group

3.	 With your Selection Shapes layer active, select the Polygonal Selection Tool  
(the third selection tool from the left in your Toolbox).

4.	 Create points for your mountain by clicking an outline of where you would like  
your peaks, valleys, and a variety of shape angles. This is what mine looks like: 

Figure 6.11 – My selection via the Polygonal Selection Tool for my main focal-point mountain
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5.	 With your selection active (you can tell this by the "marching ants" outline of  
the shape that you created), you can safely choose your brush of choice by hitting  
the B hotkey, which keeps this selection active.

6.	 Use the Ctrl hotkey (as holding down Ctrl while on your canvas will change your 
pointer to your Color Picker tool) to select colors that are close to where you're 
painting, and "expand" those colors to the edge of the selection. You'll notice that 
the colors don't go outside of the selection!

This is a fantastic way to get razor-sharp edges in your work and is something I find 
myself doing in every single digital painting I make! 

7.	 Once you're pleased with your shapes, you can deselect your active selection by 
either clicking on Select > Deselect in your File menu at the top of the screen  
or by using the default hotkey combination of Ctrl + Shift + A.

Have a look at my current mountain setup here: 

Figure 6.12 – Our brush strokes extend the values to the edge of our current polygonal selection
While the new sharp edges may look a little odd now, they will make way more 
sense once we add some painterly brush strokes to them momentarily.



Adding edges with selection tools     179

Now that we have some more interesting shapes on our mountain, let's go ahead 
and create some "lake ice." For this, we are going to use the same Polygonal 
Selection Tool and do a quick "zig-zag" pass on the middle and lower-right  
sections of our composition.

8.	 With your Selection Shapes layer active, select your Polygonal Selection Tool from 
your Toolbox.

9.	 Make your first long, sharp horizontal shape on your lake, like so: 

Figure 6.13 – Our first polygonal selection for our ice (circled for clarity)
A great feature of the Polygonal Selection Tool is the ability to add portions to  
your current selection, even if they're not connected to the first selection!  
Let's try that now.

10.	 With your Polygonal Selection Tool still active, hold down the Shift button while 
hovering over your canvas. You will notice a small plus sign (+) on top of the tool, 
meaning you can add a selection. (Pro tip: If you'd like to remove an area from  
a selection, hold Alt instead of Shift.)
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11.	 While holding Shift, create some smaller selections going back toward our main 
mountain on the left. These will assist in adding depth and the impression  
of multiple instances of "ice," as can be seen in the following screenshot: 

Figure 6.14 – The additional selections for our ice, created  
by holding Shift with our Polygonal Lasso tool

With your selections active, go ahead and swap to your Brush tool (using the  
B hotkey). Choose white as your color, and color in your selection shapes.  
Your piece should look like this: 

Figure 6.15 – The white ice slabs, via our painting of our Polygonal Selection Tool selections
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This still probably doesn't feel like it looks correct or beautiful yet, but trust me when  
I say that making these graphic shapes will help tremendously once we start getting into 
the nitty-gritty of our final painting passes.

Something tells me that what we have right now looks a little "flat" on the page, and  
we need some additional depth for our landscape. This is a perfect opportunity to discuss 
a few of the perspective tools Krita has that can assist you in navigating perspective—a 
topic that can be a bit overwhelming! 

Navigating perspective
In this portion of the chapter, we are very quickly going to take a look at the perspective 
tools that Krita provides. We will be doing a much, much deeper dive into these tools, and 
perspective in general, in Chapter 11, Working with Concept Art (where we make some 
cinematic concept art!). 

For the time being, we are going to create a one-point perspective grid to assist us in 
making more detailed placements of our ice. Follow these next steps:

1.	 On your Toolbox, click on the Assistant Tool. The icon for this tool is circled here:

Figure 6.16 – The Assistant Tool (located next to the Measure Tool) in the Toolbox

2.	 While your Assistant Tool is active, open your Tool Options docker if it's not 
already open.
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3.	 In the Add drop-down menu of Tool Options, select Perspective, as illustrated in 
the following screenshot:

Figure 6.17 – The Perspective option is selected under the Add drop-down menu in  
Tool Options for our Assistant Tool

The Perspective option for your Assistant Tool allows you to create four corners 
of a perspective grid, then drag and reposition the corners to match a specific 
perspective plane you need. Let's set up a grid for our lake to aid with our  
ice placement!

4.	 On your canvas, with your Assistant Tool still active and the Perspective  
option selected, click four times, creating a box around the bottom half of our 
composition. This will create a rectangle with anchor points, as illustrated in the 
following screenshot: 

Figure 6.18 – Our created perspective grid using the Assistant Tool in Perspective mode
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5.	 Now, we want to align our perspective grid to "match" our idea of the ice lake's 
perspective. To do this, drag the bottom corners and expand them widely out (by 
zooming out of your work area, you will have more room to adjust the width of 
these points)!

6.	 I have chosen to squeeze the two upper points closer together while expanding the 
width of the distance between the bottom two points, and "crunching" the height of 
the overall box to give a solid perspective that seems to read well when zoomed out. 
You can see the result here: 

Figure 6.19 – Our corrected perspective grid using the Assistant Tool
Now that we're happy with our perspective grid, let's transfer this information onto 
its own layer for future use!

7.	 Click over to your Layers panel, and create a new layer above your Selection Shapes 
layer, named Perspective Grid.

8.	 Go ahead and select your Brush tool (with the B hotkey), and go to the Tool 
Options window.
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9.	 Click on the checkbox for Snap to Assistants, as illustrated in the  
following screenshot:

Figure 6.20 – Enabling the Snap to Assistants feature in the Tool Options window of our Brush tool
This will ensure that our brush strokes are locked to our assistant (perspective) grid.

10.	 Return to your Layers panel, and make sure your Perspective Grid layer is active.
11.	 Brush some lines onto your layer. You'll notice that the magnetism of the Snap to 

Assistants feature is ensuring that your brush strokes are following the perspective 
grid! The intensity of the snapping can be adjusted by changing the value of the 
Magnetism slider.

Feel free to be as detailed or vague as you would like here, as this layer will only  
be for your reference throughout the piece's refinement and won't be part of the 
final piece. Have a look at my messy perspective lines in the following screenshot,  
for instance:

Figure 6.21 – Messy, dark brushed lines snapping to my perspective grid
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12.	 Once you feel comfortable with your grid's transfer, feel free to either hide the 
perspective grid (by clicking on the eyeball icon) or fully delete the current 
perspective grid (by clicking on the trashcan icon). If you would like to move 
your current perspective grid, you can use the arrow icon to move it around your 
composition. A full set of icons is shown here:

Figure 6.22 – The Assistant Tool's Move Tool, Hide/Show Tool, and Delete Tool (from left to right)

13.	 Return to your Perspective Grid layer and lower the opacity to something like 30% 
to 40%.

14.	 Go ahead and lock the layer to ensure you maintain the integrity of the layer and 
don't erase/paint over the information.

Your Perspective Grid layer should look similar to this in your Layers panel after 
these changes are made:

Figure 6.23 – Perspective Grid layer, locked, at 36% opacity in Normal blending mode
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I know this was essentially a crash course with the Assistant Tools, but as previously 
mentioned, we will be doing a deeper dive into perspective, rulers, and grids throughout 
the rest of the book when the need arises!

From here, let's wrap up this chapter by refining some of our colors on our Color Splash 
layer and adding a bit of painterly flair with some quick brushwork over the top  
of everything.

Refining our brushwork
Now that we have established some more refined shapes and given ourselves a good 
perspective grid to work with, we can really dig into splashing color in a more meaningful 
way. Once this is done, we can refine our edges with some additional brushwork and bring 
this chapter to a close!

Let's go ahead and set up some additional colors in our Color Splash layer, and merge  
a copy of what we have so far to allow for some rich, blended painting. Follow these steps:

1.	 On your Layers panel, select your Color Splash layer and ensure that it is visible  
(as we hid the layer in the first step of the Creating edges section of this chapter).

My main goal at this point is to add some subtle shifts of hues, bringing some 
interest into the middle portion of our leftmost mountain range. I plan on doing 
this by adding some brown and refining the shapes of the "mountain reflection"  
on the ice.

2.	 Grab a nice brown shade for your hue, and with your Color Splash layer  
selected, make some sweeping marks mimicking the directional textures of the 
photographic layers.

3.	 After you are satisfied with the brown hue splashes, go ahead and choose a dark 
gray and refine some of the hues of the mountain shapes we made earlier in the 
Creating edges section with our Polygonal Selection Tool.
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At this point, you may have something that looks like this: 

Figure 6.24 – More color splashing, blending in grays with browns and blues
We are now at a crossroads, and depending on the way you work, you can choose 
any of the following:

a. Continue splashing in specific colors to start setting the mood

b. Refine your values to start bringing more of a render to your piece

For me, I feel as if the color splashing isn't quite capturing the feel I'm wanting.  
This tells me it's probably a good idea to refine my values and take the piece to a bit 
more of a render. 

Now, once again, I can do this in several ways since we've set up our Krita file in an 
open-ended manner. I could choose from one of the following options:

a. �Working within pure grayscale (by disabling our Color Splash layer and creating 
a layer underneath our Value Checker layer to paint on)

b. �Integrating a few of the Color Splash decisions (such as the blue sky, browns,  
and grays) and moving forward on a new layer on top of everything.

I'm going to choose the second option here, as I think that even if what we have in 
Figure 6.24 doesn't look like much, it actually has a lot of information we can use to 
start our "real painting" layers. 
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Working to Your Strengths
Keep in mind that there's no right or wrong way to go about a painting process! 
I'm just comfortable enough with the tools to know that even with "ugly" 
painting of color on our Color Splash layer, I'm already mentally "filling in the 
blanks," knowing the next steps I want to take. If you're newer or less familiar 
with your Krita workflow, build confidence by sticking to what you know and 
your favorite parts of the process!

I'm going to want to create a new layer that contains the visual content we already 
have in our piece. This is because our thicker texture brushes are going to work 
more efficiently if we start painting on a layer that already has data on it, instead  
of creating a new empty layer. We will do this by making a "merged" layer.

4.	 On your File menu, go to Select | Select All. This will create a selection of your 
entire canvas.

5.	 Go to Edit | Copy Merged (Ctrl + Shift + C keyboard shortcut). This is going to 
give you a copy of the visuals as you currently see them on your canvas. It essentially 
takes a snapshot of your piece.

6.	 With your Color Splash layer active, go to Edit | Paste (Ctrl + V keyboard 
shortcut). This will create a new layer (in my case, named Paint Layer 4 (pasted)) 
on top of the Layers panel hierarchy.

7.	 Rename this new layer Painterly Pass 1 and ensure it is the topmost layer.

Your Layers panel should now look like this: 

Figure 6.25 – Our new Painterly Pass 1 layer, a merged visual of all of our work thus far
Now that we're set with an "underpainting" of sorts in our Painterly Pass 1 layer, 
let's go ahead and start painting on it with color!
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8.	 Grab a nice textured brush. For this, I'll grab my Thick Oil with Medium brush  
we created in Chapter 4, Utilizing Brushes and Tools.

9.	 With my brush selected and my Painterly Pass 1 layer active, I want to color-pick  
a darker gray from my leftmost mountain (using the Ctrl hotkey with my Brush  
tool selected).

I want to refine the mountains in the foreground to appear darker than they are 
now. I also want to occasionally select a nice brown hue to integrate into the rocks 
near the middle, as we did on our Color Splash layer.

10.	 Now, I have some newer textures here, as I've painted some darker, looser portions 
within our mountain. Here's the result: 

Figure 6.26 – Adding darker values and hues to our mountain with our custom brush
While the loose painterly strokes are fine for a basic block-in, let's select a sharper 
brush and start putting in actual detail of light, shadow, and form.

11.	 Select a thick, wet brush. For me, that will be the i) Wet Knife brush.
12.	 Select some of the darker hues and block in some areas on the left where our 

mountain won't get direct sunlight (as our light source is coming from the right side 
of the composition).

13.	 You can also select some midtones and create some sweeping motions in the middle 
of the mountain to give your mountain a sense of density, with "rolling rocks" and 
changes in elevation.
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After these two passes, my composition is feeling more like a mountain but still feels 
very impressionistic, as we can see here: 

Figure 6.27 – Our mountain with more solid tonal block-in and varied brushwork
We're getting there! Now, let's go ahead and quickly integrate our ice lake into the 
composition and refine the values and hues to "tie in" what we have so far, keeping 
our perspective in mind.

14.	 Grab a nice gray from your piece, one that appears in both your mountain and your 
lake area.

15.	 Near the base of the mountain, go in with a softer brush (such as b) Basic-2 
Opacity) and manually paint in a blend between the mountain's base and the edge 
of the lake.

16.	 Take this brush and extend out some of the white ice shapes, blending them with 
the foreground by lightly touching your tablet (as the b) Basic-2 Opacity brush has 
opacity tied with the pen pressure of your tablet). You can also change the opacity  
of the brush if you prefer to do your opacity control that way!
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What have now is a bit more coherent, as we can see here: 

Figure 6.28 – A slightly more readable mountain range and ice lake after our brushwork
For the last part of this chapter, let's go ahead and add some detail to the 
foreground, showcasing the icy nature of our lake by creating a reflection and 
etching some fast horizontal and vertical marks with our perspective in mind.

17.	 With a brush you're comfortable with (I'm sticking with my b) Basic-2 Opacity 
brush), color-pick (using the Ctrl hotkey) the sky color and block in some opaque 
shapes at the very bottom of our composition.

18.	 As your sky color is selected, lower the brightness of the color (or lower the opacity  
of your brush) and draw some jagged shapes coming up from the bottom of  
our composition. This will act as a "reflection" for the time being. 
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We should now have something that's starting to come together, and that certainly 
looks to be the case here: 

Figure 6.29 – Our impressionistic mountain and ice lake after our "reflection" pass

Now, there's still a lot of work to do on our landscape, but we are at a great stopping 
point for this chapter! There are a lot of moving parts that we covered here, so feel free to 
play around with various tools and functions that we may have skimmed. As always, the 
benefit of creating digital art in Krita is the ability to try things, as there's no "wrong way" 
to express yourself!

I hope this chapter showed a few tools that may get your imagination going, and I hope 
you're enjoying how well your landscape is coming along! 

Well done!
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Summary
During this chapter, we used a variety of tools to clean up and refine not only our image 
but our decision-making process as well. 

First, we learned about masks and used the Transparency Mask feature to mask out  
weird visual information from our photograph layers. We then used some selection  
tools to further clarify our shapes, adding some sheets of ice and sharpening up some  
of the jagged edges of our mountains. Once our composition was a little cleaner, we then 
discovered the Assistant Tool to overlay a perspective grid for our reference when creating 
sheets of ice on our lake. Then, we created a merged copy of what we had and applied 
some rich brushwork, blending our hues and value control, pushing our piece to more  
of a "painterly" feel.

In Chapter 7, Changing the Feel with Painting, Values, and Sliders, we're going to take  
our painting to the finish! We will learn about color toning, color gamuts, brightness  
and contrast filters, and some tricks we can use with our brushwork to really make  
our landscape pop! 

The amount of change you'll see in your landscape is going to blow your mind, I guarantee 
it! Let's get to it and finish our first project with style!





7
Changing the Feel 

with Painting, 
Values, and Sliders

In Chapter 6, Composing Using Krita's Toolbox, we discussed the importance of masks for 
our layers, and you'll notice that what we learned is going to be repeated from here on out 
through the remainder of the book in various capacities. We're nearing the portion of the 
book where your skills and understanding of Krita are bound to "level up," which means 
we'll be picking up the pace moving forward. You got this!

In this chapter, we'll be finalizing our overall design and brushwork, covering the idea of 
"changing mood" for our landscape and adjusting things such as color balance, brightness, 
and contrast. 

Topics covered in this chapter include the following:

•	 Adjusting your color balance

•	 Controlling mood

•	 Modifying brightness and contrast
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Since we're so far into our landscape painting, this will be a perfect opportunity to "refresh 
our eyes" a bit, fix some portions of the painting itself, and learn some cool tricks of the 
trade for balancing values and colors in the process!

Technical requirements
To follow along with this chapter, you will need the following:

•	 Krita (version 5.0+)

•	 A way to interact with Krita, such as a keyboard and either a mouse, tablet,  
or a touch device with a stylus

•	 Your landscape file (carried over from Chapter 6, Composing Using Krita's Toolbox)

If you did not follow along with Chapter 6, Composing Using Krita's Toolbox, a full version 
of my Krita file (.kra) as of the end of the chapter is available for you here: https://
static.packt-cdn.com/downloads/Krita_Sample_Files.zip.

There are a lot of fantastic "tricks of the trade" in this chapter, and I'm excited to share 
some of these secrets with you! Let's get started!

Adjusting your color balance
The first main step I'd like to do in this chapter is to really nail down the brushwork 
and painting, getting it near a "final render." However, before we start digging into the 
refinement of the painting, I'd like to do a slight color tweak using the Color Balance 
adjustment filter.

Let's take a look at our image as of the end of Chapter 6, Composing Using Krita's Toolbox. 
I always find it helpful to have a good "starting point" to take notes of where I'm at in 
regards to the process, and brainstorm some potential improvements (Figure 7.1):

https://static.packt-cdn.com/downloads/Krita_Sample_Files.zip
https://static.packt-cdn.com/downloads/Krita_Sample_Files.zip
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Figure 7.1 – Our landscape painting, as of the end of Chapter 6, Composing Using Krita's Toolbox

I feel like the blues of the entire composition could be pushed a little, and some of the 
colors could read a little "deeper" (higher saturation with darker color value), to give us 
some wiggle room when it comes to expanding the values for our foreground, midground, 
and background layers. I'll want the items closest to the viewer to be darker, the 
midground to be a true midtone, and our background to be pretty bright and vibrant in 
the highlights. This will add to the depth of the scene, and the visual interest, making our 
landscape "pop" for the viewer. We want this to be a showstopper!

A very fast, impactful way to get a new look for our painting is by using the Color 
Balance adjustment filter. This filter not only allows us to modify the overall color 
"leaning" of our painting, but also allows us to break down our color ranges into shadows, 
highlights, and midtones.

Let's do that now!
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Preparing our painting for color balance
There's a lot of power in being able to have total control of your colors in  
a non-destructive way in Krita. Being able to balance your shadows, midtones, and 
highlights with the click of a button not only works as a great "finishing touch" for your 
work but can also work in the way we're using it – to refresh our eye and give a more 
refined, rich color palette to work from and build our painting upon!

Let's prepare our file so we can get the biggest impact with our Color Balance pass.  
We can do so with the following steps:

1.	 Make sure your landscape painting is open. If you haven't followed along thus far 
and would like to use my file, feel free to download it by referring to the Technical 
requirements section of this chapter.

The first thing we can do to make our life a little easier is to create a "merged" copy 
of our painting thus far. This will allow us to have a "checkpoint" of progress, an idea 
we will cover in Chapter 8, Controlling Chaos – Organizing Your Workflow.

2.	 Make sure the top layer is selected in your Layers panel. My top layer is currently 
Painterly Pass 1, so I'll make sure it's the active layer.

3.	 On the File menu, click Select, then Select All (the default hotkey is Ctrl + A).
4.	 Once your canvas is selected, on the File menu, click Edit, then Copy merged (the 

default hotkey is Ctrl + Shift + C).

Your entire canvas, as it appears in your work area, is now copied to your  
Krita clipboard.

5.	 Click on Edit once again on the File menu, then select the Paste option (the default 
hotkey is Ctrl + V).

6.	 This will create a new layer at the top of your layer stack. In my case, it was named 
Painter Layer 4 (Pasted) by default. I want to go ahead and change the name of that 
new layer to Merged Copy.
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Your Layers panel should resemble something like Figure 7.2:

Figure 7.2 – Our updated Layers panel, with our new Merged Copy layer on top
This is going to let us utilize the Color Balance filter to its fullest extent, allowing 
every pixel of our painting to be impacted by the changes we make. The Color 
Balance adjustment filter only impacts the active layer in our Layers panel,  
so having a merged copy of our painting as our active layer will ensure that  
we're giving the tool the most information possible to adjust.

Let's go ahead and see what this tool is all about!
7.	 Make sure your Merged Copy layer is active. This ensures any edits we make going 

forward are non-destructive to what we've made previously.
8.	 On the File menu, click the Filter menu option, then hover over the option  

named Adjust.
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9.	 Once the Adjust category expands, select Color Balance (Figure 7.3):

Figure 7.3 – Our Color Balance filter selection, found through the Adjust category in the Filter menu

10.	 A pop-up menu will come up, showing you a variety of options and sliders  
(Figure 7.4):

Figure 7.4 – The Color Balance adjustment filter window
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The Color Balance window allows you to have control over the amount of hue 
impact based upon the direction of the sliders present. You will notice the hue 
sliders are all repeated under each category (namely Shadows, Midtones, and 
Highlights), with a Reset button on the sides to bring each category back to  
zero, respectively. 

11.	 Play around with the sliders and notice the impact the adjustments are making on 
your image. This may seem like a vague step, but noticing the vast changes your 
image can go through with a subtle slider adjustment can be eye-opening!

Our goal is to add a little bit of color vibrancy to our piece by adding some deeper 
colors to the darks, while also adjusting the lights to have higher saturation as well. 
We can also embrace the differences in the hue of our mountain and the atmosphere 
surrounding it, which should give us a nice contrast for the viewer. 

12.	 I want to give a nice, rich brown tone to our mountains, and because they are the 
darkest values on our piece at the moment, these hues will primarily be impacted by 
adjusting the Shadows sliders.

Understanding the Math
While the terms used in the Color Balance window refer to Shadows, 
Midtones, and Highlights, you should instead think of them as "darkest 
darks," "average midtones," and "lightest lights." The software doesn't  
think in relation to your painting's narrative (as in, "here is the shadow  
of my character" or "here is the highlight of my building"); it only understands 
the values present and reads your piece as a collection of lights, darks,  
and midtones. 

Adjusting the Shadows slider will impact the darkest darks, no matter the 
context of your piece. If your piece doesn't have a lot of darkest darks and 
instead your darks hang out around the 50% value level, your "darks" may 
actually be more impacted based on the Midtones slider, as Krita may see  
your darks as registering in its "midtone algorithm." It's all about the context  
of your piece and further amplifies the importance of distinct, easily parsed 
value control!
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13.	 I want to add some nice reds and yellows to our mountain, so under the  
Shadows slider, I bump the sliders closer to Red (instead of Cyan), don't touch the 
Magenta/Green slider, and go toward Yellow (instead of Blue) on the third slider 
(Figure 7.5):

Figure 7.5 – Our Shadows sliders in the Color Balance window,  
with numeric values included on the right

14.	 Since we will be making our adjustments to our brightest brights (Highlights) and 
darkest darks (Shadows), we will be passing over the Midtones slider here.

On the Highlights slider, since our Shadows are leaning more toward the "warmer" 
side of the color wheel (as we increased the amount of Red and Yellow in Step 13), 
let's move our Highlights slider to a "cooler" range. 

I tweak the Highlights slider to go more toward Cyan than Red, I once again leave 
the Magenta/Green slider alone, and increase the amount of Blue (Figure 7.6):

Figure 7.6 – Our Highlights sliders in the Color Balance window,  
with numeric values included on the right

This provides us with a nice balance of warms, cools, and gives us our overall goal of 
maintaining our painting's mood while making the colors more vibrant and deeper.
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15.	 Now, once you're pleased with your overall look, you have a few options. If you click 
OK, you will immediately apply the changes to your active layer. However, I think 
it's best if we maintain control over this filter, so we will click on Create Filter Mask 
(Figure 7.7):

Figure 7.7 – The Create Filter Mask, OK, and Cancel buttons in the Color Balance window
This allows us to maintain total control of the location and intensity of our changes, 
as we can use what we learned in Chapter 6, Composing Using Krita's Toolbox, 
regarding masks to make the visual tweaks as we see fit. We will keep white on  
the mask for the areas of this Color Balance correction that we would like to  
keep, while for the parts we want to hide, we can brush away using black  
on the mask.

16.	 Use your preferred brush (or brushes) to hide and show parts of your Color 
Balance adjustments using the attached filter mask we just created.

17.	 Once you're happy with the look, be sure to save your progress thus far!

Our Layers panel should resemble Figure 7.8 at this point:

Figure 7.8 – Our Layers panel with our newly added Color Balance filter mask

We have successfully used the Color Balance filter to give ourselves some new colors  
we can choose from, to take our painting to a nice finish.

Let's do our final painting push for this landscape!
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Painting using our new adjustments
Now, we'll be taking our newly-adjusted piece and using our new values and color 
palette to bring a better sense of cohesion to our painting. That's the benefit of making 
adjustment layers for the work we've done so far – we can compare our changes to things 
such as values and colors in order to make sure they're the most beneficial to our work.  
It also has a great side-effect of "refreshing our brain," giving us a new sense of momentum 
to add more details and rendering to really bring out the best of our project!

Speeding Things Up
While I'm going to show and mention a few main painting ideas, we're going 
to make a huge leap in quality in relatively few steps. Don't worry if it seems 
like we go from "point A to point Z" too quickly, as we will be doing a full look 
at the painting techniques used during this section in Chapter 10, Enforcing 
Fundamentals, where we do a still-life study that focuses on edges, the direction 
of strokes, balancing of shapes, and more. This chapter is a bit more focused  
on adjustments you can make while painting, rather than the painting 
technique itself.

Firstly, let's make another "merged copy" layer of our piece, now that we have some extra 
color hue and intensity information to work with:

1.	 With your top layer selected (in my case, the Merged Copy layer that has our Color 
Balance filter mask attached), choose Select > Select All from the File menu.

2.	 Once everything is selected, choose Edit > Copy Merged.
3.	 Then, choose Edit > Paste. This will create a new layer (in my case, called Paint 

Layer 4 (pasted)). 
4.	 Rename the layer Painting Refinement 1 (Figure 7.9):

Figure 7.9 – Our new Painting Refinement 1 layer at the top of our Layers panel stack



Adjusting your color balance     205

Now we're ready to paint!
5.	 With your Painting Refinement 1 layer selected, change over to your Brush tool 

and choose your favorite sharper edge brush. In my case, I want to choose the i) 
Wet Knife brush.

6.	 Using your stock photographs as a visual reference, add some brushwork to the 
middle of our foreground mountain. I'm selecting some of the lighter and darker 
colors when making my shapes (color picking by holding down the Alt key to bring 
up the eyedropper tool) in order to add some visual variety of hues and values. 

7.	 Since the main light source is coming from the right side of the composition, I'll add 
my lightest "highlights" to the right side of some rock shapes to have the appearance 
of light "catching" on the ridges and edges of the rocks.

8.	 Be sure to also add some horizontal, brighter brushmarks to the base of your 
mountain. This will give a great sense of depth, as it'll appear to the viewer that the 
"sheets of ice" are approaching the summit.

9.	 At this point, my piece looks like Figure 7.10 after just a few passes with the i) Wet 
Knife brush and adjusting the size (using the hotkeys of [ for decreasing brush size, 
and ] for increasing, respectively) of my brush for details "in the distance":

Figure 7.10 – Our refined painting so far, using harder brushes with color picking for variety
While we're definitely getting there, I feel like we need to add in some nice, thick 
brushwork for added visual impact. 
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10.	 Go ahead and switch over to a thick impasto style brush (I'll be using the m) RGBA 
Thick-dry brush) and further refine the foreground mountain, adding a variety  
of colors and sizes with your brushwork (Figure 7.11):

Figure 7.11 – Our painting with added RGBA Thick-dry brushwork on top
I'll now choose a smaller, more "hard round" brush to create some leading lines 
(marks that make a path to "lead the viewer" to our focal points) on my main 
mountains, and solidify some design shapes for the sheet of foreground ice,  
my background mountains, and my clouds. 
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11.	 For this task, I'll choose my trusty b) Basic-1 brush, as it is more opaque than its 
opacity-based sibling. Now we have a piece that is ready for some blending and 
detail work (Figure 7.12):

Figure 7.12 – Our piece with some leading lines and a more structured background
At this point, I believe we're ready to go to our finishing steps to complete our 
painting, meaning creating some varied edges (between hard edges, soft edges,  
and lost edges). It also means our Blender Blur brush has some time to shine!

12.	 Select a nice blender brush (as mentioned in Step 11, I've selected my Blender  
Blur brush for this) and smudge some of the background and midground edges. 
Based on the pressure you put on the tool, the impact and intensity of the blur effect 
will change.

While I use my chosen blender brush, I try to keep in mind to keep a variety of 
edges. I'd like to keep the chaotic, seemingly random brushwork near the bottom of 
the piece, as this can be used to infer "details" when seen at first glance. I also want 
to blur some of the color changes together in the middle of the mountain, but keep 
some sharp edges to signify "sharp rocks." 
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13.	 I work until I like the overall feel, keeping the brushwork and blending nice and 
loose (Figure 7.13):

Figure 7.13 – Our blended landscape after our Hard Round brush and Blender Blur passes
Now we are truly at the final steps! 

14.	 Make a new layer. Name this layer Finishing Touches.
15.	 Select your pencil brush (in my case, it will be the c) Pencil-2 brush). We will use 

this to "draw details," essentially performing a color sketch on top of our current 
painting. This is useful as a way to make very specific, precise marks for things such 
as mountain edges, ice portions in the lake, and random outlines and marks near 
things we find the most important in our composition.
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16.	 Once you are pleased with your details, be sure to save your work! 

That's essentially it for this composition, although I highly recommend taking  
a nice break (maybe even a day or two), coming back, and fixing any small areas  
you would like adjusted (Figure 7.14):

Figure 7.14 – Our refined sketch layer on top of our piece brings us to the final painting result!

Congratulations, you've made a huge amount of progress since the start of the book, and  
I hope you found this initial painting project rewarding and educational! Fantastic work!

Before we wrap this project up, there are a few more tweaks and adjustments we can use  
to get the most out of our hard work. Firstly, let's discuss the aspect of our painting's 
mood, and a few tried-and-true methods we can use to further understand and push the 
mood of our piece.
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Controlling mood
Mood, in the context of painting, usually refers to the emotional impact a piece can 
have on a viewer based on either the feelings expressed in the composition (such as the 
storytelling or subject matter) or the atmosphere used in the values (lights and darks) and 
color themes present in the painting. 

Now, we can also use the humanized concept of "mood" to discuss this as well, such as 
"how did this painting make me feel?", which is still a very valid approach. In our instance, 
however, we'll be focusing on the mechanics of the painting itself, and leave the feelings to 
the viewer to sort out on their own!

To make this idea a little more tangible, let's first discuss a way we can control the color 
harmony and "color themes" of a piece in order to elicit a response. While we discussed 
basic warm-and-cool color theory in Chapter 2, Reviewing Canvas Properties and Color, 
I'd like to show a cool trick that Krita has in giving you a great limited palette to work 
with: Color Gamut Masks. After we explore color gamuts, we can take a look at another 
secret weapon in regard to color harmony and adjustments – the Mother Color.

First, let's begin by discussing color gamuts.

Choosing color gamuts
A color gamut, as defined in Chapter 2, Reviewing Canvas Properties and Color, is the 
confined distance between colors. That's all well and good, but what does that actually 
mean? In essence, a color gamut is a mask of the color wheel that confines your color 
choices, essentially creating a limited palette for you. This enables a high level of color 
harmony within your work, and can be a "secret weapon" in relation to making your art 
have "mood."

Here is a quick refresher on some common color gamut recipes:

•	 Complimentary Color – Two colors that are located on polar opposite sides of the 
color wheel (yellow and blue, red and cyan, green and purple, and so on).

•	 Monochromatic Color – All variants of a single hue. Ranging throughout the full 
value spectrum, monochromatic (mono meaning "one," chromatic meaning "color") 
colors consist of a single hue, plus its shades (adding black), tints (adding white), 
and tones (adding gray).

•	 Analogous Color – The term analogous color refers to a group of three colors  
that are next to one another on the color wheel. Red, red-orange, and orange are  
one example of an analogous color group, with blue, blue-violet, and blue-green 
being another.
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•	 Triadic Color – A three-color set with equal distance between each color, creating  
a triangle on the color wheel. Red, green, and blue are a triadic color set.

•	 Tetradic Color – A four-color set, consisting of two sets of complementary colors. 
There is an equal distance between the color groupings, usually resulting in an equal 
color balance.

Krita actually has a built-in tool to aid us with the use and creation of Color Gamut 
Masks, and it can be found under the Dockers menu:

1.	 On your File menu, click on Settings, then select Dockers.
2.	 In the pop-out menu, select Gamut Masks. A window will open (Figure 7.15):

Figure 7.15 – The Gamut Masks window from our Dockers panel

3.	 Clicking on one of the Gamut Masks will enable the gamut on your functional 
color wheel.

From left to right, the gamuts you can choose from by default are as follows:

a. Atmosphere with Accent

b. Atmospheric Triad

c. Complementary

d. Dominant Hue with Accent

e. Shifted Triad

f. Split Complementary
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Our current painting has a Complementary color palette (blues and yellows/
oranges), so we can go ahead and select it.

4.	 Upon selecting the Complementary option in our Gamut Masks window, our color 
wheel will update with the gamut enabled.

5.	 Use your color picker (hold Ctrl for the eyedropper tool) and select any color from 
your painting.

You are now locked into your Complementary color gamut! This is exciting 
because you can use any color within the confines of this gamut, and your painting 
will maintain its current color theme and mood (Figure 7.16):

Figure 7.16 – Our Complementary color gamut applied to our color wheel

I'm such a big fan of using gamuts in this way, as it's almost like having the "correct" 
answer to the question of "which colors will work well with my painting?". I'm a big fan of 
working in confidence, and I think having the safety net of a locked range of color options 
to choose from can actually liberate you to be more expressive in other portions of your 
art, such as composition and brushwork.
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If at any point you would like to change which gamut mask you are using, you can select 
it from the Gamut Masks selection menu. Also, if there's a time you would like to cancel 
out of using a color gamut, you can click the color wheel icon to return back to your 
non-gamut color wheel (Figure 7.17):

Figure 7.17 – The color wheel icon to exit out of Gamut Mask mode

I highly recommend using Gamut Masks if you ever have a hard time deciding on what 
color theme or mood a piece should provide. It's also extremely useful to use if you ever 
find yourself in a creative rut, or things you are trying on a piece aren't working in the way 
you intend. 

For instance, if you're working on a piece and your values are exactly where you want 
them, but you aren't sure of colors to use over the top for a "color splash" phase, use  
a gamut mask to select your color range! It's sure to give you some great ideas and rev  
up your creative momentum!

Another great, fast way to enhance the mood of any of your work is by using the famous 
art technique known as "mother colors."

Utilizing a mother color
A Mother Color (also known through certain generations as an anchor color or ground 
color) is a color that is incorporated into every single color you use on your canvas. 
Famously, Renaissance painters would use a ground color for creating an underpainting 
on their canvas before beginning their layers (usually a burnt sienna or raw umber, but 
any color they had access to could be used). This color would then influence and "bleed" 
into the other layers, providing a harmonious impact on their paintings.
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You can also achieve a Mother Color in traditional painting by having your chosen color 
off to the side of your palette and mixing various amounts of it with every other color, 
before putting those colors onto your canvas. This is the method I enjoy using when  
I work traditionally, as it can make for some bizarre (but beautiful!) colors that really test 
my knowledge of color temperature and value.

There are also several ways you can utilize a Mother Color within digital art, and Krita 
makes it very easy to do this. What I want to show you is a simple trick, one that I use  
a ton on both my personal paintings and my professional client work:

1.	 Make sure your landscape painting project is open. You thought we were done with 
it, didn't you?! Ha!

2.	 Create a new layer on top of your Layers panel stack. Name this layer  
Mother Color.

3.	 Choose a nice, rich blue that you would enjoy being part of your entire landscape. 
I'm choosing a midtone and mid-saturation blue (Figure 7.18):

Figure 7.18 – Our midtone blue. Also notice that our gamut mask is disabled

4.	 Make your Mother Color layer entirely this blue color. You can either use a large 
brush, or the Fill Tool (the default hotkey is F).

5.	 Once your Mother Color layer is filled with blue, change the layer's blending mode 
to Soft Light (Photoshop).
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You will notice that our blue color has integrated itself with every other color of our 
landscape. Feel free to use other layer blending modes to see the impact that your 
Mother Color layer has on your composition.

6.	 I choose to keep my blending mode as Soft Light (Photoshop), but I want to lower 
the Opacity of the layer down to about 54% (Figure 7.19):

Figure 7.19 – Our new Mother Color layer, with Soft Light (Photoshop) blending mode at 54% opacity

Now that we have applied the Mother Color technique, I'm really enjoying the piece! 
There's still one slight tweak I'd like to make, and that has to do with the overall brightness 
and contrast level of the painting. 

Let's adjust that now!

Modifying brightness and contrast
Brightness and contrast are probably terms you've seen before, either in the context 
of digital art or perhaps even as a setting on your computer monitor or television set. 
Essentially, Brightness is the overall lightness (or darkness) of a display or image, while 
Contrast is the amount of distance between the darkest darks and the lightest lights on  
a display or image (also known as…you guessed it, the value range!). 

Wait, haven't we already done this? While it is true that your brightness and contrast 
decisions are made fairly early into your project by doing things such as selecting your 
value range (the amount of contrast between your lights and darks), and the location 
on the value scale that your piece will inhabit (the darkness/lightness, or brightness of 
your overall piece), it's never a bad thing to have a "second opinion" from Krita as you've 
worked on your piece for a while. Much like tweaking your colors with a gamut mask, 
you would be amazed at just how refreshing doing a slight tweak to your brightness and 
contrast can be for your project!
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Now, when a task or step of your process comes up that needs solving while you work in 
Krita, there may be a lot of different ways to correctly solve the problem. This is why the 
flexibility of Krita is so fantastic! Depending on the task, however, there may be a "most 
correct" tool that can handle the most amount of problem-solving, with the least amount 
of hassle. Let's find the right tool for this brightness and contrast adjustment job!

Finding the right tool
Krita's an outlier when it comes to brightness and contrast editing, as there's no set filter 
or adjustment layer called "Brightness and Contrast" as you would see in other digital 
painting apps. You can use a variety of tools to make adjustments to your brightness and 
contrast levels, including the Levels Curve filter, the Color Adjustment Curves filter, and 
even the HSV Adjustment filter. While these can work, in my opinion, there is a better 
tool to adjust these settings. 

Instead of trying multiple different filters with varying degrees of success, I've found that 
the ability to alter the brightness and contrast of your piece in the most straightforward 
way can be found by using the Cross-Channel Adjustment Curves filter. Krita actually 
used to have a dedicated "Brightness and Contrast" filter back in earlier versions of the 
software, but as of the beta of Krita 5.0, these features have been contained within this 
newer, more comprehensive location.

Let's go ahead and truly finalize our landscape painting by tweaking our brightness and 
contrast using our new filter and a layer mask. With your landscape open, we are going to 
go ahead and make a merged copy of what we have thus far:

1.	 We can do this by going to our File menu and under Select, choosing Select All  
(Ctrl + A hotkey).

2.	 Go to Edit and choose Copy merged (Ctrl + Shift + C). Then, choose Paste  
(Ctrl + V).

3.	 This will create a new merged layer on top of our Layers panel stack. Rename this 
layer to Brightness and Contrast Pass.
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Your Layers panel should resemble Figure 7.20 at this point:

Figure 7.20 – Our new Brightness and Contrast Pass merged layer

4.	 With our new Brightness and Contrast Pass layer active, click on the Filter option 
on the File menu.

5.	 Hover over the Adjust category, and select Cross-channel adjustment curves… 
(Figure 7.21):

Figure 7.21 – The Cross-channel adjustment curves adjustment filter location
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This will open a separate window, showing you a set of drop-down boxes and  
a curve adjustment graph (Figure 7.22):

Figure 7.22 – The Cross-channel color adjustment filter, accessed through the Adjust category
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While this window may seem a bit intimidating, we're only going to focus on three 
key aspects to simplify things:

a. �Channel selector – This is where you will select what aspect of the image you 
would like to manipulate. Options include RGBA, Red, Green, Blue, Alpha, Hue, 
Saturation, and Lightness.

b. �Driver Channel selector – This is where you will select what you would like 
to adjust within the channel you have selected. The options here include Red, 
Green, Blue, Alpha, Hue, Saturation, and Lightness.

c. �Curve map – The map area in which points are placed upon a grid, correlating  
to changes related to channel, driver channel, and value. The horizontal axis 
represents the driver channel you selected in the drop-down menu, while the 
vertical axis represents the channel you selected in the drop-down menu, located 
above the map itself. The left-most dot represents your range of darks, while the 
right-most dot represents your range of light. Any dot you put in between those  
two will influence varying midtones, depending on the channel and driver  
channel selected. 

For instance, let's say you wanted to alter the saturation of your reds. You would 
select Saturation for Channel, and Red for Driver channel. Think of it as an Edit 
the ________ of the ________ formula, with your channel and driver channel filling 
in those blanks, respectively.

6.	 Since we only want to manipulate our brightness and contrast levels of the piece in 
its entirety, go ahead and select Lightness for Channel, and also select Lightness 
for Driver channel. 

This tells Krita that you'd like to modify the contrast amount of the lightness of your 
piece, essentially acting as a makeshift brightness and contrast filter.
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After adjusting the points on my grid, I'm enjoying the slight tweaks to brightness 
and contrast. My finalized settings can be seen in Figure 7.23:

Figure 7.23 – The Cross-channel color adjustment settings for my Brightness and Contrast Pass layer
Since we want to ensure these changes are non-destructive, let's go ahead and click 
on Create Filter Mask to save our changes and attach them to our Brightness and 
Contrast Pass layer. You can always modify the visibility of this mask by using your 
black and white brushes to hide and show information from this layer, respectively. 
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Guess what? We have completed our first project (Figure 7.24):

Figure 7.24 – Our completed landscape painting. Well done!

Fantastic work! Be proud of your four chapters of work! Hopefully, you have a basic 
understanding of the workflow and some often-used tools for Krita's digital  
painting structure. 

From here on out, we are going to really embrace what we've learned and take our art to 
the next level!

Summary
In this chapter, we finally finished our landscape project! First, we utilized some additional 
brushes to make some refinements to our painting. Then, we moved over to discussing 
altering the mood of our piece using the color gamut and mother color methods.  
Finally, we adjusted the overall brightness and contrast of our piece by introducing the 
Cross-channel color adjustment filter, discussing the overall impact of using masked 
adjustment filters as a finishing touch.
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While we made some great progress and finalized our painting, our finely-organized file 
structure sort of flew by the wayside, which introduces us to what we're going to cover in 
the next chapter! In Chapter 8, Controlling Chaos – Organize Your Workflow for Maximum 
Efficiency, we are going to "package" this project for delivery, including restructuring our 
Layers panel, making new layer groups, and finally saving our project for ease of use in 
case we want to continue working on it down the line, or share our work with other artists 
for collaboration.

Let's get going!



8
Controlling  

Chaos – Organizing 
Your Workflow

In Chapter 7, Changing the Feel With Painting, Values, and Sliders, we completed  
our landscape painting project, which is great news! What isn't so great news, though,  
is that our nice and tidy project got a bit unwieldy. Extra layers, merged compositions,  
and out-of-order masking got us to a final painting that we can be proud of but added 
some ugly complexity to our file structure. 

This chapter is dedicated to "cleaning up our mess," making our file more structured and 
accessible for working in a team environment. This process will also be helpful if we want 
to return to this piece in the future, as our organizational process will aid us in making 
edits or corrections during any revisits we may have.

In this chapter, the main topics will include the following:

•	 Organizing with shape language

•	 Retaining clarity through structure

•	 Taking notes 
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Essentially, the goal of this chapter is to teach you a few ways you can think about your 
file organization after you paint, meaning you don't have to feel guilty if, while creating 
your art, you are not fully focused on creating the "perfect file structure." I love getting 
laser-focused on my painting and feel like taking constant breaks to rename layers, move 
around masks, and mess with sliders and properties can take me out of my artistic flow. 
Fear not – we'll learn some tricks of the trade to make your work accessible, team-ready, 
and modular, even after you've already painted it!

Technical requirements
To follow along with this chapter, you will need the following:

•	 Krita (version 5.0+)

•	 A way to interact with Krita, such as a keyboard and either a mouse, tablet, or touch 
device with a stylus

•	 Your landscape file (carried over from Chapter 7, Changing the Feel With Painting, 
Values, and Sliders) 

If you did not follow along in Chapter 7, Changing the Feel With Painting, Values,  
and Sliders, a full version of my Krita file (.kra) at the end of that chapter is available 
for you here: https://static.packt-cdn.com/downloads/Krita_Sample_
Files.zip.

To get started, we will break our painting down in the most simple way possible – shapes!

Organizing with shape language
Shape language is a term you may have seen floating around various other art, character 
design, or animation tutorials you may have seen, but what does it mean? While there are 
many different functional definitions of shape language, in the capacity of this book, shape 
language can be defined as simplifying complex areas of a painting into basic geometric 
shapes, giving us the "essence" of what we are trying to communicate to the viewer. Instead 
of focusing on the main focal points as the item's terminology or definition in the context 
of the subject matter (for instance, referring to something as a mountain, clouds, a vehicle, 
or a character), think of basic shapes that make up the silhouette of the subject matter, 
such as triangles, circles, ovals, rectangles, squares, and diamonds. 

https://static.packt-cdn.com/downloads/Krita_Sample_Files.zip
https://static.packt-cdn.com/downloads/Krita_Sample_Files.zip
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This is useful for clarifying our designs and breaking our artwork down into repeatable 
steps for others (such as an art team). Another usage for the term shape language can 
come into play when discussing the emotional reaction a viewer may subconsciously have 
to a shape. A few examples of this include (but are not limited to) the following:

•	 Squares and rectangles can show stability and balance (equality on all sides of the 
shape, or providing a sturdy foundation to build upon).

•	 Circles and ovals can represent peace and flow (as there's no combative "hard edge" 
to draw the eye).

•	 Triangles and diamonds can represent power and danger (as they lead to a sharp 
point or points, much like a dagger or pointed weapon).

These are very basic breakdowns, and you can adjust proportions to change the meanings 
of a shape. For instance, if you squash an oval to where it is very flat and wide, it can build 
tension (as it may remind the viewer of a ball or balloon under immense pressure, about 
to pop) instead of having the feeling of peace that is inherent with the oval's rounded 
edges. Playing around with the mixing and matching of these shapes in relation to one 
another on your canvas is a great way to make engrossing, impactful artwork.

There's much to think about regarding shapes, but this theory of emotional impact  
and asking the question, "what does this shape represent to the viewer?" is extremely 
helpful during the initial creation of the image. But what can we do after the image is 
already created? 

This ties into our chapter's goal of proper organization. Breaking down our complex 
canvas into basic shapes will not only help the clarity of sending this artwork off to  
a team or other artists but also allow us the ability to "reverse-engineer" our own painting, 
looking at aspects we may not have noticed until after we finished the image. 

Cleaning up our layers
Let's start our organizational process by cleaning up our Layers panel, before jumping into 
making any new layers:

1.	 Make sure your previous landscape painting project is open. If you haven't followed 
along with the project and need a copy of the file I will be using, you can download 
the final landscape painting Krita project by referring to the Technical requirements 
section at the start of this chapter.

2.	 Select your top-most layer in your Layers panel. For me, this is the Brightness and 
Contrast layer with my mask attached.
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3.	 Select Group Layer by clicking on the side-arrow of the + button on the bottom-left 
of your Layers panel (Figure 8.1):

Figure 8.1 – The Group Layer option is highlighted from the  
Add Layer options menu at the bottom left of the Layers panel

4.	 This will create a default group with a default name (mine, for instance, was Group 
4). Change this Group Layer name to Completed Piece. 

5.	 With your Completed Piece layer group active, create a merged version of your 
image. Do this by going to Select on your File menu, and then Select All. Go to 
Edit, and then Copy Merged (the Ctrl + Shift + C default hotkey).

6.	 Now, Paste (the Ctrl + V default hotkey) your copied piece. This should create a new 
layer called Painter Layer 4 (Pasted) above your Completed Piece group layer.  
Go ahead and change the name to Merged Final.
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Your Layers panel should resemble Figure 8.2 at this point:

Figure 8.2 – The updated Layers panel with the Completed Piece group layer  
and the Merged Final layer on top

7.	 Select your Merged Final layer on your Layers panel and drag it on top of your 
Completed Piece group layer.

This will cause your Merged Final layer to be inherited by your Completed Piece 
group layer (Figure 8.3):

Figure 8.3 – The Merged Final layer placed into the Completed Piece group layer  
by the drag and drop method

This will be helpful, as we will always have access to an instant, "final" version  
of our painting at the click of a button moving forward. 
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8.	 For our next set of steps, let's create a group layer for all of our current layers to 
really clean up our Layers panel.

9.	 With your Layers panel still open, select your top-most layer that is not held within 
your Completed Piece group layer. In my instance, this will be my Brightness and 
Contrast Pass layer.

10.	 Scroll down to the bottom of your Layers panel. While holding Shift, click on your 
bottom-most layer (in my instance, that would be Starting Layer).

If done correctly, your Layers panel should be primarily highlighted, as all your 
layers (outside of the Completed Piece group, of course) have been selected. This is 
known as a Shift + click selection method.

Inversing This Method
Currently, we are doing what's known as the Shift-click method of adding 
multiple layers to a selection at once. If you would like to do the inverse of this 
and start with everything in your Layers panel selected and removing what 
you don't want in the selection group, you can do so easily by right-clicking 
any layer within your Layers panel and choosing Select > All Layers from the 
right-click pop-out menu. Then, find the layers you would like to remove from 
your selection, and Ctrl + click on them. This removes the layer from the active 
selection group you have chosen.

In this instance, after right-clicking and choosing Select > All Layers step in 
your Layers panel, you would Ctrl-click the Completed Piece layer group, 
which would deselect your Completed Piece layer, as well as anything nested 
inside of it.

11.	 With all your chosen layers selected, right-click once again. Your right-click menu 
will pop up inside of your Layers panel.
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From these options, choose the Group > Quick Group (keyboard shortcut  
Ctrl + G) selection (Figure 8.4): 

Figure 8.4 – The right-click menu on the Layers panel, selecting  
the Quick Group option in the Group category

This will create a new group layer with a default name (in my instance, the  
default name is Group 4) with all of your selected layers nested within it. Since 
group layers have multiple layers as part of a group, you may notice a bit of 
slowdown on your file.
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12.	 Change the name of this group to Step By Step Process.

Once you have your two groups named with your layers nested within them, check 
out how clean your Layers panel looks now (Figure 8.5):

Figure 8.5 – Our newly cleaned-up Layers panel – ahhh, that's better!

Congratulations! You went from having roughly 28 lines of layer data to sort through 
down to a nicely compressed 2 lines! Of course, your 28 lines of layer data are still present 
in your file, and you can go back and edit/tweak any specific layer you'd like, but the clean 
Layers panel is going to make the next steps much more rewarding and less chaotic! 
Sometimes, it's the little things that make all the difference!

Simplifying it down to three (again)
If you remember way back in Chapter 3, Utilizing Layers and Layer Groups, when we first 
started this painting, we broke down our composition into three separate plane layers for 
clarity – Foreground, Midground, and Background. 

While our painting has got much more complex since those early stages, it can be helpful 
for file organization to retain that separation of planes. By doing this, we can later return 
to our piece, make a fast selection, and edit a specific area of our painting, without having 
to sort through dozens of layers in the process to "find our spot" of where we originally 
created a specific portion of a plane, as it were. 
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Using our Polygonal Selection Tool, redefining our planes is an extremely easy process. 
Let's create new merged layers for our foreground, midground, and background now:

1.	 In the Toolbox, select Polygonal Selection Tool (Figure 8.6):

Figure 8.6 – The Polygonal Selection Tool, via our Toolbox
With my Polygonal Selection Tool active, I want to draw a fairly accurate selection 
around the ice lake. This will act as my foreground. 

Switching Tools
If, for some reason, the Polygonal Selection Tool isn't working as intended 
(such as not displaying the "marching ants" around your selection, showing  
a connector line between your clicked pivoting points, or allowing you to 
"close" your selection by connecting the last line to the start of the first line), 
feel free to use the Bezier Curve Selection Tool instead (located directly to  
the right of the Polygonal Selection Tool in the Toolbox). 

2.	 Click areas outlining the ice lake of your composition. Be sure to get close to  
the base of the mountains, but don't have any specific ridge or edge selected within 
the mountains. 
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3.	 Once you're pleased with your selection, close the selection (making it active) by 
returning to your starting point. This will close the selection loop and create an 
active selection (Figure 8.7):

Figure 8.7 – The foreground ice lake, as selected by the Polygonal Selection Tool

4.	 On your File menu, click Edit > Copy Merged (the default hotkey is Ctrl +  
Shift + C). 

5.	 Then, click Edit > Paste (the default hotkey is Ctrl + V).
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6.	 This will create a new layer with only your foreground ice lake as its contents. The 
name of this layer should be changed to Foreground (Ice Lake) (Figure 8.8):

Figure 8.8 – Our new Foreground (Ice Lake) layer, on top of our Layers panel
Now, we want to make sure we lock the transparency (or alpha channel) of this layer 
(as it will allow us to paint within the confines of the layer but not outside of it).

7.	 To lock the transparency of the layer, click the checkerboard grid icon on the  
right-most portion of the layer's row on your Layers panel.
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If I hover over the layer once I've done this, a small pop-up window will show  
me some properties of the layer, including a thumbnail and statuses of certain 
layer properties. The property I'm checking for will be the Alpha Locked property, 
located at the bottom of the list. The status is currently showing Yes, since  
we clicked the checkerboard grid icon to lock the transparency (or alpha  
channel) (Figure 8.9):

Figure 8.9 – The layer properties pop-out window

8.	 Next, we're going to create our midground layer, which will consist of  
our mountains.

Select your Polygonal Selection Tool once again and use it to outline your 
mountains. Don't worry too much if your selection area overlaps your foreground 
selection slightly.
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9.	 Once you are pleased with your selection, click Edit > Copy Merged from your File 
menu (Figure 8.10):

Figure 8.10 – Our selected area of mountains with our Polygonal Selection Tool

10.	 Now, paste your layer, creating a new layer. Change this layer's name  
to Midground (Mountains).

11.	 Lock the transparency on the Midground (Mountains) layer by clicking the 
checkerboard grid icon on the right-most side of the layer row.
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12.	 Finally, we will create our background layer.

Using your Polygonal Selection Tool, choose the area of the sky and clouds, using 
the mountain's edges as an outline (Figure 8.11):

Figure 8.11 – Our background area selection using the Polygonal Selection Tool

13.	 Once again, choose Edit > Copy Merged from your File menu. Then, paste your 
selection to create a new layer.

14.	 Change this layer's name to Background (Sky).
15.	 Be sure to lock the transparency of the layer by clicking the checkerboard grid icon 

on the right-most side of the layer row.
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Your Layers panel should now look like Figure 8.12:

Figure 8.12 – Our newly updated Layers panel with our Background, Midground,  
and Foreground layers with locked transparency

Good work! While this series of steps may seem redundant, they'll tie in beautifully with 
our next series of steps in the chapter. There's a powerful reason we've created these 
custom shape selections, and it has to do with retaining the clarity of our painting  
through structure.

Retaining clarity through structure
Since paintings are complex beasts, it's always a good idea to re-simplify and break down 
our paintings at various points of their creation. Maintaining our sense of clarity, or visual 
coherence, is key.
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So, why did we make the new foreground, midground, and background plane selections? 
Why make these new alpha-locked layers that essentially already existed in a previous part 
of our painting exercise? Let's reveal the true power of this technique:

1.	 In your Layers panel, select your Midground (Mountains) layer to make it the  
active layer.

2.	 Ctrl-click on the layer's thumbnail (on the left-hand side of the layer's row, next to 
the hide/reveal eyeball icon) (Figure 8.13):

Figure 8.13 – A close-up of the Midground (Mountains) thumbnail for Ctrl-click selections
Bam! This immediately selected only the contents of the selected layer! Try holding 
Ctrl and clicking on another layer's thumbnail.

See the power this shortcut method provides? You can quickly scroll to a separated 
plane's layer, Ctrl-click the thumbnail, and have a live painting surface. The coolest 
part (in my opinion)? The selection can carry over to a new layer, acting as a mask 
for your edits and brushstrokes!

Let's see what I mean by adding a few more sharp edges to our foreground, further 
adding depth to our ice lake.

3.	 On your Layers panel, create a new layer. Name this layer Ice Lake  
Detail Pass.

4.	 Ctrl-click on the thumbnail of the Foreground (Ice Lake) layer.
5.	 Switch back to your Ice Lake Detail Pass layer by selecting it in your Layers panel. 

Note how the active selection (the "marching ants") are still surrounding the 
Foreground (Ice Lake) layer's information.
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6.	 Switch to your Brush Tool (the default hotkey is B on your keyboard). Choose  
a brush, and start painting on your Ice Lake Detail Pass layer using the selection 
area dictated by the Foreground (Ice Lake) layer (Figure 8.14):

Figure 8.14 – Painting on our new Ice Lake Detail Pass layer using  
the selection area from our Foreground (Ice Lake) layer

7.	 Try painting strokes outside of the selection area. None of your painting strokes will 
show up outside of your selection's confines because the selected area is acting as 
your live painting area mask, meaning anything outside of it isn't retained.

This is a wonderful way to quickly add, remove, or paint over specific areas of your 
painting without being destructive to what you've worked so hard for. Does a client 
love the piece you made for them, but they'd like a small tweak of the background 
color? Retain the clarity of your background layer's shape by creating a Polygonal 
Selection Tool selection of it, create a new merged layer with locked transparency, 
and keep it separate from the overall "step-by-step" parts of your initial work. 

Before we move on to our final portion of this chapter, let's clean up our Layers 
panel, as we've introduced some new concepts.

8.	 In your Layers panel, select your Background (Sky) layer.
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9.	 While holding Shift on your keyboard, click on your Foreground (Ice Lake) layer.

This will create a selection of all three of your planes' layers (Figure 8.15):

Figure 8.15 – Our planes' layers selected on our Layers panel via the Shift-click selection method

10.	 With all three of our planes layers actively selected, right-click in your Layers panel. 
11.	 Select the Group > Quick Group option from the pop-up menu.
12.	 Rename this group from its default name to Planes (Masked).
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Your Layers panel should now look like Figure 8.16:

Figure 8.16 – The cleaned-up Layers panel with our new Planes (Masked) group

Now, if at any point you need to do a "quick selection" of a specific plane of your painting, 
you have a dedicated group that you can call back to, quickly and easily!

To wrap this chapter up, we're going to make a new category and group for our Ice Lake 
Detail Pass layer, but we're also going to discuss something that is often overlooked in  
a digital art workflow – note-taking.

Taking notes
While at our core we are artists, I would argue that our primary job is as a communicator. 
Surely, painting is visual communication, but you should never overlook the sheer power 
of words to convey an idea. For every one of my clients that require preliminary sketches 
or "value passes" (such as card art, tabletop roleplaying game art, and concept art jobs), 
I always send in a draft with notes not only in an email but also embedded in the art 
file itself. These can be either handwritten or typed using the Text tool, but no matter 
the method, I want to make sure that my client can follow my train of thought, or see 
questions I might have for them directly relating to the piece.
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I've heard from a vast number of my art directors that they love that I include notes, as it 
helps them relay information to their team, and saves everyone time (and about 20 emails) 
in the process. Saving time saves money for companies, and if you're a skilled artist that 
also communicates well and you save the company money… well, congratulations!  
You're well on your way to safely accruing a long list of clients that will love to work  
with you on a regular basis.

Let's create a layer for notes to really solidify this painting as not only a work of art that 
we can be proud of but also a design tool that would work well in a large amount of 
professional pipelines:

1.	 Select your Ice Lake Detail Pass layer on your Layers panel.
2.	 Create a new layer. This will make a layer above our Ice Lake Detail Pass layer. 

Change the default layer name of this new layer to Notes BG.
3.	 Select your Fill Tool (the default hotkey is F on your keyboard) and make sure you 

have black selected as your color.
4.	 Fill the Notes BG layer completely black.
5.	 Now, lower the Opacity value of your Notes BG layer to somewhere between 50% 

and 95%, depending on your preference. 

Our goal here is to make a dark enough background so that we can write, type, and 
draw on a layer above this one to create our notes. 

6.	 When you are happy with the opacity of your Notes BG layer, go ahead and create  
a new layer on top of it and name this layer simply Notes.

7.	 From here, choose a light color (a light red is nice, as it draws attention) that will 
show up well against the Notes BG layer underneath it. A pure white brush also 
works well here!
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8.	 With your Notes layer active, draw, type, or hand-write notes on areas that you 
notice you would like to improve in your piece (Figure 8.17):

Figure 8.17 – Notes taken on the Notes layer, calling out points of interest and potential changes
Is the background a little too hazy? Would you want to add anything to this piece, 
such as a person or building? Where would you like to place those items? Is there 
anything you'd like to fully change, such as the shapes of the mountains? These are 
some valuable questions to ask yourself as an artist but also great information to jot 
down on your Notes layer.

To bring this entire landscape project all to a close (for real!), let's finalize and clean 
our Layers panel for the last time.

9.	 On your Layers panel, select both your Notes and Notes BG layers by using the 
Shift-click method.

10.	 Right-click in the Layers panel once both layers are selected, and choose Group > 
Quick Group from the pop-out menu.

11.	 Name this new group Notes.
12.	 Now, select the Ice Lake Detail Pass layer, and then Shift-click the new Notes layer 

group you just created.
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13.	 Once again, right-click on the Layers panel and choose Group > Quick Group 
from the pop-out menu. This will group not only your Ice Lake Detail Pass  
layer but also the entire Notes group as well! Groups within groups – what  
madness is this?

14.	 Name this new group Additional Information.

Your final Layers panel layout should look like Figure 8.18:

Figure 8.18 – Our finalized Layers panel for our landscape project – clean!

Fantastic work! We now have four rows on our Layers panel, leaving a super-clean setup 
that we can revisit at any time. The organizational skills learned here will also help when 
working in a team environment, working on revisions for your piece, or even submitting 
your work to an art director. 

While these steps may seem like extra work, your future self will absolutely thank you for 
taking the time to break your piece down into iterative steps like this if you ever need to 
revisit it! Using the simple Ctrl-click method, you can make vast changes to your piece in  
a matter of seconds!

Throughout these past five chapters, we've gone through an entire crash course of using 
Krita from beginning to end to create a pipeline-ready landscape painting we can be 
proud of. It's been an outstanding job, and I hope you picked up some valuable tricks 
along the way!
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Summary
In this chapter, we discussed organization in many forms. Through shape language,  
we were able to break down our piece into easily identifiable planes (foreground, 
midground, and background) for revision and quick access. We then looked at the power 
of retaining these clear separations by using the Ctrl-click selection method, where we can 
select only information from select layers for an unbeatable masking shortcut. Finally,  
we discussed taking embedded notes not only for our sake but also for the sake of our 
clients and art directors as well.

That brings us to the close of Part 2, Methods of Visual Communication within Krita, of the 
book – congratulations! In Part 3, Projects Unleashing Your Inner Artist with Krita, we are 
going to unleash your inner artist, and go through a crash course of formal art training! 
Whether you've been through an Atelier program or are self-taught, there's going to be  
a LOT of discussion in the coming chapters. We are going to begin in the next chapter  
by using Krita to lay out the foundation for an art exercise as old as time – a formal  
still-life painting!





Part 3:  
Projects Unleashing 

Your Inner Artist  
with Krita

Now that you understand the mechanics of Krita, it's time to put this knowledge to use in 
the best way possible: by creating portfolio-ready art! In this part, with the help of these 
two projects, you'll reinforce your comfort level and understanding of Krita while creating 
material that will grab the attention of your family, friends, and potentially even clients  
or art directors (if going pro is your goal!).

This part comprises the following chapters:

•	 Chapter 9, Setting Up a Still-Life Study

•	 Chapter 10, Enforcing Fundamentals

•	 Chapter 11, Working with Concept Art

•	 Chapter 12, Refining and Creating Cinematic Concept Art

•	 Chapter 13, Going Beyond These Pages





9
Setting Up  

a Still-Life Study
Welcome to the final chapters of the book! 

I hope you've enjoyed the journey so far, and your familiarity with Krita is getting 
more comfortable. It's a stellar program, and I'm hoping that you're starting to see the 
possibilities the software can provide to aid in your artistic output. 

To really drive home our mastery of this great program, we're going to hone our skills 
with a tried-and-true method that artists have used for centuries. Before we fully dig in, 
though, it will be important to set ourselves up for success.

Here's a quick breakdown of what this chapter will cover:

•	 Setting expectations

•	 Discussing our reference

•	 Setting up grids and guides

•	 Transferring what you see
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From here until the end of the book, we are going to level up the difficulty of our projects 
to really push your artistic skillset. For this chapter, we are going to set up a canvas and 
transfer a stock photo to the canvas for our next project.

The project? We will be painting a still-life in Chapter 10, Enforcing Fundamentals. 

Technical requirements
To follow along with this chapter, you will need the following:

•	 Krita (version 5.0+).

•	 A way to interact with Krita, such as a keyboard, and either a mouse, tablet,  
or touch device with a stylus.

•	 A copy of the stock photo used for this project is provided at https://static.
packt-cdn.com/downloads/Krita_Sample_Files.zip, courtesy of 
Pexels.com and photographer Suzy Hazelwood.

Setting expectations
I know you may be thinking that a still-life may not be the most advanced thing you've 
ever made. I mean, a still-life? Those things that you make during your first week of Art 
101 at university or secondary school? Why would we go back to the basics of art yet again 
when Krita allows for so much variety and sophistication with its tools and mechanics?  
I thought this was the advanced portion of the book! I've already done the boring  
artistic mechanics stuff; I'm ready for the hard stuff that will make me world-famous!  
I've been bamboozled!

Hey now, this book is a no-bamboozle zone! Ironically, you're going to realize that the 
more "advanced" we get in our projects, the more we're going to be dealing with the 
fundamentals of art, advanced Krita tools, and problem-solving in equal measure. There 
are two main points that may explain and support my way of thinking here. Why are  
we going back to the basics while at the same time claiming to be getting more advanced? 
Well, two reasons are as follows:

•	 By keeping our project more basic in its expectations, it will further provide us 
moments to allow ourselves to focus on, and really master, our workflow and 
growth within Krita. Repetition and basic problem-solving skills will promote more 
mastery of learning Krita and its tools at a faster rate. The next reason may ruffle 
some feathers!

https://static.packt-cdn.com/downloads/Krita_Sample_Files.zip
https://static.packt-cdn.com/downloads/Krita_Sample_Files.zip
http://Pexels.com
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•	 Krita is a powerhouse piece of software, and with the amount and breadth of 
the features it provides you as an artist, you should focus on improving your 
fundamental artistic skills to "catch up" with the capabilities the software provides. 
Krita isn't holding us back; we are holding Krita back. A sobering thought, yeah?

Both points have a common goal of being "learner-focused." It's a powerful mindset to 
always be a student. Allow yourself possibilities to fail, never overestimate your ability, and 
realize there's always room for growth. 

While painting and artistic pursuits are never easy, taking the complexity out of the 
subject and overall goal for our project (as the photo is already chosen, and the goal is to 
transfer what we see in the photo) allows us the mental bandwidth and capacity to use 
Krita in ways that aid the goals we set for ourselves. We will have the opportunity to try 
new brushes, new composition tools, new techniques, and new workflows.

In my opinion, people who say there's no creativity or artistry in still-life studies because 
"the work has already been done for you" simply aren't approaching the subject in a way 
that could benefit them the most. While that may seem open-ended (as every artist has 
different goals), it's important to dissect exactly why we study, just as much as dissecting 
what we study.

Let's get started by discussing the reference image we'll be using. This will aid us in setting 
up our canvas and grids and getting proper shapes transferred onto our canvas for the 
next chapter.

Discussing our reference
While we gave some general guidelines for getting references in Chapter 5, Implementing 
Layer Blending Modes, in the Finding the right reference and Choosing our reference 
sections, I thought it'd be interesting to evaluate an image in "real time" to better help us 
with our project planning. 
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First of all, let's take a look at our image, titled Three Red Apples on Wooden Surface by 
Suzy Hazelwood, provided courtesy of Pexels.com (Figure 9.1):

Figure 9.1 – Our reference image, courtesy of Suzy Hazelwood via Pexels.com

In an atelier setting, still-life studies usually consist of a variety of stationary objects (such 
as vases, skulls, books, flowers, or other odds-and-ends) stacked and situated in a specific 
way, under specific lighting conditions, for students to draw from life. Students can find 
seating arrangements and move to get various vantage points of the materials to fully 
understand how light, shadows, and shapes all create forms while transferring them into  
a painting, sketchbook, or another type of canvas. It's a dynamic exercise, one that I highly 
recommend you try for yourself if you're ever able to join in a group setting or set up  
a dedicated still-life in your home. There's nothing quite like drawing from life.

After all that talk of dynamic angles, atelier approaches, and drawing from life, we will be 
using a static photograph that doesn't move, already has the lighting set up, and that  
we can't change.

While this may seem limiting, this particular photograph has three main elements I look 
for when doing a study, whether it is from life or based on a photograph:

•	 Good contrast between lights and shadows

•	 A variety of shapes and textures

•	 Rich hue and saturation variance

http://Pexels.com
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These apples pop. By contrasting the rich reds (which will act as our warms, seeing as how 
red is natively on the "warm" half of the color wheel) against the neutral wooden surface 
(it appears more "gray", which moves our hue toward the middle of the color wheel), we 
get a sense of separation of the subject from the background, while also showcasing the 
differences between the wood and the apple's skin texture. The grays of the wood panels 
appear "cold" relative to the more warm reds of the apples to give a large amount of visual 
color contrast, as you can see in Figure 9.2:

Figure 9.2 – The variance of hues (warms versus cools) and texture (apple skin versus wood panel)

We also have a beautiful repetition of shapes, not only with the apples themselves  
(the apples all have a modified circle appearance) but with the apple stems all facing  
a similar direction.

A part that I really love (and that will provide us with some options once we start 
transferring this to our canvas) are the lines of wood grain in the wooden panels. These 
lines give us the proper texture comparison versus the more smooth, circular apple shapes. 

These wood grain lines also provide a few other benefits: they act as "leading lines" to 
frame our subject (the apples), and also provide us with a proper perspective grid if  
we want to stretch the composition out a bit (spoiler – we will!)
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You can see how effectively these wood grain lines not only aid in leading our viewer to  
our subject of the apples, but how they also give us a decent perspective grid to work from 
in Figure 9.3:

Figure 9.3 – The leading lines of the wooden panels will aid in our transferring process

There's an old saying I used to hear in art school, and it's 100% true. If you can paint 
an apple, you can paint anything. Composition, edge control, proportion, hue variance, 
texture contrasts, subtle shifts between lights and darks, and tons of opportunities for us 
to have thick, gorgeous brushwork. Sounds good to me!

Now that we have looked at our stock photo and dissected a few key elements to take 
forward into our painting, I think it's time to start transferring our version of this 
composition onto our canvas. That brings us to a few key tools in Krita that will help us to 
get there: grids and guides.
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Setting up grids and guides
There are a variety of methods to transfer an image to a canvas. In the next section, 
Transferring what you see, we will go through, step by step, getting our shapes and main 
composition down on the canvas with brushes. Before we get there, we need to make 
some decisions. This will tie into what your overall goal of the study is, and the aspects 
you would like to focus on.

For this project, my main goal is to make a strong composition showcasing the  
differences between the apples and the wooden panels. I would also like to modify the 
composition slightly, as it will help me work on my imagination skills while basing my 
decision-making on the foundations that the stock image provides. I will do this by 
changing the orientation of the study. Instead of doing a landscape orientation to match 
our stock photo (as the image is wider than it is tall), I want to create a piece in portrait 
orientation (taller than it is wide). 

By changing the orientation, I'll be less likely to "lock in" and make an exact copy of what 
I see, and instead, take some slight artistic liberties to make a more engaging painting. 
Remember, the photograph already exists, so unless your goal is to make a one-for-one 
perfect likeness to hone (or flex) your draftsmanship skills, what's the incentive to make 
an exact, pixel-perfect copy?

With our goals established, we will now create our canvas so we can dig in and start 
setting up our composition. Once our canvas is set up properly, we will apply a visual grid 
to aid us when we start transferring our drawing. Let's get started by creating our canvas!

Creating our canvas
This project is primarily focused on adjusting an already-established composition,  
and allowing ourselves some freedom in adapting our source material from a photograph 
to an emotive painting. For that reason, I'm going to make a small canvas, both in 
dimension and resolution. This will allow us to work quickly, loosely, and generate ideas. 
Let's get started:

1.	 Make sure Krita is open.
2.	 Create a new document. Width will be 1200 pixels, while Height will be  

1500 pixels.
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3.	 We will set Resolution as 72.00 pixels per inch (PPI) to keep our file size small 
and fast. Our Color model will be RGB/Alpha, and Depth will be 16-bit integer/
channel (Figure 9.4):

Figure 9.4 – The full settings list for our new project document
Once our canvas is created, the first thing we'll want to do is make sure our Grid 
and Guides window docker is open and accessible.
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4.	 On your Settings menu, hover over the Dockers row and make sure Grid and 
Guides is activated within the pop-up menu (Figure 9.5):

Figure 9.5 – The location of the Grid and Guides docker under the Settings menu
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Once active, your Grid and Guides docker should give you a list of options. For this 
project, we will primarily be using the Grid tab. 

Let's take a look at the Grid tab now (Figure 9.6):

Figure 9.6 – The default settings for the Grid tab under Grid and Guides

Some key features of the Grid window include the following:

•	 Show grid – Toggles the visibility of the grid on or off. Note that this grid is only 
viewable in your document while editing it within Krita as, if you export an  
image with the Show grid option enabled, you will not see the grid in the final 
exported image. 

•	 Snap to grid – Enables the ability of your Brush and Text tools to snap to the grid. 
Also allows the Move tool to move any objects or layer contents using the confines 
of the grid as well.

•	 Type – Here you can choose between the grid styles of either Rectangle  
or Isometric.

•	 X spacing and Y spacing – The number of pixels between each line of the grid,  
on the x and y axis, respectively.
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•	 Subdivision – Creates subdivisions within your established X spacing and Y 
spacing parameters. The inner lines of each cell become subdivisions. 

•	 Main Style – The visual look of the grid's main lines (as decided in the X spacing 
and Y spacing options).

•	 Div Style – The visual look of the grid's subdivision lines (as decided in the 
Subdivision option).

•	 Grid Offset – Changes the starting position of the grid. Normally the grid starts 
flush with the upper-left corner of the canvas, but Grid Offset allows you to bump 
the starting location to the right based upon your chosen X Offset and Y Offset 
numbers, in pixels.

A few other things to consider about the Grid window. On the right of the X spacing and 
Y spacing prompts, you'll notice a chain link icon. This allows you to keep the X spacing 
and Y spacing numbers the same (link icon active) or different (link icon inactive). Also, 
there can only be one grid per canvas, and you can save a document with an active grid as 
a template for later use. You can do this by setting up your image with your preferred Grid 
settings active and going to File > Create Template from Image.

Applying our grid settings
Now that we've discussed just what we're working with regarding the Grid window, let's 
set up our grid for our canvas:

1.	 Make sure the Show grid box is checked.
2.	 In both X spacing and Y spacing, enter 300 pixels.
3.	 For Subdivision, set it to 1.
4.	 For Main Style, choose whichever is most appealing to you. I prefer the Lines 

option, with the default dark gray as the color.
5.	 Since we don't have any subdivisions, we don't need to worry about Div Style.  

We also won't be using the Grid Offset feature, so we can keep this unchecked.
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Your settings should resemble Figure 9.7 at this point:

Figure 9.7 – The Grid window settings for our still-life project

Since our initial canvas was created with a width and height value both divisible by three, 
this gives us a nice, clean canvas of four grid blocks across (as 1,200 divided by 300 is 4), 
and five grid blocks down (as 1,500 divided by 300 is 5). Neat! Who says artists don't  
use math?

Your canvas should now be displaying the custom grid you've created (Figure 9.8):

Figure 9.8 – Our canvas with our Grid settings enabled
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Now that our grid is fully set and overlaid on our canvas, it's time to start transferring  
our stock image!

Transferring what you see
We've now entered the next part of the process, where we finally get stuff transferred 
onto our canvas! Before we get too far into this, we must make a decision that is pretty 
important: exactly how are we going to transfer this information? There's a topic that  
I need to bring up right about now, as there's been an intense stigma around this topic  
for generations.

What could I be referring to? Well, in Chapter 5, Implementing Layer Blending Modes,  
we discussed the use of references in varying capacities. We even mentioned a little word, 
a dirty word, that may have captured your attention or caused wide-eyed gasps: tracing. 

Tracing isn't cheating
The idea that tracing is "cheating" is an art stigma thing that I have some strong opinions 
about. In my opinion, to put it simply, tracing is not cheating. Now, this does have some 
caveats, and they deal with artist intent. Can relying on tracing slow your artistic growth 
regarding hand-eye coordination, eyeballing proportions, and adapting source material 
into something stylistic? Absolutely. Do I think you should trace other people's artwork? 
Absolutely not (as that gets into murky legal territory). However, I believe that artists put 
too much emphasis on the mechanics of "making a perfect recreation" of their intended 
subject and forget about more fulfilling, interesting aspects of creating images. I have two 
anecdotes that I use in classes to show just how little tracing means in the grand scheme  
of things:

•	 If I had a room full of 30 students, handed them a print-out of our apple stock 
image, and gave them an assignment saying "Trace this. The assignment is due next 
Tuesday," I would get 30 different versions of the same image. How is that possible? 
Notice in my instructions I didn't give any sort of parameters such as canvas size, 
materials, composition, or the "amount" of tracing involved. While some students 
would bring in a highly rendered replica of the image on tracing paper, other 
students may only bring the outlined apples on notebook paper, or focus their 
attention on the shadows by using a dark ink wash on a thin linen canvas. Different 
artists have different approaches to their art and emphasize different visual aspects 
of the world around them, even if they "trace."
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•	 Let's say you're working with an art director at a studio, and they want a painting 
of these exact apples, and the stock photo is cleared and approved to be used by 
the legal department. The deadline is tight, and you outright ask if it's okay to 
"just trace the apples" to speed up the process and ensure you meet the deadline. 
The art director gives the go-ahead, so you do it. A few days go by, and at the art 
department meeting, the lead project producer points out your painting among 
all of the others showcased. They say it's outstanding, and exactly what they need 
for the project! However, there are a few slight things that may need adjusting: the 
lighting of the scene needs to be changed from bright and midday to dusk. Oh, and 
the color of the apples needs to be green, not red. Can the wood panel actually be 
more of a metallic table? And, do you mind adding an orange in there as well?

Now, you can see that recreating the exact shape of the apples by tracing doesn't really 
matter all that much, does it? Yes, you can trace the apples and it's not technically cheating, 
but you should also learn and master your fundamentals. Good fundamentals never go 
out of style and will get you away from the temptation of using tracing as a crutch (which 
it often can become if you're not careful). Let's talk about a method that uses aspects  
of tracing, but allows for much more creative freedom: landmarking.

Landmarking your shapes
Since we've discussed tracing, I want to introduce you to a method of tracing that's 
common in both the fine art world and the digital art space. Landmarking is a method 
of loosely transferring basic shapes and proportions onto your canvas, usually using an 
image as a guide. 

We will be landmarking our apples and expanding our composition, all while using the 
Reference Images Tool (which we added to our main toolbar all the way back in the 
Configuring the toolbars section of Chapter 1, Getting Started With Krita). 

Working with Opacity
Another quick method to get our stock photo onto our canvas, without using 
the Reference Images Tool, is the tried-and-true method of importing the 
image on a new layer, using the Move Tool. We can use this tool to position 
the image where we would like based on our grid, and lower the opacity of 
the layer to 10%, or whatever works best for you. Remember, there are always 
multiple ways to approach your problem-solving in Krita!



Transferring what you see     263

Let's get our stock photo added to our Krita project now:

1.	 Click the Reference Images Tool icon (the push-pin styled icon) in your toolbar 
(Figure 9.9):

Figure 9.9 – The Reference Images Tool on our modified toolbar

2.	 Now, locate your Tool Options window. If it is not present, you can open this 
docker via the File menu by clicking on Settings > Dockers > Tool Options.

The Tool Options tab for the Reference Images Tool provides you with a few 
options that we'll discuss quickly (Figure 9.10):

Figure 9.10 – The Tool Options tab provided for the Reference Images Tool
From left to right, our options allow for the following:

a. Add – Add a reference image from a file location on your computer.

b. �Paste – Paste an image from your system's clipboard (allowing you to right-click 
an image online, then paste it directly into Krita as a reference image).

c. �Load Reference Image Set – Loads a custom Krita Reference Image  
Collection (a proprietary file type for collections of multiple reference images)  
in .krf format.
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d. �Save Reference Image Set – Saves your collected references in the proprietary 
Krita Reference Image Collection file type (.krf) for use later using the Load 
Reference Image Set option.

e. Delete All – Deletes all reference images contained within a document.

Now that we've covered Tool Options for Reference Images Tool, let's bring in  
our stock photo.

3.	 Click on the Add button.
4.	 Browse to find where you've saved your stock image asset (provided in the Technical 

requirements section at the beginning of this chapter).

This will import your stock photo (which will probably be pretty large compared 
to our canvas size), as well as provide a new Tool Options menu for the Reference 
Image Tool (Figure 9.11):

Figure 9.11 – The new Tool Options menu for the Reference Images Tool after image import
Now that you have an image imported, you have a few options such as adjusting 
the opacity of the image, adjusting the saturation of the image, locking the image's 
aspect ratio, and telling Krita whether you'd like to embed the image into your Krita 
file or not. 

Remember, since this is a reference image embedded by a specific tool within your 
Krita document, any images made as references using this method will not export 
as a layer or be visible in your final export. However, if you use the Working with 
opacity method, which was mentioned earlier in this section, the image will be part 
of your overall export as a separate layer (if you export in a file type that supports 
layers, such as .kra or .psd).
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5.	 Manipulate the settings and size of your stock photo using the tools provided.  
I am going to lower the Opacity setting to 10% while keeping Saturation at 100%. 
I'm also going to keep the aspect ratio locked, and keep the saved file embedded 
into the .kra project file.

6.	 I now want to resize my stock image using my grid as a visual aid. I'd like to keep 
the apples as the star of the show, but maybe make them a little off-center, leaning  
a bit more toward the left side of my canvas, a little lower than halfway down  
the canvas.

For a quick glimpse of what is on the canvas so far, check Figure 9.12:

Figure 9.12 – The location of our stock photo on our canvas
This position allows us to maintain the clarity of our shapes, keep the fantastic cast 
shadows of the apples, and also allows us some "playing around" room near the top 
of the canvas, with some spare room near the bottom as well.

7.	 Make sure your Layers tab is visible, and create a new layer. Name this  
layer Sketch.
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8.	 Switch over to your Brush tool (hotkey B on your keyboard).

Find a good sketch brush that you enjoy the feel of. I'll be using the c) Pencil-4 Soft 
brush under the Sketch category tag in the Brush Presets menu.

9.	 With your preferred brush selected, sketch the outlines of your apples, as well as the 
outlines of the cast shadows and wood panel separations.

You may have something similar to that in Figure 9.13:

Figure 9.13 – Our landmarked apple sketch with extended information

10.	 Notice that I've also done faint outlines of highlight and shadow areas using  
a slightly softer touch with a smaller brush size. 

11.	 For ease of readability, I'm going to do some basic cross-hatching in the shadow 
areas to solidify my basic outlining of shadow shapes. This will allow me to paint 
more confidently once we start applying some color and value shifts, maintaining 
my separations of light and shadow. By also adjusting the size of my brush, it's  
very clear for me what my "main outline" shapes are versus my "smaller detail" 
landmark shapes.
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12.	 Once I'm pleased with my loose landmarking sketch, I go ahead and delete the 
reference image for the time being. While I'm at it, I also go ahead and hide my grid 
by unchecking the Show grid button on the Grid and Guides docker.

I'm now left with a loose sketch, and we're ready to take this into the next chapter 
and start painting (Figure 9.14):

Figure 9.14 – Our loose landmark sketch is completed!
Now, if you feel uncomfortable with this quick landmarking method and feel  
like you would rather "eyeball it" to challenge your ability to transfer by eye,  
that's fantastic! 
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13.	 A simple way to do this is to enable the Subwindows mode in the Settings > 
Configure Krita > General > Window tab. Choose Subwindows as your Multiple 
Document Mode option (Figure 9.15), and this will allow you to open new images 
and drag them around your Krita workspace:

Figure 9.15 – Activating Subwindows via the General > Window tab
Once you have the Subwindows mode activated, you can use your workspace as 
more of a "reference board," allowing multiple images to be open right next to  
your painting area.

14.	 With your sketch still open, go to File > Open and open the stock photo image 
itself. Now that you have activated the Subwindows mode, you should see your 
image open in a new window beside our sketch!
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15.	 Before we start drawing, on the new subwindow that is housing our stock photo, 
right-click on the title bar of the subwindow and choose the Stay on Top option  
at the bottom of the drop-down menu (Figure 9.16):

Figure 9.16 – The Stay on Top option of our stock photo subwindow's right-click menu

16.	 With the Stay on Top feature enabled for our stock photo subwindow, you will be 
able to draw on the Sketch layer of your canvas, while keeping the stock photo 
subwindow up! If you didn't have the Stay on Top option enabled, every time you 
would try to draw on your canvas, your stock photo subwindow would disappear, 
and it's no fun trying to wrangle the windows back and forth when you're trying  
to concentrate!

While this chapter may have seemed like a lot of setup for not much "delivery," we'll be 
happy we dedicated a separate chapter to this portion of our study. In the next chapter,  
we can jump head-first into painting, adjusting, and making this piece our own!
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Summary
In this chapter, our goal was to accurately transfer information from a stock photograph 
to a canvas. There are many ways to approach transferring an image, all of which are 
equally valid. Artistic intent, knowledge of skillsets (or lack thereof), setting goals, and the 
willingness to use tools to aid in the pursuit of your goal is a balance each artist must find 
for themselves. Whether you use elements of tracing, gridding, pure transferring-by-eye, 
or a mix of all of these methods, Krita can comfortably handle the task at hand. The tools 
are there; you just need to utilize them in the way that suits your vision the best!

We looked at the Reference Image Tool and the Grid and Guides docker, activated the 
Subwindows mode for multiple windows, and broke down some helpful hints and tricks 
for finding a proper stock image to study.

In Chapter 10, Enforcing Fundamentals, we will be taking this study to the finish line,  
and primarily discuss some helpful tips on painting using actionable steps and a 
methodical execution, while also inviting for true artistic expression. This one's going  
to be a portfolio-ready piece when we're done with it, I'm sure!

Let's get painting!



10
Enforcing 

Fundamentals
In Chapter 9, Setting Up a Still-Life Study, we used a few features within Krita to 
successfully and accurately transfer an image reference onto our canvas. In this chapter, 
we're going to pick up the speed (and the complexity) by bringing the entire still-life study 
of our apples to fruition! 

We are going to be increasing the complexity of some of our steps, and combining 
fundamentals we have established earlier in the book. This is intended, as hopefully,  
we will be able to "multi-task," essentially doing multiple steps in a single step. 

Here's a quick look at the structure of this chapter, and some topics we will be covering:

•	 Working within our framework

•	 Blocking in values using color

•	 Laying in your initial colors

•	 Finishing touches with edge control
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Technical requirements
To follow along with this chapter, you will need the following:

•	 Krita (version 5.0+).

•	 A way to interact with Krita, such as a keyboard, and either a mouse, tablet,  
or touch device with a stylus.

•	 The completed sketch from Chapter 9, Setting Up a Still-Life Study. If you did 
not follow along in the previous chapter, feel free to use my completed Chapter 9 
Krita file (in .kra format) from here https://static.packt-cdn.com/
downloads/Krita_Sample_Files.zip.

•	 A copy of the stock photo used for this project, provided here in the Chapter 9 
folder, https://static.packt-cdn.com/downloads/Krita_Sample_
Files.zip, courtesy of Pexels.com and photographer Suzy Hazelwood.

With our files prepared, we are ready to take this still-life to the final stage! To get 
things going, we will first discuss what our end goal will be with our study, and how the 
framework we created in the last chapter will aid us in achieving our vision. Then, we will 
do a combined value pass and color pass, mixing both aspects in a single combined pass to 
achieve more dynamic colors. 

We'll then use our values and colors to stretch our imaginative muscles by introducing 
more subtle colors for added expression. Then, we will really set our style into full gear  
by refining our piece with some nice, painterly edge control and finishing touches.  
To get started, let's evaluate the framework we created in the last chapter and see where  
it takes us!

Working within our framework
We have a sketched transfer of our subject (Figure 10.1), a high-quality stock photo  
to work from, and enough digital brushes and features within Krita to give us  
infinite possibilities:

https://static.packt-cdn.com/downloads/Krita_Sample_Files.zip
https://static.packt-cdn.com/downloads/Krita_Sample_Files.zip
https://static.packt-cdn.com/downloads/Krita_Sample_Files.zip
https://static.packt-cdn.com/downloads/Krita_Sample_Files.zip
http://Pexels.com
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Figure 10.1 – Our transfer sketch as it appeared at the end of the previous chapter

So, what do we do now? Before digging into our project with paint, it's important to 
realize there can be some pitfalls when doing direct photo studies like this. Working on 
every aspect of still-life at the same time is a recipe for disaster, as a few possible outcomes 
tend to happen:

•	 You can hyper-focus on a specific aspect of the piece (such as colors or texture), 
ignoring the "entire picture" as a standalone piece of art.

•	 You can rely too heavily on the stock photo to give you exact information, to 
such an extent that you don't to deviate from the reference image. So, you could 
potentially spend dozens of hours on something that's not only not fulfilling  
or engaging, but also ends up being boring to look at.

•	 Interest in the project can plummet if things such as values or shapes don't come 
smoothly as you progress. Since this image already exists, the drive to essentially 
re-create the image may seem not worth the hassle once the "ugly phase" of the 
painting process hits. This is especially true when you only do a study of a single 
reference image of more mundane, inanimate objects.



274     Enforcing Fundamentals

Essentially, the problems come down to the fact that the image doesn't move or change, 
and it's also not fun to be a copy machine. How can we make sure we don't fall into the 
"boring, academic" trap of a reference study?

Setting creative limitations
A great, effective way to counter some of these issues before they become problems is 
to set creative limitations. Setting creative limitations, or purposefully limiting certain 
choices, is a helpful practice before going into any art piece, as it allows you some 
boundaries to simplify your decision-making and keep your momentum up when 
working. There's a variety of creative limitations, such as subject matter and canvas size 
(which we've already solved in the previous chapter), but they can also cover things such 
as your color palette, brush choices, and value ranges as well.

Keeping a balance of trusting our source image's information while allowing for artistic 
interpretation is going to be key to making this an impactful study, and there are a few 
rules we will put into place to maintain a sense of ownership and add creative fuel to our 
project and decision making:

•	 We will work with color and value at the same time instead of going from grayscale 
to color as separate steps, as we have previously followed in the book.

•	 We will initially allow only six colors – two shadow tones, two midtones, and two 
highlight tones.

•	 No pure black or pure white is allowed at any point in the process.

•	 Do not go for 100% perfectly accurate rendering; keep things expressive and painterly 
while also staying refined and clean.

Having these limitations in place will force our "creative brain" to stay engaged during the 
entire image-making process. I know that, personally, if I don't set up fun "challenges" 
for myself, I have a bad tendency to become glued to my reference without making any 
artistic changes. While doing a one-for-one exact copy of an image can be a great exercise 
for our rendering and drafting skills, I feel that the best exercises hit a nice balance of 
referenced believability and using artistic imagination.

Before we start laying down paint, there's one more thing I'd like to discuss regarding 
using photographs as reference: levels.

Adjusting the levels
Levels, in the context that we'll discuss here, can be defined as the value range of an image, 
or simply asking the question "how dark are the darks, and how light are the lights?" 
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Images that you find on the internet tend to be "sweetened," or have contrasts and colors 
adjusted to make the image "pop" when viewed on a digital screen (essentially, darkening 
the darks and brightening the brights while adding saturation to colors). This is nice and 
all, however, it can skew the way our eyes process the information if we're not aware that 
these adjustments have been made. Instead of using nice, natural colors that we would see 
in nature and mixing them with traditional paint, we're more likely to take the "extreme" 
option that we see from the post-processed photo.

A perfect example, and something we will discuss in our apple stock image, is the darkest 
darks and lightest lights. In the stock image, the value extremes end up being pure  
digital black and pure digital white, which are not correct in regards to creating  
a traditional-looking still-life painting. Since it's our goal to mimic the "traditional" feel 
of painting with this still-life exercise, it makes sense to bring in our traditional color 
creation sensibilities.

With a traditionally painted still-life, your darkest darks could be created using a mix of 
ultramarine blue and raw umber, making for a very dark neutral brown. This could act 
as a "black," as it would be darker and more neutral than any other paint mixture on the 
canvas while retaining some personality of color, as seen in Figure 10.2:

 

Figure 10.2 – A blue and brown mixture to create "black," next to pure digital black

Having a dark value created by mixing a warm and a cool hue works extremely well in 
keeping the color vibrant in your piece. Small tweaks to your process like this will do  
a lot of heavy lifting in retaining a "traditional" feel to your work. This process of creating 
a "colorful neutral" isn't just for shadows, it can also work well for highlights and your 
brightest brights!

"Pure white," in that same way of thinking, could be created using a mix of lemon yellow 
and titanium white. This will be extremely bright, but will also retain some of the chromas 
of the yellow, giving a vibrance that "digital white" or "pure white" simply doesn't have. 
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While you could use pure black or white paint directly from the tube when making  
a traditional still-life painting, in both traditional painting and digital art, pure black  
and pure white tend to strip the majority of life and personality from colors around them.  
This is because black and white have no inherent "hue" to bounce off and they tend to 
flatten any depth you may have achieved by using color in your piece. Remember in  
the Dissecting a color section of Chapter 2, Reviewing Canvas Properties and Color,  
where we discussed the color wheel and "traveling through" the color wheel instead of 
around it? Think of pure black and pure white as your "extremes," not existing at all on  
the wheel itself.

Let's make sure our photo doesn't have "pure black" and "pure white" by adjusting the 
image's levels, which will allow us to see the color range we will have when selecting colors 
for our values in the upcoming Blocking in values using color section of this chapter.

With our stock photo open in Krita, click on Filter > Adjust > Levels. You can also use 
the shortcut Ctrl + L to bring up the Levels menu immediately (Figure 10.3):

Figure 10.3 – The Levels adjustment menu from the Filters > Adjust section

We're going to look at the two main areas of this menu: Input Levels and Output Levels.



Working within our framework     277

Input levels
The Input Levels area is a diagram that shows the number of pixels of a particular value 
present in your image. We read this slider from left to right, with the 0 area (left) being 
pure black, and the 255 option (right) being pure white. Everything in between is, you 
guessed it, in between pure black and pure white! By sliding the black slider icon, white 
slider icon, or middle slider icon, you can adjust the lightness or darkness of a specific 
tonal region of your image. You will also notice a "peaks and valleys" graph, which shows 
you how much of your image's information exists within a certain value range.

In Figure 10.3, it looks like our highest density is in the lights (as the right half of Input 
Levels is averaging higher for a larger portion of time), but the most extreme value would 
be in the darks (as the tip of that first, left-most peak is the overall highest point on the 
graph). By seeing this information presented in this way, we can get a quick breakdown 
of our image in a tonal way, allowing us some insight into what we can focus on while 
we paint. Namely, this graph is telling me that I'll have more room to play around with 
colors and hues in the lights, but the darks will be pretty contrast-heavy and drastic. With 
that being said, let me make sure I'm working with some more "natural" colors and fewer 
"post-processed" adjustments that the photographer may have made.

For instance, I am going to bump the black slider icon slightly to the right (toward the 
middle), and the white slider slightly to the left (toward the middle) (Figure 10.4):

Figure 10.4 – The adjusted black and white sliders for Input Levels
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You've probably noticed that the numbers for our respective outer values have changed. 
Instead of our black levels being directly at 0 (meaning no light), they're now bumped 
to 6, meaning we're slightly lighter than pure black. Likewise, our white levels have now 
been changed from 255 (full brightness) to 249, meaning the brightest white is now not as 
harsh, and ever-so-slightly darker than pure "monitor light" white. You will also see these 
changes impact your image while you adjust the sliders, so be sure to see how the image 
is changed! Of course, if you'd like to lighten or darken your midtones, you can move that 
middle gray icon to the left (to darken) or to the right (to lighten) of the gradient slider, 
with respect to the adjustment you'd like to make.

Output levels
Output levels define the "value rules" that input levels will play by. If you take a glance  
at the Output Levels slider, it looks like the Input Levels slider, but a bit more basic 
(Figure 10.5):

Figure 10.5 – Our Output Levels slider

Here, you'll see that the output levels control the "global amount" of our value range for 
the image, regardless of how much of each value is present in the image itself. If you'd like 
to ensure that your images don't have pure black or pure white in them, you can slide the 
respective icon toward the middle of the scale. For our purposes, I'm actually going to 
replicate the settings I have for the Input Levels gradient slider, making our darks go to 6 
and our lights to 249. This takes the aggressive "flatness" out of the darks and lights, giving 
us a more pleasant image to work with regarding choosing colors for painting. Now, these 
numeric values of Output Levels don't have to match what Input Levels show, but it's  
a nice starting point to find some balance in your tonal range.
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A few other options on the Levels menu that I'd like to point out are the Auto Levels 
button, and the Create Filter Mask button (Figure 10.6):

Figure 10.6 – Additional options, including Auto Levels and Create Filter Mask

By clicking the Auto Levels button, Krita will run a quick evaluation process on your 
image and dictate "optimal value levels" for what you have present in the image. If you 
have no real clue on where to begin on altering your image, or are just curious about how 
well your value control compares to Krita's algorithmic balance of values, the Auto Levels 
option may be a great way to get started! Also, by clicking the Create Filter Mask button, 
you will make all of your levels change on an editable layer mask, giving you even further 
control. If you would like to keep your painting the way it is, but want to have the "option" 
of going back and forth between a level-adjusted version and your base version, the 
Create Filter Mask button is a perfect way to go.

Now that we have tackled the idea of adjusting the tonal levels of our image, we can get 
into the more manual, painterly take on value control: selecting our colors for blocking in 
our subject!

Blocking in values using color
As we established earlier, in the Setting creative limitations section, we're going to tackle 
three of our challenges, all at the same time. First, we're only going to be choosing six 
colors initially, three sets of two to correspond with our shadows, midtones, and highlights 
respectively. Second, instead of working in grayscale to block in our initial values,  
we'll be working directly in color for the entire process. Third, we are not allowed to use 
pure black or pure white in this study; however, that doesn't mean we can't use some 
extremely dark or light colors!
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Letting Value Do The Work
Up until this point of this book, I have been very adamant that value takes 
precedent over the other aspects of color (hue and saturation, respectively). 
Enough so, that in our previous five-chapter long landscape project, we started 
with a "value pass" of black and white to block in our values in Chapter 3, 
Utilizing Layers and Layer Groups, then added color with a layer on top of our 
value pass set to the Color blending mode in Chapter 5, Implementing Layer 
Blending Modes. If you feel more comfortable with this "splashing color on top 
of values" method we practiced during our landscape project, feel free to do so! 
However, just know that you'll get some really interesting, vivid results if you 
work directly in color from the start. It's a big leap of faith to work directly in 
color, but I believe in you!

Our first order of business is to find our initial six colors that we will be using as a baseline 
for our painting. Think of this as finding your "limited palette" in place, giving you not 
only your tonal range but your overall mood for your piece. While I'll be looking at the 
stock reference, I'm actually going to choose my colors by eye. Let's take a quick look at  
a small portion of our stock image to discuss our problem-solving process (Figure 10.7):

Figure 10.7 – A small snapshot of our stock image, with all six of our tonal colors present
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This is a great snapshot, as it has the full value range present in a single area of the image. 
While we can see some very bright colors (especially the highlight of the apple, alongside 
the direct light source coming in from the left, and the more yellow-orange textured areas 
of the apple), we have some highly saturated midtones (the very saturated reds next to the 
highlights, for instance), and some deep shadow colors (from the shadow of the apples 
cast onto the wood panels, and the darker red form shadows as the apples face away from 
the light source). 

Doing this dissection, I've made these overall decisions for colors based on observation:

•	 Highlights – A very bright, low saturated yellow for the highest highlight on the 
apple, and a slightly more saturated, slightly darker red to inform the cast light from 
the wood panel onto the bottom of the left-most and middle apple.

•	 Midtones – The highly saturated red (although darker than the highlight red), and 
that nice neutral yellow-orange for the apple's textures.

•	 Shadows – The lightly saturated (although very dark) purple for the apple's cast 
shadow onto the wood panel, and the slightly more red version of the same value to 
act as the form shadow of the apples themselves.

A quick look at my palette (which will also be included as a separate layer in this chapter's 
final Krita document provided to you at https://static.packt-cdn.com/
downloads/Krita_Sample_Files.zip) can be seen in Figure 10.8:

Figure 10.8 – My six selected "color values" to block in our still-life study

There's a saying about choosing values, and it goes as follows:

The lightest dark will be darker than the darkest light. The darkest light will still be lighter 
than the lightest dark.

While it's almost a tongue-twister for your brain to think about, essentially this can be 
interpreted in the following way.

https://static.packt-cdn.com/downloads/Krita_Sample_Files.zip
https://static.packt-cdn.com/downloads/Krita_Sample_Files.zip
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On a nine-point value scale (1 to 9, with 5 being the exact middle gray), where 1 counts as 
pure black, and 9 counts as pure white, the higher the number, the higher the brightness. 
If your highlights end up being 7 and 9 on the value scale, for instance, your midtones by 
definition of being darker than highlights, cannot be 7 or above on the value scale. In that 
same way of thinking, if your shadows exist on 1 and 3 on the value scale, your midtone 
number cannot match or go below 3 (Figure 10.9):

Figure 10.9 – A nine-point value scale, with 5 being pure midtone, for your reference

Essentially, don't mix your values! In the initial block-in phase, it's much easier to block  
in using simple, direct values to make sure your lights, darks, and forms read well at  
a distance. 

Using Figure 10.7 and comparing it with the value scale of Figure 10.8, we can see if  
we achieved our goal of value clarity (or non-overlapping) for our colors. After 
observation, I would argue that the results are as follows (from left to right as shown  
in Figure 10.7):

•	 Highlights – 8 and 6

•	 Midtones – 5 and 3

•	 Shadows – 2 and 1

Awesome! Our highlights, midtones, and shadows have all been chosen and follow that 
golden rule of value control. Let's select your colors and add them to your project:

1.	 Go ahead and make a new layer on your open project, and call this layer  
Six-Tone Palette.

2.	 Choose your six colors, making sure you keep in mind where they land on the  
nine-step value graph. 

3.	 Choose a nice, opaque brush to put your six tones onto your canvas. For placing in 
my tones, I used the f) Bristles-5 Flat brush from the Paint category.
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4.	 Place your highlight color pair, your midtone color pair, and your shadow color  
pair in a dedicated space, separated from one another on the Six-Tone  
Palette layer.

5.	 Don't overlap your values; be sure to keep them separate, not only by having them 
physically not touch but not repeating places on the value scale! Basically, you don't 
want your midtone values to be dark enough to confuse your viewer into thinking 
they're shadow values, or your lights to be so neutral that they start approaching  
(or intersecting with) our midtones.

Now that we've put our palette on our canvas on a new layer, we're ready to lay in these 
selected colors based on our initial sketch!

Laying in your initial colors
We have our six-tone palette now as part of our canvas, which allows us to simplify our 
shapes and values while working directly in color:

1.	 With your project open, create a new layer and name it Value Block-In.
2.	 Move this layer to be the second to-bottom-most layer on your Layers panel 

(meaning the Sketch and Six-Tone Palette layers will be above it on  
the Layers panel window, while the only layer below it would be our initial 
Background layer.)

This will be where we put our initial colors. At the end of Chapter 9, Setting Up  
a Still-Life, we covered a way to set up the Subwindow mode – a mode where  
you can have two Krita windows open side-by-side. This is a fantastic way to keep  
a reference open while you work, and will be incredibly helpful for the remainder  
of the study.
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A quick look at my workspace setup can be seen in Figure 10.10:

Figure 10.10 – An overview of my workspace, using my stock reference as a subwindow
Having our stock image set up directly beside our painting canvas is incredibly 
valuable as, at any time, we can select our stock image subwindow and zoom,  
move, and manipulate the image to aid in our painting process, all without covering 
our canvas. Even though we've placed in our guiding sketch to aid in the placement 
of our values, having our images right next to one another will make this step even 
more relaxed.

3.	 With your Value Block-In layer selected, choose your darkest shadow color  
(by hovering over the shadow color you'd like from your Six-Tone Palette 
layer, and using the default shortcut of Ctrl + Left-click to select it).

4.	 With this darkest shadow color, go ahead and block in the cast shadows of your 
apples, as well as the "darkest darks" of your apples. Use your guiding sketch to  
help you!

Don't worry if you're not exactly staying in your lines at this point; we will be going 
from "broad strokes" to "more specific shapes" as we add more layers and steps.

5.	 Once you are pleased with your darkest shadows, select one of your midtone colors, 
and block those in to be next to your darkest shadows. Once again, don't worry  
if some of these colors and values overlap; this is what we want to happen!
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6.	 Finally, select your highlight colors and block those in as well (touching the 
midtones you have placed in).

My quick pass can be seen in Figure 10.11:

Figure 10.11 – Our initial Value Block-In layer using our six-tone palette
Notice that, while I've stayed locked in and used only my six-tone palette, I've added 
a little bit of variety to my shadows, midtones, and highlights by sprinkling in the 
other color from their respective category.

While the cast shadow of the apples primarily consists of my darkest dark, for 
variety I added a little bit of the more red-focused shadow tone. While we are still 
following the rules of keeping our shadows, midtones, and highlights separate,  
we're free to mix the two colors within each category.

7.	 Once you've set in your initial shadow, midtone, and highlight colors, make  
a new layer.

8.	 Name this new layer Added Color Flair. Make sure this layer is on top of our 
Value Block-In layer.
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9.	 Choose a nice, wet brush for this step. I have chosen the i) Wet Bristles brush from 
the Paint category tag.

10.	 With both your stock photo and your painting canvas open, choose some colors 
that are not part of your Six-Tone Palette layer and integrate them into your 
painting. Feel free to color pick directly (with the Ctrl + left-click default shortcut) 
or use the skills you learned about comparing colors during Chapter 2, Reviewing 
Canvas Properties and Color.

I make sure to start introducing some of the lighter yellows into my midtones,  
while ensuring they don't interfere with the lightest lights of the highlight colors 
I've chosen. Since this is a new layer, feel free to experiment with different colors 
and tonal values here, really comparing your work versus the stock image. While 
we don't want to have a one-for-one photocopy of our stock image at the end of this 
project, using it as our guide and interpreting what we see is the main goal.

During this phase of the project, I'm constantly zooming, color picking, and 
noticing changes and transitions between colors, values, and shapes. A quick glance 
at what I have so far can be seen in Figure 10.12:

Figure 10.12 – Actively adding in new color relationships on the Added Color Flair layer of our painting
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As you can see, I'm starting to lay in some "transitional colors," trying to bridge the 
gap between midtones-to-highlights as well as from shadow-to-midtones. Namely, 
I'm using a more yellow-orange color to start adding in some of the foremost 
texture on the apple, as well as some slightly deeper darks in the portion of the 
apples where the stems sit. Let's keep pushing our textures by utilizing a dry  
brush pass:

11.	 Create a new layer.
12.	 Name this layer Dry Brush Textures.
13.	 Choose a few brushes that can add a bit of "dry" texture to add a bit more visual 

interest to our piece. 

Essentially, these "dry" brushes will have gaps within their brush tips to mimic  
a brush whose tip has "dried out," making the spread of paint uneven. I chose 
g) Dry Bristles and g) Dry Brushing, both of which can be found in the Paint 
category tag.

14.	 Continue color picking (or eyeballing color shifts) and implementing subtle color 
changes using your dry brushes.

You'll start noticing that because the spread of paint is "uneven" with these dry 
brushes, the apples and wood panel are starting to get a sense of depth that wasn't 
there previously. This has to do with the idea of controlling our textures using the 
basic rule of "information versus no information," a topic we'll go further into later 
in the Finishing touches with edge control section of this chapter.

Controlling Your Brush Movement for Greater Impact
A great tip when using a variety of brushes is to focus on the angle of the 
brushstroke itself while you work. Since we are painting apples, be sure to 
make your brushstrokes "follow the curves" of the apple. Imagine a trail of ants 
crawling across the surface of your object, and do your best to "trace" the trail 
the ants would create. This will not only ensure you retain the form of your 
object but will give your brushwork a gorgeous, natural feel.
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You can see a quick look at my current progress in Figure 10.13:

Figure 10.13 – A look at the 'dry brush' pass in relation to the stock image on the left

One thing I'm keeping in mind while I work is adding some brighter, higher saturation 
pops of red connecting the shadows and highlights. Another thing I'm keeping in mind is 
making sure that the cast shadow of the apples has some visual interest by introducing  
a darker shade of the wood panel's grays into the shadow area, while shifting the tint to be 
a bit on the cooler side.

Hopefully, you're seeing how this still-life study is coming together, utilizing your 
brush choices and tonal value relationships! I think we have a comfortable grasp of our 
composition and basic color block-ins, so now it's time to focus on finishing, with edge 
control and controlled rendering.

Finishing touches with edge control
Every step up until this point can be viewed as "setting up" for this final portion of our 
project. Newer artists, and even some seasoned professionals, seem to doubt themselves 
when it comes to crossing the finish line on a piece. How do you know when a piece is 
done? Are there any ways to ensure that your piece is the very best it can be? What are  
a few things you can do to give yourself a little more peace of mind, feeling confident that 
you've done everything within your power to make an impactful piece of art?
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While I don't believe there's a "one-size-fits-all" magic answer, I can think of two main 
things to look for while you're pushing to your final phase of completing a piece of art:

•	 Control your edges. Make sure there's a variety of hard edges, soft edges, lost edges, 
and "painterly" edges.

•	 Find a focal point and highly render that specific area to give contrast to the rest 
of our piece. The human eye can only focus on one thing at a time, remember? 
Embrace this limitation to bring life and a sense of human emotion to  
your painting.

To get into the correct mindset, let's discuss the various types of edges you can have within 
a painting. After that, we will cover some great rendering techniques to push our piece 
further, tweak our piece with fine detailing and glazing, and focus on the often-overlooked 
technique of smudging to really add some emotional depth to your piece!

Discussing edge types
Edges can be defined as the shift of colors, planes, values, or objects in a painting.  
I remember my mind being blown when the realization hit that there are no such things 
as "lines" in real life, only edges. That's a wild idea, so let's cover some examples to aid in 
the understanding of that concept.

Making a "line drawing" of something is simply creating the contrast of a hard edge 
against a backdrop, signifying the shapes and contours of an object in relation to its 
surroundings. Lines in nature (such as the edge of a desk, the bits of mortar between 
bricks on a building, or a silhouette of a tree against a bright sky) only exist as a contrast 
of planes, color, and value against their surroundings. Even notebook paper (the type 
with the blue "lines" to guide where you write) is simply a sheet of paper with a difference 
between the white backdrop of the paper, and the blue "guiding line," which is simply  
a contrast of color in a predetermined, measured way to aid in a task.
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I bring this up because thinking of edges as a tool you can use will level up your art 
significantly, and without too much effort! Let's dissect the main types of edges you can 
find in a piece of artwork. We can use Figure 10.14 as a guide while defining our edges:

Figure 10.14 – Showcasing hard (A.), soft (B.), and lost (C.) edges in our piece so far

Here's a quick rundown of Figure 10.13, highlighting the differences between edge types 
and where they can be used for maximum impact:

•	 Hard edges consist of a sharp, sudden change from one color, value, or shape to 
another. In our example (A.), a hard edge separates the apple's cast shadow from the 
wooden plank.

•	 Soft edges consist of a smoother transition, usually being a more subtle gradient 
from one color, value, or shape to another. In our example (B.), a soft edge is 
blending midtone colors into one another for a smoother texture appearance on the 
foremost apple.

•	 Lost edges consist of no edge, bridging two separate shapes into one cohesive shape. 
In our example (C.), this can be seen as the form shadow of the back apple blending 
seamlessly into the cast shadow portion closest to the apple itself. 
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While these are the three types of primary edges you're likely to find in a painting,  
I actually want to discuss a "fourth" edge that I'm pretty fond of, even if it doesn't really 
exist on its own. The painterly edge can be defined as an edge that "breaks the rules" of 
edges in a fun and creative way (Figure 10.15):

Figure 10.15 – Painterly edges, breaking the flow of hard edges in a creative way

 Notice in Figure 10.15 how the standard "hard edges" of the apple's outline and the apple's 
cast shadow are broken up by smudged marks, giving the eye something of interest to 
look at. While these smudges, pushes, and knife scrapes don't "make sense" from a logical 
standpoint, they can be a fantastic way to add emotion, spontaneity, and interest to your 
work. We will play with these as we get closer to completing our piece.

Now that we have a basic understanding of edges and how they can impact your work, 
let's dive in and start rendering by using what we know.

Rendering and pushing to the final piece
We've made it this far, so now it's time to finish this piece up! I am going to be dissecting 
and comparing our stock photo to our painting a bit more as we work through these steps, 
so the pace may slow down a little bit. However, use this time to really play and experience 
what different brushes, edges, blur tools, and layer masks can do for you.
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Let's have a quick comparison shot to see where we can start our refinement process 
(Figure 10.16):

Figure 10.16 – A zoomed-out comparison shot of our stock image and painting side by side

It's a good idea during your painting process to zoom out and do an at-a-glance 
comparison with the item you're doing a study from. There are a few things I already 
notice about my painting when compared to the stock photo that I want to look at during 
this final push:

•	 The shadows, midtones, and highlights need to be slightly blended in order for the 
apples to read as round, tactile three-dimensional objects. 

•	 The wooden plank still needs some texture variety to make its surface read as 
different than the skins of the apples.

•	 I really like the shapes of the apples, however, I want to make sure that the edges 
of each apple (the silhouettes) are very sharp, allowing me to go in and add some 
painterly edges for dramatic effect at the very end.

With these thoughts at the front of my mind going forward, I feel comfortable  
knowing where we're headed. You know, it's always helpful to have directions to guide 
your journey!
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Let's go ahead and merge our image at this point, so we can really start digging into  
our brushwork, allowing all of the colors and edges to aid in our paint's believability:

1.	 On your Layers panel, go ahead and hide your Six-Tone Palette and Sketch 
layers. We don't want our sketch lines to interfere with our painting as we start 
refining our brushwork!

2.	 With our Six-Tone Palette and Sketch layers hidden, go ahead and click 
Select All > Copy Merged (the Ctrl + A shortcut for Select All, and Ctrl + Shift + C  
for Copy Merged).

3.	 Paste your merged copy (Ctrl + V shortcut). Rename this new layer Merged Copy.
4.	 With your Merged Copy layer selected, choose a nice blender brush. I have 

chosen the k) Blender Textured Soft brush from the Paint category tag.
5.	 Start blending between the high saturation midtones and your shadows on your 

foremost apple (as seen in Figure 10.17):

Figure 10.17 – Blending in our midtones and shadows using a textured blender brush
A great technique for blending is to use a "circular" motion when you approach an 
edge. Having a variety of brushstroke directions will aid in the believability of our 
painting, giving it a very traditional feel.
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6.	 Continue blending a few smaller areas of your transition, until your edges become 
smooth enough to appear as a gradient. Feel free to change your blender brush for 
this step if you prefer a smoother look (Figure 10.18):

Figure 10.18 – Smoothing our edges to be softer, aiding in the believability of our form
Continue to work your way around the form of the apple, taking note of the 
"smooth" transitions in our stock photo and implementing those into your piece. 
Apply your blender brushstrokes as you see fit.

Remember, the direction of your brushstrokes (even with a blender brush) will 
dictate form!
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After using a variety of blender brushes in and around the changes of colors and 
values, you should have a piece that's looking a little more like the photographic 
reference (Figure 10.19):

Figure 10.19 – Our piece after our "blender brushes" pass
Pretty cool, yeah? The impact of our blender brushes works so dramatically because 
we're working on our merged version of our piece, meaning that every pixel of our 
canvas has visual information that the blender brush can use to smooth and blend 
in a natural way.

7.	 Once you're pleased with your blender brush results, go ahead and create a new 
merged layer (using the Select All > Copy Merged > Paste method from earlier).
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8.	 Name this new merged layer Edge Pass 1.

Since our goal is a "painterly" study, it's important to keep as much visual 
information on the layer as possible. Using a new "blank" layer can still work if you 
prefer that method, but the beauty of Krita's brush engine is the natural way colors 
and tones can melt into one another – an effect that is not quite as impactful with  
a "blank" layer on top of a layer full of information. Experiment with which way you 
like best!

Our goal for this layer is to refine our apples' stems, as well as work on the sharp 
silhouettes of our apples.

9.	 Choose a good default brush. I'll be using the b) Basic-5 Size Opacity brush from 
the Paint category tag.

10.	 Start placing your marks to sharpen your apples' stems. An effective way to do this 
is to color-pick some of your darker darks already on your canvas, and "draw" using 
your paintbrush (Figure 10.20):

Figure 10.20 – "Drawing" our detailed stem using a default paintbrush
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Also notice that I'm adding in a bit of shape refinement (with hard edges) to the 
stem's shadow area, and the area on the apple where the stem is sprouting from. 
Remember, values and colors only work in relation to one another. So, if something 
isn't looking correct to your eye, make sure that the relationships are working 
immediately surrounding the "problem area."

Now, we're going to take this idea, and work on the silhouettes and shape 
relationships on each apple, not only in relation to each other but to the wood plank 
and overall composition as a whole.

11.	 Staying on our Edge Pass 1 layer, start refining the shapes around the foremost 
apple using your same default brush. The goal should be a very sharp "outline" of 
sorts for the apple.

12.	 To help with this, I color-pick (Ctrl + left-click) a color right next to the edge I want 
to refine. This will allow my colors from the wet, blended "painting" pass to inform 
the edge's colors directly (Figure 10.21):

Figure 10.21 – Color-picking a darker red (circled) to apply to  
the foreground apple's edge to make it sharper (as shown by the arrow)
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13.	 I make sure to get rid of any "noise," or bits of texture that surround the silhouette as 
well. We want smooth clarity for this pass!

After a full outline of my shape, I have something that looks like Figure 10.22:

Figure 10.22 – Our refined foreground apple compared to our stock photo reference
We're getting there! It's always exciting when you get to the "controlling edges" 
portion of a piece, as that's where it really starts to come alive!

You'll probably notice that, because we sharpened the edge of the foreground apple's 
silhouette, it has now become the focal point of our piece. Perfect! We can embrace 
this fact by refining the wooden plank near that foreground apple, and have detail 
"melt away" the further we get from our focal point.

14.	 Stay on your Edit Pass 1 layer, and continue using your trusty default brush.
15.	 Draw in a bit of wood grain detail, as well as the harsher black "guiding line"  

that the wood plank has, as this will guide the viewer's eye to our focal point apple 
even more.
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16.	 For the wood panel detail, try "scribbling" in perspective. You'll be amazed at how 
much even random sharp strokes can infer about our subject when it's following the 
correct perspective!

After a bit of toying around, I have a wood plank (and regarding the full 
composition, a lower-left corner) that I'm pretty pleased with (Figure 10.23):

 

Figure 10.23 – The lower left of our study compared with our stock reference image
Now, we're approaching our last bit of detailing and finishing touches. Exciting 
stuff! Let's go ahead and do a quick "painterly wash," blending some of our edges 
into each other, as well as refining some shapes across the composition to tighten up 
our rendering.

17.	 Create a new layer.
18.	 Name this layer Glazing Pass.
19.	 Find a preferred wet brush that allows for good pressure sensitivity. I have selected 

the f) Bristles-4 Glaze brush from the Paint category tag.
20.	 While looking at your stock photo, compare the amount of texture (or any visual 

information) to what you have in your painting. 
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Do you notice anywhere on your piece that looks barren or less detailed than what you'd 
like? Does the stock image have a certain area of texture that you'd like to see in your 
painting? If so, keep some of these basic tips in mind:

•	 If you would like to add detail or visual interest to an area, a dry brush may be  
a great way to go. The spacing between bristles can act as "details" at a glance and 
aid in putting down detail very quickly.

•	 If you would like to remove detail, or blend areas to make smoother transitions, start 
with a wet brush and use your blender brushes as a "finishing touch" after your wet 
brush passes. This will keep a more painterly feel, as you'll be manually creating 
your blends, instead of always relying on a "blender brush" to do the soft edge work 
for you.

With these points in mind, I know I want to glaze in some color variations into my  
apples, add a bit of dry brush detail to my wooden planks, then go with a blender brush  
to "finalize" the painting, before adding my signature and calling this project complete.

Glazing
Near the end of a piece, I enjoy the act of glazing some colors or applying a light wash 
of color to add visual variety to my paintings. This not only ties our colors together, but 
also allows some added brushstroke variety to give our painting a little extra push of 
refinement. Let's go ahead and glaze some subtle color shifts into our apples:

1.	 Make sure you're on your Glazing Pass layer.
2.	 With your glazing brush selected (mine is still the f) Bristles-4 Glaze brush),  

color-pick (Ctrl + left-click) some of your richer red tones from your  
foreground apple.

3.	 Do some light-touch strokes of color making a subtle "bridge" of color between 
areas of your apple with value shifts, such as from the front shadow of the  
apple, the area where the stem is resting, and the right side of the apple facing  
our cast shadows.

Since our glazing brush (f) Bristles-4 Glaze) is a mix of a wash, a wet bristle brush, 
and a blender, depending on the amount of pressure you're using (if using a tablet) 
or the opacity setting of the brush, you will get a variety of opportunities with  
a single brush!

4.	 Continue color-picking some more subtle yellows, orange-reds, and desaturated 
reds, shaping our foreground apple with light brushstrokes.
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After some passes of various colors, following the shape of the apple, I have something 
that looks like Figure 10.24:

Figure 10.24 – Our nearly-completed foreground apple after our glazing pass

Now that the apple is coming together, it's time to do one final "detail" pass using some 
smaller sketch brushes and dry brushes, before we complete our piece with a painterly 
edge pass!

Adding final details
Now, we're ready to add our final touches, using dry brushes and some detail brushes:

1.	 Create a new layer.
2.	 Name this layer Final Details.
3.	 Select a nice dry brush. I have chosen the g) Dry Bristles brush from the Paint 

category tag.
4.	 Color select (Ctrl + left-click) some of the darker textural areas at the front  

of the apple.
5.	 Apply some dry brushstrokes (at various sizes by using the [ and ] bracket buttons 

to make the brush size smaller and larger, respectively) in the shadow areas to add 
some visual information. Scribbles may work well here; just be sure to follow the 
shapes and forms we've already established!



302     Enforcing Fundamentals

The finishing portion of this painting may seem repetitive (pick a brush, paint in 
some details, smooth out those details, rinse, and repeat), but that's because it is 
repetitive. Rendering (bringing a painting to a polished finish) is a skill of patience. 
Your willingness to spend the time necessary to paint over portions of your piece, 
seemingly over and over again, separates having "okay art" and art that will turn 
heads, especially when creating for a client or art director. 

In fact, I can speak from personal experience. On a 6-week deadline for a card game 
I was illustrating, the initial sketch, color block-in, and value refinement phases 
approved by my art director took a total of 2 working days. The rest of that 6-week 
deadline timeframe? Dedicated solely to the rendering and texture of details. Your 
patience with rendering, and the link to overall image quality, can't be overstated.

6.	 After more repetitive steps, applying some sharp edges, color refinements, and 
wet-and-dry brushwork (all on the same Final Details layer for optimal blending 
and integration), you should have a piece that you're pretty pleased with! A quick 
glance at mine (next to the stock image) can be seen in Figure 10.25:

Figure 10.25 – Our apple study compared to the stock photo after our "details" pass
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Now that we have some great clarity, detail, and sharp edges on our apples, it's time to do  
a quick "painterly pass" to our edges to bring this to a close!

Smudging our paint for the finish
We've already established that by using a mix of wet brushes and blender brushes,  
we can "smudge" some paint, creating a realistic "painterly" effect. This mimics  
a traditional painter's differences of pressure and directional pull on a brushstroke, as, 
unless you're using tools such as a ruler, straight-edge, or another guide, there are going to 
be "wavering" edges in a piece of art. To finalize our piece, we're going to do the same to  
our work:

1.	 Create a new merged layer (Select All > Copy Merged > Paste).
2.	 Name this merged layer Final Pass.
3.	 Select a wet brush and a blender brush. For my wet brush, I have chosen i) Wet 

Textured Soft and for my blender brush, the k) Blender Textured Soft brush, both 
found in the Paint category tag.

4.	 Focus your attention on the dark cast shadow and brighter wood plank area  
(Figure 10.26):

Figure 10.26 – The cast shadow of our apples contrasted with the wood panel
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5.	 Using your wet brush, color-pick (Ctrl + left-click) the wood plank color, and lightly 
mimic a few sweeping "I" and "H" gestures (vertical and horizontal strokes, no 
diagonals) with your brush, going from within the wood plank area (the lights) to 
inside the cast shadow area (the darks).

6.	 Go over these same brushstrokes with your blender brush, using the same "I" and 
"H" motions (vertical and horizontal) in the same locations, smudging the tips of 
the brushwork into the forms you have established (Figure 10.27):

Figure 10.27 – Our "I" and "H" shapes of wet and blender brushes for painterly edges

7.	 Find other areas of harsh contrast around your painting and continue your wet 
brush to blender brush method of making "painterly" edges. Usually, places that 
have your hardest edges work best for this technique.

8.	 For an added impact, vary the sizes of your wet and blender brushes during these 
steps. I'm going to make a point to blend out some edges on my two background 
apples, as it can add a nice "depth of field" effect, further pushing our foreground 
apple as our focal point.

And that's it! I hope you're pleased with your still-life study! I know there's a ton  
of information in this chapter, but I'm confident that the more you practice these 
techniques, the more you're going to find a workflow that works naturally and comfortably 
for your paintings!



Summary     305

My final study can be seen in Figure 10.28:

Figure 10.28 – Our completed still-life study! Well done!

A fully labeled Krita file of this painting can be downloaded from the Chapter 10 folder 
at https://static.packt-cdn.com/downloads/Krita_Sample_Files.
zip, to compare your work with mine!

Outstanding work on this project and the skills we've utilized and learned in this chapter 
are going to come in very handy for our final project….one that we'll get started on in the 
very next chapter!

Summary
In this chapter, we took the initial transfer sketch of our still-life study, and brought it 
to the final piece! We utilized Levels to equalize our lights and darks, creating a limited 
tonal palette for ease of blocking in our values. Then, we chose six color tones to act as our 
values, learning the appeal and workflow of staying with a limited palette. After blocking 
in our initial colors, we started refining texture using a variety of brushes, then did a few 
"painterly" passes with some wet brushes and blenders to tie our final piece together.

https://static.packt-cdn.com/downloads/Krita_Sample_Files.zip
https://static.packt-cdn.com/downloads/Krita_Sample_Files.zip
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In our next chapter, Chapter 11, Working with Concept Art, we will be creating thumbnails 
of environments for a fictional video game. We will be developing ideas using very loose 
brushwork, but focusing on some critical ideas of perspective and compositional tricks 
to sell our ideas to a potential art director. Mood will be the main driver of our work, and 
we'll even learn some great ways to present our ideas to really streamline our presentation!

We're prepping for the grand finale…let's get to it!



11
Working with 

Concept Art
In Chapter 10, Enforcing Fundamentals, we took our traditional painting technique to the 
next level by utilizing Krita's varied feature set to mimic an old tried-and-true art school 
classic: a still-life. Now, it's time to pick up the pace and enter a fairly new illustration 
style (compared to our centuries-old atelier still-life), one that actually has some 
misconceptions in the greater entertainment art industry: concept art.

In this chapter, we will be discussing what concept art entails, the differences between 
creating concept art and illustrations, various fundamental techniques to aid in the 
creation of concept art, and some tips and tricks I've learned throughout working with 
various professional clients in this capacity.
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Here's a rundown of topics we will be covering in this chapter:

•	 Defining concept art

•	 Understanding perspective

•	 Utilizing composition tricks

•	 Keeping things loose

Technical requirements
To follow along with this chapter, you will need the following:

•	 Krita (version 5.0+)

•	 A way to interact with Krita, such as a keyboard, and either a mouse, tablet,  
or touch device with a stylus

Defining concept art
Before we begin our journey on our final project, I think it's only fair to give a definition 
of what "concept art" means in the case of this book. In my mind (and professional 
experience), there are two "types" of concept art:

•	 Very rough block-ins for characters, environments, or visualizing key moments of 
a video game, movie, commercial, or another visual project. This can be as quick as 
a sketch on a napkin during lunch with a client, or a set of multiple options of an 
item, person, or location for our client to choose from, such as "mood paintings" 
(which is what we'll be making) or "turnarounds," where we create a front, rear, and 
side view of an item or character to assist team members with other specializations 
in a company or team environment (such as 3D modelers, technical artists, and 
lighting artists, for example).
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Here is an example of a conceptual "mood painting" that I created for a personal 
project (Figure 11.1):

Figure 11.1 – A quick "mood painting" concept of a ship entering a foggy area. Notice the blend of 
colors, loose linework, and messy brushes

•	 A much more refined, "finished" piece of artwork created for a movie, video game, 
commercial, or another visual project. This is the type of artwork you would see 
referred to as "key art" or "marketing art," also being collected and published in 
the popular The Art of ________ books you have probably seen for sale online 
and at your local bookstore. This is the style of concept art we will be creating and 
completing in Chapter 12, Refining and Creating Cinematic Concept Art, using the 
rules we learn during this chapter.
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As an example of this second type, I've taken the image from Figure 11.1 and done 
a "marketing art" pass, making sure to keep the overall mood and composition 
intact, while bringing about a sense of completion to the illustration with a mix 
of photobashing, impasto brushwork, and removing the line art. You can see the 
results of this pass in Figure 11.2:

Figure 11.2 – The "marketing" art version of our ship idea, developed  
using various techniques, such as edge control and photobashing

Notice that Figure 11.2 has a more comprehensive feel, pushing our initial concept to  
a new level of detail. While you could say that Figure 11.1 is a "sketch" while Figure 11.2 
is a "final," the same theory applies when it comes to stages (and uses) of concept art. 
Sketches lead to designs, designs lead to sketches, and all of these can lead to a finalized 
illustration used for various purposes.

Concepting Styles – Which Is Best?
I feel it necessary to separate these two definitions of concept art as, if you 
search for "concept art" on the internet, you're more likely to find examples 
of the second bullet-point definition of the term (the more refined, finished 
work used for marketing, such as our example in Figure 11.2) rather than the 
first. Many times, the "napkin sketches" and initial design documents are in 
sealed project files, owned by their respective developers and companies, never 
seeing the light of day. Concept art, no matter what the stage of completion 
or complexity, is valuable during all stages of a product's development cycle. 
There's no "correct" way of defining concept art; it all depends on the task at 
hand. When in doubt, ask your client or team what they need! If it's a personal 
project, ask yourself what kind of sketching could help you solve problems later 
down the line!
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The muddy reality of "concept art" can give hobbyist artists, students, and even new 
professional artists a wrong (or rather, misguided) idea of what concept art is and how it's 
utilized in a professional pipeline. Concept art does not need to be attractive to be effective. 
It is primarily used for problem-solving, and dissecting designs in a capacity that is useful 
and actionable for various team members to use in their creative process. Remember, as  
a professional painter (or hobbyist, or even a hobbyist wanting to go professional), 
your aim is to be a visual communicator before anything else, no matter who your final 
audience ends up being. Communication is key!

I wanted to open this chapter in this way to get your mind prepared for our final project. 
Instead of the atelier, "paint what you see," objective, realistic approach to creating 
artwork, this final project is going to venture into imaginative realism. How do you paint 
what doesn't exist?

Contextualizing concepts
In order to paint what doesn't exist, you should approach your fictional reality with 
the artistic foundations present in real reality. What makes a solid image when you're 
painting from life? Things like composition, focal points, color choices, brushwork, and 
edge control don't just disappear when you work from imagination; if anything, they're 
more important than ever! Using artistic fundamentals can give us context while we 
create something from imagination, whether it is for personal work or from a professional 
prompt. Let's get to the good stuff. Let's discuss our prompt for our final project:

Create an environment for a video game that a player would be interested in exploring.  
Use whatever is in your artistic toolbelt to make an image that is compelling, nice to look at, 
but gives a sense of exploration of a world that is not our own. Trinkets or machines  
of a past or future civilization can add to the sense of wonder, but above all else, make the 
image engrossing.

This may seem like a broad description open to tons of interpretation, but I can assure 
you that this is closer to a professional prompt than you might think. Sure, you may have 
something such as an art bible (a design document outlining the visual identity of  
a brand, intellectual property, or already-established creation to ensure that future designs 
"fit well" with what is already established) to aid in this task when working with a client, 
but a lot of the time, you're on your own. This is where communication with your art 
director or fellow artists on the project is the key. 
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Making a list, checking it twice
Now that we have our brief, your mind is probably racing with ideas! Or, just as common, 
you may have a mental roadblock in front of you, the trusty "paralysis by analysis" that 
rears its ugly head when we don't know how to get started. This prompt is very broad in 
its expectations, but there are some keywords from our creative brief that we can dig into 
to get the creative juices flowing. Let's make a list of some of these keywords, with some 
very quick "brainstorming" ideas that come to mind for each to help us contextualize this 
prompt with some actionable items:

•	 Exploring – Something vast (large area), with several travel opportunities (various 
focal points?).

•	 Compelling – Sort of an empty phrase in my opinion, but maybe something that 
catches the viewer's and player's eye (high contrast near focal points, maybe?).

•	 World not our own – Some sort of visual dissonance (shapes that don't fit together, 
or the rules of gravity don't apply, for example).

•	 Trinkets – Small doodads or man-made items (pipes, books, torches, or crystals that 
emit unnatural lights).

•	 Machines – Larger man-made items (things that make the world functional such as 
gears and pulley systems). These could tie into the Trinkets by using similar shape 
language (diamonds or spheres, for example).

•	 Past or future – Dilapidated machinery? Or, maybe a nice mix of both future and 
past (such as the worn-out ships in Star Wars or Battlestar Galactica, having new 
fancy technology that is "old and rusty" in the lore of the world).

•	 Sense of wonder – This ties into Exploring and Compelling; maybe use 
complementary colors with some higher saturation near the focal points as well.

•	 Engrossing – Once again, kind of an empty phrase, but the first thing that comes 
to mind is "atmospheric" (such as dense fog or clouds) to ground you in the 
environment and give a sense of depth.
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Alright, so we've made decent progress, even without lifting our stylus! We went from 
having a very open-ended creative brief to a prompt that is a little more digestible and easy 
to understand: 

A big environment that features some machinery that looks large and other-worldly,  
with a moody atmosphere and bombastic colors with good lighting.

While this is still an open-ended description, these are terms we can work with! It's taking 
a creative brief that is very emotional in its expectations and creating some logical context 
for us to utilize our artistic problem-solving skills. Making a list and brainstorming ideas 
is a fantastic way to get through the muck of a dense description of what a client might 
need. In fact, I highly recommend this exercise for every piece of art you make, no matter 
if it is from imagination, for a client, or a study from life. The more information you have 
before beginning, the more you are setting yourself up for success!

Looking at our newly-revised prompt, I'm excited to get started! I already have a few 
ideas (three in particular), but I need to do a few quick reviews of some very basic art 
fundamentals. This first fundamental deals with not only creating a compelling and 
coherent image but will also greatly help us with a number of our bullet-listed  
keywords: perspective.

Understanding perspective
Perspective, in its most simple sense, is the technique in which you take something 
that is two-dimensional (a drawing or painting) and give its contents a sense of three-
dimensional space. Alternatively, you can think of perspective as the viewer's eye line. 
What is our perspective of what we're looking at? Are we above our subject, looking down? 
Are we eye-level with what we're looking at? Are we viewing our subject from below,  
or does it have a crazy effect such as fish-eye lenses? Each one of these options can give the 
viewer a different narrative of your artwork and can be very impactful in selling a concept 
correctly. Let's break down the three most used perspectives in painting, all of which are 
considered linear perspectives – one-point, two-point, and three-point perspectives.  
Let's start with one-point perspective.
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One-point perspective
One-point perspective is defined as a perspective grid that consists of a single vanishing 
point (or "one point") on a horizon line (or the viewer's eye level) (Figure 11.3):

Figure 11.3 – A one-point perspective grid, with the red line acting as the horizon line

Notice how each line goes back to the single dot (vanishing point) on our horizon line 
(the straight horizontal line in red). This is the most basic form of adding depth to an 
image and can be highly effective at giving clear focal points, a sense of stability (as there's 
not a lot of variance in directions for the eyes to travel), and a clean design sense. You 
can see this a lot in background environment design for television, movies, and even 
architecture prompts. 

A great example of one-point perspective in the real world is this photograph, entitled  
Taj Mahal under Clear Blue Sky, by artist Fuzail Ahmad, courtesy of Pexels.com  
(Figure 11.4):

Figure 11.4 – Fuzail Ahmad's photograph showcasing the clarity of  
one-point perspective (courtesy of Pexels.com)

http://Pexels.com
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A gorgeous image with a very clear, centered focal point. There's no mistaking where we 
should be looking, or if we wanted to use this as a visual reference for our prompt, where 
we should be exploring! 

I recommend doing quite a few pieces using one-point perspective to start developing 
your comfort with using things such as horizon lines and vanishing points. How does 
your composition change if your horizon line is higher on the page? What if it's lower, 
giving you more room to explore the sky? What if your vanishing point isn't centered on 
the page, but on the extreme left or right of your image? Does that potentially change the 
meaning or emotional impact of the image?

Once you have a solid grasp on developing a one-point perspective image, you can add  
a bit of complexity by going for two-point perspective.

Two-point perspective
Two-point perspective can be defined as an image with a single horizon line, but two 
vanishing points. While this seems self-explanatory and not much of a change from 
one-point perspective, I would argue that the complexity of images you can create using 
two-point perspective is vastly higher than using only one-point (Figure 11.5):

Figure 11.5 – Two-point perspective, with circled vanishing points on  
the extreme left and right of the composition

Notice in Figure 11.5 that even creating multiple basic shapes, such as boxes, already gives 
a dramatic sense of depth. Much like one-point perspective, the only lines not headed 
toward one of our vanishing points are the lines that go straight up and down, giving  
a sense of verticality. Two-point perspective is a valuable asset in giving the viewer options 
on which direction their eye could follow, and works as a perfect "fork in the road" for  
a video game player to make an exploration decision.
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You will likely see this type of composition in cityscapes, particularly at a crossroad  
or junction where two roads meet. A great example of this can be seen in the following 
photograph by Anna Tis, courtesy of Pexels.com (Figure 11.6):

Figure 11.6 – Anna's image gives us a great choice of direction – which way should we explore?

Something to keep in mind, especially with Anna's image, is your vanishing points can 
actually exist outside of your canvas! While the vanishing point on the right-hand side 
of the image is on the right-most edge, the left vanishing point exists a few inches off the 
page (which we can find by using a ruler on the building's upper and lower edge, as well 
as the upper and lower lines of the windows on the left side of the building. I've done this 
exercise in Figure 11.7:

Figure 11.7 – Our two vanishing points, with the left-most point existing off Anna's image

http://Pexels.com
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A great exercise to get accustomed to two-point perspective is to find images or paintings 
that interest you, which you think may have a two-point perspective, and grid them out 
(as I've done in Figure 11.7). Remember, the more information you have, the easier it  
will be to add your own spin on things! Finding perspectives is a fantastic skill set for 
matte painters, landscape painters, environmental concept artists, photographers,  
and cinematographers. 

Once you feel comfortable with your two-point perspective, it'll be time to put your skills 
to the test with three-point perspective.

Three-point perspective
Here's perspective hard-mode, in my opinion! Three-point perspective can be defined as 
a perspective grid that not only has two vanishing points on the horizon line but a third 
vertical vanishing point above or below the horizon line. This gives a very dynamic sense 
of scale and depth but is exponentially more difficult to work with than one- or two-point 
perspective (Figure 11.8):

Figure 11.8 – Three-point perspective, showing two horizontal points and a third, higher vertical point

Adding in the third vanishing point has always been a challenge for me, and I personally 
think that my lack of confidence in using three-point perspective has held back some of 
my creativity throughout the years. Like anything else in art, the more you practice a skill, 
the easier it will become, so I'd like to try my hand at three-point perspective for one of 
my concept ideas in this chapter.

Pushing Yourself
Growth usually happens when you leave your comfort zone. Putting yourself 
out there and pushing yourself past your points of comfort is always a 
positive when it comes to creativity and honing your skill sets. Do you have 
a "weakness" that always makes you nervous to attempt it, such as vehicles, 
environments, or character designs? That's probably the thing you should focus 
on the most for maximum artistic growth!
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The thing I love about viewing photographs, movie scenes, and paintings or drawings 
that have three-point perspective is the sense of dizzying depth. If you have a character 
standing on the edge of a skyscraper, three-point perspective with the vertical vanishing 
point below the horizon line would be an incredible way to sell your audience on that 
sense of height. On that same line of thinking, if you'd like to create a monolithic structure 
or foreboding item that dwarfs us as a viewer, creating three-point perspective can give 
a great sense of being "a small person in a larger world" if angled with your vertical 
vanishing point above the horizon line. For instance, take this stunning photograph from 
Jeremy Levin, entitled Low Angle Shot of Gothic Themed Cathedral, courtesy of Pexels.
com (Figure 11.9):

Figure 11.9 – Jeremy Levin's Low Angle Shot of Gothic Themed Cathedral

While cathedrals are already ornate buildings heavy with details, showcasing one using 
three-point perspective from the ground level (sometimes known as "worm's-eye view" 
instead of the above-looking-below term of "bird's-eye view") almost gives a further sense 
of how intense and mammoth the structure seems. So many ominous, romantic stories to 
be told!

http://Pexels.com
http://Pexels.com
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Going Higher than Three-Points
Can you go higher than three-point perspective, such as four-, five-, or six-
point? Yes! My personal recommendation, however, is to ask yourself why 
you're choosing to go higher than three-point. Is there a narrative reason,  
such as looking through a fish-eye lens (five- or six-point perspective),  
or distorted reality (four-point perspective) to do so? As we've seen, adding 
a single additional vanishing point to our perspective grid exponentially 
increases the difficulty level of our drawing, although it's worth pushing your 
artistic boundaries if you're brave! For the purposes of this overview, I'll just 
be covering one-, two-, and three-point, as those are the fastest to create and 
revise in a professional setting. In your personal work, go as crazy as you'd like!

Making your choice – linear versus curvilinear
You have your full pick of perspectives when creating your art, so it would be wise to 
understand what your artistic intent is before making your choice. Staying with one-, 
two-, or three-point perspective is an example of adhering to linear perspective (as seen 
in Figures 11.4, 11.6, and 11.9), while going above that (four-, five-, six-point, or above) 
would represent curvilinear perspective (where your image will appear as if it is being 
viewed through a curved lens, as seen in the grid and real-life comparison shot in  
Figure 11.10):

Figure 11.10 – A grid and a real-life example of a simplified curvilinear perspective

Much like other aspects of art, there's no one "right answer" that is going to be the perfect 
solution for solving your problem. It's all up to your ability, creativity, and execution.  
For this book, I will be adhering to linear perspective, as it's quick and gets our point 
across quickly. 

While figuring out the perspective of your artwork is a great way to solve problems before 
they occur, another question ties together with that choice: where do I put items such 
as my focal points, or my main points of interest when working from imagination? This 
brings us to the ever-important concept of composition.



320     Working with Concept Art

Utilizing composition tricks
Composition is a term that has quite a few meanings within visual arts, but two of the 
most common definitions I've come across are as follows:

•	 The placement and/or location of items in a piece of art relative to one another

•	 How the "entire piece" works together (think of a composed piece of music, or the 
way all of the components in a car work together for functionality, for instance)

For this chapter, we will be covering the first definition (dealing with the tangible location 
of focal points, angles, and shapes on our canvas) of composition. In regard to the second 
definition, I'm hoping every chapter of the book is helping you piece together your perfect 
methodology for that! Color, theme, movement, value, edge control, and item placement 
all combine to make the second definition come to life. That, come to think of it, could be 
defined as style.

Much like our introduction to various linear perspectives in the previous section,  
we're going to take a very quick glance at a few rules, or guidelines, that can help us place 
our subject matter on the canvas in a visually appealing way.

Defining art rules
While I am of the belief that art doesn't have a set of "rules" that an artist must always 
follow, I do hold the belief that certain techniques have been tried and proven to be 
impactful over the course of hundreds of thousands of art pieces for many generations 
of artists. Not only that, but these results can also be repeated, meaning that an artist can 
embrace their learnings and findings while using these methods, and essentially use them 
in a capacity they find most impactful for their own work through experience. 

You may have heard the saying It's important to learn the rules, so you know how to break 
them, and I find this to be true with things like composition. There's no correct way to 
compose your images, but if you're at a loss during the creative process, these upcoming 
composition tricks can definitely give you the upper hand and help you get started. After 
all, it's impossible to edit what doesn't already exist, so just get your stuff on your canvas!

There are two composition guides we are going to cover that are both effective not only 
in drawing and painting, but in every visual medium, including (but not limited to) 
animation, cinematography, photography, and illustration. These are the Rule of Thirds 
and the Golden Ratio. Let's take a look at the Rule of Thirds first.
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The Rule of Thirds
The Rule of Thirds is a composition technique that states that if you cut your canvas into 
three rows and three columns of equal size (creating a 3x3 grid that matches the height 
and width of your entire canvas), an area where your vertical and horizontal grid lines 
pass through one another is a great area to put a subject you would like your viewer to 
focus on (Figure 11.11):

Figure 11.11 – A landscape template (1,500 px wide x 1,000 px tall), with a Rule of Thirds grid applied

As you can see in Figure 11.11, I've circled the four areas where our vertical and horizontal 
lines intersect. Placing points of interest near one of these intersections (or multiple, if 
your content allows it) is a great way to draw attention to it. There's stability, but since  
the material isn't perfectly centered on the canvas, it brings a little bit more drama to  
the material. 

Likewise, you can also break up your composition into thirds, using either the three 
rows (going horizontally across the canvas) or the three columns (the three vertical 
subsections) to balance out your piece's information. Coupling two smaller shapes in the 
leftmost column, while putting a single larger shape in the rightmost column, will still 
bring a sense of balance to your piece (Figure 11.12):

Figure 11.12 – Three shapes, one large and two smaller, placed using  
the column principle of the Rule of Thirds
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I've lowered the opacity of our Rule of Thirds grid to help you notice the balance that 
having our shapes within the columns can provide. While there's nothing technically in 
the "center" of our composition, there's still a nice sense of balance, as we could visualize 
a scale being "balanced" between the weight of these two columns. Here, in Figure 11.13, I 
show one of my landscape paintings that uses this balancing technique, including the Rule 
of Thirds grid overlay:

Figure 11.13 – A landscape painting of mine, balanced by the Rule of Thirds grid

Notice that I've measured the "weight" of items to be balanced between the extreme right 
and extreme left of the canvas. While there's a large tree trunk leaning toward the middle 
coming from the right-hand side, there are multiple, smaller trees doing the same thing 
coming from the left. Also notice that I've purposefully not centered the sword directly 
in the middle of the canvas, instead choosing to have it leaning in the reverse direction 
(almost perpendicular) of the larger tree trunk, hopefully bringing the viewer's eye back 
to the middle of the canvas.

I've also tried to put something interesting in all nine squares on the canvas, building 
visual interest, but also allowing the eye places to rest by using less information in key 
locations (bottom-right and bottom-left corners, respectively).

Cutting the CRAP
There's actually a funny way you can remember four of the most important 
composition placement tricks. The acronym CRAP stands for contrast, 
repetition, alignment, and proximity. By contrasting shape sizes, you can 
draw attention to one over another. By repeating certain design motifs (in this 
case, the diamond shapes) you can bring about a sense of unity in your work. 
Where the items are aligned can draw attention to them in unique ways (such 
as our Rule of Thirds intersection example in Figure 11.11), and the proximity 
of items can either bundle them together or make them feel separate for 
dramatic effect (such as the shape proximity differences in Figure 11.12).
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The Rule of Thirds is a tried-and-true method of placing your focal points, or information 
you think should grab the attention of your viewer, which has existed for hundreds of 
years. However, many people find the straight-up-and-down nature of the Rule of Thirds 
to be too stoic and limiting for their creativity. For those people, I bring you the  
Golden Ratio!

The Golden Ratio
The Golden Ratio is another method in developing areas to distribute information and 
visual weight to our work. You may have heard this called the divine proportion, as it is  
a proportion of dissecting widths, heights, and width versus height that has been found 
and documented in nature for centuries, but was most popularly brought to light in 
artistic circles (pun intended) by Leonardo DaVinci and his illustration work within the 
Luca Pacioli book entitled De Divina Proportione (or, On the Divine Proportion) which 
was published in 1509. Here is a well-known example of the Golden Ratio labeled with 
some measurements (that will hopefully make more sense momentarily!) (Figure 11.14):

Figure 11.14 – The Golden Ratio shown with collapsing ratios showing  
the limitless nature of the proportion

What? What is that thing? In a mathematical sense, the Golden Ratio equals (roughly) 
1.618 to 1, or 1.618:1. This is considered a "magic ratio" because mathematically, the line 
of your width or height can be divided into two parts in such a way that the entire length 
of the line, divided by the long part of the line, is also equal to the long part of the line, 
divided by the short part of the line.
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See, that makes it perfectly clear, right? No? I thought not.

I won't even begin to act like I'm some sort of master of understanding how or why this 
ratio works. Trust me, I'm no DaVinci, and I'm definitely no Pacioli. I will say, though, 
that there is merit to this ratio being found in nature. There's a sequence of numbers 
that is very similar to the Golden Ratio (known as the Fibonacci sequence) where when 
starting from zero, if you add the next number in the line, you create the next number in 
the line. For instance, let's make a small number sequence example:

1.	 0 + 1 = 1. The last two numbers written here are 1 and 1.
2.	 So, 1 + 1 = 2. The last two numbers written here are 1 and 2.
3.	 So, 1 + 2 = 3. The last two numbers written here are 2 and 3.
4.	 So, 2 + 3 = 5. The last two numbers written here are 3 and 5.
5.	 So, 3 + 5 = 8. The last two numbers written here are 5 and 8.
6.	 So, 5 + 8 = 13. You hopefully get the idea! 

At this point, our Fibonacci sequence is 0, 1, 1, 2, 3, 5, 8, and 13 but could  
continue forever.

You can continue this trend until infinity, which is a neat exercise in itself and probably  
a cool parlor trick. However, there's something interesting about this structure. What 
if you were to divide the total of each equation by the number that came before it? For 
instance, with 5 + 8 = 13, you could do the following:

•	 13 / 8 = 1.625

Hmm, interesting. That's kind of close to 1.618. What about 8 divided by 5?

•	 8 / 5 = 1.6

What about 5 divided by 3?

•	 5/3 = 1.6 repeating

These are all eerily close to 1.618, and if we were to keep going with the Fibonacci 
sequence until we're in the six- or seven-digit number territory, it'd be more accurate and 
closer to 1.618, every single time. Once again, I have no earthly idea what it means, and if 
I think about it too long, I'm probably going to be putting lines of yarn on pictures and 
talking about aliens.
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Investigating These Proportions
There are examples of this ratio not only in nature (for example, flowers and 
seashells) but in items you probably have near you right now. In fact, go and 
grab your credit card; it follows the Golden Ratio very closely. A standard-
sized credit card is 86 mm long x 54 mm tall. 86 / 54 = 1.592, very close to the 
1.618. Sure, it's not exact, but it's a very helpful and abundant reference when 
discussing the Golden Ratio to fellow artists.

How does this relate to art and object placement, though? If you look at the circles within 
each quadrant of Figure 11.14, there's a nice sense of size harmony and relationship 
between the shapes. Also, the curved nature of the spiral path itself is incredibly effective 
at showing the viewer's eye where to look. There's a great sense of momentum to the 
spiral, and your eye actually wants to stay inside of the composition, which is as valuable 
as gold for us artists (once again, pun absolutely intended).

My advice for using the Golden Ratio? The most direct way is to place items on the spiral, 
leading them to a focal point where the spiral becomes the smallest. This can be used for 
environments, portraits, still-lifes, and other studies such as master studies, as seen in 
Figure 11.15:

Figure 11.15 – The Golden Ratio applied to the Mona Lisa and a still-life of flowers in a vase

 A great exercise is to use classic art from artists such as Vermeer, Velasquez, or DaVinci 
(as shown in Figure 11.15), and see if the Golden Ratio appears (and if it does, how  
many times). 
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There's a little bit of controversy with the Golden Ratio, as there are many artists that 
think it's all nonsense, and you can "just slap the Golden Ratio on top of anything" and 
it would theoretically work. That may be true in a reductionist sense, but in my opinion, 
having any guide that allows us to be more confident in our creativity is at least worth 
exploring. It's always best to compare results for yourself and use what works best for you 
based on experience.

Comparing the two methods
That brings us to the question: when creating our artwork, which "rule" is better to follow, 
the Rule of Thirds or the Golden Ratio?

This is actually a trick question as, not only is there not one "correct" answer, but what if 
I told you that they're actually more similar than they are different? Let's take a look at 
Figure 11.16:

Figure 11.16 – The Rule of Thirds grid overlayed on top of the Golden Ratio



Keeping things loose     327

Notice how the Rule of Thirds grid fits snuggly inside the structure of the Golden Ratio? 
The horizontal lines are very close to the middle of the Golden Ratio's box structures, 
while the lower-right "intersection point" of the Rule of Thirds grid is a little above and on 
the inside of the Golden Ratio's "spiral focal point."

All of this is to prove a point: whatever method of composition you choose, you can't 
really make a "mistake," as creating a visual image follows more tried-and-true "rules" 
than just answering the question, "Where do I put these items on my canvas?" Things 
such as value, shape dynamics, hard versus soft edges, perspective, and color choice can 
give a lot of impact to your work, even if composition isn't at the front of your mind. That 
being said, solving the problem of composition early can help you work more confidently 
in the other aspects of image-making, making the entire image-making process more 
comfortable and rewarding from the early stages. Remember, you can't build a good house 
without a foundation.

To close this chapter, we are going to discuss possibly my favorite part of creating 
conceptual art, and that leads us to the sheer amount of art you can create on a short time 
schedule. In order to do this, you must keep things loose while working.

Keeping things loose
Since concept art usually exists in a pre-production environment on a project, its main 
purpose is often to inspire the rest of the creative team you're working with. Some of my 
favorite moments of professional work so far come from being part of the pre-production 
phase known as the "Blue Sky" phase. The Blue Sky phase is all about ideation, and 
daydreaming about "how cool would this be" when creating the first batch of art. This 
allows producers, executives, and other artists to become inspired by possibilities before 
making design decisions on what to keep or what to remove in the context of designs, 
mood, and "feel" that the art provides. 
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When I worked for adidas on their X9000 shoe commercial campaign in 2019, we had 
some Blue Sky sessions to create some inspiring cyberpunk art using location scouting 
images pre-approved by the advertising campaign's executive team (Figure 11.17):

Figure 11.17 – Some loose "Blue Sky" mood art for the adidas X9000 shoe campaign.  
Courtesy of adidas and Black and Cameron Productions

You can see the mix of photobashed assets, color correction, painterly strokes, and general 
atmospheric fog passes. While I wouldn't consider this "marketing art book ready" by any 
means, it worked wonders in allowing the design team to get a sense of what we could  
(or more importantly, couldn't) budget into our filming time. We only had roughly 
2 weeks for the entire production turnaround, so things had to be efficient, fast, and 
accurate. In a production pipeline, it's much cheaper for companies to license out concept 
art from illustrators to "see" their ideas rather than filming/producing/adjusting footage 
and "hoping" their vision comes to life. As is often said, time is money, and skilled 
illustrators can save time and headaches, allowing for smoother production pipelines.

Our goal for this final project, then, can correlate to a "Blue Sky" phase of pre-production 
for the video game we're creating the environment for. In certain genres of video games 
(namely massively multiplayer online games or other roleplaying games such as World of 
Warcraft, Final Fantasy XIV, Neverwinter Nights, or Guild Wars 2), the "blue sky" concept 
art can be used for backgrounds, loading screens, and behind-the-scenes special features 
for players to unlock or enjoy during their adventures. Even though the main usage of 
these images is primarily for ideation and creation of content, they themselves can be 
utilized as content if it is of a high enough level of quality.
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Keep your art inspiring, loose, and grounded using tried-and-true compositional 
techniques, and you'll be making winning images that are sure to be pivotal in the success 
of a variety of projects. Logical problem-solving combined with emotional storytelling is 
always in demand and will ensure you will go far. Buckle up, it's time to get started on our 
final project and bring this book to a close!

Summary
In this chapter, we discussed various forms of constructing an image, namely dealing with 
perspectives and compositional techniques. We first defined three different types of linear 
perspective, and where each is most impactful when creating images. We then covered 
two compositional techniques: the Rule of Thirds and the Golden Ratio. While both are 
extremely effective ways to plan out your images before getting started, remember that 
there's no "right" or "wrong" way to go about it. Art's never that easy, remember?

We then quickly covered the idea of keeping ideas flexible and loose, defining the 'Blue 
Sky' phase as a powerful phase of a pre-production pipeline. We can solve problems, try 
crazy ideas, and do so with a variety of techniques without breaking the bank (both the 
physical money spent for a production crew and our personal mental bank of ideas as  
an artist).

With what we've learned in this chapter (coupled with the other lessons learned so far 
in the entire book), we can now move forward to Chapter 12, Refining and Creating 
Cinematic Concept Art, where we will develop two thumbnail value sketches using our 
prompt, alongside our newly-reviewed perspective and composition theories. After we try 
our hand at two thumbnails, we will choose a favorite, and push it to "final production-
quality," meaning not only will it work as a "Blue Sky" ideation, but as something quality 
enough to be published as part of our imaginary project's marketing materials.

It'll be our most dense chapter yet, but what else would you expect for the grand finale? 
You've done incredibly so far, so let's finish this thing off with style! See you in the  
next chapter! 





12
Refining and 

Creating Cinematic 
Concept Art

In Chapter 11, Working with Concept Art, we discussed using perspectives and 
composition templates (namely, the Rule of Thirds and the Golden Ratio) to pre-plan  
our final project: a cinematic piece of concept art that would be worthy of being published 
in a "Making Of " style artbook for a fictional video game.

Think of this as our "capstone assignment" – something that will utilize tricks and 
techniques we have learned throughout this book. We will put Krita, and ourselves, to 
our highest creative capacity and push ourselves past any preconceived "art skill plateau." 
Since this book is aimed to be a drawing and painting book, and Krita is the ship that has 
taken us on this voyage, it's only right that we ride Krita into the sunset! Or something 
like that – I'm not sure where I was going with that allegory.
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Get your game face on – it's time for the grand finale! In this chapter, we will cover the 
following topics:

•	 Creating two thumbnails for comparison

•	 Choosing our strongest composition

•	 Learning industry-standard paint-over techniques

•	 Applying finishing touches and post-processing

Technical requirements
To follow along with this chapter, you will need the following:

•	 Krita (version 5.0+)

•	 A way to interact with Krita, such as a keyboard and either a mouse, tablet, or touch 
device with a stylus

•	 A copy of GoldenRatio–ForReference.png, which can be found in the 
Chapter 12 folder at https://static.packt-cdn.com/downloads/
Krita_Sample_Files.zip

Creating two thumbnails for comparison
Welcome to the final project! While the chapters in this book have mainly been a mix of 
theory chapters and practical step-by-step chapters, this chapter will be a hybrid where 
we are going to create our images step by step, but by discussing design and creative 
sensibilities during the process. I say this because I don't want you to feel like you have to 
follow along step by step with what we're creating in this chapter: it's a narrated tutorial on 
problem solving while creating a piece of art. There is a lot to cover in this chapter, so it's 
going to be fast-paced with a lot of moving parts. Let's get started!

Taking Your Time
If you ever feel like your ability in a skill that we are covering is lacking, feel free 
to do outside studies, or follow up on techniques that were discussed earlier 
in this book. I expect this project to take between three and six full painting 
sessions of multiple hours each, so take all the time you need to feel good about 
what you're creating! I believe in you. At the end of this chapter, you're going 
to have a fun, imaginative environment painting you're going to want to show 
everybody, whether you're a hobbyist having fun or a professional looking for 
your next gig at a studio.

https://static.packt-cdn.com/downloads/Krita_Sample_Files.zip
https://static.packt-cdn.com/downloads/Krita_Sample_Files.zip
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Deciding on our options
Since we're creating two thumbnails, we should probably make them as different as 
possible. First, let's review our project's prompt from the Contextualizing concepts section 
of Chapter 11, Working with Concept Art:

"Create an environment for a video game that a player would be interested in exploring.  
Use whatever is in your artistic toolbelt to make an image that is compelling, nice to look at, 
but gives a sense of exploration of a world that is not our own. Trinkets or machines of  
a past or future civilization can add to the sense of wonder, but above all else, make the 
image engrossing."

As you may recall, we put this open-ended prompt through our "logical artist" mental 
filter, and came away with this more clear-cut description:

"A big environment that features some machinery that looks large and other-worldly, with 
moody atmosphere and bombastic colors with good lighting."

Since we reviewed composition techniques and perspectives in the previous chapter,  
let's utilize that knowledge. We have already set one project up in "landscape" orientation 
(our photobashed mountain project from Chapter 3, Utilizing Layers and Layer Groups, 
Chapter 5, Implementing Layer Blending Modes, Chapter 6, Composing Using Krita's 
Toolbox, and Chapter 7, Changing the Feel with Painting, Values, and Sliders). We've also 
created a project in "portrait" orientation (our still-life study from Chapter 9, Setting Up 
a Still-Life Study, and Chapter 10, Enforcing Fundamentals). We've looked at projects that 
use each canvas orientation so far, so let's go ahead and use this final project to create  
a thumbnail with each orientation type. This will give us a variety of options to approach 
our problem solving while we're creating our thumbnails.

With one of our thumbnails being in portrait orientation and the other being in landscape 
orientation, we can use those differences to use one of each of our compositional guides 
from the previous chapter. This will give us a variety of options, where, if a certain design 
or technique doesn't quite fit with one thumbnail, we may be able to alter it and apply it to 
the other.

Since we have two canvas orientations that we want to use (landscape and portrait), 
multiple linear perspectives that we have reviewed (one-point, two-point, and three-point 
perspectives), and two main compositional techniques (the Rule of Thirds and the Golden 
Ratio), this will make for a great variety. Let's establish our canvas templates using what 
we've discussed so far. Our two thumbnail compositions will consist of the following:

•	 A landscape orientation thumbnail that uses a one-point perspective and applies the 
Golden Ratio to our composition
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•	 A portrait orientation thumbnail that uses a two-point perspective and applies the 
Rule of Thirds to lay out the composition

So far, we've established that we will only take one of these to a final, pre-production level 
of quality, but giving both compositions their fair shake only seems like the proper thing 
to do. Therefore, we will take both pieces to a point of value thumbnail with color wash, 
and then choose our favorite at that point.

This will allow us to go through our design sensibilities and try out some loose brushwork 
and good value control, while not being too "sacred" with our ideas. We can try anything 
because only the strongest will get the time-intensive rendering passes! Remember, the 
goal of this project is to expand your imagination and go for a true "what-if " scenario for 
your video game environment, so don't be afraid to shake things up creatively and get out 
of your comfort zone!

With our pre-planning out of the way, it's time to formally get started with our final project! 
First, we are going to get our canvases set up for efficiency and speed, and structure each of 
them with the grids and compositional overlays we may need. Let's do that now!

Preparing our first canvas
Since we are going to be doing loose paintings for our thumbnails, we could keep our 
canvases relatively small (in terms of height and width, as well as resolution) to make 
painting extremely fast (since our computer's processing power won't be taxed as much as 
if we were working on a large canvas with high resolutions (> 100 ppi, for instance). 

To start, let's go ahead and set up our landscape-oriented canvas for our first thumbnail:

1.	 Go ahead and make sure Krita is open.
2.	 Click on the New File button under Start. Then, use the Ctrl + N hotkey or go to 

File > New to bring up the New File window.
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3.	 First, we will create our landscape thumbnail. Here, our settings are going to be 
1920 pixels for the width and 1080 pixels for the height, at 72.00 pixels per inch, 
using the RGB/Alpha color model at an 8-bit integer/channel depth. These settings 
can be compared to the ones shown in the following screenshot:

Figure 12.1 – The New File settings for our landscape orientation thumbnail

4.	 Click the Create button to create your landscape thumbnail canvas.
5.	 With that, your blank canvas should be up and ready to work with! The first thing 

we should do is rename our layers.
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6.	 On the Layers panel, rename your Paint Layer 1 layer to Sketch by either double-
clicking the name of the layer in the Layers panel or right-clicking the layer and 
selecting Properties in the pop-out menu. This will bring up the Layer Properties 
window, which will allow you to rename the layer in the Name field at the very top 
of the window:

Figure 12.2 – The Layer Properties window, with the Name field of Paint Layer 1 highlighted

7.	 If you've used the double-click method, once you've typed in Sketch, hit Enter to 
save the change. If you used the Layer Properties method, click the OK button once 
your settings have changed.

Next, we're going to be using our Golden Ratio image template, so we should import 
that into our project. Before we do that, though, we should save what we have!

8.	 Click File > Save or use the Ctrl + S hotkey to save your project. I'm saving mine as 
Landscape-Thumbnail, in the native Krita file format (.kra)

9.	 Once your project has been saved successfully, go ahead and click the File > Open 
option (or use the Ctrl + O hotkey) on the main menu.

10.	 Select the GoldenRatio-ForReference.png image that was provided in the 
Technical requirements section at the beginning of this chapter.
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Your Krita work area should switch over to the newly opened GoldenRatio-
ForReference.png file, making it the active image:

Figure 12.3 – Our imported GoldenRatio-ForReference.png image set in a tab next to our project

11.	 With the GoldenRatio-ForReference.png tab open, click Edit > Copy from 
the main menu, or use the Ctrl + C hotkey to copy the Golden Ratio image.

12.	 Click back over to your Krita landscape painting project (with mine being 
Landscape-Thumbnail).

13.	 Click Edit > Paste or use the Ctrl + V hotkey to paste the Golden Ratio image into 
your project file. It will paste onto a new layer, which you can rename Golden Ratio 
using the layer renaming method of your choice.

Depending on your canvas settings, you may notice that the Golden Ratio image 
we've imported is much larger than our canvas. Don't worry – we can just transform 
it in place!

14.	 With your Golden Ratio layer active in your Layers panel, use the Ctrl + T hotkey to 
enter the Free Transform mode. This will allow you to manually change the outer 
corners, height, and width of the Golden Ratio layer information. 
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15.	 Resize the Golden Ratio layer so that it fills up most of your canvas but leaves a tiny 
bit of room near the outer borders:

Figure 12.4 – Our Golden Ratio layer with the Free Transform sizing anchors, sized to fit our canvas

16.	 Once the Golden Ratio layer has been sized the way you would like, hit Enter to 
accept these changes.

17.	 Now, we will want to lower the opacity of our Golden Ratio so that we can paint 
underneath it (on our Sketch layer). Lower the Golden Ratio layer's Opacity to 
20% using the dial above your Layers panel when the Golden Ratio layer is active:

Figure 12.5 – The Golden Ratio layer adjusted to have its Opacity set at 20%
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18.	 Be sure to Save (Ctrl + S) your file now that we have everything set up how  
we want it!

Now that we've created our layers so that we can start the thumbnail, let's go ahead and 
create our second canvas for our portrait-oriented thumbnail.

Preparing our second canvas
Let's go ahead and create our second canvas while keeping our first canvas open (but on  
a separate tab). The decision to have two active paintings going on at a time may seem 
odd, but there's an interesting thing I've found in my experience: if you have immediate 
access to both images and can just click between the two at a moment's notice, both 
paintings tend to feel similar (in a good way). This is probably because you may have the 
same brush or brushes loaded (that will stay the same between tabs) and the colors of your 
Advanced Color Selector are global (meaning the same color is active as you go from tab 
to tab). The decisions you make in one project can immediately influence the other with  
a simple click of your mouse to change tabs!

Another fantastic thing I've found is that having multiple projects open helps fight against 
artist's block. Feeling stuck in a certain location in one painting? Save, then swap over to 
the other piece for a bit. Your problem solving from the first project may roll over and help 
solve an issue you may have been having with your second, and vice versa. 

Taking Breaks
Of course, we're not art machines, so regular breaks are not only recommended 
but encouraged! A great night's rest can end up saving you time in the long run 
as you can see your work with fresh eyes once a new day starts. Be sure to stay 
hydrated and take breaks at regular intervals: your art (and mental well-being) 
will be better for it!

Let's go ahead and get our portrait-orientation thumbnail canvas created and add a Rule 
of Thirds grid to it:

1.	 In Krita, create a new file by going to File > New or using the Ctrl + N hotkey.
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2.	 In the Create new document window, set Width to 1750 pixels, Height to 2250 
pixels, Resolution to 72 ppi, Color Model to RGB/Alpha, and Color Depth to 
8-bit integer:

Figure 12.6 – The document settings for our portrait-orientation thumbnail

3.	 Click Create once you've entered your settings to create your canvas.
4.	 Go ahead and save your project by going to File > Save or using the Ctrl + S hotkey. 

I'm saving my project as Portrait-Thumbnail in the native Krita file format (.kra).

You should now have two tabs open in your work area, with your first project being 
next to your newly created second project:

Figure 12.7 – Our two project files open simultaneously in Krita, separated by tabs
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5.	 Now that our second project has been created, we should add our Rule of Thirds 
grid. Since the Rule of Thirds is a mathematical calculation that depends on the size 
of your canvas, you shouldn't "stretch" an image of a 3 x 3 grid onto your canvas. 
Instead, you should use the Grid and Guides functionality we discussed in the 
Setting up grids and guides section of Chapter 9, Setting Up a Still-Life Study. For  
a full overview of the mechanics of this tool, be sure to review that section. For this 
chapter, we'll quickly discuss the necessary settings.

6.	 Make sure your Grid and Guides Docker is available by clicking on Settings > 
Dockers and making sure Grid and Guides is set to active:

Figure 12.8 – Our Grids and Guides checkbox set to active via the Settings > Dockers menu

7.	 Once our Grid and Guides Docker is activated, we need to do a little math! The 
Rule of Thirds is a very easy grid to make as you just need to divide your width 
and your height by 3 to get your X spacing (width) and Y spacing (height) values, 
respectively. Since our canvas is currently 1750 pixels wide (x axis) and 2250 pixels 
wide (y axis), our values should be as follows:

a. �1750 / 3 = 583.3333, so we can round down to 583, or round up to 584, for  
our X Spacing.

b. 2250 / 3 = 750, so that will be our Y Spacing.

c. We only want one main line, so we can set our Subdivisions to 1.

d. �Since we've done the math manually ourselves, we can leave Grid Offset for both 
the x axis and the y axis set to 0.
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8.	 If you notice that your X Spacing and Y Spacing are locked to be the same, click 
the chain-link icon to the right of the X Spacing and Y Spacing fields to unlink the 
sizes. This should allow you to enter two separate numbers for spacings. You should 
end up with a Grid and Guides window that looks as follows:

Figure 12.9 – Our Grid and Guides window. Notice the unlinked icon next to  
the X and Y spacing values to allow for separate numbers

Now that we've set up both of our canvases, we can start painting our thumbnails! Since 
we have the portrait thumbnail ready to go, let's start with that one!
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Starting our portrait-oriented thumbnail
In Chapter 11, Working with Concept Art, we had an entire section titled Keeping things 
loose, and that's exactly what we're going to do for our thumbnails! Let's review our 
truncated brief so that we can have it at the forefront of our minds:

"A big environment that features some machinery that looks big and other-worldly, with  
a moody atmosphere and bombastic colors with good lighting."

Alright! So, when I read this prompt back, there are a few things that stick out that we can 
use – the terms "big" and "good lighting." "Big" tells me we can use large brushes to put in 
huge shapes fast, while "good lighting" tells me we should have a clear separation of our 
foreground, midground, and backgrounds while controlling our values in grayscale to nail 
our lighting. Our sense of depth can be directly tied to value control here, so it should be 
of the utmost importance. The great thing about having our Rule of Thirds grid overlaid 
on our canvas the entire time is that we'll never be without a solid visual foundation!

Since this is a thumbnail phase and I want to work quickly, I'm only going to work on one 
layer for my value pass. If you're fairly new to digital painting or art, I highly recommend 
using three different layers for your foreground, midground, and background, respectively. 
We covered this method in Chapter 3, Utilizing Layers and Layer Groups, in detail, so  
I highly recommend starting in this way to build your comfort level in maintaining clarity 
of depth.

Now that we have established our working method, let's get started on our  
portrait-oriented thumbnail:

1.	 Grab a brush that allows for a little bit of texture but places a heavy, opaque mark, 
depending on the pressure that's applied. I'm going to choose the f) Bristles-3 
Large Smooth brush from the Paint category in my Brush Presets panel. If  
the bristle brushes or more "wet" brushes don't work well for your machine, 
something such as b) Basic-2 Opacity would be great as well and be easier on  
your system's resources.
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2.	 My first order of business is to "tone" my canvas, so I'm going to choose  
a roughly 50% gray value from my color wheel and lay in some brushstrokes to  
start warming up:

Figure 12.10 – A quick 50% gray wash using a large bristle brush to tone our canvas
Toning our canvas in this way gets rid of the blinding white that was staring back 
at us, as well as gets us over the "blank canvas syndrome," which can keep us from 
getting started.

Since I'm working on one layer, I'm going to do some "sketching," but by using  
a paintbrush instead of a pencil or finer point tool. This is going to allow me to 
utilize those bigger brushes to make larger shapes quickly. Also, we will have the 
benefit of getting "happy accidents," where paint can start to blend and give us 
random nooks and crannies that we may be able to utilize later.

3.	 I'm going to choose the f) Bristles-2 Flat Rough brush, also from the Paint 
category. I'm going to select a darker gray, maybe closer to 70% black (or a 7 on the 
10-step value scale).
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4.	 Apply some long, vertical strokes using a variety of brush sizes (a quick way to 
change brush size is to use the bracket keys, [ and ], on your keyboard to decrease 
and increase the brush's size, respectively). You can also resize your brush by 
holding down the Shift key, clicking down on your canvas, and panning your mouse 
left or right to make your brush's size smaller (left) or larger (right).

5.	 I'm thinking of an idea of large rock formations, almost creating a valley between tall 
mountain-esque towers with random horizontal shapes to break up the silhouettes:

Figure 12.11 – Our vertical brush strokes, starting to place our value structure
The somewhat random, chunky marks near the top of our left-hand side shape will 
come in handy as they could easily become a "machine" or "ancient technology" that 
our prompt requires. Also, notice that two of our main vertical "structures" literally 
fall upon the two vertical Rule of Thirds lines. This is why having our grid set up 
and active is so valuable during this phase!
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What about Perspective?
As you may recall, we established that this piece will be in a two-point 
perspective. While this is still the plan, I think we should continue blocking 
in some of our shapes, and decide on what the actual content of our image 
could potentially be, before we start worrying about the time-consuming part 
of setting up a proper perspective. Remember, it's important to work fast and 
loose at this point – we're not tied down to anything yet.

6.	 I want to embrace some of these shapes we've started establishing, so I'm going to 
use the f) Bristles-2 Flat Rough brush and add a bit of visual interest by painting in 
some darker darks where I think the foreground could be and adding a few spots of 
bright light, almost creating a "slice of light" to start manipulating shapes and forms:

Figure 12.12 – Adding some darker darks and brighter brights to bring about interesting silhouettes
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This is already feeling pretty cool, and we're only a few minutes in! I'm starting to 
get a sense of what this environment could be, and using the Rule of Thirds grid  
we created is helping define some interesting shapes.

For instance, notice that the right-most shape flattens out directly on the top 
horizontal Rule of Thirds line, while the "antenna" of our left-most structure traces 
over the left-most vertical line of the grid:

Figure 12.13 – Utilizing our Rule of Thirds grid to great effect to position structures

Yeah, we are getting our money's worth with the grid! While we could keep going with 
this one, we have another thumbnail to create! Before we take a break from this one, 
let's go ahead and do a very rough color splash-in so that we can get a sense of a color 
combination we like.
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Splashing in colors
It's time to splash in some colors! This is a repeat of the method we established in the 
Splashing in color section of Chapter 5, Implementing Layer Blending Modes. Head back 
to that section if you want to understand the mechanics behind this method a little more 
clearly. Let's get started:

1.	 Create a new layer. Name this layer Color Splash and change the layer's 
Blending Mode setting to Color. Your Layers panel should look something  
like this:

Figure 12.14 – Our current Layers panel for our portrait-oriented thumbnail.  
Notice that the Color Splash layer is on the color blending mode

Since this is an outdoor scene, we can have a nice blue sky with our mountain-esque 
shapes acting as a warm contrast by using warmer, neutral orange (meaning closer 
to gray in saturation).

2.	 Select a large brush and paint a gradient of a mid-saturated blue on the upper half of 
your composition, and an orange-brown color on the lower half.

3.	 Follow the shapes of your mountain-esque structure shapes when placing color, 
making sure that they maintain clarity by giving them various shades of orange, 
brown, and gray to contrast with the blues of the sky. To add variety, you can also 
add splashes of more saturated colors (such as a red and a green, in my case) to 
areas you think might be a focal point for the viewer:
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Figure 12.15 – Our color-splashed portrait thumbnail
I know you may be thinking this looks like a total mess, and you'd be right! It 
doesn't matter about the details or formal structure of anything yet since we haven't 
even begun on our second thumbnail, so locking in designs right now may be 
jumping a little too far ahead.

On that note, let's start on the second thumbnail – I'm getting excited about the 
possibilities! Once we nail down a quick composition for the second thumbnail 
and splash in some colors there, we will be ready to compare both of our color 
thumbnails and choose which one we'd like to take to the final!

4.	 Be sure to save what you have for your portrait-oriented thumbnail so far!

Now, let's hop over to our second thumbnail and get started.

Starting on our second thumbnail
For our first thumbnail, we decided on a vast, vertical outdoor scene that integrates 
mountain-esque canyons, a bright cloudy sky, and some brightly saturated "points of 
interest." While we could continue down this path with our second thumbnail, we can use 
this new thumbnail as an opportunity to shake things up and try something quite different. 
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Instead of a vast, fresh-air-filled landscape, what if we made a murky, darker alien 
interior? It can still be vast in scale with some dramatic lighting and large machines, but 
the feel would be much different than our first thumbnail while still being in keeping with 
the goals that were established in our prompt. Having two drastically different thumbnails 
will make it a little more varied when we're selecting the strongest composition of the two. 
Let's get started on our landscape-oriented thumbnail:

1.	 Click the tab for your landscape-oriented portrait in Krita to make it your  
active project.

2.	 You should have your three layers, with your Background, Sketch, and Golden 
Ratio layers presented from bottom to top:

Figure 12.16 – Our landscape-oriented thumbnail's Layers panel at this point

3.	 Click on the Sketch layer to make sure that you'll be putting your values on the layer 
below your Golden Ratio layer.

Being Able to Always See by Multiplying
As we begin working on the Sketch layer, you may notice that the Golden 
Ratio layer can be fully hidden, especially if the values you put down on your 
Sketch layer match that of your lower-opacity Golden Ratio layer. A great 
way to ensure that you always see what your Golden Ratio layer has, even at 
a lower Opacity setting, is to set the Blending Mode setting of the layer to 
Multiply. This makes all the lines from our Golden Ratio layer darker than 
anything below it, allowing you to see it more clearly as you work. This is a very 
helpful trick if you're painting and want to use line art, sketches, or hand-made 
perspectives while doing so.
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4.	 Much like in our first thumbnail, find a large opaque brush that can be used to tone 
our canvas using a midtone, roughly 50% gray.

5.	 Tone the canvas using your midtone value and large opaque brush.
6.	 After your canvas has your midtone grays on it, using the same brush, follow the 

spiral provided by your Golden Ratio layer, using it to create a "curved cavern" of 
sorts by making the outside of the spiral darker than the inside:

Figure 12.17 – Our first few values added, following the spiral of our Golden Ratio layer

7.	 I've also added some dark marks near where the spiral's focal point exists. I'm not 
sure what's going to go here yet; I just want to mark it as important. 

8.	 Using this shape as a foundation, I'm going to add a variety of shapes, edges, and 
curves to the "inside edge" of this spiral to make it look less organic and smooth, 
and more man-made (as this can work well with our machinery and technology 
motif from the prompt).
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9.	 While I'm adding these shapes, I also want to start establishing lighter and darker 
values, including adding a floor (to guide our viewer and/or player into the 
composition) using the b) Basic-2 Opacity brush and creating a few "light bloom" 
shapes using the b) Airbrush Soft brush from the Digital subcategory to add our 
strong, moody light source:

Figure 12.18 – Our additional lights and darks, following the lines provided by our Golden Ratio image
Notice how I'm almost "coloring in the lines" using some of the Golden Ratio layer 
information? Tracing the lines in this way is going to ensure I adhere to the main 
shapes and proportions of the tried-and-true ratio, allowing me to add my creativity 
on top. Once again, at this point, it doesn't matter what marks exist, as this is just  
a casual brainstorming session. 

Let's go ahead and add some colors and see what we're working with!
10.	 Create a new layer. This layer should be above your Sketch layer, but below the 

Golden Ratio layer. Name this Color Splash. Be sure to change this layer's 
Blending Mode setting to Color.

Since our first thumbnail contained some bright blues, orange-browns, grays, and 
a few pops of red and green, let's work a bit different here and stick with a more 
simplified color range. Oranges and purples go well together, allowing the purple 
to act like the "cool" color, while the orange can be our light source and source of 
warmth for the viewer.
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11.	 Using a large brush, while on your Color Splash layer, select a deep, saturated 
purple color.

12.	 With this purple color selected, paint over your darker tones (essentially, your 
foreground, floor, and "outer spiral").

13.	 With your orange, paint over your lighter tones. This should bring a nice, if weird, 
contrast. This works in our favor, as the mixture of colors seems "alien" to what 
we're used to on Earth, adhering to the "otherworldly" motif of our prompt.

14.	 Go ahead and hide your Golden Ratio layer. You should have something that looks 
close to the following:

Figure 12.19 – Our color-splashed thumbnail with our Golden Ratio layer hidden
Now that we've hidden the Golden Ratio layer, the piece is standing on its own! 
Our focal point still works (from the mix of the Golden Ratio itself and keeping  
it darker to heighten the contrast for the viewer), and now we have an  
interesting-looking composition that has a myriad of possibilities.

I think we're at a pretty good stopping point for our color splash on this second 
thumbnail, which can only mean one thing: it's time for the moment of truth – choosing 
our favorite thumbnail!
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Choosing our strongest composition
In a perfect world, we would love all our paintings equally. However, I can tell you with 
absolute certainty, that will never be the case. As your skills develop and take shape, 
paintings or drawings you may have loved at one point in your hobby or career may end 
up being outright embarrassing to you months or years later. One of the strongest skills you 
can develop as a working illustrator or painter is learning when to scrap an idea or be able 
to objectively see the pros and cons of your work. There is a term called "the artist's curse," 
which is an idea that states that we will never be able to enjoy our art in the same way  
we enjoy the art of others. This stems from two primary places:

•	 We have been with our artwork since it was a blank canvas, so all we see are the 
"decisions" we made during the production of the work, instead of the work as  
a collective whole. We constantly harp on about what we "should have done," 
instead of what we did do.

•	 As human beings, we tend to undervalue our worth and overvalue the worth of 
others. Statements such as "Oh, I could never do that" seem to happen a lot when 
you're looking at your favorite artist's work. However, if someone compliments 
your work in the same capacity, you brush it off as them "being nice." Don't feel 
bad about this dichotomy – it's normal! Just be aware that it happens to everyone 
and give yourself a little bit of credit for performing the miraculous feat of creating 
something from nothing!

If there's a lesson to take from this, it's to be kinder to yourself, while also understanding 
where you'd like to improve in the future. It's a healthy mindset and it greatly reduces the 
amount of stress you place on yourself.

With that being said, let's look at the two thumbnails side by side and make a bullet-point 
list to figure out which piece we will take to the final stage:

Figure 12.20 – Our two thumbnails, side by side for comparison and self-critique
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My main goal with this comparison is to look at the strengths and weaknesses of each 
initial concept. We can use this stage to do our first set of mental "edits" of our images, 
choosing what we could potentially keep or get rid of in either piece. Here's a quick 
breakdown of my thoughts while looking at them side by side in Figure 12.20:

•	 The piece on the left looks a bit more "majestic" to me, as the buildings and structures 
have more room to breathe and establish a sense of place, including more interesting 
shapes and the possibility of "cultural touchstones" for our fictional world.

•	 The lighting in the right-hand piece, while cool, doesn't leave a lot to the 
imagination in my opinion. While the purple and orange do give a sense of 
otherworldly-ness, they may have to be tweaked a bit to catch the eyes of our 
viewers and players.

•	 On the left-hand piece, the blue sky and orange-skewed mountains seem a little too 
ordinary and obvious, not selling the idea of an "alien world" that we're going after 
with our prompt.

•	 I'm liking the more contrast-focused nature of the right-hand thumbnail, but the 
overall structure and possibility of the left-hand thumbnail. Is there maybe a way  
to mix the two?

By breaking your ideas down in this way, you can take your favorite parts from each 
composition, creating something greater in potential and possibility than your combined 
attempts thus far. Reviewing each piece at its basic level, and doing this compare-and-
contrast exercise, I've come to this conclusion:

Let's take the foundation of the left-hand thumbnail (our vertically-focused,  
portrait-oriented piece) and integrate the higher contrast, non-Earth color scheme  
of the right-hand thumbnail (our landscape-oriented purple and orange piece). Also,  
let's keep with the motif of "crazy colors" that are out of the ordinary, but not limit 
ourselves to just the purple and orange – let's have fun with it!

Refining our idea
Give a salute and wave goodbye to our landscape-oriented design: you served us well, 
mighty thumbnail! There's an old saying that you have to "get through the rough ideas to 
get to the good ones," and that's why this process is critical in the pre-production phase of 
any project. By ruling out what you don't want, you end up with something that ticks all of 
the right boxes. 
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Now that we have decided on which thumbnail we'd like to move forward with, it's time to 
set our focus on refining our winning idea:

1.	 Close the thumbnail that you won't be taking to the final stage. (At this point, that 
is! You can always keep thumbnails to use later for some neat ideas, as we will 
discuss in Chapter 13, Going beyond These Pages.)

2.	 Use this step to make any general, sweeping changes (such as colors, values,  
or shape layout) to the thumbnail you are going to keep.

3.	 I am going to make a new color splash layer (naming it Color Splash 2) and add 
some more outrageous, varied colors such as cyan, red, and purple using a soft 
brush (the b) Airbush Soft brush from the Digital subcategory, for instance) to 
allow the hues to blend into one another gradually:

Figure 12.21 – Our recolored thumbnail. That's more like it!
Yeah, that feels way more interesting! The standard "blue sky" look we had before 
wasn't giving us an interesting feel, and while we could have made a great painting 
using the more traditional color palette (and it'd be easier to find references!), this 
piece is meant to spark the imagination. It's always important to do what's best for 
the piece, not necessarily what's best for your ego!

Since we're liking where this color and value setup is going, let's go ahead and make 
a merged layer of what we have so far.
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4.	 Select everything on your canvas by using the Select > Select All menu option  
(or the Ctrl + A hotkey). Once everything is selected, go to Edit > Copy Merged  
(or use the Ctrl + Shift + C hotkey).

5.	 Paste your selection (using Edit > Paste or the Ctrl + V hotkey).
6.	 Name this new layer Merged Layer. Make sure this layer is at the top of your  

Layers panel!
7.	 On your Merged Layer, start refining your shapes and values by color selecting 

(using the Ctrl key while hovering over a color you want to select on your canvas) 
and controlling your edges to make more defined shapes. We still want to stay loose 
in our decision making, but giving a little bit more depth and structure to our piece 
using our new color palette will start giving our artistic eye something to latch onto 
to develop further:

Figure 12.22 – Our slightly refined thumbnail using a smaller brush and color picking
By adding these small lines and brush strokes of "details," we're starting to come 
up with something that is feeling more coherent. Notice the repeating shapes of 
antennas and pipes as our silhouettes become more vertical. 
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There's one shape in particular, though, that has captured my attention and has 
given me an idea that may dictate the direction the entire piece starts to go in:

Figure 12.23 – An interesting shape has appeared; what can we make of it?
I originally put down this streaky mark thinking "I don't know, this could be a big 
rock or something for scale," but looking at the flow of the line and the structure  
of the base, it's making me think of a dragon! Dragons are awesome, yeah? What  
if this composition was showing us a massive tower in the background, almost  
a "docking bay" of sorts, with a variety of dragons and dragon riders positioned  
and flying around?

This idea checks all the boxes we need for our concept: otherworldly, vast, dramatic 
lighting, and it gives our viewers and player a place they'd want to explore. I mean, 
who doesn't want to fly around on a dragon? That being said, I think I want to move 
the dragon shape over to the left-hand side of the foreground, as having it on the 
lower right seems a bit cramped (and dragons need room to stretch!).

Now that I have my solid "finalized" idea, it's time to start blocking in the shapes  
we need before we integrate our textures. 
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8.	 Create a duplicate layer of our Merged Layer so that we can make some dramatic 
changes while keeping what we have so far as a backup. Do this by right-clicking 
Merged Layer and selecting Duplicate layer or mask (or using the Ctrl + J hotkey), 
or hitting the double-page icon at the bottom of our Layers panel:

Figure 12.24 – The Duplicate layer or mask button at the bottom of our Layers panel

9.	 Name this new layer Merged Changes.
10.	 On the new Merged Changes layer, I moved the dragon shape over to the lower  

left while refining it to read as a dragon, alongside a few smaller humans for scale.  
I want them to face the inside of the composition as I want this to be something that 
draws the viewer into the composition.
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I also want to add some dragons flying around the composition (leading the viewer 
into the background tower), and edit the shapes of our machinery/towers so that 
they fit a little better with a high-fantasy topic such as dragons (making curved 
edges that come to a sharp point, such as dragon's teeth, might be a cool idea here):

Figure 12.25 – Our artwork taking shape
Here, I'm making sure to refine my edges, adjust the values a bit, and start getting  
a sense of location and mood. It's starting to come together, and once you start 
getting excited about the possibilities your art is providing you, that's a great 
indicator that you're ready to push to the final stages of your work.
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I think we are at a great point to start going to the final stage, so let's create a new 
merged copy of this and increase the canvas size so that we can start rendering details 
and applying some photo textures to speed things up! We'll be using a version of the 
techniques we discussed in the Bashing our reference section of Chapter 5, Implementing 
Layer Blending Modes. In the next section, we'll discuss some "tips and tricks" that  
I've learned from my own experiences and industry veterans on how to quickly and 
effectively utilize paint-over techniques.

Learning industry-standard paint-over 
techniques
We are at a place where we are confident with our idea, and it's time to push to the final 
stage! There are two important steps I do at this point (well, one of them I always do; the 
other one is optional, but we'll discuss that momentarily):

•	 Make a merged copy of our work thus far, create a new file, paste our merged image 
into it, and then increase the size to what we want our final output's width, height, 
and resolution to be before we start rendering. This is the step I always do, as  
I want to make sure every brushstroke and decision I make is going to make it to 
our final output.

•	 Grab a large number of photo references to photobash. This is the "optional" part,  
so if your project doesn't need or require a photobash, don't feel pressured to do this 
part. While it's a great way to speed up getting your textures and visual information 
in your painting, it's not a requirement. To speed up this portion of the chapter (and 
so we don't have a 500-page chapter dedicated to rendering every single rock on  
a mountain), I'll be using photobash techniques here.

Let's get started on our final render by creating a properly sized canvas that we can start 
painting on:

1.	 Create a merged copy of what we have on our canvas. You can utilize either the 
Select > Select All and Edit > Copy Merged methods, or use the Ctrl + A and  
Ctrl + Shift + C hotkeys.

2.	 Then, create a new document by either clicking File > New or using the  
Ctrl + N hotkey.
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3.	 To save a bit of time, you can use the Create from Clipboard option in the Create 
New Document prompt. This will not only bring in the resolution and dimensions 
of what's on your clipboard, but a copy of the content as well, placing it as the 
Background layer on the new project's Layers panel:

Figure 12.26 – The Create from Clipboard option while creating a new document

4.	 Once your new file has been created, be sure to save it. I'm saving mine as Dragon 
Rider Temple, in native Krita format (.kra).

5.	 Now, we need to resize our canvas to what we'd like our final output to be. Click on 
Image > Scale To New Size or use the Ctrl + Alt + I hotkey combo to bring up the 
Scale To New Size window.

6.	 The default settings in this window will be what our image is currently sized at. The 
only thing I want to do is change Resolution from 72 ppi to 300 ppi, which will 
scale up our width and height from 1,750 x 2,250 to 7,293 x 9,375, respectively. This 
is due to having the Constrain proportions box checked, allowing the scale ratio of 
the width and height to remain locked while we change the pixels per inch setting. 
I'm also going to keep Filter set to Auto as that will allow Krita to use the most 
effective rescaling algorithm when upscaling our image:
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Figure 12.27 – The Scale to New Size window with our width, height, and  
resolution adjusted with Constrain proportions checked

Once you're happy with the new dimensions and resolution settings, hit OK to 
commit these changes. Depending on the new size and resolution you've chosen, 
you may have a few seconds of processing time while your computer is doing some 
number-crunching to scale your image correctly.

Now that our canvas is the size we'll be exporting the finished piece out at, we can 
safely start placing some photo references to help us add detail! As we mentioned 
earlier in this section, this portion is entirely optional as you can just start rendering 
using the methods we discussed throughout Chapter 11, Enforcing Fundamentals. 

I'm going to head over to the trusty site Pexels.com and look for the  
following items:

a. Iguana and Lizard (for the dragon design inspirations and scale textures)

b. �Mountain and Canyon (to get a variety of rock textures and formations to  
have on file)

c. Clouds and Fog (for, well, clouds and fog!)

d. �Rocky Trail (to assist in the ground-level texturing and our zig-zagging trail going 
into the distant canyons)

http://Pexels.com
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I will combine all of these references (I get between three to four per set of 
keywords) into a single document (acting as a reference board), notating them by 
category for organization purposes:

Figure 12.28 – My custom reference board using prompt searches from Pexels.com
Keeping our preferred references on a single file can be extremely helpful since 
just copying and pasting from our reference board can save a ton of time during 
the photobashing and referencing process. I will be attaching a copy of this exact 
reference board (warning: it's pretty huge, whopping in at over 18,000 pixels wide!) 
for you to use if you're following along! 

We have our photos, we have our reference board, and we have our full-size canvas. 
Let's get to the finale of this project by applying our photobashing on top of a value-pass 
version of our piece, applying our initial color splash, and then rendering it to completion!

Applying our photo textures
Since all of our reference images have different color keys and lighting setups, let's simplify 
this step by creating a "value checker" layer:

1.	 Create a new layer named Value Checker. Fill in this layer with pure black  
or pure white, and change its Blending Mode to Color. This will desaturate all the 
colors in our painting, allowing us to work only in values.
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2.	 Underneath this Value Checker layer, start copying and pasting your images by 
using your transform tools, transparency masks, and layers to manipulate and shape 
the textures so that they "fit" your already-established shapes:

Figure 12.29 – Our value-filtered photo textures after they've been added to our composition
Depending on the quality of your image (the resolution of not only your canvas 
but the images that you've used to do your photobashing), your file size may grow 
exponentially. For instance, before resizing my canvas and adding my photo textures, 
my total file was 49 MB in size. After making these changes – that is, adding photo 
textures, applying transparency masks, and doing the value checker tweak – my file is 
clocking in at a whopping 4 Gigs in size. This can cause some extreme slowdown, and 
even with a pretty beefy computer, it can cause Krita to crash if you're not careful,  
so be sure you save your work (using the Ctrl + S hotkey):

Figure 12.30 – Using high-resolution photobashing techniques at 300 ppi can take a toll!
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Auto-Saving Is a Life-Saver!
A great feature Krita comes with is the ability to set a timer to "auto-save" 
files after a certain duration passes in the program. This is extremely useful 
and ensures that you'll always have a relatively recent backup in case disaster 
strikes! I can't tell you how many times a power outage has halted my progress, 
only for Krita's auto-save feature to recover my work from only a few minutes 
prior. You can customize these settings by going to Settings > Configure 
Krita > General > File Handling. I have my timer set to save every 7 minutes 
as anything shorter than that and my machine starts to use a lot of system 
resources (namely, CPU and RAM), while much longer than that and I would 
have made a lot of progress that would end up being lost. Find a time that 
works well with your working style, and save yourself some heartache! Yes, that 
pun was intended.

3.	 If Krita starts to run slowly or becomes unresponsive I recommend using the Scale 
To New Size function to lower the fidelity back down to a more manageable level by 
either lowering your ppi (if you're working above 72 ppi, for instance) or lowering 
the width and height values (while keeping the proportions intact with the Constrain 
Proportions box checked in the Scale To New Size window). Since Krita's algorithm 
is smart enough to resize everything in the composition equally, you'll still retain your 
high-quality work but get Krita to perform significantly better as a result of making 
the image smaller in terms of computer resource intensity requirements.

4.	 Now, take your Background layer (the layer that consisted of the merged copy of 
our color splash from our thumbnail) and duplicate it. Then, move this duplicated 
copy to the top of your Layers panel (even on top of your Value Checker layer) and 
change its Blending Mode setting to Color:
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Figure 12.31 – Our color-splashed version of our post-photobash piece

5.	 Use this new color layer to correct and edit any colors that may look out of place. 
Keep the rules of atmospheric perspective in mind (the further something is from 
the viewer, the more it matches the value and hue of the background sky) and light 
theory (nothing can be brighter than the light source, and the further something is 
away from the source of light, the less light it receives).

For instance, I'm thinking of either cutting back or focusing on the saturated blue 
as it's causing a lot of attention to be drawn to it now since it's large. I also want 
to integrate the green and cyans into the foreground mountains more to ensure 
the reds of the sky creep into the background elements a little more, as well as to 
maintain some brighter white light on the right-hand side of the composition.

Now that we have our colors where we want them, it's time to make some adjustments to 
our piece and refine some shapes. From there, we can push to the most time-consuming 
steps of rendering. For now, let's look at a few shapes and see whether we can improve on 
our ideas to make them a little more cohesive.
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Improving our design sense
While I feel good about where the piece is going, I feel like it's a little disjointed. Why 
would dragons be flying around an industrial-style structure? What is tying our designs 
together, and does it make sense as a magical, mythical place that the viewer would want 
to explore?

This is an important turning point in our piece. Earlier in this chapter, there was a callout 
section called Taking Breaks that discussed the importance of stepping away from your 
piece for a few hours (or a few days, if your schedule allows). This allows you to clear your 
mind and come back to your work with a fresh perspective. I've done this, and when  
I came back, my thoughts of the piece being disjointed reared their ugly head. Let's talk 
about the editing process.

Let's take a look at the four main items that I want to change or alter in a fairly  
dramatic way:

Figure 12.32 – Four main areas I want to address before going to the final render
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For clarity (and speed!), let's quickly review what my thoughts are on these four areas,  
plus what my plan is to refine them before moving forward with the piece:

•	 A: �While this tower can be a great, hi-tech focal point, I think that this is prime real 
estate in our composition (as it is at a Rule of Thirds intersection and a large focal 
point of the overall piece). Since it is of primary importance, I think it should  
fit more thematically with the idea of dragons, so I'm thinking of adding  
a rock-based "dragon head" monument of sorts, almost acting like a statue  
of a fallen dragon from legends of old in our imaginary world.

•	 B: �For this area, while I like the idea of a physical "landing pad," I do feel like this 
idea is a little too ordinary. What if we took these more stoic shapes and added 
a bit of chaotic energy? Instead of a rigid, flat surface, what if there were more 
curves and pivots in different directions, almost like a tree trunk and some 
massive tree limbs? This may be a bit too "out there" for our imaginary art 
director, but since this is a concept art piece, it's a perfect time to experiment! 
Throw ideas at the proverbial wall – you'll never know what sticks!

•	 C: �I need to adjust the darks and lights in this portion. While the idea of a flat 
plateau of rock for our structure to sit upon is a neat one, I think that if  
we're moving more toward a "massive statue" dedicated to a legendary dragon,  
we should emphasize the size of this monument by removing a plane change.

•	 D: �Once again, if we're thinking of changing the motif of our left-most structure to 
a monument, we should probably make the head of it the focal point and remove 
anything that may take away from that. I love the design of this little doodad  
(it almost looks like a viewing room that you would see in a lighthouse or the 
Space Needle in Seattle, Washington), but it may not fit if we're shifting gears.

 Let's go ahead and make some of these adjustments with some darker line art, almost as  
if we're taking notes on our composition:

1.	 Create a new layer and name it Notes and Changes.
2.	 Choose a simple brush that you feel comfortable using as a "sketching" brush.  

I will be using the b) Basic-6 Details brush from the Digital subcategory. 
3.	 Using pure black, draw very rough changes you would like to integrate into  

your piece.
4.	 If there's anything you would like to remove from your piece, go ahead and change 

your brush's color to red (as we'll be "red-lining" or "red-inking" things we want to 
remove, just like a copy editor on a piece of writing).
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You can see my (very rough) sketching and red-lining pass in the following figure:

Figure 12.33 – Our Notes and Changes layer using black for changes and  
red for removal (with a grayscale background for clarity)

I've removed the unnecessary portions of the buildings and structures that  
would be taking away interest from our changes. We want to drive home the 
otherworldly nature of what we're making, so letting those new assets shine would 
be in our best interest.

Before we start rendering, let's integrate these changes quickly by using a basic 
brush, color picking, and doing some edge refinement.

5.	 Create a new layer and name it Implementing Changes.
6.	 Find a nice brush to block in some new shapes. I will go back to using my trusty  

b) Basic-2 Opacity brush for this one.
7.	 In the areas you would like to remove, color pick some colors around these areas 

(for instance, since we're removing the tall tower on the left of the composition,  
we can pick a color from the pink mountains around where portion A is notated  
in Figure 12.32).
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8.	 Remove these items by painting over them with the nearby colors you have selected. 
Since your Notes and Changes layer is still active, simply paint over the portions 
you have marked in red.

You can see my removal process in the following figure:

Figure 12.34 – Our removal phase color picking and painting over  
our red-marked edits from our Notes and Changes layer

As you can tell, this is already reading a little more clearly! Now, let's take this same 
idea and block in the new items we want to add.

9.	 Make sure you're still on your Implementing Changes layer.
10.	 Using your same brush (I still have my b) Basic-2 Opacity brush selected), use the 

same color-picking technique, but pick the colors of the items you're adding into. 
(For instance, we can color pick from the remnants of our left-most structure and 
mountain to fill in the rest of our dragon's head.)

11.	 Go ahead and continue blocking in your new material. It is up to you whether you'd 
prefer to keep the black outlines from your Notes and Changes layer intact. For 
clarity of following along and seeing my steps, I'm going to keep mine intact for you. 
Remember, we'll be painting over these anyway during our main render pass!
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Keeping Things Interesting
As a quick tip (and to ease the rendering steps momentarily), feel free to 
slightly shift your hues and colors during this block-in phase. This acts as  
a "rendering roadmap" of sorts, so anything that you want to add or adjust to 
aid in the upcoming rendering phase is helpful!

12.	 Be sure to save (using the Ctrl + S hotkey) when you're at a good point!

You can see my blocking-in pass (with the Notes and Changes layer's black outlines 
still mostly intact) in the following figure:

Figure 12.35 – Our Implementing Changes layer, as dictated by  
painting over our Notes and Changes layer

Ahhh, that's better! It feels a little more open, and a little weirder and more interesting! 
Also, I'm liking how the "tree trunk" shapes from the right-hand side are starting to point 
at our other dragons on the right. 

I think we're at a pretty good spot now – I'm confident in taking this to the "final" render 
stage. I put "final" in quotation marks as this isn't necessarily going to be the finished, fully 
rendered final image that would grace the cover of a magazine or something, but it will 
be solid enough to turn into our imaginary "art director" to integrate into a mood board. 
We're keeping everything loose and open-ended but refining our ideas enough to be able 
to discuss them with our peers for further feedback.
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Now, take a break, grab a snack, and do some stretchy yoga moves – we're about to  
dive into the most time-consuming part of any piece of art, regardless of whether it's  
a "quick" piece of concept art or a full painting you intend to sell to a gallery for six figures: 
the rendering phase.

Rendering
As we established in Chapter 10, Enforcing Fundamentals, rendering can be defined as 
bringing a painting to a polished finish. You can do this in a variety of ways: 

•	 Brushes: Dry brushes for details, hard round brushes for specific drawing, detail, and 
refining edges, and soft brushes to allow for atmosphere, fog, and softening edges.

•	 Edges: Sharp edges to bring focus, soft edges to lose focus or imply softer forms, 
and lost edges/painterly edges to bring artistic flair and emotion near focal points.

•	 Contrasts: Repeating shapes, breaking shape patterns, values, complementary 
colors, and size proportion comparisons such as our dragon versus our mountains, 
and our rider versus our dragon.

Instead of discussing each step that I will perform regarding fully rendering this piece  
(as I plan to spend upward of 4 hours doing the rendering pass on this one so that I can 
maybe refine it further for my portfolio), I want to provide a cheat sheet on the brushes, 
edge techniques, and contrasts I'm planning to use. Let's look at them in the same order 
they were mentioned in the previous list:

•	 Brushes: I plan on using the b) Basic 2-Opacity, b) Basic 6-Details, d) Ink-1 
Precision, k) Blender Basic, m) RGBA 01 Thick-dry, m) RGBA 03 Rake, and m) 
RGBA 05 Impasto Details brushes as my heavy-hitters, making up a vast majority 
of my brushwork. 

•	 Edges: My mountains, dragons, and architecture will have relatively sharp outlines 
while having smoother edges within each form. I want the texture of the impasto 
brushes to allow for a variety of edges where possible (namely, the mountains and 
ground), and softening edges where I want to bring mist, fog, and clouds to separate 
planes and lead the eye of the viewer and player.

•	 Contrasts: The red background will work well with our more cyan-inspired 
foreground, with our midground being a nice transitional gray (with hints of blue 
and purple). The size comparisons of the dragons will bring a nice sense of scale 
as we will repeat some general shapes (such as their wings and tails), making the 
viewer figure out that the dragons are similar.
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The following are a few general tips on rendering:

•	 Be patient. The time that's spent during this portion of a piece can be the difference 
between a good piece of art and a piece of art that will get you noticed/hired/
commended by your peers. 

•	 After enough practice, the rendering process can be relaxing instead of stressful. 
If you are a fan of podcasts, audiobooks, or other audio/video material, you could 
implement this into your "rendering time," giving you something to preoccupy your 
mind while you whittle away on the small details of a piece.

•	 Stay committed. The longer you stare at your piece, the more you're going to want  
it to be done. You'll start noticing problems where there are none, you'll start 
second-guessing your choices, and often, you will feel like the time you are investing 
isn't going to amount to much. This is where techniques such as "flipping your 
canvas" (changing your perspective on a piece by flipping the canvas horizontally 
via Image > Mirror Canvas Horizontally to notice things in a new way) can be 
refreshing and useful. Another great strategy? Sleep on it! When you wake up the 
next day, you may notice exactly what you want to fix or come to the realization that 
you have a better painting than you thought you did. A win-win!

After about 4 hours of rendering, here's what we have of our Dragon Rider Temple  
piece so far:

Figure 12.36 – Our piece, "Dragon Rider Temple," after 4 hours of rendering
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You'll notice that some dramatic changes were made during rendering, namely, to our 
structures, the rendering of our foreground dragon, and the overall "vibe" of the piece.

For the foreground dragon, I wanted to add a nice, pronounced contrast, leading me to 
choose a warmer orange color to play against the cyans of the mountain behind it. I also 
wanted to separate the form of the dragon from the background, so the bright rim light, 
even if it's not realistic, is an effective tool to achieve this:

Figure 12.37 – The foreground dragon, using complementary colors and rim light to separate forms
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I also wanted to develop the structures we added during the Improving our design sense 
section of this chapter to make them feel a little more "alien" in nature, embracing the 
high-fantasy feel of the dragons by implementing some strange structural brushwork 
under our dragon head monument while giving our tree-trunk type shapes almost  
a transparent, ethereal glow-type feel:

Figure 12.38 – The structures, featuring a few new design ideas

We've gotten our piece to a point where we can present it to a committee or art director, 
and I'm feeling happy with what we have! I feel like it meets the prompt well, but also 
leaves some room for interpretation and refinement based on feedback from our fictional 
art director. It's always a good idea to keep an open mind (and an open canvas!) for other 
ideas that could improve your piece. Never be sacred with your ideas when you're working 
in a professional pipeline, as anything can be improved with tweaking and feedback!  
Be confident, work well with others, and you'll have a storied career ahead of you.

To seal this deal, let's do a few of my favorite "finishing touches" – things that will get  
you a few "oohs and aahs" when your piece comes across a person's timeline or art share.
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Applying finishing touches and  
post-processing
Post-processing can be defined as tweaks that you can make to your image after the fact 
to further enhance and finalize your image. This can include (but is not limited to) color 
corrections, level (value) adjustments, light bloom effects, noise filters, and sharpening 
passes. Let's dig into a few of these, starting with adding some cool light bloom effects.

Creating our light bloom
To add some dramatic flair to our concept design, we can add some cinematic 
"light bloom" effects, where saturated bright hits of light can be sprinkled about our 
composition, drawing in our viewers with some fancy contrasts. These are pretty easy  
to create in Krita and only take a few steps:

1.	 Grab a nice airbrush (such as b) Airbrush Soft) and create a new layer. Name this 
layer Light Blooms and set the blending mode to Color Dodge.

2.	 Choose a color, preferably one that matches a background hue (in our case, maybe  
a red or gray-purple).

3.	 Lightly apply some brush strokes around points where you would like light to be 
"bloomed" or "blown out." This can help draw the eye, but also add a mystical touch 
to your work. I want to add a few light bloom hits to our upper clouds, as well as the 
gaps of the canyons with the fog near the ground:

 

Figure 12.39 – Our "light bloom" effect gives some cool ethereal lighting effects



378     Refining and Creating Cinematic Concept Art

The most impactful area you can place these light bloom effects in is where a hard edge  
of a foreground element overlaps with a more atmospheric, out-of-focus background 
element, as we have in the preceding figure. Experiment with other locations, but remember 
to be subtle! It's just like seasoning on food – a little goes a long way if done properly!

Adjusting colors
We've added some cool lighting, so let's do a quick color correction to get one last look  
at our colors and how they work together:

1.	 Create a merged copy of our image on a new layer. Name this new layer Color 
Adjustment.

2.	 Click Filter > Adjust > Color Balance.
3.	 From here, make some edits to the Shadow, Midtone, and Highlight tones. Keep 

in mind the theory of "warm light and cool shadows" or vice versa to guide your 
decision making. Let's take a look at my image, and the settings I used in the Color 
Adjustment layer:

Figure 12.40 – Our image after adjusting its colors with the settings shown
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4.	 The colors are slightly more vibrant, the contrasts became slightly higher, and 
overall, the piece reads a little better at a distance. Job well done!

There are only two steps left in my normal post-processing ritual, so let's get to them! 
First, let's run a quick sharpening filter to bring out those brush strokes and edges.

Running a sharpening filter
Using Sharpen and Unsharp Mask are great ways to bring about clarity and crispness on 
your edges. Technically speaking, these filters "sharpen" the edges of contrasts on your 
piece, giving a higher fidelity and increasing contrasts for things such as painterly edges 
and hard edges. Think of it as "outlining" edges that have the potential to stand out from 
one another in terms of their composition.

I'm going to run a quick Unsharp Mask filter on my Color Adjustment layer since  
this layer already has the full amount of visual information I need as it's a merged copy  
of the image:

1.	 With the Color Adjustment layer active, click Filter > Enhance > Unsharp Mask.
2.	 With the Unsharp Mask filter (and really, any of the sharpening filters), making  

a little tweak goes a long way in changing the amount of information that's 
presented via the filter. You may be tempted to crank the knobs all the way up,  
but you'll essentially end up with a disaster of pixels, blown-out contrasts, and  
wild-looking colors.
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While making a blown-out, psychedelic pixelated mess might be a cool effect in and of 
itself, it's not what we're needing for this piece. All we need to do is enhance the clarity of 
some of our paint strokes and add some crispness to the hard edges, so I'm going to apply 
just a touch of increase to the Amount and Threshold properties. The full settings, plus  
a zoom-in of how it is impacting my edges and brushstrokes, can be seen in the  
following screenshot:

Figure 12.41 – The Unsharp Mask settings, with brushstrokes on the left-hand side for comparison

I always enjoy the look of a nice sharpening mask as it helps accentuate more painterly 
brushwork. Of course, if you'd like to only have your Unsharp Mask impact certain key 
areas of your piece (which is especially helpful near focal points), you can click Create 
Filter Mask to save these settings into a mask and control visibility that way.

There's one final step that I like to do to "finish" a piece, especially if it goes in my 
portfolio: adding a noise filter.
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Adding a noise filter
Noise (also known as visual noise, or sometimes known as visual static) can be defined 
as a special effect that gives your work a more "filmic" look as it adds grainy pixels of red, 
green, and blue hues to your painting, giving a great approximation of "film grain." It's 
very easy to do this in Krita, gives you complete control of the effect, and the results look 
superb! To create a convincing, filmic noise filter, follow these steps:

1.	 Create a new layer and name it Film Grain.
2.	 Fill this layer with 100% black. You can either paint this in manually or use the Fill 

bucket tool (the F hotkey) with black set as your foreground color.
3.	 Once the full black has been applied to your Film Grain layer, click Filter > Other 

> Random Noise.
4.	 A window will appear, and you will immediately see the black canvas fill up with 

red, green, and blue "static" pixels of noise. The default value for Level is 50, but I'm 
going to lower it to 26. I'm also going to keep Opacity at 99 as I'll be controlling the 
opacity of this layer manually momentarily:

Figure 12.42 – Our Random Noise settings on our black Film Grain layer
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5.	 Once you're happy with your settings, click OK.
6.	 Now, for the magic! Change the Blending Mode setting of your Film Grain layer to 

Screen. This will remove the black and lighten the noise pixels.
7.	 Lower the Opacity setting of your Film Grain layer to around 30%. 

As you zoom in, you'll still see the clarity and sharpness of your brushstrokes (due to 
the Unsharp Mask filter we ran), but everything will "mix" well as the noise gently 
softens the colors to be more harmonious (since all of the colors are now impacted by 
the red, green, and blue noise pixels evenly, acting as a "mother color" of sorts).

And there we have it! A successful, portfolio-ready piece of concept art that you 
can wow your friends, colleagues, and potential employers with! You've used all of 
the tips and tricks you've learned from the book thus far and integrated all of the 
lessons into one giant project that you can be proud of:

Figure 12.43 – Our completed concept art piece, "Dragon Rider Temple"
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Woohoo, congratulations! This is a piece you should feel proud to show off, and hopefully, 
it successfully integrated and got you to practice a lot of the topics we've covered in this 
book. Feel free to continue with this piece, make further refinements, or start a new 
concept art piece from scratch using the methods we've covered!

You're only limited by your imagination and should have a solid understanding of Krita 
and many of its bells and whistles to make your artistic journey more rewarding, more 
capable, and, honestly, just more fun!

Summary
Wow, what didn't we do in this chapter? You started with nothing more than a blank 
canvas and a few general layout ideas, and ended up with a portfolio-ready piece of 
concept art, completely from your imagination!

We discussed using our tools and knowledge (namely our ideas of perspective, and some 
layout aids in the form of our Golden Ratio image and our Grid and Guides setup to do  
a proper Rule of Thirds) to make a strong start. Then, we discussed the power of values and 
shape language to build a few basic, but visually appealing, thumbnails to compare with 
one another. After that, we covered the all-important task of looking at our work objectively 
and learning some skills to help us in making the best choice between images when we are 
faced with multiple compositional options for a project.

Once we decided on our favorite thumbnail, we made some edits to colors and shapes  
to find a nice middle ground to keep the best of each of our two thumbnails. Then,  
we covered the act of rendering and finalizing a painting while staying loose and open 
with our decision making.

Finally, we learned how to "finalize" our image, bringing some great special effects such 
as light blooms, film noise, and sharpened paint strokes to the forefront to showcase what 
we've learned throughout this book.

Needless to say, I'm very proud of how far you've come and how your understanding of 
Krita (and digital image making in general) has hopefully graduated leaps and bounds 
since the beginning of our journey together.

You know what they say, all good things must come to an end, and in Chapter 13, Going 
beyond These Pages, we will bring this book to a close. We will cover things you should 
keep in mind during your journey in visual arts, as well as ways you can work on your 
artistic weaknesses. I'll also provide some recommendations on further reading and 
communities to be a part of and discuss the single most important rule of all visual art…

See you shortly!





13
Going beyond  

These Pages
We've made it! Congratulations if you've been following along step by step, project by 
project! If you're using this book as a general reference, I hope that each time you picked 
it up, you found what you were looking for! For this final chapter, I wanted to bring this 
experience to a close with some general tips for artistic improvement, give some shout-
outs to other Packt Publishing books that may enhance your abilities in digital drawing 
and painting, and give a few platitudes for you to remember on your lifelong artistic 
journey.

In this chapter, we will cover the following topics:

•	 Finding your niche – what Krita can do for you

•	 Working on your weaknesses – exercises for artistic growth

•	 Reading recommendations – where should you go from here?

•	 Remembering the single most important rule of art

Throughout this chapter, instead of tutorial images, I'll be sharing some images from my 
portfolio, featuring both client and personal work. Let's get started by discussing Krita's 
capabilities and how they can shape your journey as a digital artist.
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Technical requirements 
For this chapter, you may want to prepare the following: 

•	 Your favorite drink

•	 A nice pile of snacks

•	 A comfortable place to sit

Finding your niche – what Krita can do for you
Throughout this book, we went through three different project styles:

•	 A basic landscape to learn about layers, blending modes, and color splashing

•	 A still-life study, bringing a traditional artistic approach to a digital art project

•	 A piece of imaginative concept art using all the skills we've learned throughout this 
book as a "capstone" project to go into a portfolio

The projects were set up in this way to give you a range of experiences and working styles 
within Krita.

Where's the Animation Stuff?
I also know that Krita has some incredible animation tools, but as I'm not an 
animator by profession or by hobby, I didn't feel comfortable giving advice for 
that art medium in this book. In this chapter, I'll provide a link to a fantastic 
Krita community that has a wide range of artists from multiple disciplines, 
including all of the animation tips and tricks you could ever want!

I'm a digital painter, illustrator, and art instructor by profession, so that's where the focus 
lay with these projects. I'm hopeful that each project provided a few problem-solving 
techniques that can be used for your projects, whether they match the "style" of what we 
did together here in this book or not. 

Krita's strength is in its versatility, and it's a piece of software that can (and will) grow 
alongside you and your skills. Every time I open up Krita, I'm surprised by how well it  
can handle pretty much anything I throw at it. Photobashing, traditional-style painting, 
even graphic designing thumbnails for videos or websites – Krita doesn't break a sweat.  
As shown in the following figure, I wanted to do a vibrant color study with loose 
brushwork in a mishmash hybrid style of three of my art idols – Anders Zorn, Craig 
Mullins, and Joaquin Sorolla:
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Figure 13.1 – A loose-brush color study in the style of Anders Zorn, Craig Mullins, and Joaquin Sorolla

I highly recommend finding your artistic niche and tailoring Krita to be your  
powerhouse toolbox for that craft. Do you have a huge interest in doing art for video 
games or books? Card games? Traditional-style portrait painting? Children's books? 
Television commercials? Fashion design? No matter what your goals (whether 
professional or hobbyist), find your preferred workflow in Krita and make it happen.  
Trust me, as we discussed previously, Krita can keep up with us no matter what we throw 
at it and its flexibility is second to none in customizing your perfect workspace.

Another benefit of Krita's versatility is, let's say you want to change your niche or dabble 
in a different style altogether. Since Krita has so many features, the only investment you 
need to make to change up your artistic goals is the time and dedication it would take 
to learn the new workflow. Once you know the ropes of Krita, the custom UIs, and your 
favorite brushes and tools, you'll be amazed at how fast you will learn new mediums. 

Speaking of, let's talk about a few key exercises you can perform to improve your overall 
artistic skillset.
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Working on your weaknesses – exercises for 
artistic growth
This section is going to be very short but will cover a few very dense topics that you can 
study (using either this book, other Packt books, or online resources) to improve your art 
skills. I will put my top three recommended exercises in bullet-point form, as they're not 
long or difficult to describe:

•	 Draw basic shapes intersecting with other shapes: As I get more and more  
work in the industry, I'm noticing that the fundamental of "shapes on shapes,"  
or 3D shapes (such as a cube with a sphere or cone on top, in various perspectives) 
intersecting with one another, makes up at least 85% of the problem-solving in 
concept art, key art, and marketing art. The following is an example of this:

Figure 13.2 – A mountain painting, focusing on "shapes within shapes" to show light and form
I focused primarily on how different shapes of rock could protrude out of  
a mountain, and the different ways they could catch fantastical light. Believability 
in how shapes relate to each other is the job, and exercises that help you define basic 
forms will improve your art dramatically in a small amount of time.
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•	 Master studies: Find your favorite artist and do a master study. This can be a study 
of their brushwork, their composition, their values, or a one-to-one, stroke-by-
stroke recreation of one of their pieces. I always feel like I make huge improvements 
after I do a master study, as I get the experience of solving similar problems that  
my art heroes have, and I get to understand why they made certain decisions.  
For instance, I learned a lot from this painting study of a marble statue:

Figure 13.3 – A master study of a statue, focusing on edge control and brushwork
Transferring one artistic medium into another is a great way to further your 
understanding of both.

•	 Still life: There's a reason we included a still-life project in this book! While a lot of 
people may find these mundane or boring, I've had an immense amount of success 
by taking my time doing still-life studies. What's so powerful about this is that you 
can focus on getting a photo-realistic likeness of your still-life, or you can use it as 
an excuse to try brand-new mediums within Krita (such as gouache, watercolor,  
ink on board, or charcoal). You can even improve your traditional art chops in this 
way as well!
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There is a ton of exercises, techniques, and foundational skills you can practice to improve 
your artistic skills. Don't limit yourself to only trying one thing – the power of working 
in a digital format is how fast you can experiment with things such as color, sizes, 
techniques, and formats. As proof, here's a true blast to the past: my first main attempt at 
"photobashing," circa 2019, using Krita and a busted-up old Wacom tablet I had owned 
since 2006:

Figure 13.4 – An old photobash painting, circa 2019! *Wipes tears* Man, we grow up so fast!

With the flexibility of Krita, I had the confidence to try my hand at a technique I had only 
dreamed about learning, and now look – I'm writing a book on the topic! It's crazy what 
possibilities decent tools can open up for you! 

On that same point, I'd like to do a shout-out to two other books from Packt Publishing 
that you may enjoy, and are perfect supplements to this book if you want to improve your 
overall comfort and understanding of creating digital art.
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Reading recommendations – where should 
you go from here?
I'm honored to be one of the first (if not the first!) authors for Packt to cover Krita! That 
being said, there are a few other authors that have done incredible work discussing a few 
other programs you may be interested in learning as a digital artist:

•	 Learn Clip Studio Paint – Third Edition, by Inko Ai Takita and Liz Staley: This book 
covers another great digital art platform, Clip Studio Paint! They cover creating 
comics, using 3D figures and objects to create line art, color palettes, and more.  
This is a natural successor to this book if you wish to further your understanding  
of the craft!

•	 Mastering Adobe Photoshop Elements 2022 – Fourth Edition, by Robin Nichols: 
If you're interested in the Adobe suite of products, there's no better primer for 
Photoshop than Robin's, in my opinion. You'll go deep into digital art mainstays 
such as metadata, keywords, backing up your media, some advanced drawing and 
painting techniques, and more. It's a true masterclass that's highly recommended!

I suggest taking a good look at what Packt has to offer since I learned how to program 
JavaScript thanks to some of their books! That feels like a lifetime ago – before I went  
full-time as an artist… But, as they say, that's for another book, ha!

Now, all joking aside, it's time to bring this book to a close. I want to leave you with some 
motivational, "artist guardian angel" advice that has served me well, as well as teaching 
you the single most important rule for all visual art. Yes, I'm being serious.

Remembering the single most important rule 
of art
Before we cover the "single most important rule of visual art," I want to give you a few 
choice things to think about:

•	 Done is better than perfect: You've probably heard the saying "quality is better 
than quantity." While I agree with the sentiment, I think quality and quantity will 
make you that much better. Defeat your instinct of being a perfectionist – it's self-
defeating in nature. I would rather say you make 30 "okay" pieces of art, rather than 
one "great" piece that took you 30 times as long to make as the others. Why? I'd be 
willing to bet that after the 30 "okay" pieces, you'll be more confident in your skills, 
you will have solved more problems successfully, and the quality of your last few 
pieces will be better than your "great" piece that took you 30 times as long. Work 
hard, and work often. You've got this.
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•	 Your voice matters: There is only one you. I've seen many incredible creators stop 
their hobby or their passion outright because they feel they're "not good enough," 
or "not adding anything of value" to the craft they're looking to learn. Keep this in 
mind: you are the only you that has ever, and will ever, exist. There's nobody that 
can tell your story the way you can, nobody can express ideas in the same way as 
you, and the world is a better place because you're in it. We want to hear stories 
from others – that's how we grow as a people. The world needs more creation and 
less destruction, so don't be afraid to put yourself out there.

•	 Fail fast and fail often: The only way to get better at something is to be bad at  
it first. Art, just like any other tangible skill, can be learned. Think about this: can 
you drive a car? Can you ride a bike? Have you learned a language or the rules of  
a game or sport? Before you knew how to do these skills… you didn't know how to 
do them! I know it sounds obvious, but the point is this – be kind to yourself, show 
yourself grace during the learning process, and allow yourself to fail fast and often. 
You learn from your mistakes and failures, and the beauty of working in digital art 
is how fast and often you're able to fail. Make it a habit: you have to get through the 
bad paintings to get to the good ones.

•	 If you don't like it, change it: On the same line of thought as our previous point, 
the fact that we are creating works of art in a digital format allows us a lot of 
liberties regarding changing and editing something we may be working on. If you're 
ever in a rut when it comes to a project you're making, take some time away to get 
a refreshed perspective. When in doubt, sleep on it, or take a break to play your 
favorite game or do one of your favorite hobbies. You'll return with a "new tank of 
gas" in your creative tank and be ready to tackle problem-solving in a more coherent 
way. Save many variations of a piece, save often, and know that you can always 
change something that's not working. Digital art – isn't it awesome?

Now, without further ado, let's discuss the single most important rule of visual art. If you 
take nothing else from this book, take this next sentence, post it up on a placard in your 
home or office, and think about it every day:

If it looks good, it is good.

That's it. That's all there is to it. If you find a workflow in Krita that works well for you,  
that breaks every single rule or lesson I taught in this book, but you like the look of what 
you created, then you've succeeded as an artist. 

If it looks good, it is good. 
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When you make your biggest strides in your work and "level up" your skills, you're going 
to notice new ways to solve problems and add emotion to your work. You'll be excited to 
crank out new stuff, apply for those art jobs, and even hang your art in your own home. 
While you go through the learning, the successes, and the failures, you'll always return to 
the number one rule.

If it looks good, it is good.

When you make art for loved ones, make emotional art to get through hard times, apply 
your skills by teaching a family member what you know, win awards for your work, seal  
a contract with that dream client, or take a 12-year break from not so much as picking up  
a pencil before being pulled back into your calling (guilty as charged here), when you 
return to the craft, there's only one rule that matters.

If it looks good…

It is good.

I'll leave you with something I always say to my students once they graduate from  
a mentorship or semester with me:

Go make cool art.

Summary
In this chapter, we discussed how Krita can grow alongside your artistic growth, some key 
exercises to always level up your skills, some amazing books from Packt to further your 
learning, and a few rules and motivational ideas to take with you far beyond these pages.

I want to take this final moment to personally thank you. Thank you not only for taking 
a chance on this book but also for adding your artistic voice to the world. As I said 
previously, I think creation always defeats destruction, and your creative voice has made 
an impact on the world for the better. Thank you so much for allowing me to be part of 
your artistic journey – I'm honored. 

I'm rooting for you – know that you always have an art guardian angel in me, and know 
that you have what it takes to make your dreams come true, too.

With great power comes great responsibility, and I can't wait to see the art you create  
that changes the world.
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graphic drawing tablet  4, 5
grids and guides

setting up  255
grid settings

applying  259-261
Grid window

key features  258, 259

H
hard edges  290
high-dynamic-range (HDR)  45
Highlights  201, 281
HSV Adjustment filter  216
Huion H610 Pro V2 graphic 

drawing tablet  5
Huion Kamvas 20  6

I
Image Maximum (IMAX)  45
industry-standard paint-over techniques

design sense, improvement  368-373
learning  361-364
photo textures, applying  364-367
rendering phase  373

initial colors
laying in  283-288

K
key art  309
Krita

about  8, 386, 387
Android mobile version  9
.appimage file  11
features  9, 10
hardware  4
history  9
key exercises  388-390
styles  386
URL  9

Krita Artist community
about  9
URL  9

Krita documentation
reference link  95

Krita hardware
computer upgrade  7, 8
graphic drawing monitor/pen display  6
graphic drawing tablet  4, 5
tablets  4

Krita installation
about  10
step-by-step installation guide, 

for Windows  11, 13-15
system requirements  11

Krita UI
about  16
advanced options, configuring  27
file menu  18
pop-up palette  20, 21
reset Krita configurations option  27
splash screen  16
startup screen  17
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toolbar menu  18
toolbars, configuring  24-26
workspace  19
workspace, customizing  22, 23
workspace, sharing  24

L
landmarking  262
landscape

versus freeform  39
versus portrait  39

landscape composition
controlling, with layers  69-74

landscape orientation  
thumbnail  333, 350-353

lasso tool  175
layer blending modes

about  140
browsing  142-146

layer group  68
layer masking

about  166
Colorize Mask  167
Filter Mask  167
photo information, blending  168-174
Transform Mask  168
Transparency Mask  167

layer modes  140, 141
layers

about  66, 67
grouping  80-85
used, for controlling landscape 

composition  69-74
levels, adjusting

about  275, 276
input levels  277, 278
output levels  278, 279

Levels Curve filter  216
limited color palette  61
linear perspective

versus curvilinear perspective  319
lost edges  290

M
magic wand tool  175
magnetic selection tool  176
marketing art  310
Masks  166
Midtones  201, 281
monochromatic color  57, 210
mood

concept  210
mood painting

example  309
Mother Color

about  213
utilizing  213-215

MyPaint brush engine  121

N
naming conventions

bundling  133
notes

taking  241-244

O
one-point perspective  314, 315
opacity

working with  262
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P
paint

smudging  303-305
painterly edge  291
painting

color, selecting  88
refining  85-91
starting  75-80

path selection tool  176
perspective

about  313
one-point perspective  314, 315
three-point perspective  317, 318
two-point perspective  315-317

perspective tools
about  181
navigating  181-186

photo information
blending  168-174

photo textures
applying  364-367

Pixel  121
pixels per inch (PPI)  37, 256
polygonal selection tool  175
portrait

versus freeform  39, 40
versus landscape  39, 40

portrait orientation  
thumbnail  334, 343-347

post-processing
about  377
colors, adjusting  378, 379
light bloom effects, creating  377, 378
noise filter, adding  381-383
sharpening filter, running  379, 380

print
versus digital resolution  38

Q
Quick Brush  121

R
random-access memory (RAM)  38
RBG/A (alpha)  43
rectangular selection tool  175
red, yellow, and blue (RYB)  43
Reference Images Tool  263, 264
reference material

evaluating  149
reference in art, destigmatizing  149
resources online, discovering  151, 152
right reference, finding  152
selecting  153-155
stock assets and references, using  150

rendering  302
rendering phase

about  373, 375, 376
tips  374

resolution  36
resource

about  127
exporting  128-133

resource bundle
importing  133-135

return on investment (ROI)  41
RGBA modes

modifying, to CMYK  46, 47
RGB color model  42
Rule of Thirds

about  321-323
versus Golden Ratio  326, 327
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S
selection tools

defining  175
used, for adding edges  174

service provider (SP)  38
Shadows  201, 281
shape language

about  224, 225
examples  225
Layers panel, cleaning up  225-230
used, for breaking into background 

plane  230, 231, 234-237
used, for breaking into 

foreground plane  230-236
used, for breaking into midground 

plane  230, 231, 233, 234, 236, 237
uses  225

shapes
landmarking  262-269

Shift + click selection method  228
Shift-click method  228
similar color selection tool  176
Sketch  121, 310
soft edges  290
still-life studies

about  252
expectations, setting  250, 251
reference, obtaining  251-254

subtractive color model  43
SVG (scalable vector graphics) files  133
SWAP feature  7

T
tags

about  100
categorizing with  101-103
custom tag, creating  103, 104
custom tag, filling  104-109

tetradic color  211
Text tool  241
three-point perspective  317, 318
thumbnails

focusing on  355-359, 361
selecting  354, 355

thumbnails for comparison
colors splashing  348, 349
creating  332
creating, for comparison  334
first canvas, preparing  334-339
landscape-oriented thumbnail  349-353
options, deciding  333
portrait-oriented thumbnail  343-347
second canvas, preparing  339-342

Tool Options  263, 264
tracing  261, 262
Transform Mask  168
Transparency Mask  167
triadic color  57, 211
two-point perspective  315-317

V
value checker layer

setting up  146-149
visual art rule  391, 392
visual noise  381
visual static  381
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W
workspace, Krita UI

about  19
advanced color selector tool  20
brush preset docker  19
customizing  22-24
layers panel tool  20
overview area  20
sharing  24
specific color selector  20
toolbox docker  19
work area  19

Z
Zorn palette  62
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Hi!

I am Wesley Gardner, author of Draw and Paint Better with Krita. I really hope you 
enjoyed reading this book and found it useful for increasing your productivity and 
efficiency in Krita. 

It would really help me (and other potential readers!) if you could leave a review on 
Amazon sharing your thoughts on Draw and Paint Better with Krita here. 

Go to the link below or scan the QR code to leave your review:

https://packt.link/r/1801071764

Your review will help me to understand what's worked well in this book, and what could 
be improved upon for future editions, so it really is appreciated.

Best Wishes,

https://packt.link/r/1801071764
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Subscribe to our online digital library for full access to over 7,000 books and videos, as 
well as industry leading tools to help you plan your personal development and advance 
your career. For more information, please visit our website.

Why subscribe?
•	 Spend less time learning and more time coding with practical eBooks and Videos 

from over 4,000 industry professionals

•	 Improve your learning with Skill Plans built especially for you

•	 Get a free eBook or video every month

•	 Fully searchable for easy access to vital information

•	 Copy and paste, print, and bookmark content

Did you know that Packt offers eBook versions of every book published, with PDF and 
ePub files available? You can upgrade to the eBook version at packt.com and as a print 
book customer, you are entitled to a discount on the eBook copy. Get in touch with us at 
customercare@packtpub.com for more details.

At www.packt.com, you can also read a collection of free technical articles, sign up  
for a range of free newsletters, and receive exclusive discounts and offers on Packt books 
and eBooks.

https://Packt.com

https://packt.com
mailto:customercare@packtpub.com
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Other Books You 
May Enjoy

If you enjoyed this book, you may be interested in these other books by Packt:

Up and Running with Affinity Designer

Kevin House

ISBN: 978-1-80107-906-8

•	 Explore the interface and unique UX characteristics of Affinity Designer

•	 Discover features that allow you to manipulate and transform objects

•	 Apply color, shading, and effects to create unique compositions

•	 Employ layers to organize and simplify complex projects

•	 Use grids, guides, and snapping features as design aids

https://www.packtpub.com/product/up-and-running-with-affinity-designer/9781801079068
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Learn Clip Studio Paint - Third Edition

Inko Ai Takita , Liz Staley

ISBN: 978-1-80056-497-8

•	 Explore Clip Studio Paint and create your own manga stories

•	 Familiarize yourself with the CSP ecosystem

•	 Use Clip Studio Paint Pro's inking tools and find ways to customize your art

•	 Explore the flexibility of the brush engine in Clip Studio Paint Pro

•	 Use palettes to generate colors between foreground and background colors

https://www.packtpub.com/product/learn-clip-studio-paint-third-edition/9781800564978
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Packt is searching for authors like you
If you're interested in becoming an author for Packt, please visit authors.
packtpub.com and apply today. We have worked with thousands of developers and 
tech professionals, just like you, to help them share their insight with the global tech 
community. You can make a general application, apply for a specific hot topic that we are 
recruiting an author for, or submit your own idea.

https://authors.packtpub.com
https://authors.packtpub.com
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